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Software Copyright and Warranty

This legal document is an agreement between you, the
end user, and BIAS, Inc. BY UTILIZING THE SOFTWARE
ON THESE DISKS, YOU ARE AGREEING TO BECOME
BOUND BY THE TERMS OF THIS AGREEMENT, WHICH
INCLUDES THE SOFTWARE LICENSE AND THE SOFT-
WARE DISCLAIMER OF WARRANTY (collectively the
‘Agreement”). THIS AGREEMENT CONSTITUTES THE
COMPLETE AGREEMENT BETWEEN YOU AND BIAS,
INC. IF YOU DO NOT AGREE TO THE TERMS OF THIS
AGREEMENT, DO NOT USE THE SOFTWARE ON THE
DISKS INCLUDED IN THIS PACKAGE AND PROMPTLY
RETURN THE UNOPENED PACKAGE AND THE OTHER
MATERIALS (INCLUDING WRITTEN MATERIALS,
BINDERS OR OTHER CONTAINERS) THAT ARE PART OF
THIS PRODUCT TO THE PLACE WHERE YOU
OBTAINED THEM FOR A FULL REFUND. BIAS SOFT-
WARE LICENSE

1. GRANT OF LICENSE. In consideration of payment of
the LICENSE fee, which is part of the price you paid for
this product, BIAS, as Licensor, grants to you, the
LICENSEE, a non-exclusive right to use and display this
copy of a BIAS software program (hereinafter the
“SOFTWARE”) an a single COMPUTER (i.e., with a single
CPU) at a single location. BIAS reserves all rights not
expressly granted to LICENSEE.

2. OWNERSHIP OF SOFTWARE. As the LICENSEE, you
own the magnetic or other physical media on which the
SOFTWARE is originally or subsequently recorded or
fixed, but BIAS retains title and ownership of the SOFT-
WARE recorded on the original disk copy (or copies) and
all subsequent copies of the SOFTWARE, regardless of
the form or media on which the original and other
copies may exist. This License is not a sale of the original
SOFTWARE or any copy.

3. COPY RESTRICTIONS. This SOFTWARE and the
accompanying written materials are copyrighted.
Unauthorized copying of the SOFTWARE, including

SOFTWARE that has been modified, merged, or includ-
ed with other software, or of the written materials is
expressly forbidden. You may be held legally responsible
for any copyright infringement that

is caused or encouraged by your failure to abide by the
terms of this License. Subject to these restrictions, and if
the SOFTWARE is not copy-protected, you may make
one (1) copy of the SOFTWARE solely for backup pur-
poses. You must reproduce and include the copyright
notice on the backup copy.

4. USE RESTRICTIONS. As the LICENSEE, you may phys-
ically transfer the SOFTWARE from one computer to
another provided that the SOFTWARE is used on only
one computer ata time. You may not electronically trans-
fer the SOFTWARE from one computer to another over
a network. You may not distribute copies of the SOFT-
WARE or accompanying written materials to others. You
may not modify, adapt, translate, reverse engineer, de-
compile, disassemble, or create derivative works based
on the SOFTWARE. You may not modify, adapt, translate,
or create derivative worksbased on the written materials
without the priorwritten consent of BIAS.

5. TRANSFER RESTRICTIONS. This SOFTWARE is
licensed only to you, the LICENSEE, and may not be
transferred to anyone without the prior written consent
of BIAS. Any authorized transferee of the SOFTWARE
shall be bound by the terms and conditions of this
Agreement. In no event may you transfer, assign, rent,
lease, sell, or otherwise dispose of the SOFTWARE on a
temporary or permanent basis except as expressly pro-
vided herein.

6. TERMINATION. This License is effective until termi-
nated. This License will terminate automatically without
notice

from BIAS if you fail to comply with any provision of this
License. Upon termination you shall destroy the written
materials and all copies of the SOFTWARE, including
modified copies, if any.
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7. UPDATE POLICY. BIAS may create, from time to time,
updated versions of the SOFTWARE. At its option, BIAS
will make such updates available to the LICENSEE and
transferees who have paid the update fee and returned
the registration card to BIAS.

8. MISCELLANEOUS. This Agreement is governed by the
law of the State of California.

DISCLAIMER OF WARRANTY AND LIMITED WARRANTY
THE SOFTWARE AND ACCOMPANYING WRITTEN
MATERIALS (INCLUDING INSTRUCTIONS FOR USE)
ARE PROVIDED “AS IS” WITHOUT WARRANTIES OF ANY
KIND. FURTHER, BIAS DOES NOT WARRANT, GUARAN-
TEE, OR MAKE ANY REPRESENTATIONS REGARDING
THE USE, OR THE RESULTS OF THE USE, OF THE
SOFTWARE OR WRITTEN MATERIALS IN TERMS OF
CORRECTNESS, ACCURACY, RELIABILITY, CURRENT-
NESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE
RESULTS AND PERFORMANCE OF THE SOFTWARE IS
ASSUMED BY YOU, AND NOT BIAS OR ITS DEALERS,
DISTRIBUTORS, AGENTS, OR EMPLOYEES, YOU AGREE
TO ASSUME THE ENTIRE COST OF ALL NECESSARY
SERVICING, REPAIR, OR CORRECTION. BIAS warrants
to the original LICENSEE that the disk(s) on which the
SOFTWARE is recorded is free from defects in materials
and workmanship under normal use and service for a
period of ninety (90) days from the date of delivery as
evidenced by a copy of the receipt. Further, BIAS here-
by limits the duration of any implied warranty (or war-
ranties) on the disk to the respective periods stated
above. Some states do not allow limitations on duration
of an implied warranty, so the above limitation may not
apply to you. BIAS’ entire liability and your exclusive
remedy as to disk(s) shall be, at BIAS’ option, either (a)
return of the purchase price or (b) replacement of the
disk that does not meet BIAS' Limited Warranty and
which is returned to BIAS with a copy of the receipt. If
failure of the disk has resulted from accident, abuse, or
misapplication, BIAS shall have no responsibility to

replace the disk or refund the purchase price. Any
replacement disk will be warranted for the remainder of
the original warranty period or thirty (30) days, whichev-
er is longer.

THE ABOVE ARE THE ONLY WARRANTIES OF ANY
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING BUT
NOT LIMITED TO THE IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A PARTICULAR PUR-
POSE, THAT ARE MADE BY BIAS CONCERNING THE
BIAS PRODUCT. NO ORAL OR WRITTEN INFORMATION
OR ADVICE GIVEN BY BIAS, ITS DEALERS, DISTRIBU-
TORS, AGENTS, OR EMPLOYEES SHALL CREATE A WAR-
RANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS
WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH
INFORMATION OR ADVICE. THIS WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER
RIGHTS WHICH VARY FROM STATE TO STATE. NEI-
THER BIAS NOR ANYONE ELSE WHO HAS BEEN
INVOIVED IN THE CREATION, PRODUCTION, OR
DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR
ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR INCI-
DENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS
OF BUSINESS PROFITS, BUSINESS INTERRUPTION,
LOSS OF BUSINESS INFORMATION, AND THE LIKE)
ARISING SUCH DAMAGES. BECAUSE SOME STATES DO
NOT ALLOW THE EXCLUSION OR LIMITATION OF LIA-
BILITY FOR CONSEQUENTIAL OR INCIDENTAL DAM-
AGES, THE ABOVE LIMITATION MAY NOT APPLY TO
YOU.

This Disclaimer of Warranty and Limited Warranty is gov-
erned by the laws of the State of California.

U.S. GOVERNMENT RESTRICTED RIGHTS

The SOFTWARE and documentation is provided with
RESTRICTED RIGHTS. Use, duplication, or disclosure by
the Government is subject to restrictions as set forth in
subdivision (b)(3)(ii) of The Rights in Technical Data and
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Computer Software clause at
252.227-7013.

Contractor/manufacturer is:

BIAS (Berkley Integrated Audio Software), Inc.
1370 Industrial Ave.

Suite A

Petaluma, CA 94952

USA

Should you have any questions concerning this
Agreement, or if you desire to contact BIAS for any rea-
son, please contact in writing:

BIAS Customer Sales and Service
1370 Industrial Ave.

Suite A

Petaluma CA 94952

USA

Copyright 19962003 BIAS, Inc.

Credits:
Peak™ software: Steve Berkley, Andrew Kimpton, Dave
Tremblay

Audio Units™, Mac OS X™ , Macintosh™ , iMovie™ , and
Final Cut Pro™ are registered trademarks of Apple
Computer, Inc.

VST™ is a registered trademark of Steinberg Media
Technologies, AG.

POW Dithering™ is a registered trademark of the POWr
Consortium LLC.

JAM™ & Toast™ are registered trademarks of Roxio, Inc.

™

Pro Tools™ is a registered trademark of Digidesign, Inc.

Premiere™ is a registered trademark of Adobe Systems,
Inc.

FileMaker Pro™ is a registered trademark of FileMaker,
Inc.

Paris™ is a registered trademark of E-mu Systems, Inc.
US-428™ is a registered trademark of Tascam, Inc.
828™ is a registered trademark of MOTU, Inc.

Word ™ is a registered trademark of Microsoft, Inc.
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BIAS Product Support:

Unlimited Complimentary Self Help
Options

If you have questions about installing or using your BIAS
products, please check the manual or user guide first,
you will find answers to most of your questions there. If
you need further assistance, please check:

http://www.bias-inc.com/support.html

for frequently asked questions, an extensive database of
related articles, troubleshooting tips, and more.

Limited Complimentary Technical
Assistance

Ninety days of technical support assistance for up to
three incidents is available with the initial purchase of
Type 1 BIAS products (Peak and Deck). Ninety days of
technical support assistance for a single incident is avail-
able with the initial purchase of Type 2 BIAS products
(Peak DV, Peak LE, Deck LE, Vbox, SuperFreq,
SoundSoap). Type 3 products (OEM versions) are
excluded. Thirty days of technical support assistance for
a single incident is available with the purchase of paid
upgrades to Type 1 and Type 2 BIAS products. The sup-
port period begins when the product authorization code
(PAC) is initially issued following the product registra-
tion. To receive e-mail or telephone technical support,
you will need a valid serial number and must be regis-
tered for a current BIAS product. Please keep your orig-
inal product serial number and PAC in a safe place as it

will be required for support. For customers preferring e-
mail assistance, please use the email form available on
our web site at:

http://www.bias-inc.com/support.html

Or, email:

support@bias-inc.com

For customers preferring telephone assistance, (connect
and toll charges apply), please have your computer run-
ning and close by the phone and call us at:

+1-707-782-1865

9AM-5PM Monday-Friday PST — excluding BIAS holidays

Fee-based Technical Support Options
Fee-based Support is available for those customers
whose support period has expired or for Type 3 (OEM
version) customers. Please call:

+1-707-782-1865

9AM-5PM Monday-Friday PST — excluding BIAS holidays
For customers living outside of North America, please
contact your local BIAS distributor, or contact BIAS

directly. A list of BIAS distributors may be found at:

http://www.bias-inc.com/distributors.html
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BIAS Support Policy and Hours

BIAS, Inc. support policy and hours are subject to
change without notice.

Sales and Non-Technical Customer

Service

For product information, sales, and other non-technical
customer service, please email or call:

sales@bias-inc.com

US: 1-800-775-BIAS (2427)

International: +1-707-782-1866

9AM-5PM Monday-Friday PST — excluding BIAS holidays

No technical support is available at the numbers or email
address above.
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Chapter 1:
Introducing Peak

BIAS Peak is an advanced audio application that provides
superior tools for editing and processing digital audio on
the Macintosh computer. Peak was specifically designed
to meet the needs and demands of audio professionals.
By combining high-quality direct-from-disk digital audio
editing features with a lightning fast, completely nonde-
structive editing environment, Peak provides unsur-
passed audio editing power, and makes a superb addi-
tion to multitrack audio applications programs, such as
BIAS Deck™. Peak offers advanced sampler support,
and works directly with many popular MIDI sampling
keyboards and rackmount samplers. Peak is also the per-
fect audio complement to digital video editing pro-
grams, such as iMovie ™ and Final Cut Pro™.

Peak Features

* Direct-to-disk recording and playback at all sample
rates supported by the sound hardware on your
Macintosh, or supported through third-party audio

hardware
*  User-customizable waveform display

*  Support for commonly used audio document for-
mats, including AIFF, Sound Designer II™ | WAVE,
QuickTime™, Raw, System 7 Sound, Sonic AIFF,
Paris™, JAM Image, AU, MP3, and MP4 formats

*  Completely non-destructive file-based editing with
unlimited undo and redo

Professional editing abilities, including user-defin-
able fade curves, silence, and complete support for
cut/copy/paste with multiple undo and redo

By using an application that supports Apple
Events, such as FileMaker Pro™, you can catalog
your Peak sound files and audition them from
within the application

Support for third-party digital audio hardware,
such as M-Audio™, Mark of the Unicorn™, or
Digidesign™ digital audio interfaces, through
Core Audio.

Support for 8-, 16-, 24-, and 32-bit audio files

Support for third-party VST™ & Audio Unit Plug-
Ins, adding more signal processing features to
Peak. Plug-Ins from companies such as BIAS,

™ ™

Cycling"74™ Steinberg™ , Waves ™, and Apple
can be used with Peak for digital filtering, noise
reduction, reverb, equalization, and other effects

in real time

The ability to create audio CDs directly from a Peak

™

Playlist or audio document - or with Roxio Toast
Lite, which is included with Peak

Sophisticated Tools for looping, including Loop

™

Surfer™, Loop Tuner™, and Guess Tempo
Sampler Support

Playlist editing and mastering
Customizable Toolbar and Keyboard Shortcuts

QuickTime Movie window with scrubbing
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Who Is Peak Designed For?

Peak is designed for a wide variety of users, ranging from
composers and multimedia producers to sound design-
ers, mastering engineers, and remix editors. Peak’s com-
prehensive recording, editing, looping, and processing
capabilities make it a powerhouse tool for virtually any
aspect of digital audio production. If you are interested
in sound and possess imagination and creativity, Peak is
for you.

What's New in Peak 4.0?

Version 4.0 of Peak software has several new features and
enhancements, including:

Multi-threaded/multi-processor support
*  AudioUnit plug-in support

* Direct Red Book CD burning from an audio docu-
ment or playlist (no helper burning app needed)

*  New brushed metal interface
*  New high-contrast meters

* Resizable toolbar icons & reconfigurable toolbar
(vertical, horizontal, “cluster”)

*  Audio documents with an expandable drawer, con-
taining a library of reference, region, and loop
markers for that document

¢ Transluscent cursor info overlay (follows mouse
cursor when active)

¢ Improved Nudge Regions ( region crossfade editor)
window

* ImpulseVerb™ convolution-based  sampling

reverb
¢ Bit Usage Meter

*  Harmonic Rotate (DSP tool mainly for sound
design)

*  BIAS Sqweez™ dynamic compressor/limiter VST
plug-in

¢ Ability to use single inserts or Vbox matrix for plug-
ins (Vbox hosts only VST plug-ins/Inserts can host
VST or AU plug-ins, and both types can be mixed
on different inserts

*  Dynamic tempo change (envelope based)
*  Markers from Tempo (Grid)

*  “Magic” Pencil Tool mode - automatically smoothes
out clicks and pops in waveform

*  Higher MP3 encoding rates (up to 320 kbps)

Minimum System Requirements

To use Peak you will need:

* Any G3/G4 Macintosh or PowerBook (including
iMac and iBook)

*  MacOSXv.10.2 or later

e 256 MB RAM

*  Ahard drive with 18ms access time or better
*  Color Monitor, minimum 640x480 resolution

*  CoreAudio support of third-party hardware for play-
back may require drivers from hardware manufacturer
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Maximizing Peak’s Performance

To get the best performance out of Peak and your
Macintosh, do the following:

To maximize Peak performance:

* Set your monitor to no more than thousands of
colors (256 colors is recommended for older
Macintoshes).

* Turn File Sharing off, unless you need it.

* Disconnect your Macintosh from any networks
and turn off AppleTalk, unless you need to be on a
network.

*  Optimize your hard drive. (See Chapter 3 to learn
about proper hard disk maintenance.)

e Use a fast, dedicated hard drive for audio record-
ing and playback.

About Your User’'s Guide

Peak is designed to be simple and intuitive. Your User’s
Guide is designed to help you set up and use Peak for
digital recording and editing as quickly and easily as pos-
sible.

This User’s Guide assumes that you are familiar with
standard Macintosh operating techniques, including;

*  Setting up, starting, and using your Macintosh

*  Choosing commands from menus

*  Double-clicking, selecting, Shift-selecting, and

dragging with the mouse
*  Opening, copying, saving and deleting files

*  Opening, closing, scrolling, moving, re-sizing, and
selecting Macintosh windows

If you don’t know how to perform these tasks, please
refer to your Macintosh User’s Guide and spend a little
time learning about your Macintosh before going any
further. This will make using Peak much easier and more
enjoyable.

The Chapters in your Peak User’s Guide are arranged in
the order in which you would typically perform tasks
when embarking on an audio project:

* Chapter 1 introduces you to Peak and explains
some of the requirements for using Peak software

*  Chapter 2 explains how to install Peak software
and configure your Macintosh for recording and
playback

*  Chapter 3 introduces you to some basic concepts
of digital audio and disk-based recording, as well as
basic Peak operations

e Chapter 4 explains how to configure Peak for
recording and playback with Apple’s CoreAudio
system, as well as optional configuration informa-
tion for using the Mac OS X Audio HAL & FireWire
DV systems.

* Chapter 5 introduces you to the concepts and
techniques of nondestructive editing with Peak

*  Chapter 6 explains how to create regions and
sequence their playback using Playlists, as well as
how to burn audio CDs

*  Chapter 7 explains how to use Peak’s native DSP
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tools

*  Chapter 8 explains how to use VST & Audio Unit
plug-ins, and how to use Vbox SE to enhance
Peak’s audio production capabilities

*  Chapter 9 explains how to use Peak’s Batch File
Processor as well as how to use Apple Events for
file management

*  Chapter 10 explains how to import samples direct-
ly from compatible samplers (to edit or process
the audio using all of Peak’s functions) and send
the modified sample back to the sampler

*  Chapter 11 describes each of the commands found
in Peak’s menus

*  Appendix 1lists the default Keyboard Shortcuts for
Peak

*  Appendix 2 provides a list of useful Peak actions
not described elsewhere

*  Appendix 3 includes a troubleshooting guide for
common problems

* A Glossary and an Index complete your Peak
User’s Guide

Look for important tips and notes whenever you

H see this exclamation mark.

About Peak LE & Peak DV

Peak LE & Peak DV are feature-limited editions of “Peak”,
and not all features are available. Peak LE has a feature

set designed for music production, and Peak DV is
designed to provide the essential tools required by a dig-
ital video editor, needing to edit the audio contained in
QuickTime movie soundtracks, DV clips, and audio files
commonly used in Non-Linear Editing systems.

Upgrades are available from Peak LE or Peak DV to the
professional edition of Peak at discounted prices. Please
contact BIAS for further information.

If you are using the limited edition (LE edition) of Peak,
not all features will be available. Specifically, the follow-
ing features are not available in Peak LE:

* 32 bit support

*  Crossfades and VST effects in Peak LE Playlists

* Limited to a single VST insert without Vbox inte-
gration

*  Loop Surfer and Loop Tuner
*  Customizable Keyboard Shortcuts
*  Customizable Toolbar

*  Remove DC Offset

*  Pitch Change

e ImpulseVerb

¢ Harmonic Rotate

¢ Bit Usage Meter

*  Markers from Tempo

¢ Import Dual Mono

*  Meters Dialog

*  QuickTime movies
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*  Batch File Processor If you are using the digital video (DV) edition of Peak,

. not all features will be available. Specifically, the follow-
*  Export Regions . . .
ing features are not available in Peak DV:

*  Sampler Support
* 32 bit support

¢ Convolve

*  Crossfades and VST effects in Peak DV Playlists
*  Modulate

* Limited to a single VST insert without Vbox inte-
* Add

gration

*  Amplitude Fit . .
P *  Loop Surfer™ and Loop Tuner ™

* Ch Durati
ange Juration *  Customizable Keyboard Shortcuts

. fade L
Crossfade Loop *  Customizable Toolbar

e Dith
ither e Remove DC Offset

*  Find Peak
nare *  Pitch Change

*  Mono To Stereo e ImpulseVerb
u

L]
Stereo To Mono *  Harmonic Rotate

*  Phase Vocoder « Bit Usage Meter

. Rappi
ppify e Markers from Tempo

*  Repair Clicks e Import Dual Mono

*  Swap Channel
wap Channels *  Meters Dialog

*  Threshold .
*  Export Regions

*  Recording Notepad
ecording Notepa *  Sampler Support

*  Recording Input Levels

e Convolve
e Specialized Apple Events for Playback fi data-
pecialize ppe vents for Playback from a data . Modulate
base such as FileMaker Pro
e Add

Features that are not supported in Peak LE will ) i
L ) *  Amplitude Fit
@ show this icon in the manual. Features unavail-

able in Peak LE will appear grayed out in their o (rossfade Loop

menus.

e Dither
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*  Find Peak

*  Mono To Stereo

¢ Stereo To Mono

¢ Phase Vocoder

*  Rappify

*  Repair Clicks

*  Swap Channels

*  Threshold

*  Recording Notepad

*  Recording Input Levels

*  Specialized Apple Events for Playback from a data-
base such as FileMaker Pro

&

Features that are not supported in Peak DV will
show this icon in the manual. Features unavail-
able in Peak DV will appear grayed out in their
menus.

Using Online Help

Peak provides two types of online help. The first type,
Balloon Help. Balloon Help will show you the functions
of each menu item as you move the mouse across differ-
ent menu items. If you hold the mouse cursor over a
Toolbar icon for 2 seconds, the Balloon Help for that
icon’s function will appear.

The second type of online help is available under the
Peak menu. Choosing Help will launch your browser and
load the BIAS documentation page where you can access
BIAS Tutorials — you may want to visit this page from

time to time, to check for availability of new tutorials.
You can also use the Links menu to access BIAS docu-
mentation and technical support online.

Peak 4 (G4+) |
About Peak...
Help %8/
Authorize Peak™...
Preferences...
Services »
Hide Peak 4 (G4+) &H
Hide Others C88H
Show All
Quit Peak 4 (G4+) 8Q

Online Help is available in the Peak menu

Conclusion

Now that you know a little about Peak, proceed to the
next chapter to learn how to install your software and
get started using it.
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Chapter 2: Installing
and Configuring Peak

Installing Peak

Peak’s auto-installer software makes installation very
easy.

Your complete Peak package includes:

e CD-ROM Installer

e Licensed Products Certificate, with the Peak serial
number

Before you install Peak, please check the Minimum
System Requirements in Chapter 1 of this Users Guide.

To install Peak:

1. Ifyou are using any virus-protection software, turn
it off or temporarily remove it, and restart your
Macintosh.

2. Insert the Peak Install CD-ROM in your CD-ROM
drive, open the Product Installers folder, and
double-click the Install Peak icon.

3. When the Installer dialog appears, read the Read
Me for late-breaking information concerning the
Installer; then click Continue to proceed.

4. Select where you would like to install Peak, using
the Switch Disk pop-up menu.

5. Click Install at the bottom right of this dialog.

6. After you have clicked Install, follow the on-screen

instructions.  Peak will be installed onto your
selected hard disk.

7. At the end of the installation, the installer will allow
you to register Peak electronically, which you may
find more convenient than mailing your registra-
tion card.

8. When the installation is complete, a message will
appear indicating that the installation was success-
ful. Click Quit to quit the Installer (don’t forget to
turn back on any virus-protection software that
you may be using the next time you restart the
computer).

Authorization

Peak must be authorized to work on your Macintosh. To
authorize Peak, you will need your Product
Authorization Code (PAC) in addition to the serial num-
ber that appears on your Peak Owner’s Certificate. BIAS
will provide you with your Product Authorization Code

when you register Peak.

You must register Peak in order to obtain your
Product Authorization Code; Peak will not launch
after the 14 day registration period unless you
authorize Peak with your Name, Organization,
Serial Number, and Product Authorization Code!
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When you first launch Peak, it will prompt you to author-
ize it by entering your Name, Organization, Serial num-
ber, and Product Authorization Code.

Welcome to Peak™ 4.01

orveniance,
cally from your Address Bogk.

Frak same | UITET
Wy Studic

123 Ay Street

Smwor o
Gty Peralum <A
city eraluma E

Dp/Postal Code 12345 Country | U5

Emal Address  me@emailcom | prone | 123-456-7380

‘Sl ®  BPR-1Z34567890

tathorizstien (1537 | TAgCD | . 567890 . |EFGHI

 Natify me of product updates & special offers
M Norify P p

(" still Waiting for Autharization Code ) 7 Authorize )

Peak Authorization dialog

Be sure to register! After you have installed Peak, please
register online (by choosing Authorize from the Peak
Menu) or send in the Registration Card included with
your software to receive your Product Authorization
Code, technical support, software updates, and notifica-
tion of upgrades.

Peak will run, fully functionally, in Registration Mode for
14 days. This allows you the time necessary to register
your product and get the Product Authorization Code
from BIAS.

Registering online is the fastest way to receive your
s Product Authorization Code!

Making Audio Connections

While it is possible to listen to Peak using a Macintosh’s
built-in speaker or headphones, most people will prefer to
listen through a better quality external speaker system.

It is very easy to set up audio connections between your
Macintosh and a mixer or speaker system. Your exact
setup will differ slightly depending on whether you are
using the built-in sound input and output connectors on
your Macintosh, or those of a third-party audio interface.

Using the Macintosh’s Built-In
Inputs and Outputs

If you wish to use your Macintosh’s built-in audio inputs
and outputs for recording and playback, do the follow-

ing:

1. Turn down the volume on your playback system.
Peak can be used with a variety of playback sys-
tems, including:

* headphones

* astereo receiver or amplifier and
speakers

* amixer, amplifier, and a pair of speakers

* amixer and a pair of amplified (self-powered)
speakers

¢ orsimply a pair of amplified (self-powered)
speakers, smaller versions of which are often
called “multimedia” speakers.

2. For recording, connect your audio source output
to the Macintosh’s audio input connector. Your
audio source can be one of a variety of devices,
such as:

* acassette or DAT deck output

® amixer output
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* astereo receiver line output (such as “tape Many newer Macintoshes may not have a built-in

deck record” output) sound input in which case you will have to use a

! third-party audio interface for sound input —

* aninstrument line output (such as the output unless using a built-in mic, such as that on a
of a synthesizer or guitar pre-amp) PowerBook.

* microphone (built-in or external) ) ) »
For advanced users: Certain professional mixing

consoles, DAT decks, or other audio sources may

On most Mac models, audio input and output jacks are bave a nominal output level of +4 dBu, whereas

- . 1 the Macintosh expects to see a nominal -10 dBV
standard stereo mini-plug (1/8-inch) connectors. Most . ,

) ) d lified Ker i level. Be aware that you may need to adjust your
mixer, receiver, and ampiilied speaker inputs are mixer’s output levels accordingly to prevent over-
equipped with XIR, 1/4-inch, RCA, or mini-plug jacks. To loading the Macintosh’s input; or alternately, you
make the proper connection, you may need to use an may need to use a “+4 to -10” line-matching
adapter. transformer.

Common connections when using the Mac's built-in sound*

Speakers

Audio Input Monitor audio signals coming
from Mac, or any other audio
sources routed through the
mixer — also allows monitoring
audio signals being recorded
into the Mac.

Receives input from
any line-level audio
source (mixer, ampli-
fier, etc.)

Connects to Mac with
1/8” stereo mini-plug

Mixer Main Outputs

Sends audio out to amplifier, or
self-powered speakers.

Audio Output P P
Common types of output con-
nections include 1/4%, XLR, or
RCA - refer to your mixer’s doc-
umentation to see which you
should use.

Macintosh CPU
Sends line-level

audio signal out of
Mac to headphones,
mixer, amplifier, or
self-powered speak-
ers.

Mixer Inputs

Receive audio input from Mac’s

Connects to Mac with audio outputs.

1/8” stereo mini-plug Mixer Auxilliary Outputs

Common types of input connections
include 1/4°] XLR, or RCA - refer to
your mixer’s documentation to see
which you should use.

Sends audio output to Mac’s audio input.

When recording an audio signal through a mixer, the Aux
Outputs allow the computer to record the signal, while the
mixer’s Main Outputs send the signal to the speakers/head-
phones, so you can monitor what you are recording.

*Diagram shows connections via a mixer, which is not required - if connecting directly to speakers, use their volume control, or the volume control on your Macintosh
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Connect your Mac’s audio output to your playback
system’s input.

Connect your playback system’s output (typically
an auxiliary or bus send) to your Mac’s audio
input.

Be very careful to avoid feedback loops (the audio
signal feeds back into itself) when recording.
Feedback can damage both your equipment and
your hearing.

5.

Raise the volume on your mixer or playback sys-
tem. Your system should now be properly config-
ured and ready for recording and playback.

Third-Party Audio Interfaces
If you have a CoreAudio-compatible ~PCI, PCMCIA
(CardBus), USB, or FireWire audio interface installed in
your computer and wish to use its inputs and outputs,
do the following:

1. Turn down the volume on your mixer or playback
system.

2. Make sure that you have installed the third-party
audio interface according to the manufacturer’s
instructions.

3. Install the CoreAudio drivers for your audio inter-
face according to the manufacturer’s instructions.

Common connections with a third-party audio hardware device*

Audio Input

Receives input from
any line-level or mic-
level audio source
(connections will vary
with different devices)

Typically connects to
Mac with RCA, 1/47

or XLR cables

Audio Output

Macintosh CPU

Mixer Inputs

Receive audio input from audio

Speakers

Monitor audio signals coming
from Mac, or any other audio
sources routed through the
mixer — also allows monitoring
audio signals being recorded
into the Mac.

Mixer Main Outputs

Sends audio out to amplifier, or
self-powered speakers.

Common types of output con-
nections include 1/4°, XLR, or
RCA - refer to your mixer’s doc-
umentation to see which you
should use.

Sends audio signal
out of Mac to head-
phones, mixer, ampli-
fier, or self-powered
speakers.

Typically connects to
Mac with RCA, 1/47
or XLR cables

hardware’s outputs.

Common types of input connections
include 1/4°; XLR, or RCA - refer to
your mixer’s documentation to see
which you should use.

Mixer Auxilliary Outputs

Sends audio output to audio hardware’s input.

When recording an audio signal through a mixer, the Aux Outputs
allow the computer to record the signal, while the mixer’s Main
Outputs send the signal to the speakers/headphones, so you can
monitor what you are recording.

*Diagram uses a PCl audio card as an example - other devices, such as USB or FireWire interfaces connect to the computer differently (ie: USB/FireWire
cable), but generally have the same types of inputs & outputs, and can be connected to mixers and other audio equipment in a similar manner
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4. Connect your source’s outputs to the inputs of
your audio interface.

5. Connect the outputs of your audio interface to the
inputs of your mixer or playback systems

6. Raise the volume on your mixer or playback sys-
tem. Your system should now be properly config-
ured and ready for recording and playback.

A typical mixer/computer configuration is to have the
computer outputs go to channel inputs on your mixer
and to have the auxiliary or bus sends from the mixer go
to the inputs of the computer. Instruments you want to
record patch into other channel inputs on the mixer and
can then be routed out the auxiliary or bus sends on the
mixer to be recorded by the computer. The mixer’s main
outputs go to the amplifier/speakers.

CoreAudio

Peak can use CoreAudio — if you want to use a
CoreAudio-compatible third-party audio interface with
Peak, install the CoreAudio driver for the interface (if
required) and launch Peak. Be sure to consult the man-
ufacturer’s instructions when installing your audio inter-
face. For more detail on using Peak with a CoreAudio-
compatible audio interface, please read Chapter 4:
Playback and Recording.

Settings for CoreAudio compatible audio devices can be
set up and customized using the Apple AudioMIDI Setup

utility, located in /Macintosh HD/Applications/Utilities.

eoce

Audio MIDI Setup
[Audio Beviees | MiDi Devices
System Sentings

Detauls Inpu: (DigidesignFW{WSesy T Defaui utpur [Digibesgn i {sibony T

System Output | Buili-in sudio controlier 58]

Selected Audio Device | Digidesign HW ( MBax ) 18

Input Volume nia @8 Dutput Volume nla d8

input Section Output Section
Input Source

Current Format. { 1Ch-44100.0 We-3zbit [§)  Current Format | 10h-44100.0 Ka=32bit 18]

Cnannet b Vaiue Mute Py Chassel o6 vahus taste

The Apple AudioMIDI Setup Utility

USB and FireWire Audio Interfaces

Mac OS X supports USB Audio on iMacs, iBooks, B/AW
G3s, and G4s. Peak supports USB audio with interfaces
such as the Tascam US-428. Peak also supports compati-
ble FireWire audio interfaces, such as the MOTU-828.

BIAS recommends using USB, FireWire, PCL, and
1 PCMCIA audio hardware which is provided with
dedicated software drivers by the manufacturer.

Conclusion

Now that you have installed Peak, and installed and con-
figured any third-party audio interface and its drivers,
proceed to the next chapter to learn several basic con-
cepts and functions essential to using Peak.

Chapter 2: Installing and Configuring Peak 33




34

Peak User’s Guide



Chapter 3
Peak Basics




36

Peak User’s Guide



Chapter 3:
Peak Basics

Introduction

This chapter explains several key Peak concepts and
functions, including how to open, close, and save audio
documents.

A Brief Explanation of Digital
Audio

If you are new to digital hard-disk-based recording, you
may wish to acquaint yourself with a few of the principles
behind digital audio before you dive into using Peak soft-
ware. This section explains a few key concepts that will
give you a good general understanding of how Peak does
what it does. What we hear as sound is actually a pattern
of pressure waves that move through the air. The fre-
quency of these waves determines the pitch of the
sound - how low or high it sounds. Sound frequency is
measured in cycles per second, or Hertz (Hz). The
range of human hearing is generally considered to be
from about 20 Hz at the low end to 20 kHz at the high
end. In practice, however, most adults hear only as high
as 12 kHz to 18 kHz, especially those of us who may have
spent more time than we should have with headphones
or at loud rock concerts.

Sampling and Sample Rate

Your Peak software-equipped Macintosh computer
stores audio digitally. This means that analog electrical
signals from microphones or other sources are convert-
ed into numbers by a circuit called an analog-to-digital
converter and stored on hard disk. The analog-to-digital
(A/D) converter uses a technique called digital sampling
to convert analog electrical signals into numbers. Digital
sampling is the sonic equivalent of taking a snapshot. By
taking thousands of little digital samples per second and
storing them to a hard drive, an A/D converter can cap-
ture an accurate sample-by-sample representation of a
sound, much like a movie is a frame-by-frame represen-
tation of a moving image. The number of samples taken
of the audio in a second is called the sample rate. The
sample rate determines the recording’s upper frequency
response. A higher sample rate delivers higher frequen-
cy response. As a rule of thumb, a digital recording’s
upper frequency response is roughly half of its sample
rate (known as the Nyquist frequency). The audio on
compact discs, for example, is recorded at 44,100 sam-
ples each second, or 44.1 kHz. This sample rate is the
standard for professional-quality digital audio, and pro-
vides an upper-end frequency response of approximate-
ly half the sample rate (known as the Nyquist frequency):
22.5 kHz, somewhat higher than most people’s hearing
range.
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Bit Resolution

Another factor that affects the quality of the audio is the
resolution of each sample. The greater the resolution,
the better the quality. To use an analogy from the film
world, just as image resolution and quality increase with
film size (8 millimeter film is much lower in image quali-
ty than 70 millimeter film) greater bit resolution (8-bit,
16-bit, 24-bit, and 32-bit) results in better fidelity digital
audio. Audio CDs have a resolution of 16-bits.

In practice, the bit resolution determines the recording’s
dynamic range — that is, how many distinct steps you
have to describe a sound’s level, from quiet to loud. For
instance, an 8-bit recording has 256 (28) levels available,
which is the equivalent of 48 decibels (dB) of dynamic
range. On the other hand, a 16-bit recording has 65,536
(216) levels available, equivalent to 96 dB dynamic range.
(The rule of thumb for determining the dynamic range
in decibels is to take the bit rate and multiply it by 6.)

About Disk-Based Recording and
Editing

If you are new to hard-disk-based recording, you will be
impressed by the power and control that Peak software
provides for recording and editing digital audio. You will
encounter several new concepts and techniques for
using a disk-based system such as Peak. Perhaps the
most important among these is the concept of nonde-
structive manipulation of audio.

Non-linear Versus Linear Recording

Non-destructive audio manipulation is possible thanks
to the nature of Peak’s recording medium: a hard disk
instead of a roll of analog tape. Unlike analog tape,
which is a linear recording medium, hard disks provide a
nonlinear, or random-access medium. This is because
audio is stored on hard disk as digital information which
the hard disk can access immediately or randomly
(hence the term “random-access”), simply by moving its
read/write head to the appropriate location and reading
the appropriate data. This allows you to perform such
miraculous feats as cutting and pasting “pieces of sound”
and rearranging material long after it has been recorded.

Non-destructive v. Destructive Editing

Perhaps most impressive is the fact that with disk-based
audio production you need not actually modify the orig-
inal source material in any way to accomplish these feats.
In most cases, by cutting and pasting you are in reality
only asking the hard disk to access portions of the audio
file in a slightly different order. Since Peak doesn’t nor-
mally cut up, move around, or delete the actual record-
ing on the hard drive, it's said to be a nondestructive
editing system. Peak does not rewrite the file until you
choose to save your edits. Other manipulations, such as
playing audio material backwards, can be accomplished
by reading the data in reverse order. The power and flex-
ibility of disk-based audio production software such as
Peak far surpasses the capabilities of traditional analog
audio production tools.

Hard Disk Storage Requirements

The actual recording of audio to hard disk requires a sig-
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nificant amount of storage. This is directly affected by
the sample rate and bit resolution at which you record:
the higher the fidelity, the greater the requirements for
storage. As a guideline, 16-bit, 44.1 kHz audio requires
roughly 5 megabytes of storage per minute of mono
recording. Stereo 16-bit, 44.1 kHz audio requires rough-
ly 10 megabytes per minute. Stereo 24-bit, 44.1 kHz
audio requires roughly 15 megabytes per minute.

Hard Disk Maintenance

Because audio recording and playback is a hard disk
intensive task, it is important that your hard drive be in
good operating condition. In the computer world, this
means keeping it from becoming fragmented by using
hard drive maintenance software. Fragmentation occurs
as your hard drive begins to run out of contiguous (unin-
terrupted) space where it can write files. If the data that
makes up a file is stored at a single location on your
drive, it is much easier and faster for your drive to find
the data and read it. However, as contiguous space runs
out, the drive may not be able to write the entire file in
one location and instead must fragment the file by writ-
ing pieces of it at various locations in whatever smaller
open areas it can find. This requires that the drive
search near and far to read the pieces of the file. Too
much fragmentation can lead to errors in recording and
playback as the hard drive struggles to keep up with the
demands of your audio application. In general, you
should keep your hard disk below 10% fragmentation.
Most hard drive maintenance software packages let you
monitor the degree of fragmentation on your drive and
defragment it by rewriting files into contiguous blocks of
data. In addition to defragmenting your drive regularly,
you should also back up your files and reformat your
drive on a regular basis to keep your system in top oper-
ating condition. By doing this, you will ensure maximum

performance from your Macintosh and Peak software
and keep your studio running smoothly. Now that you
understand some of the basic principles behind digital
audio and disk-based recording, take a few moments to
learn some of the basic operations of Peak. These are
covered in the sections that follow.

Creating a New Peak Document

Peak will allow you to create an empty audio file of zero
duration by choosing a new mono or stereo document.
However, you would typically record a new audio file in
Peak or open an existing audio file into Peak for editing.

Open... 80

Mono Document 8N
Stereo Document O8N

Playlist Document O ®RP

Creating a new Peak document

Peak allows you to have multiple audio documents open
at the same time.

To create a new audio document:

*  Choose New (38-N) from the File menu or Toolbar.
This command provides a hierarchical menu
which allows you to choose either a mono or
stereo format for the new document.

Opening Existing Audio Documents

Peak allows you to open audio files created in a variety of
common audio formats including AIFF, Sound Designer
II, WAVE, QuickTime, .dv, Raw, System 7 Sound, Sonic
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AIFF, Paris, JAM Image, AU, MP3, and MP4.

Opening Compressed Audio
Documents

AIFF/AIFC and QuickTime files with compression such
as MACE 3:1, MACE 6:1, IMA 4:1, QDesign, or Alaw are
compatible with Peak.

To open an audio file:

1. Choose Open (38-0) from the File menu.

2. In the dialog that appears, locate the file that you
wish to open. From this dialog, you can open AIFF,
Sound Designer II, WAVE, QuickTime, .dv, Raw,
System 7 Sound, Sonic AIFF, Paris, JAM Image, AU,
MP3, and MP4 formatted audio files.

Cpen

Audio 2]

From: |

AIFF

[ Traktor Lo...anzleramt
A Untitled-1.mp3

Kind: Document
Size: 76.1 MB

44100.00Hz 16 bit Stereo AIFF
Duration = 00:07:31.027
Compression = raw

Sl s

Go to:

(' Add to Favorites ) " Cancel ) Open )

Open dialog

3. When you find the file you wish to open, click the Open
button and Peak will open the audio file into a new
audio window, displaying an overview of the entire
sound. Shift-click or #-click to open multiple files.

You may also preview files before opening them by
clicking the Play button in the Open dialog.

Recently Opened Documents

Peak automatically remembers up to the last eight audio
documents that you have opened and keeps a list of
these at the bottom of the File dialog.

This allows you to easily select a document’s name and
reopen it without having to search on your hard drive.
Peak can find and open a document even if you have
changed its location on your hard drive. If you change
the name of the file, the next time you open Peak, it will
automatically update the name in its internal list.

New >
Open... 80
Import CD Track...

Import Dual Mono...

Batch Processor...

Audio_1.aif

Audio_2.aif
TraktorLoops_Kanzleramt_01.mp3
All In My Mind.aif

Saltarello.aif
ClubLexStationID#1.aif
Atmosphere.aif

Blue Monday (Manuela Mix).aif

Recently opened documents in the File menu

Opening “Dual Mono” Files

Certain audio applications, such as BIAS Deck and

40 Peak User’s Guide



Digidesign’s Pro Tools, do not directly support stereo
interleaved files, and instead use “dual mono” files,
which comprise the right and left channels of stereo
material. Peak allows you to open such dual mono files,
and in the process creates a new interleaved stereo
audio document. Because Peak actually writes a new
stereo audio file to disk, this conversion process requires
hard disk space equivalent to the two original mono
files.

Please note that the Import Dual Mono command

requires that both files be mono files and have the
same sample rate.

To open a dual mono file:

1. Choose Import Dual Mono from the File menu.
2. In the dialog that appears, locate the desired files.

3. Select either half of the dual mono file and click
Open. Peak imports the first file and then prompts
you for the second.

4. Select the second audio file and click Open. When
Peak has finished creating the new stereo audio
document you can begin editing.

For simpler importing of Dual Mono files, turn on
the Auto Import Dual Mono feature in the
Preference menu. With this feature activated, you
can automatically import dual mono files by
choosing Open from the File menu and selecting

one of the dual mono file’s channels. Peak will
then create a new stereo document containing
both channels. Please note that these dual mono
Sfiles must have exactly the same file name with the
suffix “L” for the left channel and “R” for the right
channel.

Peak also allows you to export your stereo audio docu-
ments in Dual Mono format, which means that it's easy
to import dual mono tracks from BIAS Deck into Peak,
edit and process them within Peak, and then export
them as Dual Mono files to be reincorporated into your
Deck sessions.

Dragging and Dropping Folders,
Disks, and CD Audio Tracks

In addition to opening individual documents by drag-
ging and dropping them onto the Peak application’s
icon, you can drag and drop entire folders or disks onto
the Peak application’s icon. The contents of the disk or
folder(s) will be scanned for audio documents that Peak
can open, such as AIFF, Sound Designer II, WAVE,
QuickTime, MP3, and so on.

This feature is particularly useful when used with

Peak’s Batch File Processor.

Peak allows you to drag a CD audio track directly onto
the Peak icon or open the track directly from the Open
command under the File menu or Toolbar. When you
import a CD track using one of these two methods, the
entire track will be imported. If you do not want to
import an entire audio track, use the Import CD track
command under the File menu, which allows you to
import as much or as little of a CD track as desired (cov-
ered in Chapter 4).
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Saving and Closing Documents

It is good practice to save regularly throughout a project
to avoid losing valuable work in the event of a power fail-
ure or other unfortunate occurrence. The Save com-
mand saves the changes you have made to your audio
document by writing it to your hard disk.

The Save command cannot be undone. If you want to be
able to continue to undo your edits, use the Save a Copy
As command under the file menu. Peak allows you to
save your audio documents in a variety of common
audio file formats, each of which is described below. Be
aware that different formats allow different information
to be stored with the file. Peak preserves this informa-
tion unless you save the file into a different file format.
Saving a file in a format different from its original format
may, however, cause some information stored in the file
to be discarded.

Peak supports the following audio
file formats:

e AFF: This is Apple’s Audio Interchange File
Format. 1t is also Peak’s default file format and is
supported by many Macintosh software applica-
tions.

*  Sound Designer II: This is Digidesign’s audio file
format for its digital audio products. Use this for-
mat if you wish to use an audio document in a
Digidesign audio application.

*  wave/wav: This is Microsoft’s Windows Audio File
Format. It is supported by many Windows soft-
ware applications and some Macintosh applica-
tions. The WAVE format is best if you plan to use
an audio document in an application that supports

or requires WAVE format files.

*  QuickTime: This is Apple’s audio file format for
QuickTime-based multimedia. It is supported by
all Macintosh software applications that support
QuickTime. The QuickTime format is best if you
plan to use an audio document in multimedia
applications that support QuickTime, such as

™

Macromedia Director™, iMovie™, or Final Cut

™

Pro QuickTime includes formats such as
AAC/MP4.

*  Raw: This is the header-less raw file format that
may be useful for some game platforms.

*  System 7 Sounds: This the Apple audio file format
used for legacy Macintosh Operating System
Sounds.

*  JAM image files: This is the JAM audio image file
format. JAM audio image files may be created in
Peak and used in Roxio JAM for burning certain
types of audio CDs such as those intended for com-
mercial replication and release.

*  Sonic AIFF: The file format used by Sonic Solutions
audio workstations.

* _paf: This is the file format used by E-mu’s Paris
audio system. Note this file format favors mono
and dual mono files.

* .au: This file format is commonly used on the
World Wide Web and in Java audio applets. It is
supported by many platforms and programs.

*  mp3: This saves your document in MP3 format.

To save a Peak document:

1. Choose Save from the File menu or press #6-S on
your keyboard.
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2. Select a file format from the pop-up File Type
menu. AIFF is Peak’s default audio file format.

3. Enter a name for the new audio document, select
where you want to save the new file, and then click
Save.

Using the Save As and Save A
Copy As Commands

The Save As command allows you to save a copy of the current
document under a different name, or in a different location on
your hard disk. Since the Save As command closes the current
document and lets you keep working on the renamed copy, it
is useful for saving successive stages of a project. This allows
you to save each major step under a different name. Later you
can retrace your steps should you want to go back to an earli-
er version. The Save A Copy As command will save a copy of
the file you are working on, but it will keep the copy you are
working on open. This allows you to continue working on
your audio and still be able to undo any edits you executed
prior to using the Save A Copy As command.

Save Audio Document

Save As:  AUEIGEN aif

Where: | Trakior Loops Kanzlerams

]
File Tyoe: [ AWFE
BitDepth:  [16-bits 1)
Compressor: | None [ K4

[#] # Auto File Type Extensions

Options... )

The Save dialog

Both of these methods are non-destructive, as they cre-
ate copies of the original file.

To save an audio document under another name:

1. Choose Save As (Shift-38-S) or Save A Copy As

(Option-38-S) from the File menu. The Save dia-
log appears.

2. Select the desired file format from the File Type
pop-up menu. AIFF is Peak’s default audio file for-
mat.

3. If you wish to save the audio document to a dif-
ferent bit depth resolution, click the bit depth pop-
up. It is strongly recommended that you enable
the POW-r™ dithering option if you are saving to a
lower bit depth (e.g., 24-bit to 16-bit).

4, Enter a name for the new audio document, select
where you want to save the new file, and click
Save.

Using POW-r™ Dithering

Peak uses the POW-r™ (Psychoacoustically Optimized
Wordlength Reduction) dithering algorithm, one of the
industry-leading technologies for reducing bit depths
and maintaining high-quality audio. If you are saving to
a lower bit depth (e.g., 24-bit to 16-bit), it is strongly rec-
ommended that you enable the POW-r™ dithering
option.

pow-r™ Dither Settings

|")(_)W'
Choose dithering algorithm:
S

The POW-r™ dither settings dialog

Choose the POW-r™ Dither Settings from the
Preference menu to adjust the settings for POW-r™
dither. For mono files, or stereo files with a narrow

Chapter 3: Peak Basics 43




stereo field (e.g., recordings of solo instruments), use
POW-r 1; for more stereophonically complex material,
use POW-r 2; for full-spectrum audio with a wide stereo
field, use POW-r 3.

Saving Compressed Audio Documents
AIFF/AIFC and QuickTime files with compression such

as MACE 3:1, MACE 6:1, IMA 4:1, QDesign, or Alaw are
compatible with Peak.

You can only Save with file compression using

! AIFF or QuickTime file formats.
Audio compression should be the last step in mas-
tering your audio documents. Decompressing
and re-compressing audio documents will
1 degrade their sound quality each time they are re-

compressed, so it is best not to save with compres-
sion until all editing and mastering has been
completed.

To save an audio document with compression:

1. Choose Save As (Shift-38-S) from the File menu.
The Save As dialog appears.

2. Choose the audio compressor you wish to use
from the Compressor pop-up menu. Some com-
pression formats only work with 8-bit or 16- bit
data, so the compression options may be grayed
out, depending on your setting in the bit depth
pop-up menu. Some of the types of available audio
file compression include: MACE 3:1, MACE 6:1,
QDesign Music, ALaw 2:1, 32-bit Floating Point, 64-
bit Floating Point, IMA 4:1, 24-bit integer, 32-bit
integer, 16-bit Little Endian, and 16-bit Big Endian.

3. Click the Options button to adjust the settings for
the specified compression format, and then click
OK.

4. Type the name of the new audio document, select
the folder you wish to save the audio document,
and click Save.

Closing Audio Documents

To close a file in Peak, choose Close from the File menu
(38-W). If you have made any changes to your docu-
ment since the last time you saved, Peak will ask you if
you want to save them. If you do, choose Yes; if you do
not, choose No. If you change your mind and wish to
continue your session, choose Cancel. To close all files
currently open in Peak, choose Close All from the File
menu (38-Option-W).

Peak Windows and Palettes

There are several windows and palettes when you open
Peak that either appear by default or are available to you
under Peak’s Windows menu. Windows that appear in
Peak by default include an audio document window for
each audio file currently opened. Windows and palettes
that may be enabled or disabled include the Transport,
the Toolbar, the Contents Palette, and the Movie
Window. This section will cover the basic function of
these Peak Windows and Palettes.
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Peak Audio Document Window

Peak Audio Document windows contain a Waveform
Display, an Audio File Info Bar, a Max Level Indicator in
the lower left corner, and an expandable contents draw-
er which contains information about reference, region,
and loop markers. The Waveform Display is a graphic
representation of the audio file, the Audio File Info Bar
shows the sample rate, bit resolution, file format and file
size of the audio file, and the Max Level Indicator shows
the highest amplitude level in the audio file. At the top
of the Audio Document window is the File Overview,
which is on by default, and can be turned off by choos-
ing Show Overview in the Options Menu. The contents
drawer is similar to the Contents palette, but offers a
convenient way to view markers on a per document
basis. The Audio Window is described in more detail in
Chapter 5.

v

Verse 4
v

LIMK: ~1.208 44.1kHz 16-Dit Stereo raw AIFF [42.09MB)

Peak’s audio document window also contains several dif-
ferent tool icons representing different cursor modes.
The default cursor is a standard Arrow Cursor. You can
also select a Hand Cursor for moving a waveform within
its window, a Pencil Tool for drawing directly on the
waveform at the sample level, and a Magnifying Glass
Tool for zooming the waveform view in and out. The
ESC key on your computer keyboard will toggle through
the four cursor modes.

To access any of these cursors or functions, just click on
the corresponding icon. To change the cursor tool, click
on a new icon. The various cursors and editing modes
are discussed briefly below, and in greater detail in
Chapter 5: Editing.

Atmosphere.aif

The audio document window
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Hand Cursor Pencil Tool

Vertical Lock

Blending On/Off

Horizontal Lock Arrow Cursor Magnifying Glass Tool Toggle Drawer

Blending On/Off Button

When Blending is turned on, Peak creates very short
crossfades between sections of audio that are cut, past-
ed, copied, or inserted. Blending helps to avoid clicks
and pops that can occur when cutting an audio wave-
form at a non-zero crossing, or when combining materi-
al with significantly different amplitude. The left-most
button toggles Blending on and off.

Horizontal Lock Button

The Horizontal Lock button allows both the begin &
end markers in a loop or region to be moved simulta-
neously. This feature is very useful in situations where
the duration of a selection needs to be maintained, but
the selection needs to be made in a different part of an
audio document. The second-from-left button toggles
Horizontal Lock on and off.

Vertical Lock Button

The Verical Lock button allows multiple reference,
region, and loop markers that are placed in the same
location to be moved simultaneously. This feature is
very useful in situations where you may have back-to-
back regions - such as in mastering a live recording or DJ

mix - and you need to adjust where a track break will
occur, without introducing any gaps between the two
regions.

Arrow Cursor Tool

The Cursor Tool is the default tool. It is the standard
“arrow” tool that lets you click and select on-screen
items.

Hand Tool

The Hand Tool lets you grab and move a waveform
around in its window.

Magnifying Glass (“Zoom Tool")

To use the Magnifying Glass tool, simply click on the tool
in the audio document window, then move the cursor
over the waveform. A “plus” (+) sign will appear inside
the Magnifying Glass. Click on the waveform to zoom in;
each click of the mouse will zoom in farther. To zoom
out, option-click on the waveform.

Zoom Amount
Zoom Tool Amount:

Description

The zoom tool can be configured to zoom
at different ratios. Enter an amount for
the zoom tool to zoom in or out by in
percentage.

(Cancel) @EF0IGH

The Zoom Amount dialog
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“minus” (-) sign will appear in the Magnifying Glass, and
you can click on the waveform to zoom out. Option-
clicking on the Magnifying Glass will open the Zoom
Amount dialog where you can specify the Zoom
Amount.

Pencil Tool

The Pencil Tool lets you draw directly on the waveform
at the sample level. This is very useful for drawing out
clicks in the waveform. Hold down the Option key when
using to bring up the “Magic” Pencil Tool, which auto-
matically removes clicks/pops.  Option-click on the
Pencil Tool icon for the Drawing Tool Smoothing

Settings.

Draw Tool:
Drawing Tool Smoothing

R

A,
(ot P

R ot e |

Description

The drawing tool can be configured to
smooth out any rough edges. Enter an
amount for the draw tool to smooth by
where 0 is no smoothing and 100 is
maximum smoothing.

Cancel |

The Draw Tool dialog

Cursor and Selection Information

The lower section of the audio document window’s
Contents Drawer displays the X (time) and Y (ampli-
tude) coordinates of the cursor point, Sel: the duration
of any currently selected audio), DTR (Distance to
Reference Marker), and BPM: the tempo in beats per
minute. You can type a value in for the X, Sel, and BPM
parameters.

The same information can also be displayed by toggling
the transluscent cursor overlay to the “on” position,
which appears next to the mouse cursor, and moves
along with the mouse cursor.

Translucent cursor overlay turned on — follows mouse cursor

Transluscent cursor information can be turned on and
off under Peak’s Options menu (38-T). Here is how to
read the cursor and selection information that appears
in the Cursor Location display.

Y = the current cursor position along
the vertical scale (amplitude) or
start point of a selection

X = the current cursor position in the
currently specified time units
(Samples, Min:Sec:ms, SMPTE, or
Bars | Beats)

L] = the cursor is currently positioned
over the left channel of the audio

[R] = the cursor is currently positioned
over the right channel of the audio

pTrR = distance in the currently specified
time units (Samples, Min:Sec:ms,
SMPTE, or Bars | Beats) to the nearest
reference marker

sel = the duration of the current selec-
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tion in the currently specified time
units (Samples, Min:Sec:ms, SMPTE,
or Bars | Beats)

+or - = indicates positive or negative
phase

BPM = beats per minute

The time format displayed in this field depends on which
time format (Samples, Min:Sec:ms, SMPTE, or
Bars | Beats) you have chosen with the Time Units com-
mand under the Preference menu.

Transport Window

The Transport window is a floating, re-sizable window. It
contains three areas: a time display showing elapsed
time, the Transport controls (Return to Zero, Stop, Play,
Go to End, Record, and Loop during playback), and
audio level meters with clip/peak indicators.

Time Display

The Time Display is like a counter. It shows elapsed time
and tracks the “playback head” as audio plays. Clicking
on the waveform when playback is stopped will cause
the current cursor location to appear in the Time
Display. This display will also show the time remaining
while performing Open, Save or DSP processing actions.
Clicking on the counter will bring up the Go To Time dia-
log, allowing you to type in a time location — when you
click OK, Peak’s playhead cursor is inserted at the

fenn

R EMERGRER [« [ = [F] ]

Transport

desired time location in the audio waveform.

Meters

Peak’s meters are much like the VU or LED meters on a
mixing board or tape recorder. They are bar graph
meters that show the relative volume or loudness in
decibels (dB), of audio as it plays. They are also
designed to show peak volume and whether the signal

has “clipped,” or distorted.

Meters

Peak Hold Time: Clip Indicator Hold Time:

) None ) None
) 3 Seconds 9 3 Seconds
_ Infinite ) Infinite
( Cancel'? f oK )

Meters dialog

You can configure the Meters display by choosing Meters
from the Audio menu, or by clicking the appropriate but-
ton in the Toolbar. Using the Meters dialog, you can
select the Peak Hold time and Clip Indicator Hold Time.
The Peak Hold indicators appear as yellow bars at the far
right of each of the bar graphs as audio plays, and select-
ing a hold time causes the indicator to pause for easy
reading of the peak value during playback. The Clip
Indicators appear as red bars at the far right of each of
the bar graphs as audio plays, and are triggered when
audio distorts, or “clips”, and selecting a hold time caus-
es the indicator to pause for easy reading of any clipping
or distortion that occurs during playback. Setting the
Peak Hold and Clip Indicator Hold Times to None turns

L T T e T P P T e T T
QT e e T T P T ey

Transport window - contains counter, transport controls, precision VU meters, and master fader
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these features off.

The Meters dialog is not available in Peak LE.

The Meters dialog is not available in Peak DV.

Progress Bar

The Meters display changes to a progress bar during
audio processing, and while saving or opening audio
files.

Sample Rate Conversion...

Progress bar

Contents Palette

Peak has a floating Contents Palette that will display all
Regions, Markers, and Loops contained in any open
audio documents.

J Contents

Name ¥ Time

» All In My Mind.aif . 00:0...4.448

» Audio_l.aif 00:0...4.830

¥ Atmosphere.aif 00:0...0.175
Verse 4 00:0...3.657
Verse 10 00:0...2.970
Verse 9 00:0...2.145 A
Verse 8 00:0...1.010 v

The Peak Contents Palette

There are three buttons at the bottom of the palette that
allow you to select which items to view-from left to right:
the Region Button, the Marker Button and the Loop
Button. Option-double-clicking on any item in the
Contents window will bring up the Edit Region or Edit
Marker dialog.

To resize the Contents Palette:

*  (Click and drag on the lower right hand corner of
the Contents window to resize the Contents
Palette.

To resize columns in the Contents Palette:

*  (Click and drag to the right of the column’s title bar
that you want to resize. For example, to make the
Name column wider, click and drag the line
between Name and Time to the right.

To sort columns in the Contents Palette:
*  Click the title of the column by which you want to
sort. For example, to sort by Time, click on Time.
To change the sort order in the Contents Palette:

*  Click the sort order button in the column title to
change the sort order.
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Setting Preferences

You can customize a number of Peak’s parameters so you
can work with the program in a way that best suits you.
These parameters are found in the Preference dialog and
Options menu. These include the controls for playing
back audio documents, the selection of the icons in the
Toolbar, and the colors that you want for the audio doc-
ument window.

Peak™ Preferences

Colors...

Scratch Disks... )

Blending...

Auditioning...

Fade In Envelope...

Fade Out Envelope...

VST Plug-Ins Envelope...

Sampler Preferences...

DSP Preferences...

¢ Playback Preferences...

( Shortcuts /Toolbar Preferences...

Window Preferences...

pow-r™ Dither Preferences...

£

) D

Save Preferences Now

The Preference dialog

Once you have set these preferences as you like, they
will stay that way until you decide to change them again.

This section explains how to set several of these param-
eters. For any menu items not covered here, please refer
to Chapter 11: Peak Menus. There you will find explana-
tions of each command in the Preference dialog and
other Peak menus. Items from the Preference dialog and
Options menu are also covered throughout this manual
where their discussion is relevant.

Time Units >
Sample Units >

Use Loop in Playback 8L
 Scroll During Play

Move Waveform During Play

Compute File Max dB

Show Edits

Show Marker Times
v Show Overview 38,
+ Show Cursor Info 8T

+ Auto-Import Dual Mono
Audio Info... 88l

Dynamic Scrub Time >
+ Auto Snap To Zero

+ Auto-Balloon Help
“Open” Dialog after Launch

The Options Menu

Setting Peak’s Playback Parameters
Peak’s Playback Preferences dialog allows you to control
the master output volume, hard disk playback buffer

size, and window buffer size.

Playback Preferences

Playback Master Volume:

bk be —ta B

Use the lowest possible setting. Higher
settings will require much more RAM for the
Peak™ application. 32k or 64k should work for
most purposes.

Window Buffer: ' 128k
This controls how much of the audio file is kept
cached in RAM. Increase if working with only a
few files at once for better performance, or
decrease if you work with lots of files.

P mm—— Gconcoin
[ Cancel } L OK

Peak Playback Preferences dialog
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Playback Master Volume

Peak provides a master volume control for audio play-
back. In the Playback Preferences dialog, set Peak’s out-
put volume to the level that you desire by adjusting the
slider or entering a number value from 0 (silent) to 7
(loudest). If you are controlling your playback volume
with the volume control of your playback system, you'll
probably want to leave the output level set to 7.

Playback Buffer

Peak allows you to control the amount of RAM the pro-
gram uses when playing back audio documents. In gen-
eral, lower is better. A playback buffer of 32k is a good
place to start. If you are experiencing clicks in your play-
back, working with fragmented files, using processor-
intensive real-time DSP, or are using a slow hard drive,
you may need a larger playback buffer setting.

Window Buffer

Peak also allows you to control the amount of RAM the
program uses to cache audio data and the size of each
processing chunk. Use larger values if you are working
with a few large files, and smaller values if you are work-
ing with many smaller files.

Dynamic Scrub Time

Peak provides a unique audio auditioning technique
called dynamic scrubbing. This feature is very useful for
precisely pinpointing and selecting a desired location in
an audio document. Dynamic scrubbing allows you to
drag the mouse forward or backward over a waveform
while Peak plays a short loop (between 10 and 600 mil-

liseconds) at the scrub location. When you have found
the location you are looking for, let go of the mouse and
the insertion point will be exactly where you want it to
be. Peak allows you to choose the length of this play-
back loop with the Dynamic Scrub Time command in
the Preference menu. You can also select Tape-Style
Scrubbing in this dialog. For a full description of scrub-
bing audio in Peak, please see Chapter 5.

To select a loop duration for dynamic scrubbing:

1. Choose Dynamic Scrub Time from the Options
menu, and choose a duration from the hierarchical
submenu. Typically, a value of between 40 to 80
milliseconds works well.

2. You can also select Tape-Style Scrubbing by select-
ing it in this submenu. To deselect Tape-Style
Scrubbing, just click any duration value in the sub-
menu.

Tape-Style Scrubbing requires using the Mac OS X

H Audio HAL engine and is not available when
using CoreAudio.

Scroll During Playback

With the Scroll During Playback command enabled, Peak
will “scroll” through the audio document as playback
progresses. This allows you to visually follow the
progress of audio playback. A check next to this menu
item indicates that it is enabled.
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To enable Scroll During Playback:

1. Select Scroll During Play from the Options menu.
A check next to this item indicates it is enabled.

2. To disable Scroll During Playback, simply re-select
Scroll During Play from the Options menu. The
absence of a check next to this item indicates it is
disabled.

Move Waveform During Playback

With the Move Waveform During Play command
enabled, Peak will move the waveform under the cursor
as playback progresses, so that the playbar is always in
the middle of the waveform display. A check next to this
menu item indicates that it is enabled.

To enable Move Waveform During Playback:

1. Select Move Waveform During Play from the
Options menu. A check next to this item indicates
it is enabled.

2. To disable Move Waveform During Playback, sim-
ply re-select Move Waveform During Play from the
Options menu. The absence of a check next to this
item indicates it is disabled.

Show Marker Times

With the Show Marker Times command enabled, all Peak
markers will show a time value as well as the marker
name.

To enable Show Marker Times:

1. Select Show Marker Times from the Options
menu. A check next to this item indicates it is
enabled.

2. To disable Show Marker Times, simply deselect
Show Marker Times from the Options menu. The
absence of a check next to this item indicates it is
disabled.

Auditioning

Peak’s Auditioning command allows you to audition a
selection along with a specific amount of audio preced-
ing or following it.

Auditioning
Preroll:
1.000000 seconds
Paostroll:
'1766660”0 7777777777 seconds
( cancel ( oK )
The Auditioning dialog

The Auditioning dialog allows you to select a desired
amount of pre-roll or post-roll when you play the selec-
tion. To play a selection with the selected amount of pre-
and postroll, press 8-Spacebar.

To configure Auditioning:

* Select Auditioning from the Preference dialog.
Enter the desired amount of Pre-roll and Post-roll
into the dialog boxes. Click OK to exit the dialog.

Blending

Blending is an automatic crossfade function with a user-
editable envelope. Peak can apply blending to areas of
an audio document when they are modified by cutting,
deleting, or other editing processes in order to smooth
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abrupt transitions between waveform amplitudes. It can
be very useful for creating a smooth transition between
edits that would otherwise sound too abrupt. If you
have cut, pasted, or inserted audio into a document, you
may wish to enable blending to smooth things out a bit.
It can be toggled on or off by clicking the Blending but-
ton in the Audio Document Window, or by using the
caps lock key on your keyboard.

To configure blending:

1. Select Blending from the Preference dialog. Enter
the Duration over which you wish Blending to
occur into the dialog box.

2. To edit the Blending Envelope, click on the Edit
Blending Envelope button. Click OK to exit the
dialog and click Save Preferences Now to save the
change.

For detailed instructions on how to use blending or how
to edit the blending crossfade envelope, see Chapter 5:
Editing.

Auto-Import Dual Mono

Certain audio applications, such as BIAS Deck and
Digidesign’s Pro Tools, do not directly support inter-
leaved stereo files, and instead use “dual mono” files-a
pair of files, one for the left channel and one for the right
channel. These files have typically been exported with
the suffix “.I”” for the left channel, and the suffix “R” for
the right channel. Auto-Import Dual Mono, when select-
ed, will allow you to select just one channel of the dual
mono file in the Open dialog. Peak will automatically
“grab” the other half of the file, and convert both files
into a single stereo Peak document.

Please note that the Import Dual Mono command
requires that both files be mono files, have the

! same sample rate and bit depth, and the must
bave the exact same name followed by the suffixes
“L"and “R".

To enable Auto-Import Dual Mono:

1. Select Auto-Import Dual Mono from the Options
menu. A check next to this item indicates it is
enabled.

2. To disable Auto-Import Dual Mono, simply reselect
Auto-Import Dual Mono from the Options menu.
The absence of a check next to this item indicates
it is disabled.

Choosing Colors for the Audio
Document Window

Peak allows you to customize the colors used to display
the elements in audio documents. You can use this dia-
log to set the background color, waveform color, and col-
ors for markers and loops. You can select either a preset
color combination, or individual colors for each element
in the audio document window, as well as picking your
own custom colors from a color palette. You can also
choose to have the waveform display shading for a 3-D
look, as well as select the amount of shading. Changes
made using the Colors dialog affect both the current
audio document’s colors, and any subsequent new audio
document’s colors.
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To customize the colors and shading of the waveform dis-
play:

1. Choose Colors from the Preference dialog.

Document Colors

Theme  Custom B
Background Black ?}
Waveform | Graphite Gray [¥)

Markers Yellow [E

Loops Red |

“r

White

3

Regions

"l Shadowed Waveforms
Selection Shading Intensity:
gl %
i 104

{ Change All ) f€hange)

(_Cancel )

The Colors dialog

2. To select a preset color combination, click the
Theme pop-up menu and choose the preset that
you desire.

3. Alternatively, to select individual colors for each
element in the audio document window, choose
Custom from the Theme pop-up menu and then
select the desired colors from the Background,
Waveform, Markers, Loops, and Regions pop-up
menus.

4. Ifyou wish, you can use this dialog to further cus-
tomize any element in the audio document win-
dow. Pick an element to customize, choose
Custom from the Theme pop-up menu, and select
User Color. A standard Macintosh color palette will
appear. Use this wheel to select any color you
wish. Click OK to return to the Colors dialog.

5. You can also customize the degree of shading, or
darkness, of audio selections in the waveform dis-
play. Use the Selection Shading slider or enter a

percentage in the number box to choose the
degree of shading you wish to see in selected por-
tions of audio.

6. Another way to enhance the look of audio wave-
forms in Peak is by giving them a 3-D look. Use the
Shadowed Waveform checkbox to turn the wave-
form shadow on or off.

7. To close this dialog, click Change (to change one
color) or Change All (to change the colors for all
open audio documents). The audio document
window is now set to the colors and look you've
selected.

Choosing a Time Format

The Units command allows you to choose a time format
for the audio timeline in Peak’s audio document win-
dow. You can choose samples, seconds, SMPTE frames,
and Bars | Beats. The format you choose will depend on
the nature of the project that you are working on.

To choose Peak’s time format:

1. Choose Time Units from the Options menu.

~ Time Units samples
Sample Units P ¥ Min:Sec:ms
SMPTE 30 fps

Use Loop in Playback 8L
+ Scroll During Play

Move Waveform During Play

Compute File Max dB

Show Edits

Show Marker Times
v Show Overview a8,
 Show Cursor Info 8T

SMPTE 29.97 fps
SMPTE 25 fps PAL
SMPTE 24 fps FILM
Bars|Beats

¥ Auto-Import Dual Mono
Audio Info... 381

Dynamic Scrub Time >
v Auto Snap To Zero

v Auto-Balloon Help
“Open” Dialog after Launch

Choosing a time format with the Time Units command
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2. From the submenu, choose the time format that
you desire: samples, Min:Sec:ms, SMPTE frames,
or Bars | Beats. The timeline in Peak’s audio docu-
ment window and Transport switches to the for-
mat that you choose.

Audio File Meter, Tempo, and
Timestamp Settings

If your audio document is using bars | beats as its units, you
will want to tell Peak what the tempo of the audio docu-
ment is. Use the Audio Info command from the Options
menu — or enter the BPM in the Cursor info sectionof the
file drawer — to set the tempo of the audio document. You
can also enter the meter of an audio document using the
Audio Info dialog. The numerator represents the number
of beats per measure, and the denominator represents the
value of a beat, where 4=quarter note, 8=eight note,
16=sixteenth note, and so forth.

Audio Info

cobo.mov

Sterec L6-bit raw QuickTime™ audio document.
Approximately 18.76MB of disk space

Contains 0 markers, 0 loops, and 0 regions.

Sample Rate: 44100.0000

Audio Document Length; 00:01:51.491 _Min:Secims eS|

Tempo:

AR RS

Audio Document Info

You may also enter a timestamp for the audio document
in seconds. If the audio document has a timestamp,
then the displayed time in an audio document will be
offset from this time rather than starting at zero. For
example, if the timestamp for an audio document is four
seconds, then the first sample in the audio document

will appear in the audio document with a time of 4 sec-
onds instead of zero seconds.

Choosing a Scratch Disk

Because audio data can be very large, Peak utilizes a por-
tion of your hard disk’s free space to hold audio data that
has been cut or copied, as well as for temporary or
scratch files for undo purposes. If your hard disk is short
on space, you may not be able to cut, copy, or modify
large selections. If you have more than one hard drive
attached to your Macintosh, the Scratch Disks section in
the Preferences dialog allows you to choose the hard
drives (or “scratch disks”) that you wish to use for these
temporary files. Peak allows you to select which disk you
want to have as your default, or “Primary” disk for this
purpose-usually you would select the disk that has the
most free space. If you are connected to a file server,
you can utilize available storage on the server by clicking
the Allow Servers checkbox. Any available servers will
then appear in the Scratch Disks pop-up menu. This fea-
ture is recommended only if you have access to a high
speed Ethernet, Media Net, or other fast server.

To choose a scratch disk for temporary files:

1. Choose Scratch Disks from the Preference dialog.
The Scratch Disks dialog appears.

(5] Scratch Disks:
Primary Folder... U

=
B

£ [ # BigMomma  5325.5 MB free
® W ™ iMacov 2082.7 M8 free
’_' Reset \ @ Allow Servers ‘ Cancel \ oK 4

The Scratch Disks dialog
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The Scratch Disks dialog will show all hard drives
currently connected to your Macintosh. Choose
the hard drive(s) that you wish Peak to use when it
creates temporary files by clicking the checkboxes
next to the drives in the list. To choose the
Primary Disk, or the default disk for temporary

files, click on the Primary button next to that disk.

If you are connected to a file server and would like to use

storage available there as well, enable the Allow Servers

checkbox.

3.

Click OK to close this dialog. Peak will use the disk
you have selected as your Primary scratch disk,
and, if it becomes full, will then use the other disks
you've chosen.

The hard drive with the original audio file must
bave the equivalent amount of free space (i.e, a
00MB file would require that there be an addi-
tional 6GOMB of free space on the hard drive on
which the file resides).

You must have write permissions for the selected
Scratch Folders and Disks or else Peak will report
an error. Contact your System Administrator if
you need assistance changing Directory or Disk
permissions.

Keyboard Shortcuts

Peak allows you to customize any Peak menu item with a

keyboard shortcut. To change your keyboard shortcuts,

go to the Preferences dialog and select the Shortcuts and

Toolbar item. Preferences are stored in a file called Peak

4.0 Shortcuts, located in  the following directory:

MacintoshHD/Users/<YourUserAccount >/Library/Preferences

Peak’s default Keyboard Shortcuts are listed in Appendix

1 at the end of this manual.

To add a new Keyboard Shortcut:

1.

4,

Choose Shortcuts & Toolbar in the Preferences dia-
log.

Scroll through the list of menu items, or, with the
list box selected, simply type in the first few letters
of the menu item you wish to assign. Then click
on the name of the Peak menu item you wish to
assign a new keyboard shortcut.

Use the Shortcut Key box to enter the letter you
wish to use for a shortcut. You may select the
Command, Option, Shift or Control keys as addi-
tional modifiers by clicking on the checkboxes in
this dialog.

Close the Shortcuts/Toolbar Preferences dialog.

To remove a Keyboard Shortcut:

1.

Choose Keyboard Shortcuts in the Preference dia-
log.

Scroll through the list of menu items, and click on
the name of the Peak menu item for which you
wish to remove a keyboard shortcut.

Click on the Clear button.

Close the Shortcuts/Toolbar Preferences dialog.

©

User-defined Keyboard Shortcuts and Toolbox cus-
lomization are not supporied in Peak LE.
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User-defined Keyboard Shortcuts and Toolbox cus-
ltomization are not supported in Peak DV.

Z

Making a Keyboard Shortcuts “Cue
Card”

It's easy to make a “cue card” that you can keep on your
desk with all the Peak shortcuts you've assigned. Using
the supplied FileMaker Pro template, you can import all
of your shortcuts from a text file describing each key-
board shortcut generated from Peak.

To Create A Custom “Cue Card” of your Keyboard
Shortcuts:

1. Choose Shortcuts/Toolbar Preferences in the
Preferences dialog.

2. Click on the Save As Text button.

3. Enter the name of the keyboard shortcuts text file
you wish to save, and choose the disk and folder
you wish to save into. Click Save.

4, Switch to the Finder and Launch FileMaker Pro.
5. Choose Open from the File menu in FileMaker Pro.

6. Open the supplied “Peak Shortcuts Template”
FileMaker Pro template.

7. Choose Import Records from the File menu in
FileMaker Pro.

8. In the pop-up menu at the bottom of the Open
dialog in FileMaker Pro, choose Tab-Delimited.

9. Find the shortcuts text document you saved in
step 3 and click Open.

10.  FileMaker Pro will add the records to the database.

11.  Use the Print option in FileMaker Pro’s File menu
to print out your keyboard shortcuts. You can also
sort the imported keyboard shortcut commands
by description or shortcut. Consult your FileMaker
Pro User’s Guide for more information on import-
ing records, sorting records, and printing.

1 FileMaker Pro is not included with Peak.

The Toolbar

Peak allows you to select almost any Peak command for
the Toolbar. The Shortcuts & Toolbar menu allows you
to group together the functions you use most often, so
that you can simply click a button instead of going to the
menus. For example, if you frequently use Normalize
and Pitch Change, you can choose to have the icons for
these functions in the Toolbar, so that all you have to do
to use one of them is to make an audio selection and
click a button. The Toolbar is an easy way to make your
work in Peak faster and more efficient, allowing you to
customize the program to suit the way you work.

To add or subtract items from the Toolbar, use the
Shortcuts & Toolbar item in the Preferences dialog.
Toolbar selections are stored in a Preference file called
“Peak 4.0 Shortcuts” located in:

MacintoshHD/Users/<YourUserAccount >/Library/Preferences
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You can reshape and resize the Toolbar by clicking
on the lower right corner of the Toolbar window
and dragging to the desired shape and size. The
Toolbar can be arranged horizontally, vertically,

or as a “cluster” of buttons. Icons in the Toolbar
can be sized anywhere between 16 x 16 pixels to
64 x 64 pixels.

To add a new icon to the Toolbar:

1. Choose Shortcuts/Toolbar Preferences in the
Preferences dialog.

2. Scroll through the list of menu items, and click on
the name of the Peak menu item you wish to have
appear in the Toolbar.

3. Click on the “Place In Toolbar” checkbox to select
the icon to add to the Toolbar. If there is no icon,
the menu item cannot be placed in the Toolbar.

4. Close the Shortcuts/Toolbar Preferences dialog.

To remove an icon from the Toolbar:

1. Choose Shortcuts/Toolbar Preferences in the

Preferences dialog.

2. Scroll through the list of menu items, and click on
the name of the Peak menu item you wish to
remove from the Toolbar.

3. Click on the checkbox to uncheck the item you
wish to remove..

4. Close the Shortcuts/Toolbar Preferences dialog.

Customizable Toolbar is not supported in Peak LE.

Customizable Toolbar is not supported in Peak DV.

©
&

To resize icons in the Toolbar:

1. Choose Shortcuts/Toolbar Preferences in the

Preferences dialog.

2. Move the Toolbar Icon Size slider to the left for
smaller icons, or to the right for larger icons.

3. Close the Shortcuts/Toolbar Preferences dialog.

Quitting Peak

When you have finished a project or wish to end an edit-
ing session, the Quit command allows you to quit Peak
and return to the Finder. If you haven’t saved changes,
Peak will warn you before allowing you to quit.

To quit Peak:

*  Choose Quit from the Peak menu (38-Q).

If you have made any changes to your document since
the last time you saved, Peak will ask you if you want to
save them. If you do, choose Yes; if you don't, choose
No. If you change your mind and wish to continue your
session, choose Cancel.

Ifyou wish to close all currently open windows without
s saving, hold down the Option key and click Don't Save.
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Conclusion

You now know how to create, open, import audio files,
export, close, and save Peak documents. You also know
how to set the preferences for operating Peak. The next
chapter explains how to use your Peak software to
record audio to disk.
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Chapter 4
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Chapter 4:
Playback & Recording

In this chapter you'll learn how to record and playback
audio with Peak. Peak allows you to capture sound from
external sources through your Macintosh’s built-in audio
input or by using third-party audio hardware. If your
Macintosh is equipped with a CD-ROM drive, you can
also import audio directly from an audio CD.

Recording and Playback using
CoreAudio

CoreAudio is Apple’s new high performance audio
engine. There are numerous advantages to using
CoreAudio — including low latency, multiple channels of
audio, high bit depths and sample rates, and the ability
to share hardware devices between multiple audio appli-
cations. BIAS recommends using CoreAudio (which
Peak defaults to), though there may be some situations
in which you may want to use the Mac OS X Audio HAL
or FireWire DV audio engines. Details for using the

other audio engines appear later in this chapter.

Installing and configuring your device:

1. If applicable, install your third-party audio inter-
face and its software according to the manufactur-
er’s instructions.

2. Open System Preferences/Sound — If the audio hard-

ware  device shows up in  System

Preferences/Sound then it will be available in Peak. n

8o Sound
Sound Effects ruuxpm ] Input

Choose a device for sound output

Hame
Built-in audio controller
Digidesign HW ( MBox )

Settings for selected device:

There are no settings available for the selected device

Gutput volume: q>))

) Show valume in menu bar

OS X System Preferences Sound Output

3. To see the sample rates and bit depths that your
hardware supports, open the AudioMIDI Setup
utility and select the hardware device in the
“Selected Audio Device” drop down menu. Some
devices also include a separate control panel as
well.

806 Audio MIDI Setup
Audio Devices | MIDI Cevices

System Settings

Default Input | Digidesign HW ( MBox) 18 Default Qutput | Digidesign HW ( MBox )
System Output | Buili-in audia controlles 3]

selected Audic

Input Volume ™ Output Volume nla d8

Input Section Output Section
Input Source

Current Format | 1Ch—44100.0 Hz-32bit 18] Current Format | 1Ch-44100.0 Hz-32bit 19

The AudioMIDI Setup Utility
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Configuring Peak for Playback

1. Launch Peak.

2. Choose Hardware Settings from the Audio menu,
to open the CoreAudio Settings dialog.

CoreAudio Settings

Built-in audio contr... |3
T
v

Output Device: Built-in audio contr... -—]

Input Device:

Buffer Size: | 512 —:}
Input Level: Q‘ ==t =

CoreAudio Hardware Settings dialog

3. Select your audio hardware device as both the
input and output.

4. Close the Hardware Settings.

Playing Audio with Peak

The Transport Controls

The Transport Controls that appear in the Transport window
are useful tools for initiating both playback and recording,
They function much as the controls on a tape recorder
would. As they appear below, from left to right, they are
Return to Zero, Stop, Play, Go to End, and Record.

Returnto Zero Stop  Play  Goto End  Record

L s )

Use Loop in Playback

The Transport Controls

To start playback from the beginning of a document:

1. Press the Spacebar, or click the Play button in the
Transport. Playback begins from the beginning of
the document.

2. To stop playback, press the Spacebar again or click
the Stop button in the Transport.

To rewind playback to the beginning of a document:

*  Click the Stop button twice, or click the Rewind
button in the Transport. You can also press the
Return key if playback has been stopped.

To start playback from a specific point in a document:

1. Click the cursor at the desired location in the
audio document and press the Spacebar on your
computer keyboard. Playback begins from the cur-
sor location and continues to the end of the docu-
ment.

2. Alternatively, double-click the mouse at the
desired location in the audio document. Playback
begins from the location that you double-clicked
and continues to the end of the document.

3. You can also click anywhere in the Audio Waveform
Overview to begin playback from that point.

4. To stop playback, press the Spacebar.

Triggering Playback of Multiple
Audio Documents

As explained earlier, Peak allows you to have multiple
audio documents open at the same time. Peak assigns
each of these documents a number based on the order
in which it was opened. Peak provides you with a con-
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venient way of triggering playback of any open audio
document by pressing a number key on your computer
keyboard. This can be a very useful feature for applica-
tions such as "live" sound effects playback, since you can
open multiple audio documents and play them from
your Macintosh keyboard.

To trigger sequential playback of multiple audio docu-
ments:

1. Open several audio documents, taking note of the
number that Peak assigns them in the Windows
menu. (This is based on the order in which the
documents were opened.)

2. Press the number which corresponds to the docu-
ment(s) you wish to play. (Note: the numeric key-
pad will not work for this function, you must use
the numbers at the top of the keyboard). You don't
need to wait until a document has finished playing
to press the next number: typing a numerical
sequence on your keyboard will "cue up" all of the
corresponding files. They will then play in the
order you choose.

3. Ifyou wish to stop playback and jump to the next
document in line, press the Return key. Peak initi-
ates playback of the next document in sequence.

Configuring Peak for Recording

To record in Peak with CoreAudio you will first need to
have configured Peak for playback with CoreAudio. The
Record Settings dialog can be accessed from under the
Audio menu (Option-R) as well as from the Toolbar. The
next few steps show how to configure for recording, and

include information about various recording options
available at each stage:

1. Open the Record settings from the Audio menu or tool-
bar, and configure the following:

Record Settings
Record Disk
Recording Type

'+ File Format

Largest drive ]
Uptions

Sound Des... _ﬂ

( Device and Sample Format... |

Monitor

Split Stereo Files
Append to doecument

" | Record timer...

@. Open after saving

(cancel) oK)

© Hardware Settings... |

The Record Settings dialog

Record Disk

The Record Disk pop-up menu allows you to choose
which hard drive you would like to record to. If you have
more than one hard drive connected to your Macintosh,
use this pop-up to select your record drive. (This option
will default to the largest drive currently available to your
Macintosh unless you select otherwise.) Peak requires
that you save the audio file to the same drive on which it
was recorded.

File Format

The File Format pop-up menu allows you to select the
file format for the incoming audio. You can choose from
AIFF or Sound Designer IL. If you need the newly record-
ed audio file to be in a different format, you can always
use the Save As function to save it as a another format
once recording is complete. If you do not select a file for-
mat for recording, Peak will default to AIFF.
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Auto Gain Control

The Auto Gain Control checkbox allows you to disable
the Automatic Gain Control feature used by the Mac OS
X Audio HAL system with some Macintosh microphone
inputs. If the recording device you are using supports
this feature, check the Auto Gain Control checkbox.

This will be grayed out unless you are using the
HAL option from the Sound Out menu (using this
option is covered later in this chapter)

Monitor

The Monitor checkbox allows you to monitor the audio
throughput while you are recording.

Split Stereo

The Split Stereo Files checkbox allows you to record the
incoming stereo audio as dual mono files rather than a
single stereo file. Dual mono files are used in programs
like Pro Tools, or BIAS Deck, so this option is useful if
you need to record dual mono files (i.e., split stereo).

Append

The Append to document checkbox allows you to record
into an existing audio document. To record new audio
into an existing document, place the insertion point in
the existing audio document at the point where you
want to insert the new audio. If the insertion point is at
the beginning of the file, the newly recorded audio will
be inserted at the beginning of the file. If the insertion
point is at the end of the file, the newly recorded audio
will be appended to the end of the existing file. If the
insertion point is somewhere in the middle of the file,
the newly recorded audio will be inserted at that point.

If you make a selection of audio, the Append to docu-
ment feature will allow you to replace the current audio
with newly recorded audio from the beginning of the
selection through the end of the document or wherever
you stop the recording.

Record Timer

The Record timer checkbox allows you to designate a
specific duration for recording. Peak will stop recording
after this set time and then open the Save dialog for your
audio recording. Checking the Record timer checkbox
will bring up the Recording Time dialog. In the
Recording Time dialog, designate the duration for
recording in seconds and click OK.

r Al

Recording Time

Record for:

G22I | sec.

Description

You can instruct Peak™ to record for a
specified number of seconds by typing
into this dialog. For example, type 600
for 10 minutes of recording. Peak will
stop the recording after this duration of
audio has been recorded.

o)

= )
Cancel

The Recording Time dialog

Open after Save

The Open after saving checkbox determines whether
the audio document is opened in Peak after it is record-
ed.

Record Through VST Plug-Ins

If you have VST plug-ins installed, you can record
through them in real-time when using CoreAudio. This is
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useful if you want to use a noise reduction, equalizing, or
dynamics plug-in during recording.

2. Click the Device & Sample Format button in the Record
Settings dialog and configure the following:

CoreAudio Record Settings

Record Through:
In01&2

™

Sample Rate:

Auto v

Clock Source:

Internal v

Channels:
: Mono @Stereo
Bit Depth:

) 16-bit @ 24-bit ) 32-bit

‘Ccancel ( OK ,

CoreAudio Record Settings dialog

Record Through

Using the CoreAudio Record Through pop-up menu you
can choose the source for recording.

Sample Rate

Using the CoreAudio Sample Rate pop-up menu you can
select the sample rate at which you wish to record. Some
sample rates may not be available depending on the lim-
itations of the audio card and its CoreAudio driver.
Please note that if you are recording from a digital source
you will want to be sure that you record at the same sam-
ple rate as your digital source. For more information on
sample rates, see the Glossary.

Clock Source

Be sure to set the Clock Source to digital in the
CoreAudio dialog if you plan to record via CoreAudio
from a digital source.

Some third party devices do not provide the option
. Jfor Peak to configure the clock source

Channels

You may also choose to record a mono or stereo file
using the radio buttons under the Channels heading.

Bit Depths

Choose the bit depth using the radio buttons under the
Bit Depth heading. Please note that you will be limited to
recording at bit depths that are supported by your audio
hardware and its CoreAudio driver. For more informa-
tion on bit depths, see the Glossary.

3. Click the Hardware Settings button in the the Record
Settings Dialog to change your input device

Hardware settings will have already been set up when
configuring for playback, but can easily be accessed from
the Record Settings window, should any changes need to
be made.

For example, if you experience clicks or digital
distortion in your recordings, you may need to

1 raiseladjust your audio hardware’s buffer size,
which can be adjusted in the Hardware Settings
dialog

You are Ready to record!
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The Record Dialog

When you select Record from the Audio menu (38-R),
Transport, or Toolbar, the Record dialog appears. There
are transport buttons along the bottom to Start, Pause
and Stop the recording, an Audio Source display that
shows you the waveform as it is being recorded, and a
Notepad window. There are also text displays showing
you the sample rate, bit depth, and number of channels
you selected in the Record Settings dialog, as well as
the amount of time you have left to record on the
selected Record Disk.

Record
Audio Source Display B:g

__INotepad [l Notepad regions, not markers

Record 16-bit 44100Hz Stereo SD 1l file.

Rec Time Left: 09:46:50.703 & |1 ||m

| L]

Record Settings... Pause  Stop Record

The Record dialog — showing the record transport controls

Record Transport

In the lower left portion of the record dialog are a set of
transport controls. From left to right, these controls are
for Record Settings, Pause, Stop, Record.

Notepad Cues

The Notepad feature in the Record dialog allows you to
type in text descriptions, transcribe a recording, or type

in comments called Notepad Cues at specific points dur-
ing the recording of an audio document. The Notepad
feature is available from the Record dialog and may be
used once a recording starts.

If you enable the Notepad checkbox, you can create
markers while recording. Each time you press the Return
key, a new Notepad Cue (marker) is generated for the
current recording time. You may then begin typing text
to describe the audio recording at that time (i.e., naming
the marker). When you hear the next significant event in
the recording, press the Return key to create another
cue, and so forth.

When you are finished recording, Peak will create mark-
ers in the audio document that correspond to each
Notepad Cue you have entered. If you also enable the
Notepad regions, not markers checkbox, Peak will create
regions during recording.

Notepad Cues are not available in Peak LE.

Notepad Cues are not available in Peak DV.

©
&

Record Bit Depth, Sample Rate, File Format,
Recording Time Left

The lower left portion of the record dialog displays infor-
mation about the current record settings, and will show
the bit depth, sample rate, file format of the current
recording. Just below this display is a counter that dis-
plays the amount of recording time left, based on the
amount of available hard drive space.
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Proper Levels for Recording

To obtain the best possible fidelity when recording digi-
tal audio, it is important to record your audio signal at
the highest possible level without introducing clipping
(distortion). The reasons for this are twofold: If your
audio input level is too low, the recorded audio may con-
tain a significant amount of noise which can manifest
itself as hiss. Conversely, if your audio input level is too
high, it may clip and cause audible crackling or other
types of distortion. You should avoid digital distortion at
all costs because unlike its analog counterpart - which
can sometimes sound "warm" and appealing - digital dis-
tortion sounds terrible. In order to prevent this from
happening, always leave a little headroom (6 dB or s0)
when you set levels so that you don't hit maximum input
levels and clip.

Recording

To start recording:

1. Turn down the volume of your instrument or
audio source.

2. Connect the instrument or audio source to the
audio input jack on the rear of your Macintosh. If
you are using an audio card, use the connectors on
this card; however, many audio cards have an
external interface box which contains the input
and output connectors, if this is the case, use
these.

3. Choose Record Settings from the Audio menu
(Option-R) or Toolbar, and configure the settings
as described in the previous section. Make sure

that you have checked Monitor in the Record
Settings dialog, so that you can listen to your audio
source as it is recorded into Peak.

Select Record from the Audio menu (88-R) or the
Record button in the Transport. The Record dialog
will open.

Play your instrument or audio source. You should
see the signal levels register on Peak's Audio
Meters in the Transport window.

Adjust the output of your audio source so that its
signal registers relatively high on the meters but
never hits top (indicated by the red Clip
Indicators.). Remember to always leave 6 dB or so
of headroom on the meters so that you don't clip.
Use the yellow and orange meter lights and red
Clip indicators to help you make this adjustment.

Click the Record button in the Record dialog. You
are now recording to disk. You should see the
audio waveform begin to scroll in the Audio
Source Display window.

To stop recording, click the Stop button. To pause,
click the Pause button.

Once you have stopped recording, the Save dialog
appears and prompts you to name the audio doc-
ument. You must save the audio document to the
same hard drive you selected in the Record
Settings dialog. Enter a name and click Save. Peak
automatically saves the document in the audio file
format you selected in the Record Settings dialog.
If you wish to later save the document in a differ-
ent audio file format, use the Save As command.

To play back the recording:

1.

Press the Spacebar on your computer keyboard (or
the play button in the Transport window) Playback

Chapter 4: Playback and Recording 69




begins.

To stop playback, press the Spacebar again (or the
stop button in the Transport window).

To start playback from a specific point in the
recording, with the Cursor Tool selected in the
Cursor Palette, double-click on the waveform at
the point from which you want playback to begin,
or click the mouse at the desired point and press
the Spacebar.

Importing a Track from an Audio CD

If you own a Macintosh computer that is equipped with

a compatible CD-ROM drive, you can use Peak to import

audio directly from an audio CD.

Import CD Audio
%
@ Select Tracks To Import from this Audio CD...

2 60 Miles an Hour.aiff
3 Turn My Way.aiff

4 Vicious Streak.aiff

5 Primitive Notion.aiff
6 Slow Jam.aiff

7 Rock the Shack.aiff

8 Someone Like You.aiff
9 Close Range.aiff

10 Run Wild.aiff

’_ Set Import Times... \

('mark ALY (unmark All ) (Unmark ) EMarks)

E QOpen tracks after import

F r——
_ Cancel

' Track Name... )

F e
. Import |

Import CD Audio dialog

This process is sometimes referred to among multime-

dia developers as audio extraction, or audio-across-SCSL

If you own an Apple or non-Apple external CD-ROM

drive, you may also be able to take advantage of this fea-

ture.

Please note that not every CD-ROM drive supports
audio extraction, and that even among drives of
the same model, one drive's firmware (the inter-
nal operating software) may support audio
extraction, while another's may not. If you are
unsure as to whether or not your drive supports
Apple-standard audio extraction, your best bet is
10 try the instructions that follow. If this doesn't
work, please contact the CD-ROM drive's manu-
JSacturer to establish whether your drive (and your
drive's firmware) will support Apple-standard
audio extraction.

To import tracks from an audio CD:

1.

Insert an audio CD in your CD-ROM drive.

Choose Import CD Track from the File menu or
click the CD button in the Toolbar.

In the dialog that appears, select the CD track that
you wish to import and click Mark. You may mark
multiple tracks for import. If you wish to import all
of the tracks on the CD, click on the Mark All but-
ton.

To name a selected CD track, click the Track Name
button.

Name Track

Please name this track...

Description

The name you provide for this track on the CD will be
used when the file is saved to disk.

cancel )

The Name Track dialog
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If iTunes is installed and you are connected to the Recording into a silent QuickTime
internet, Peak will recognize the track names by ~movie

their ISRC codes as they are registered on the

CDDB™ online CD database. 1. Create a new stereo or mono document (from the

File menu >New
5. To select only a portion of the track, click on Set )

Import Times button or double-click on the track 2. Open the movie
in the list. The Audio CD Import Options dialog i
) 3. Set record settings to append to document
will appear.
Uptions

Import CD Track Range

" Monitor

| Split Stereo Files

™| Append to document
00:00:33 542 End: 000144219 " Record timer...

Open after saving

00,00:33.542

00:01:45.219

Start:

 Cancel € Pay ) @

Audio CD Import Options dialog Check the Append to Document checkbox in the Record Settings dialog

6. Byadjusting the Start and End time controls at the

bottom of this dialog you can import the entire CD 4, Record (click movie icon to have movie play along)
track, or a just specific portion of the track. The

slider in this dialog assists you in locating start and

end times. Click Play to audition the CD track (or ﬁ
selected portion of the CD track). Click OK when
you are happy with the selection. The Movie button in Peak’s Record Dialog

7. Check the Open tracks after importing checkbox if
you want the CD track(s) you are importing to - . .
open in Peak. Tf you prefer to import the CD 5. When finished recording, save with a name

track(s) straight to disk, be sure to deselect the 6, Choose Save As... and select QuickTime as the file
Open tracks after importing checkbox. format.

8. Click the Import button in the Import CD Audio
dialog to import the selected tracks and the Save

dialog appears. Use the pop-up menu at the top of
the dialog to navigate to the hard drive where you Option al Recording Settings
wish to save the audio file. Click Save to save the
file to disk. Peak will save the file(s) in the AIFF

In Peak’s Audio Menu>Sound Out, there are alternate
audio format.

options — Mac OS X Audio HAL, Mac OS X Audio HAL
(System), and FireWire DV. Peak defaults to using

CoreAudio, and BIAS recommends using this configura-
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tion. You may at some point want to switch the audio
output settings in the following cases:

FireWire DV

* Ifyou need to connect a FiréWire device, such as a
DV camera, to be used for audio input or output,
select FireWire DV from Peak’s Audio

Menu>Sound Out.

Mac 0S X Audio HAL/Mac OS X Audio HAL (System)

Selecting this will use whatever device you have selected
in the OS X Audio preferences in the System prefer-

ences.

You may want to select Mac OS X Audio HAL in the fol-

lowing cases:

*  You need to access Tape-Style scrubbing — Tape-
Style scrubbing is not available when using

CoreAudio.

*  You are using Peak’s Change Pitch DSP tool, and
need to access real-time preview — Real-time pitch
change preview is not available when using
CoreAudio.

Configuration for Mac OS X Audio
HAL & FireWire DV

When using the Mac OS X Audio HAL or FireWire DV
audio engines, there are some differences in configura-
tion. Most notably, when in the Record Settings dialog,
clicking the Device and Sample Format button, and the
Hardware Settings button will bring up different dialogs
compared to when using CoreAudio.

These different configuration dialogs are:

Compression

Sound

Source

Compression | Sample

None ]

Speaker: | Off While Recording 18]

Compressor. Volume

Gain:

fonoonnonnnn

5. 0o
Level: 0OOOOOOOODOD

I 44.100 kitz 16 bit Stereo None
Rec: 44,100 kHz 16 bit Stereo None

CCnce) (O

The Sound dialog: Compression

I The compression option is not supported in Peak,
. 50 leave Compression set to none.

Sample

Sound

Compression [ sample | source
| = =

Speaker: | Off While Recording 1%

Rate: [44.100kHz %) Volume:

Size: () 8 bits @ 16 bits

Gain:

Use: O Mono ) Steree

Level

I 44.100 kitz 16 bit Stereo None
Rec: 44,100 kHz 16 bit Stereo None

{Cancel ) SO

The Sound dialog: Sample

Selecting Sample from the Sound dialog pop-up menu
allows you to choose the sample rate and bit depth, as
well as whether the incoming audio will be recorded as
a Stereo or Mono file. To some degree, the choices that
appear here will depend on your audio hardware. For
more information on bit-depths and sample rates, see

the Glossary.
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Source

Sound
Compression | sample | Source

¥ Bullt-in audio controller Volume:
Uina In

speaker: [ Off While Recording 5}

internal microphone (105
» OV Audin Caln

I 44.100 kitz 16 bit Stereo None
Rec: 44,100 kHz 16 bit Stereo None

The Sound dialog: Source

Selecting Source from the Sound dialog pop-up menu
allows you to select and configure the audio input you
wish to use for recording. If you are using third-party
audio hardware with your Macintosh, you can select it as
the input device using the Device pop-up. Use the Input
pop-up to select the hardware inputs you wish to record

through.
Your exact setup will differ slightly depending on
the input device that you are using with Peak. You
I can use either your Macintosh's built-in audio

inputs, or, if you are using third-party audio hard-
ware, you may wish to use its audio inputs and
outpults.

Once you have configured the options in the Sound dia-
log to your liking, click OK to return to the Recording
Settings dialog.

If you are using third-party audio hardware, it
may or may not include a dedicated driver. If it
does not include a driver; it will need to be native-
ly supported by the Mac OS, and will need to be
configured to use the Mac OS X Audio HAL system.
If it does include a dedicated driver, this will be a
CoreAudio driver, and will need to be configured
1o use the CoreAudio system, described earlier in
this chapter.

Hardware Settings

Clicking on the Hardware Options button in the Record
Settings dialog brings up a dialog appropriate to the
audio hardware that you are using with your Macintosh.
Note that in many instances there may be no settings for
a given device (including the Apple Built-In Sound).
Some audio hardware drivers have control panels or util-
ity applications that will launch when you click on the
Hardware Options button. The Duo preferences dialog
for the M-Audio Duo is shown below, but the actual
third-party dialog will differ depending on the specific
audio hardware you have.

8o s Audio

Active Channels  Sample Depth
# inputs 1 & 2 @ 16 Bit
™ Outputs 1 &2 24 Bit

RAuDIo)

J IUTe)

USE Mic Preamp with S/PDIF

Maximum Sample Rate: 48000

Latency: | low +

Preference Pane Version: 1.2
USB Driver Version:
Firmware Version:

<Nat Available>
«<Not Available>

“ Apply )

M-Audio Duo Preferences dialog

Conclusion

You have now learned how to record and playback audio
to and from hard disk using CoreAudio, Mac OS X Audio
HAL, and FireWire DV. You have also learned how to
import audio tracks from CDs. In the next chapter, you
will learn how to edit audio with Peak's powerful set of
digital editing tools.
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Chapter 5: Editing

This chapter introduces you to the concept of digital
audio editing. You will learn how to edit digital audio
with Peak’s many powerful editing tools.

Editing Audio with Peak

Peak provides you with a powerful interactive, nonde-
structive environment for editing and manipulating
audio. In this environment, not only are virtually all edit-
ing actions completely “undo-able” and “redo-able,” but
they can be performed interactively while audio play-
back is engaged.

Interactive Editing

Interactive editing means that you can cut, paste, loop,
and process audio with DSP functions and Plug-Ins even
while playing back the very audio that you are editing.
For example, you can start playback, cut a selection of
audio and paste or insert it later in the document, and
when Peak reaches the location of the inserted audio, it
will play it as if it were there all along. This revolutionary
capability makes Peak a supremely fast and flexible audio
production tool that makes conventional recording and
editing methods, such as analog tape and a razor blade
or Sound Designer, seem primitive and archaic by com-
parison.

Nondestructive Editing

Peak’s nondestructive editing capabilities mean that the
edits you perform to an audio document do not perma-
nently change the original source recording until you
finally save the document. Thus, you can cut, copy,
paste, fade in and out of, and otherwise completely
change a recording, and still be able to return back to
square one - the original untouched state of the record-
ing - up until the time that you save the document to
disk. At that time, all edits are permanently written into
the document.

Unlimited Undo and Redo

As an editing session progresses, Peak maintains an
internal list of the edits that you perform. Changes that
you make to an audio document are not permanently
applied to the file until you ultimately save it. This is
what gives Peak its unprecedented unlimited undo and
redo capability. Through the use of the Macintosh’s stan-
dard Undo and Redo commands, you can undo or redo
your actions sequentially, or by using the Edits com-
mand, using a “playlist-style” editing event list. This is a
very exciting technology that allows you to maintain
complete creative freedom of choice-right up until the
last moment before you save your project to disk.
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The Audio Document Window

The heart of Peak’s powerful editing capabilities is the
audio document window. The audio document window
provides you with a “window into sound,” allowing you
to make good use of both your eyes and ears to perform
extremely precise editing tasks. The Audio Document
window gives you a time-domain representation of
sound, that is, you see the amplitude of the sound over
time.

An audio waveform

An Audio Waveform

If you have never seen sound displayed in a visual format
before, it may not be immediately obvious how to “read”
an audio waveform. It is actually quite easy to navigate
through a recording with a waveform as your road map.
The peaks in the waveform are areas of high amplitude
(loud spots). The valleys in the waveform are areas of
low amplitude (quiet spots). If the audio material is
music with a pronounced, regular beat, it is generally
very easy to pick out where the beats are simply by look-
ing for peaks. Using this information, and the guidelines
given shortly in the “A Selection” section, you will be able
to successfully locate and select a desired portion of the
audio document and perform the edits that you wish.
The cursor marks the current location, and also serves as
an insertion point.

Vertical Scaling

Peak allows you to control the vertical magnification of
audio waveforms. This feature is useful if you are editing
and viewing a document with very quiet audio material.

To increase the vertical scaling magnification:

* Hold the Control key down and press the Up
Arrow key.

To decrease the vertical scaling magnification:

¢ Hold the Control key down and press the Down
Arrow key.

Audio Waveform Overview

Peak provides an Overview display of the entire audio
waveform along the top of the screen under the menu
bar. This provides you with a convenient visual reference
of the overall document when you are editing only a por-
tion in the audio document window. The highlighted
area in the Overview display shows the area of the audio
waveform currently visible in the audio document win-
dow. If desired, you can hide the Overview display to
allow the audio document window to occupy more of
the computer screen.

To show the Audio Waveform Overview:

*  The Overview display appears along the top of the
audio document window under the title bar. Check
Show Overview in the Options menu, or click the
disclosure triangle in the upper left corner of the
audio document window. A check next to this item
indicates it is enabled.
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To hide the Audio Waveform Overview:

* o hide the Audio Waveform Overview, uncheck
Show Overview in the Options menu, or click the
disclosure triangle in the upper left corner of the

audio document window.

A waveform with selected audio

A Selection

A selection is just what it sounds like: a portion of audio
that you have selected by clicking and dragging with the
mouse. You must select audio in order to perform an
editing action on it. To make good selections for editing,
the best rule of thumb is to begin a selection just before
a peak in the waveform and end it just after a peak in the
waveform. In other words, try to make selections start
and end in areas of low amplitude (“valleys” in the wave-
form).

It is also important, when possible, to begin and end a
selection at a point where the waveform meets the zero
crossing line (the center line through the waveform).
This helps you avoid creating pops and clicks if you later
cut or paste the audio because the point at which the
waveform meets the zero crossing is a point of no ampli-
tude in the sound wave. Pops and click generally only
occur if you make a careless selection and begin or end
on a portion of the sound wave where the amplitude is
high (where the waveform is high above the center

point). Enable Auto-Snap to Zero in the Options menu
to have Peak nudge your selection to the nearest zero
crossings automatically.

The Zoom In function helps you make very precise
selections by letting you zoom in to a higher magnifica-
tion and select exactly the portion of the waveform you
desire. Also, once you have made a selection, you can
adjust the beginning or the end of the current selection
by holding down the Shift key and clicking with the
mouse. Your selection will be shortened or lengthened
accordingly.

Channel Independent Processing

To select only the Left channel, move the cursor over it.
The cursor will show asmall “L at the insertion point. To
select only the Right channel, move the cursor over it.
The cursor will show a small “R” at the insertion point.
You can process one channel of an audio document
using Peak’s native DSP or third-party plug-ins.

Peak allows you to select and process the left and
right channels of a stereo file independently, but

you cannot edit (i.e., Cut, Paste, Delete, etc.) the
left and right channels of a stereo file independ-
ently.

A waveform with a Marker (named “Verse2”)
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A Marker

A marker can be placed in a document to identify a point
of importance. A marker appears as a line with a solid tri-
angular base. Peak allows you to place markers into a
document in order to mark a given location or region in
a document for later selection, navigation, or editing.
Markers can be moved, named and renamed, “anchored”
to a particular location on a waveform, and given other
attributes. The use of markers is covered in greater detail
later in this chapter.

A waveform with loop markers

A Loop

A loop refers to a section of audio that is bounded on
either side by loop markers. In the illustration above, the
area that falls between the loop markers “beg loop” and
“end loop” is looped. Loops are used to sustain or repeat
asection of audio. They can be used for material that you
intend to transfer to a sampler, or simply for playback
within Peak itself. Peak allows you to create one loop per
audio file.

A waveform with 2 adjacent markers (named “Beat 1 and Beat 2)

Audio Between Adjacent Markers

Audio between adjacent markers refers to a section of
audio that is bounded by markers. In the illustration
above, the area that falls between the Beat #1 and Beat
#2 markers is audio between markers. (Note: A selec-
tion of audio between markers is different than an audio
Region. Regions are described later in this chapter, as
well as in Chapter 6, Playlists and Audio CD Burning.)

Audio Info Area

In the lower left corner of each Peak Audio Document is
the Audio Info Area. The Info Area shows the maximum
amplitude, sample rate, bit resolution, file format, and
file size of the audio file.

Max: 0.0dB  44.1kHz 16-bit Stereo raw AIFF [69.19MB]

Audio Info Area

Clicking on the Max dB section of the Audio Info Area
will open the Change Gain dialog, so that you can
change the gain for the entire audio file, or the current
selection. For more information on the Change Gain
DSP function, please refer to Chapter 7, DSP. Clicking on
any other portion of the Audio Info Area will open the
Audio Info dialog.

Audio Info dialog

Selecting Audio Info from the Options menu (36-I),

will open the Audio Info dialog. The Audio Info dialog
allows you to change the sample rate, duration, root key
(for use in a sample playback instrument), and high and
low key range. Note that by changing the sample rate,
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the pitch and duration of the audio will be affected. (To
change the sample rate of an audio document without
changing the pitch, use the Convert Sample Rate com-
mand from the DSP menu, or click on the appropriate
Toolbar icon.) The Audio Info dialog is described in
more detail later in this chapter, as well as in Chapter 11
Menus.

Audio Info

cobo.mov

Stereo 16-bit raw QuickTime™ audic document.
Approximately 18.76MB of disk space

Contains 0 markers, 0 lnops, and 0 regions.

Sample Rate: 441000000
Audio Document Length; 00:01:51.481 M

Meter

Tempo

:ﬂ?ﬁli‘,‘!@?}ﬂ{_:f Jﬂ]ﬂ‘ﬂ%iﬂﬂ'!ﬂiE“:’f?ﬂ'ﬂ,}?{!?ﬂiﬂ
Audio Info dialog
Selecting Audio

In order to perform any type of editing action on an
audio document, first you must select the portion of the
document that you wish to modify. Peak has several
techniques for making and modifying selections.

To make a selection with the mouse:

* (Click the cursor at the desired location in the
audio document and drag to select the desired
range.

To extend or shorten a selection:

1. Make a selection with the mouse as explained
above.

2. Hold down the Shift key and click on the end of

1.

1.

the selection that you wish to modify.

Drag the mouse to extend or shorten the selec-
tion. When you are satisfied with the length of the
selection, release the mouse.

To select audio between two markers:

Hold down the Command key (38) and click any-
where in between two markers. (Markers are
explained in detail in the next section.) Peak
selects the audio between the markers.

If there are additional markers in the document
and you wish to extend the selection to encompass
other portions of audio that fall between the mark-
ers, hold down the Shift key and the Command
key, and click between another two markers. The
selection will extend from the originally selected
audio to the audio that you just added.

Repeat as desired to navigate to and select addi-
tional audio between markers.

To select audio between two markers with the Tab key:

Create markers at several locations in the docu-
ment with one of the techniques explained in the
next section.

Press the Tab key on your computer keyboard.
Peak selects the portion of the waveform that lies
between the first two markers in the document.

Press the Tab key again to select the portion of
audio between the next two markers. (If you hold
down the Shift key while tabbing the selection
through the audio file, you can add each succes-
sive area to the selection.)

Repeat as desired to navigate to and select addi-
tional audio.
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To select all audio in a document:
*  Choose Select All from the Edit menu or press

#8-A on your Macintosh keyboard.

Auditioning Audio

It is often useful to audition a selection along with just a
bit of audio preceding or following it-without actually
including this material in the selection itself. Peak’s
Auditioning command allows you to do this by specify-
ing a desired amount of pre-roll or post-roll when you
play the selection.

To audition audio with pre-roll or post-roll:

1. Choose Auditioning from the Preferences dialog.
The Auditioning dialog appears.

Auditioning
Preroll:
1.000000 seconds
Paostroll:
'1766660”0 7777777777 seconds
( cancel ( oK )
The Auditioning dialog

2. Enter the desired amount of pre-roll and post-roll
and click OK.

3. Click the cursor in the audio document and drag
to select the desired range.

4. Press Control-Spacebar. Peak plays the selection,
adding the amount of pre-roll and post-roll that
you specified.

Scrubbing
Dynamic Scrubbing

Peak provides a unique audio auditioning technique
called dynamic scrubbing. This feature is very useful for
precisely pinpointing and selecting a desired location in
an audio document. Dynamic scrubbing allows you to
drag the mouse forward or backward over a waveform
while Peak plays a short loop (between 10 and 600 mil-
liseconds) at the scrub location. When you have found
the location you are looking for, you can commence edit-
ing. Peak allows you to choose the length of this play-
back loop with the Dynamic Scrub Time command in
the Preference menu. Peak provides two type of dynam-
ic scrubbing: dynamic shuttle scrubbing and dynamic jog
scrubbing. Both are described below.

To select a loop duration for dynamic scrubbing:

*  Choose Dynamic Scrub Time from the Preference
menu, and choose a duration from the hierarchical
submenu. Typically, a value of between 40 to 80
milliseconds works well.

Time Units >
Sample Units »
Use Loop in Playback 8L

v Scroll During Play
Move Waveform During Play
Compute File Max dB
Show Edits
Show Marker Times

v Show Overview %,
Show Cursor Info 8T
+ Auto-Import Dual Meno
Audio Info... 88l
Dynamic Scrub Time [ 10ms
+ Auto Snap To Zero 15ms
25ms
v 45ms
v Auto-Balloon Help 60ms

80ms

150ms
300ms
600ms

“Open” Dialog after Launch

Setting the Dynamic Scrub feature’s loop time
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To use dynamic “Shuttle-type” scrubbing:

1. Hold down the Control key and click and drag the
mouse across an area of the audio document in the
audio document window. As you drag the mouse,
Peak plays a short loop of the audio at the insertion
point. You can control the tempo and direction
(forward or backward) of playback by dragging the
mouse slower or faster, forwards, or backwards.

2. Release the mouse button to stop scrubbing. The
insertion point will be exactly where you left off
scrubbing.

3. To make a selection starting at the current scrub
point, stop scrubbing, hold down the Shift key,
and click the mouse to extend the selection from
the insertion point to the desired location.

Jog Scrubbing

Peak provides a variation of the dynamic scrubbing fea-
ture which is similar to a technique known in recording
studios as jog scrubbing. With this technique, Peak actu-
ally engages playback and moves through the file at its
normal pace, but allows you to control the playback
point by dragging the mouse. You can control the direc-
tion (forward or backward) of playback by dragging the
mouse forwards or backwards. This scrubbing mode
affords a greater degree of control when you are
“zoomed out” in the audio document window.

To use dynamic “jog” scrubbing:

1. Hold down the Control key and Option key and
drag the mouse across an area of the audio docu-
ment in the audio document window. As you drag
the mouse, Peak engages playback while it loops a
short portion of the audio at the insertion point.
Dragging the cursor farther away from the current

insertion point increases the velocity of scrubbing.

2. Release the mouse button to stop scrubbing. The
insertion point will be exactly where you left off
scrubbing.

3. To make a selection starting at the current scrub
point, stop scrubbing, hold down the Shift key,
and click the mouse to extend the selection from
the insertion point to the desired location.

Since jog scrubbing mode is engaged by pressing the
Option key in combination with the Control key, it is
possible to toggle back and forth between jog and shut-
tle modes simply by pressing or releasing the Option
key.

Tape-Style Scrubbing

In addition to dynamic scrubbing feature, Peak provides
tape-style scrubbing. To enable tape-style scrubbing, set
the Dynamic Scrub Time under the Preference menu to
Tape-Style.

Tape-style Scrubbing requires using the Mac OS X
I Audio HAL audio engine. 1o set this, go to the
Audio menu>Sound Out and choose Mac OS X
Audio HAL

To start tape-style scrubbing:

*  Hold down the Control key on your keyboard, and
then click and drag the mouse at the location
where you wish to begin scrubbing.

To deactivate tape-style scrubbing:

*  Release the mouse and Control key.
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To control tape speed in tape-style scrubbing:

1. As you drag the mouse towards the right, scrub-
bing speed will increase.

2. Asyou drag the mouse toward the left, scrubbing
will slow down.

3. If you drag the mouse to the left of the point
where you started scrubbing, the scrub direction
will change from forward playback to backwards
playback.

The playback bar will show the scrubbing speed at the
top of the playbar. Playback speed can vary from minus
four times (-4.0x) to four times (+4.0x) original play-
back speed.

Using Unlimited Undo and Redo

Peak maintains an internal list of the edits that you per-
form during the course of an editing session. These
changes are not permanently applied to the file until you
save it. This gives Peak unlimited undo and redo capa-
bility. Through the use of the Macintosh’s standard Undo
and Redo commands, you can undo and redo your
actions sequentially; or by using the Edits command,
using a “playlist-style” editing event list. This powerful
capability allows you to maintain complete creative free-
dom of choice-right up until the last moment before you
save your project to disk. The only limitation in using
Redo is that if you insert a new action when a redo action
is available, you will no longer be able to redo.
Remember, as soon as you perform an editing action
other than Undo in Peak, Redo is no longer available.

To undo an action:

1. Perform an edit (such as cutting audio or moving a

marker).

2. Choose Undo from the Edit menu (38-Z) or
Toolbar. The action is undone.

3. You can continue undoing actions until you return
to the original state of the audio document (the
state at which it was last saved). When there are no
actions left to undo, the Undo menu item will
appear grayed out.

To redo an action:

1. If you wish to redo the action that was undone,
choose Redo from the Edit menu (38-Y) or
Toolbar. The action is redone.

2. You can continue redoing actions until there are
none left to redo. When there are no actions left to
redo, the Redo menu item will appear grayed out.

Using the Edits Command to Undo a
Series of Actions

Peak’s Edits command provides you with a second
unique and powerful method of undoing virtually any
number of editing actions performed on an audio docu-
ment since you last saved it. You can think of the Edits
command as a kind of “event list-based” undo with a list
of all your editing actions since you last saved. Using this
list, you can navigate back in time to the point at which
you performed a particular edit, and if you wish, undo it.
Once you have returned to an earlier state in the project,
you are free to start editing from that point on.

Be aware that if you do go back to a past action
and perform a different action at that state in the

project, any edits that originally occurred after
will be gone, and you won't be able to redo them.
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To use the Edits command to return to or undo an action:

1. Perform several edits. (Don’t use the Save com-
mand or you won't be able to undo any edits that
occurred before you saved.)

2. Choose Edits from the Edit menu. A dialog appears
listing the edits you have performed since you last
saved the document.

3. In the list, double-click on the description of the
action you wish to return to (or click the Revert to
Item button). Peak returns the document to the
state it was in at the time of that edit.

4. Ifyou wish to undo a particular action, locate the
action that immediately precedes the one you wish
to undo, and double-click it. Peak returns the doc-
ument to that state.

5. When you have finished, click Done.

Please note that Peak will remain in the state of the
action that you last selected in the Edits dialog. If you
begin new edits from this point, you will change the orig-
inal sequence of edits that followed this point in the edit-
ing session.

_rystal.alff Edits

25 18:37:50 2003 :
26 18:38:0t 2003 © Now Mor
78 15:33:90 2003
28 183814 2003 :

Jul 26 18:39:16 2003 Horeonlc AOtote from B:00:55.456 to AR:00:56.636

(Reverttattem )

{ Done )

The Edits dialog

Essential Editing Functions

Peak supports all of the Macintosh’s essential editing
functions such as cut, copy, and paste and provides sev-
eral more specifically designed for audio editing. This
section explains how to use each of these functions.

Because Peak allows you to have multiple audio docu-
ments open at the same time, it is possible to conve-
niently cut, copy, paste, and insert audio between docu-
ments. This makes combining material from several
audio documents very fast and easy.

Scratch Disks

Because audio data can be very large, Peak utilizes a por-
tion of your hard disk’s free space to hold audio data that
has been cut or copied, as well as for temporary or
scratch files for undo purposes. If you have more than
one hard drive attached to your Macintosh, the Scratch
Disks command in the Preference menu allows you to
choose the hard drives (or “scratch disks”) that you wish
to use for these temporary files. Peak allows you to select
which disk you want to have as your default, or
“Primary” disk for this purpose—ideally you would select
the disk that has the most free space.

[6] Scratch Disks:

Primary Folder... Use
g = # BigMomma  5325.5 MB free
@ ™ & iMacDv 2082.7 MB free

{ Reset ‘ @Allow Servers “ Cancel \ K

The Scratch Disks dialog
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If you are connected to a file server, you can utilize avail-
able storage on the server by clicking the Allow Servers
checkbox (that is if you have a very fast server connec-
tion). Any available servers will then appear in the
Scratch Disks pop-up menu. This is recommended only
if you have access to a high-speed ethernet, Media Net,
or other fast server.

Clearing the Clipboard to Reclaim
Disk Space

If you no longer need the clipboard contents, you can
free up the disk space occupied by the clipboard by
choosing the Clear Clipboard command from the Edit
menu.

Cutting Audio

The Cut command (38-X) allows you to cut a selected
range out of a audio document. Audio that occurs after
the cut slides over to fill in the gap. By cutting and past-
ing “pieces” of audio, you can freely rearrange material in
an audio document. This can be a powerful tool for cre-
ating audio remixes for music-oriented applications, as
well as an indispensable tool for general sound design
tasks. When you cut a selection, the Macintosh holds the
cut audio data in its internal memory (the Clipboard) in
case you wish to paste it elsewhere. Because all real time
editing you do with Peak is nondestructive, the audio
isn't actually removed from the original audio document
until you finally save the file to disk with the Save com-
mand. At that time, all edits are saved and any changes
that you have made are permanently saved to the audio
document.

To cut a selection:

1. Click the cursor at the desired location in the
audio document and drag to select the desired
range.

2. Choose Cut from the Edit menu (38-X) or Toolbar.

3. The selected range is removed from the audio doc-
ument(s) and held on the Clipboard. Audio occur-
ring after the cut slides over to fill in the gap.

Deleting Audio

If you wish to remove a section of audio from an audio
document without using the Cut command, you can use
the Delete key, or the Delete button on the Toolbar. As
with the Cut command and other editing functions, the
audio isn't actually removed from the original audio doc-
ument until you save the file to disk.

To delete a selection:

1. Click the cursor at the desired location in the
audio document and drag to select the desired
range.

2. Press the Delete key, or click the Delete button on
the Toolbar.

3. The selection is removed from the audio docu-
ment. Audio occurring after the deleted section
slides over to fill in the gap.

Copying Audio

The Copy command (38-C) copies the current selection
to the Macintosh’s Clipboard (or internal memory
buffer) so that you can paste it, insert it, or use it with
optional “Clipboard-based” processing such as Add,
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Convolve, Mix, Modulate, and ImpulseVerb. As with the
Cut command, copying and pasting “pieces” of audio,
allows you to freely rearrange material in a document.
This can be a powerful tool for creating audio remixes
for music-oriented applications, and an indispensable
tool for sound design.

To copy a selection:

1. Click the cursor at the desired location in the
audio document and drag to select the desired
range.

2. Choose Copy from the Edit menu (38-C) or
Toolbar.

3. The selection is copied to the Clipboard.

At this point, you can use either the Paste, Insert, or
Duplicate commands to place the copied audio into an
audio document. Each of these commands are explained
below.

Pasting Audio

The Paste command (38-V) allows you to paste the con-
tents of the Clipboard into a location that you choose by
placing an insertion point. Pasting audio deletes any
selected audio and inserts the clipboard audio at the
insertion point. Blending can be used with the Paste
command if you have made a selection-the Pasted audio
will be crossfaded with the audio on either side of the
selection according to the Blending Envelope and
Duration.

By cutting and pasting pieces of audio, you can freely
rearrange material in an audio document. In musical
applications, this gives you the freedom to entirely
“rewrite” compositions by changing the order of things,

repeating desired sections, and so on. In sound design
applications, this gives you the power to “compose” with
sound by creating audio collages.

To paste audio into an audio document:

1. Click the cursor at the point where you wish to
paste the audio data in an audio document or
make a selection of audio you want to delete and
replace with the contents of the clipboard.

2. Choose Paste from the Edit menu (38-V) or
Toolbar.

The Clipboard contents are pasted into the audio docu-
ment(s), beginning immediately after the insertion
point. Any selected audio at the location of the paste is
overwritten when the pasted data is inserted into the
audio document.

Replacing Audio

The Replace command allows you to paste audio data
over existing audio-to paste audio into an audio docu-
ment without pushing all data to the right of the inser-
tion point farther to the right (later in time) to accom-
modate the newly pasted audio. The Replace command
is useful for “laying over” a portion of audio while main-
taining the timing of the original document.

To replace audio into an audio document:

1. Click the cursor at the point where you wish to
replace the audio data in an audio document.

2. Choose Replace from the Edit menu or Toolbar. All
data to the right of the replaced audio maintains
their time position.
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Inserting Audio

The Insert command (38-D) allows you to paste audio
data into an audio document without overwriting any
existing data at the insertion point. When you paste data
with the Insert command, all data to the right of the
insertion point or selection start is pushed farther to the
right (later in time) to accommodate the newly pasted
audio. The Insert command is one of Peak’s most useful
tools for restructuring the contents of an audio docu-
ment. It is particularly good for “composing on the fly”
since it allows you to cut and insert pieces of audio-musi-
cal phrases, riffs, or simply textural sounds-to create a
composition or soundscape.

To insert audio into an audio document:

1. Click the cursor at the point where you wish to
insert the audio data in an audio document.

2. Choose Insert from the Edit menu (38-D) or
Toolbar. All data to the right of the insertion point
is pushed farther to the right (later in time) to
accommodate the newly pasted range.

Duplicating Audio

The Duplicate command allows you to paste multiple
copies of audio data into an audio document without
overwriting any existing data at the insertion point.
When you paste data with the Duplicate command, all
data to the right of the insertion point or selection start
is pushed farther to the right (later in time) to accom-
modate the newly pasted audio. The Duplicate com-
mand allows you to specify how many times you would
like to Duplicate the audio data contained in the clip-
board. The Duplicate command is very useful for creat-
ing longer audio documents that need to repeat a certain

piece of audio, such as creating a 4 bar drum loop out of
a 1 bar drum loop.

To Duplicate audio:

1. Select a range of audio, and choose Copy from the
Edit Menu (38-C).

2. Click the cursor at the point you wish to insert
duplicate copies of the audio selected in step 1.

3. Choose Duplicate from the Edit menu.

4. Use the Duplicate slider to indicate how many
copies should be inserted, or type in the number
of desired copies.

5. Click the OK button. All data to the right of the
insertion point is pushed farther to the right (later
in time) to accommodate the newly pasted range.

Cropping a Selection

The Crop command (38-") allows you to make a selec-
tion in an audio document and quickly and easily
remove all other audio from the audio document except
the selection. The Crop command is a particularly useful
tool for editing material to be used as samples or sound
effects, since it allows you to isolate and save just the
desired portion of a recording.

To crop a selection:

1. Click the cursor at the desired location in the
audio document and drag to select the desired
range.

2. Choose Crop from the Edit menu (38- ). All audio
but the selection is removed from the audio docu-
ment.
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New Document from Selection

The New Document from Selection command will auto-
matically create a new Audio Document containing the
selected audio from the source document.

To create a new document from a selection:

1. Make a selection in any open audio document that
you want to have as its own document.

2. Choose Document from Selection from the New
submenu under the File menu (Control -N).

3. A new audio document will be created with the
selected audio.

Silencing a Selection

The Silence command (38-E) replaces the selected
audio in the audio document’s selection with silence.
This feature is very useful for silencing nonessential por-
tions of a recording that contain an unusual amount of
noise. This can be used very successfully with spoken
material such as dialog or narration to remove noise
between words or during pauses in speech. It can also be
used to remove pops or clicks that occur in such materi-
al.

To silence a selection:

1. Click the cursor at the desired location in the
audio document and drag to select the desired
range.

2. Choose Silence from the Edit menu (38-E). The
selected audio is replaced with silence.

Inserting Silence into a Document

The Insert Silence command allows you to insert a spe-
cific amount of silence into an audio document at the
current insertion point. This feature is very useful for
inserting pauses of a desired duration into a recording,
and can be particularly useful in adjusting the timing or
rhythm of spoken material such as dialog or narration.
When you choose this command, Peak will prompt you
to enter the amount of silence you wish to insert. You
can enter this value in samples, milliseconds, or seconds.
All audio occurring after the insertion point is moved
later in time by the amount of the silence that you insert.

Insertion

Enter the duration of silence to insert:

1.0000 seconds

Description

| Insert Silence will insert silent digital audio at the audio
document's insertion point. Enter the amount of silence
| you wish to insert at the insertion point.

FEE
“Cancel )

o)

The Insert Silence dialog

To insert silence of a specific duration into a document:

1. Click the cursor at the desired location in the
audio document.

2. Choose Insert Silence from the Edit menu.

3. In the dialog that appears, enter the amount of
silence that you wish to insert into the audio doc-
ument. Peak inserts the specified amount of

silence into the document.
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Show Edits

When you enable the Show Edits command Peak indi-
cates areas of an audio document that you have edited
by enclosing these areas with hatched lines. This pro-
vides you with a convenient visual reference to portions
of the document that have been affected by your editing
actions. Once you save a document, the edits are saved,
and these indicators will no longer appear.

To enable Show Edits:

*  Choose Show Edits from the Options menu. A
check next to this item indicates it is enabled.

To disable Show Edits:

*  Choose Show Edits again from the Options menu.
The absence of a check next to this item indicates
it disabled.

Using Crossfades and Blending to
Smooth Edits

Blending is an automatic crossfade function with a user-
editable envelope. Peak can apply blending to areas of an
audio document where they are modified by cutting,
deleting, pasting, or other editing processes in order to
smooth abrupt transitions between waveform ampli-
tudes. It can be very useful for creating a smooth transi-
tion between edits that would otherwise sound too
abrupt. If you are going to edit (i.e., Cut, Paste, Delete,
etc.) a document, you may wish to enable blending to
smooth things out a bit. You can toggle blending on or
off by clicking the Blend enable/disable button in the
Audio Document Window, or by pressing the Caps Lock
key on your keyboard.

The Blending Enable/Disable button in the Audio Document Window

Blending

Duration: 100 ms

(_Edit Blending Envelope“,_\

@ Linear Blend Calculations

e
Cancel !

The Blending dialog

Be aware that Blending can interfere with certain
DSP processes available under Peak’s DSP ment,
such as Fade In/Out and Normalize. You will typi-

|
= cally only want to enable Blending only when you
intend 1o make an edit in which Blending may be
desirable.
To enable blending:

*  Click the blending button in the audio document
window, or press the Caps Lock key on your key-
board. The blending button will light up in blue
when blending is turned on.

To disable blending:

* Click the blending button in the audio document
window, or press the Caps Lock key on your key-
board. The blending button will not be illuminated
when blending is turned off.
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To set blending parameters:

1.

2.

Choose Blending from the Preferences dialog.

Enter a value in milliseconds in the Duration field.
Peak will apply a crossfade of this duration across
the edit.

If you wish to edit the shape of the crossfade that
the blending function applies, click the Edit
Blending Envelope.

Peak’s Crossfades are calculated logarithmically to
preserve volume levels for crossfaded material. If
you want Peak to calculate the Blending Crossfade
linearly, check the Linear Blend Calculations
checkbox.

Click OK when you have finished.

Blend

Current Envelope T]

{ 100mses, -100.000000% )

" Reset ) [ Cancel ) fChange!

Load... ) { save...

(e

The Blending Envelope Editor

To select and edit the blending envelope:

1.

Choose Blending from the Preference dialog and
click the Edit Blending Envelope button. The
Blending Envelope Editor appears. The envelope
shape shown here represents the shape of the
crossfade. Peak also comes with several commonly
used preset envelopes that appear in the pop-up at
the top of all of Peak’s Envelope Editing windows
(see also Editing a Fade In/Out Envelope). These

are stored in the Peak Envelopes folder in your
Preferences folder.

Click anywhere on the line and a new moveable
“breakpoint” will appear.

Drag the breakpoint to the desired location.

Continue creating and dragging breakpoints until
you have created the envelope that you desire. If
you wish to delete a breakpoint, click on it with the
cursor and press the Delete key on your computer
keyboard.

If you wish to reverse the shape of the envelope
you have created, click the “<->” button. This
creates a mirror image of the envelope.

If you would like to save your custom envelope for
later use, click on the Save button before exiting
the envelope editor. Your custom envelopes will be
stored in the Peak Envelopes folder, and will
appear in the pop-up at the top of the envelope
editor.

When you are satisfied with your new envelope
shape, click Change to confirm your edits and
close the envelope editor. Peak will use this enve-
lope until you change it again.

Note that the Blending Envelope will only be
applied to an edit if it is configured prior to mak-
ing the edit.

If Linear Blend Calculations is checked in the
Blending dialog, the Equal Power X-fade envelope
is very effective for a smooth crossfade that will
not result in a dip in the energy of the audio data.
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Creating Fade Ins and Fade Outs

Peak allows you to create fade ins or fade outs at any
point in an audio document. Fade ins/outs can be very
useful for smoothly fading in or out of an audio docu-
ment, or for fading out of one type of audio material into
another. Very short fade ins can also be useful for
smoothing or removing clicks and pops in a recording.
Peak allows you to control the exact “shape” of the fade
in/out by providing you with preset envelope shapes as
well as very precise user-definable envelope controls for
the fade. Peak also comes with several commonly used
preset envelopes that appear in the pop-up at the top of
the Envelope Editing windows. These are stored in the
Peak Envelopes folder in your Preferences folder.

To create a Fade In:

1. Click the cursor at the desired location in the
audio document and drag to select the range you
desire. The Fade In will be applied to the audio
within this selection.

2. Choose Fade In Envelope from the Preferences
dialog.

3. In the dialog that appears, you can use the default
envelope, edit the envelope, or load any envelopes
included with Peak or that you have created your-
self. (“Editing Fade In/Fade Out Envelopes” is cov-
ered in the next section.) Click Change to apply
the new envelope.

4. Choose Fade In from the DSP menu. Peak applies
the Fade In to the selection you have made in the
audio document.

5. To hear the completed Fade In, press Option-
Spacebar. You will hear the selected audio com-
plete with your Fade In.

To create a Fade Out:

1. Click the cursor at the desired location in the
audio document and drag to select the range you
desire. The Fade Out will be applied to the select-
ed audio.

2. Choose Fade Out Envelope from the Preferences
dialog.

3. In the dialog that appears, you can use the enve-
lope, create your own, or load any envelopes that
you have saved to your hard disk. (“Editing Fade
In/Fade Out Envelopes” is covered in the next sec-
tion.) Click Change to apply the new envelope.

4, Choose Fade Out from the DSP menu. Peak
applies the Fade Out to the selection you have
made in the audio document.

5. To hear the Fade Out, press Option-Spacebar. You
will hear the selected audio complete with your
Fade Out.

Editing a Fade In/Fade Out Envelope

Peak allows you to control the exact shape of Fade
Ins/Outs by providing you with controls for editing the
Fade In/Out envelope. These are found in the Fade In
Envelope and Fade Out Envelope sections in the
Preferences dialog.

To edit and save a Fade In/Fade Out envelope:

1. Choose Fade In Envelope (or Fade Out Envelope)
from the Preferences dialog. The Fade Envelope
Editor appears. The envelope shape shown here
represents the shape of the fade, and overlays the
selected audio to show where the curve is graphi-
cally applied to the waveform representation of
the audio.
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The Fade Envelope Editor (a Fade In is shown)

2. Click anywhere on the line and a new moveable
“breakpoint” will appear.

3. Drag the breakpoint to the desired location on the
envelope’s curve.

4. Continue creating and dragging breakpoints until
you have created the fade envelope that you
desire. If you wish to delete a breakpoint, click on
it with the cursor and press the Delete key on your
computer keyboard.

5. If you wish to reverse the shape of the envelope
you have created, click the “<->" button. This
creates a mirror image of the envelope.

6. If you would like to save your custom envelope for
later use, click on the Save button before exiting
the envelope editor. Your custom envelopes will be
stored in the Peak Envelopes folder, and will
appear in the pop-up at the top of the envelope
editor.

7. When you are satisfied with your new envelope
shape, click Change to confirm your edits and
close the envelope editor. Peak will use this enve-
lope every time you apply a Fade In (or Fade Out)
until you change it again.

Note that the Fade In/Fade Out Envelope will only
1 be applied to a selection if it is configured prior to
applying the Fade In/Fade Out DSP function.

To load a Fade In/Fade Out envelope:

1. Choose Fade In Envelope (or Fade Out Envelope)
from the Preferences dialog. The envelope editor
appears.

2. Click the Load button.

3. In the dialog that appears, locate and select the
fade envelope that you desire, and click Open.

4. Click Change to confirm this new envelope and
close the envelope editor. Peak will use this enve-
lope until you change it again.

Creating and Using Markers

Peak has a very powerful set of features to control the
placement and modification of markers. Markers are
locations in an audio document that you define as
important. By marking specific locations in a recording,
you can navigate easily to a location for selection, editing
or playback purposes.

Markers can also be made into loops. Loops are used to
sustain or repeat a section of audio. They can be used for
material that you intend to transfer to a sampler, or sim-
ply for playback within Peak itself. Peak allows you to cre-
ate one loop per audio file. Loops are covered in detail
later in this chapter.
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A marker in the Waveform Display

Creating Markers

As we'll describe in detail on the next few pages, there
are a number of ways to create markers: by dropping
them “on the fly” during playback, inserting them during
recording with Notepad Cues, defining them with the
mouse when playback is stopped, creating markers
using the Threshold DSP command, or using the
Markers from Tempo command to insert multiple mark-
ers at regular intervals. Of the various ways to create
markers, the mouse method is perhaps the more pre-
cise. However, since it is possible to fine tune the loca-
tion of a marker at any time by dragging it, (or by using
the Edit Marker dialog, explained later) all methods work
equally well - the method you choose to insert markers
will depend largely on the task at hand.

Remember that if Auto Snap To Zero is enabled the
insertion point will snap to the nearest zero-cross-

ing. This will cause your marker be placed at the
nearest zero crossing when you use the mouse 1o
create or place a marker.

Once you have created a marker, you can assign or edit
the marker’s attributes in the Edit Marker dialog.
Double-click the triangular base of the marker to open
the Edit Marker dialog.

Edit Marker 2

Text:  Geat2

Marker Position: | 00:00:42.447 Min:Sec:... T]

® Regular Marker @Anchor To Sample

2 Loop Start [ Reference Marker
" Loop End
 Delete Marker ' ( Cancel ) i L S
The Edit Marker dialog
Text

You may wish to give markers meaningful names (up to
256 characters long) based on their locations in an audio
document. Peak gives markers default numeric names
based on the name of the audio document and the order
in which the marker was defined. To name or rename a
marker, simply type the new name in to the Text field of
the Edit Marker dialog.

You can easily find any marker, region, or loop
that you have named by simply typing the first few
letters of its name. For example, if you want to
locate a marker called “Solo,” just type s-o-l, and
Peak will automatically scroll to the marker
called “Solo.” If you hit Enter or Return after typ-
ing the characters, Peak will also automatically

Pplace the insertion point at that marker. If more
than one marker matches the letters you type in,
Peak will locate the first marker with that name.
(Note that numerical marker name entries will
only work from the keypad, not the numbers keys
along the top of your keyboard.)

Marker Position

The Marker Position field allows you to move a marker to
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a specific time location in an audio document by enter-
ing the desired value. The pop-up menu to the right of
this field allows you to choose a time format (samples,
minutes:seconds:miliseconds, etc.) for the value that
you enter in the Marker Position field.

Marker, Loop Start, and Loop End

These three radio-style buttons allow you to define
whether the marker is a regular marker or a loop mark-
er. If you choose to designate the marker as loop mark-
er, you can define it as either the loop start or the loop
end by clicking on the corresponding radio button.
Remember, Peak allows only one loop per audio file.

Anchor To Sample

When you insert or delete audio that is near a marker,
you may want the marker to move with that particular
location on the waveform. This will compensate for the
insertion or deletion, so that the marker remains with
the particular portion of audio you want it to be associ-
ated with. By enabling the Anchor feature for a marker,
you can assure that Peak will “tie” the marker to a loca-
tion on a waveform, causing it to stay with that location
even when audio is inserted or deleted into the docu-
ment. By default, Peak enables this feature for markers,
loops and regions.

Reference Point

By defining a marker as a reference point, you can use
the marker as a reference when you make selections or
move other markers. Selecting or dragging the marker
will then automatically display the distance to the closest
reference marker in whatever time format (samples or
seconds) is currently selected in the Peak application.
This may be useful, for instance, if you know that you
want a particular sound event (such as a car door slam)

to happen a certain number of seconds before or after
another sound event (such as a tire squeal).

Delete Marker

The Delete Marker button allows you to remove the cur-
rently selected marker from an audio document.

The following section explains how to create markers
and define their attributes.

To create a marker when playback is stopped:

1. Click the mouse at the desired location in the
audio document. A dotted vertical line appears,
indicating the insertion point.

2. Press 3-M on your computer keyboard or choose
New Marker from the Action menu or Toolbar.
Peak will drop a marker at that location.

To create a marker during playback:
1. Begin playback of an audio document.

2. At the desired point during playback, press 6-M
on your computer keyboard. Peak will drop a
marker at that location.

3. Repeat as desired as playback continues. Each
marker will appear at the appropriate location in
the audio document window.

To create a marker using dynamic scrubbing:

1. Hold down the Control key (or Control-Option for
jog-type scrubbing) and drag the mouse across the
desired location to scrub playback.

2. At the desired point during playback, release the
mouse to stop scrubbing,

3. Press 38-M on your computer keyboard. Peak will
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drop a marker at that location.

To name a marker or set other marker attributes:

1. Double-click on the triangular base of the marker
that you wish to edit. The Edit Marker dialog
appears.

2. Enter a name for the marker.

3. Change other attributes of the marker as desired.
For an explanation of each of these attributes, refer
to the beginning of this section.

4. When you have finished, click OK to close the Edit
Marker dialog. The marker now has the attributes
you selected.

To move a marker to a new location:

1. Click on the triangular base of the marker and drag
it to the desired location.

2. To make a marker’s position snap to a zero-cross-
ing (the point at which a waveform crosses the
center phase line) as you drag it, hold down the
Shift key while you drag.

To move a marker to a new location numerically:

1. Double-click on the triangular base of the marker.
The Edit Marker dialog appears.

2. Choose the desired time units (samples, seconds,
or milliseconds ) from the time format pop-up
menu.

3. In the Position field, enter the precise time loca-
tion that you wish to move the marker to.

4. Click OK to close this dialog. Peak moves the mark-
er to the location you entered in the dialog.

To nudge a marker or a selection of markers to a new
location:

1. Make a selection that includes the marker (or
markers) that you wish to nudge.

2. Choose Nudge Markers from the Action menu or
Toolbar. The Nudge Markers dialog appears.

Nudge Markers

Nudge markers by...

0.0000 seconds

Description

| Nudge markers slides all markers, loops, and regions in
the current audio selection by the specified amount of

|!imu. Use this feature to move several markers forward |
or backward in time. |

SR
Cancel )

€oxd

The Nudge Markers dialog

3. Inthe Nudge Markers by field, enter the number of
seconds (positive or negative) by which you wish
to nudge the marker.

4. Click OK to close this dialog. Peak nudges the
marker by the value you entered in the dialog.
To delete a marker:

1. Double-click the triangular base of the marker. The
Edit Marker dialog appears.

2. Click the Delete button. The marker is deleted
from the audio document.

3. Click OK to close the Edit Marker dialog.

To delete markers in a Selection:

1. Make a selection in the audio document that con-
tains the markers you want to delete.

2. Choose Delete All Except Audio (Option-Delete)
from the Action menu and all markers, regions,
and loops in the selection will be deleted.
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Regions

Regions are portions of an audio document defined by
Region Markers using the New Region command from
the Action menu (38-Shift-R) or Toolbar. Regions present
in currently open audio documents will be listed in the
Contents window.

Peak’s use of Regions will be discussed further in the
chapter on Playlists and CD Burning.

Regions can be saved only into AIFF and Sound
Designer 1I files created by Peak. However, Peak
will also read Regions stored from other programs
in Sound Designer Il files. The method Peak uses to
store Regions in AIFF files is specific to Peak and is

not necessarily supported by other software appli-
cations. If you are using Regions with other pro-
grams, you will want to store your files as Sound
Designer II files.

A "Region”

An audio Region (named “A Region”)

To define a new Region:
1. Make a selection in an opened audio document.

2. Choose New Region from the Action menu (38-
Shift-R) or Toolbar.

3. Type the name of the Region and click OK. The
new Region will appear in the audio document.

To modify the length of the Region by changing the start
or end:

*  Drag the start or end marker of the Region in the
audio document window.
To move a Region without changing its length:
* Hold down the Option key and drag either the
start or end marker of the Region.
To edit a Region’s start, end, or length manually:

1. Double-click on either the start or end marker of
the Region in the audio document window. The
Edit Region dialog will appear.

Edit Region
Name: | AEREQISHE
Units: (MinSecms &)
Start:  00:00:42.014 End: 00:00:42.452
T ® Adiusts End
Length:: | 00:00:00.439 Adjusts Start
‘Cancel ) [ Delete ook
The Edit Region dialog

2. Enter new values for Start, End, or Length times,
then click OK.

To change the name of a Region:

1. Double-click on either the start or end marker of
the Region in the audio document window. The
Edit Region dialog will appear.

2. Type the new name of the Region into the dialog
and click OK.

To locate a Region:

*  Double-click the region’s name in the Contents
Palette or in the audio document window’s File
Drawer. The Region will automatically snap into
view, with the region selected.
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Creating Loops

Ifyou're editing music or other rhythmically-based mate-
rial, it is generally a good idea to test a selection to make
sure it contains an even number of beats before you cut,
copy, or paste it. A good way to do this is to loop the
selection and listen to the loop as it plays. As described
in the next section, Peak includes Loop Surfer, which can
automate the process of finding a rhythmically “correct”
length of audio to loop, assuming you know the tempo
and the number of beats you wish to loop. You can also
use the Loop Tuner, found in the DSP menu, to adjust
the loop start and end points. The Loop Tuner is also
described in the next section.

Loops are useful in material that you plan to transfer to
a sampler. Loop markers created with Peak are recog-
nized by samplers as sustain loops. Peak allows you to
create only one loop per audio document.

To play a loop in Peak, select Use Loop in Playback com-
mand (38-L) from the Options menu or click the loop
button in the Transport window, begin playback, and
when Peak reaches the loop, it will continue to repeat
until you stop playback. If Use Loop in Playback is not
enabled, Peak will simply play right through the loop to
the end of the audio document or selection.

To create a loop from a selection:

1. Click the cursor at the desired location in the
audio document and drag to select the range you
want.

2. Choose Loop This Selection from the Action menu
(38-Shift-"") or Toolbar. Your selection is now
looped. Loop markers appear at the beginning and
end of the loop.

3. To listen to the loop, choose the Use Loop in
Playback command (38-L) from the Options menu
(a check next to this menu item indicates it is
enabled), or click the Loop button in the Transport
window, and start playback by pressing the
Spacebar on your keyboard.

4. You can interactively fine tune a loop by dragging
the loop start or end markers while loop playback
is engaged. As you drag a loop marker to a new
location, Peak will adjust the playback loop to
reflect the changes you make. You can also use the
Loop Tuner to call up a dialog that allows you to
visually fine tune the loop, and even play the loop
while adjusting it to listen to the changes.

To change regular markers into loop markers:

1. Create markers in a audio document.

2. Double-click on the triangular base of the marker
that you wish to define as the loop start point. The
Edit Marker dialog appears.

3. Click the Loop Start button and click OK. The
marker becomes a Loop Start marker.

4. Double-click on the triangular base of the marker
that you wish to define as the loop end point. The
Edit Marker dialog appears.

5. Click the Loop End button and click OK. The mark-
er becomes a Loop End marker. You have now
defined a loop in your audio document.

To move a pair of loop markers together:

* Hold down the Option key and drag one of the
loop markers to the desired location. Both mark-
ers move in tandem as you drag.

*  Select the loop by choosing Select Loop from the
Edit menu (38-"-"), or by command-clicking
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between the two loop markers, and then clicking
the Horizontal Lock button in the audio document
window. Both markers move in tandem as you
drag. Be sure to turn off Horizontal Lock to move
the loop markers independently.

The Horizontal Lock button

To listen to the loop only:

1. Choose Select Loop (38-"-") from the Edit menu to
select the loop.

2. Make sure loop playback is enabled using the Use
Loop in Playback command from the Options
menu (a check next to this menu item indicates it
is enabled), or by pressing the Loop button on the
Cursor Palette.

3. Press the Spacebar to begin playing back the loop.

Crossfading Loops

Peak allows you to crossfade the start and end points of
aloop. Crossfading a loop can be very useful for smooth-
ing the transition between the end of the loop and its
beginning as it repeats. Peak allows you to control the
envelope of the crossfade, the duration, and other
parameters in the Crossfade Loop dialog.

To Crossfade a Loop:

1. Create a new loop or choose and existing loop.

2. Select the loop by #8-clicking between the loop

markers.

3. Choose Crossfade Loop from the DSP menu or the
Toolbar.

4. The Crossfade Loop dialog appears.

Crossfade Loop

Example:

Loop Start
Duration for crossfade(s) :

Loop End

100 ms fEnveIope..‘\

'Zi Logarithmic

o)

o b
‘Cancel'

The Crossfade Loop dialog

5. Choose where you want crossfades to be applied
using the check boxes along the top of the
Crossfade Loop dialog. Typically, the default for
this works well.

6. Enter the Duration for the crossfade(s) in millisec-
onds.

7. Check whether or not you want the crossfade cal-
culated logarithmically or not (i.e., linearly).

The Crossfade Loop dialog is not available in Peak LE.

The Crossfade Loop dialog is not available in Peak DV.

©
&
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To edit a Crossfade Loop Envelope:

1. Click on the Envelope button in the Crossfade
Loop dialog and the Blending Envelope Editor
appears.

Blend
Current Envelope T]

€ 93msec, -100.000000% )

" Cancel |  Change )

) { Reset

The Bending Envelope Editor

Note that this is the same Blending Envelope
s Editor that is accessed from the Blending dialog.

2. Click anywhere on the line and a new moveable
“breakpoint” will appear.

3. Drag the breakpoint to the desired location.

4. Continue creating and dragging breakpoints until
you have created the envelope that you desire. If
you wish to delete a breakpoint, click on it with the
cursor and press the Delete key on your computer
keyboard.

5. If you wish to reverse the shape of the envelope
you have created, click the “<->" button. This
creates a mirror image of the envelope.

6. If you would like to save your custom envelope for
later use, click on the Save button before exiting
the envelope editor. Your custom envelopes will be
stored in the Peak Envelopes folder, and will

appear in the pop-up at the top of the envelope
editor.

7. When you are satisfied with your new envelope
shape, click Change to confirm your edits and
close the envelope editor. Peak will use this enve-
lope until you change it again.

To hear the completed crossfade, choose Select Loop
from the Edit menu, select Use Loop in Playback from
the Options menu or click the Loop button on the
Toolbar, and press the Spacebar. You will hear the loop,
complete with your crossfade.

Using Loop Surfer

Peak’s Loop Surfer feature automates some of the steps
for setting up loop points. Loop Surfer allows you to
“Loop Surf” (adjust your loops during playback) quickly,
easily and in a musically intuitive manner.

If you're working with music, and know the music’s
tempo in beats per minute, you can use Loop Surfer to
create a loop which lasts for a rhythmically “correct”
length of time.

Loop Surfer™
Tempo: Number of beats:
1521414 bpm 8 beats

__ Use Selection

Tempo Calculator
The selection is..

1 bars and 0 beats
with a time signature of... 4
The tempo is : 66.071 4

Cancel ) { Make Loop ) {(Start Surfing)

The Loop Surfer dialog
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To use Loop Surfer based on a musical tempo:

1.

Place the cursor where you wish to begin the loop
(it's okay to place it approximately, rather than
exactly, where you wish to start).

Choose Loop Surfer from the Action menu (38-]).
The Loop Surfer dialog appears.

Type in the music’s tempo. If you are not sure of
the tempo, you can use the Tempo Calculator to
determine the tempo. Simply select a portion of
audio, and type in the number of bars and beats in
the selection. The calculator will determine the
tempo based on your selection. If you are unsure,
and have used a drum machine or sequencer to
create the music, you might wish to refer back to
its settings determine the time signature and
tempo. Additionally, you can use the Threshold
command from the DSP menu to select a portion
of audio that should correspond to the beat; see
“To use Loop Surfer based on a selection” below.

Type in the number of beats that you wish the loop
to last. The beats are based upon quarter-notes, in
terms of musical time. For instance, if your song
was in a 4/4 time signature, typing “4” beats would
mean the loop would be one measure in length; if
the song were in 7/4 time, typing “14” would mean
the loop would be two measures in length. (If you
are interested in exploring syncopations, however,
there’s no reason why you can’t type a beat value
that doesn’t correspond to the time signature,
such as “5” if the music is actually in “3/4” time.)

If you then select the Start Surfing button (the
default), Peak will automatically:

a) close the Loop Surfer dialog box;

b) extend the selection from the cursor insertion
point to a calculated length, based upon the

tempo and number of beats;

¢) change the cursor insertion point to a Loop
Start marker;

d) drop a Loop End marker at the end of the
newly calculated selection;

e) turnon (if it hasn't already been turned on)
the Use Loop In Playback option under the
Options menu.

f) begin looped playback of the audio selection,
stopping only once you hit your keyboard’s
Spacebar or press Stop on the Toolbar.

If you select the Make Loop button, Peak will auto-
matically:

a) close the Loop Surfer dialog box;

b) extend the selection from the cursor insertion
point to a calculated length, based upon the
tempo and number of beats;

) change the cursor insertion point to a Loop
Start marker;

d) drop a Loop End marker at the end of the
newly calculated selection;

e) turnon (if it hasn't already been turned on)
the Use Loop In Playback option under the
Options menu.

f) At this point, you must start playback manual-
ly using the Spacebar or the Toolbar if you
wish to begin Loop Surfing.

While you're Loop Surfing (adjusting your loop during
playback), you're free to perform all of the standard
looping functions as described in the previous section,
including adjusting the Loop Start and End points during
playback. Most importantly, however, since you'll now
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have a selection that lasts fora period of time that match-
es the beat, try moving the markers in tandem, by hold-
ing down the Option key and clicking and dragging one
of the loop markers to the desired location with the
mouse. You'll find it’s a great way to set up interesting
rhythms and syncopations! Peak’s interactive editing
capabilities also allow you to use the Loop Surfer dialog
while a loop plays to adjust the tempo, beats and so on.

If you're not working with music (or if you simply don’t
know the tempo of the music you’re working with), you
might choose to Loop Surf based upon a selection (or
use the Threshold feature), rather than starting at a cur-
sor insertion point.

To use Loop Surfer based on a selection:

1. Place the cursor where you wish to begin the loop,
and using the mouse, select the portion of audio
you wish to loop. (You can make your selection in
a variety of other ways, also, as described earlier,
including selecting between markers by 38-click-
ing with the mouse).

2. Select Loop Surfer from the Action menu. The
Loop Surfer dialog appears.

3. If you check the Use Selection box and select
either the Start Surfing or Make Loop button, Peak
will automatically:

a) close the Loop Surfer dialog box;

b) extend the selection from the cursor insertion
point to a calculated length, based upon the
tempo and number of beats;

¢) change the cursor insertion point to a Loop
Start marker;

d) drop a Loop End marker at the end of the

newly calculated selection;

e) turnon (if it hasn't already been turned on)
the Use Loop In Playback option under the
Options menu;

f)  begin looping and playing. The selection will
begin looped playback (if you have selected
Start Surfing);

or:
g) wait for you to start playback manually using
the Spacebar or the Toolbar if you wish to

begin Loop Surfing (if you have selected Make
Loop).

@ Loop Surfer is not available in Peak LE.

@ Loop Surfer is not available in Peak DV.

Using the Guess Tempo and
Threshold commands to find tempo

If you are working with music and don’t know the
tempo-and your music has a relatively pronounced or
obvious beat-you can use the Guess Tempo command to
have Peak automatically guess the tempo of a selection.
Make a selection and choose Guess Tempo from the
Action menu. There will be a pause while Peak scans
your selection and calculates the tempo for you. A dialog
will then appear showing you the estimated tempo in
BPM, or beats per minute. You can then enter the esti-
mated tempo in BPM in the Loop Surfer dialog’s Tempo
field or in the Audio Information dialog’s Tempo field, or
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click Loop-It to automatically place the guessed tempo
value into the Loop Surfer dialog.

You can also use the Threshold command (described
later in this chapter) to define a number of markers or
Regions based on amplitude peaks. If you then select
audio with start and end points that correspond to these
sections, you should have a selection that precisely
matches the musical beat. Using Loop Surfer, you could
then automate the process of looping the selection by
following the steps described directly above.

Guess Tempo works best with audio selections that con-
tain one full measure of audio with pronounced attacks
on the beats, which appear visually on the waveform as
taller sections of the audio. Using the Normalize feature
on the selection prior to Guess Tempo can improve the
accuracy of its deduction.

@ Guess Tempo is not available in Peak LE.

@ Guess Tempo is not available in Peak DV.

Using the Loop Tuner

Peak’s Loop Tuner provides a way to visually line up the
start and end points of your loop to get a smooth transi-
tion at the loop points. Loop Tuner also allows you listen
to the effects of these adjustments as you make them. If
you wish to “tune” a loop you've made, simply select

Loop Tuner from the DSP menu or Toolbar, and a dialog
will appear.

]
Saliat

[= " sy LR

The Loop Tuner dialog — showing a smooth transition between the
end of the loop and the beginning

The waveform display in the Loop Tuner dialog shows
the Start and End points of the loop, which you can visu-
ally adjust with the scroll bars at the bottom of the win-
dow. The two zoom buttons-magnifying glass icons-in
the upper left of the Loop Tuner dialog allow you to
adjust the vertical zoom up of the waveform. The two
zoom buttons in the lower left hand corner of the Loop
Tuner dialog allow you to adjust the zoom view in and
out all the way down to the sample level. You can listen
to the effects of the adjustments as you make them by
clicking on the Play button. To exit this dialog, click on
OK to accept the changes, or Cancel to leave the original
loop unaffected.

Loop Tuner is not available in Peak LE.

Loop Tuner is not available in Peak DV.

@
&
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Exporting Regions

If you have placed markers or Regions in an audio docu-
ment, Peak’s Export Regions command allows you to
export those regions from the source document and
save each of these regions as a separate audio document.
This feature is very convenient if you wish to divide a
larger file into regions and transfer them as samples into
a sample playback instrument, or divide a live concert
record into regions and export those regions as separate
files. Furthermore, you can use Peak’s Batch File
Processor to process a file’s regions with any of Peak’s
DSP functions and third party plug-ins during the auto-
matic exporting of regions into new files.
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The Export Regions dialog

To export regions from an audio document:

1. Select the regions that you wish to export. (You
can use the Tab key, Shift-Tab, or if you wish to
select the entire document, press 38-A.)

2. Choose Export Regions from the File menu.

3. In the Export Regions dialog, choose the parame-
ters that you wish to use for selecting the regions
to export.

4. Using the Region Detection options, choose which
regions are to be exported.

5. Using the Output Format options, choose the for-
mat and resolution you wish for the exported
regions.

6. Using the Output Directory options, choose the
destination for the exported regions.

7. If you wish the newly exported regions to appear
as new open Peak documents, choose Output to
new windows.

8. To save the exported regions to disk, select Save To
Disk and choose whether you would like to save
the regions into the same folder as the source files,
or to a different folder. If you prefer to save to a
new folder, use the Set Path button.

9. To export the regions, click Begin. Peak exports
each of the regions into its own audio document.

Region Detection area

To export all regions in an audio document, click the
Export Regions button. To export audio between adja-
cent markers, click the Export Audio between Markers
button. To export only regions that are bounded by spe-
cific marker names, click the Only Regions button and
enter the parameters that you wish to use to select the
desired regions. For instance, if you wish to only export
only regions bounded by markers with the word “hit” in
them, click the pop-up menu, choose containing, and
type the word “hit” in the field next to the pop-up.
Conversely, if you wish export all regions except those
with the word “hit” in them, click the pop-up menu,
choose not containing, and type the word “hit” in the
field next to the pop-up menu.

104

Peak User’s Guide



Output Format area

Choose the file format, bit depth resolution, and Stereo
or Mono from these pop-up menus for the resulting
exported audio documents. You can set the Sample rate
in kHz for the resulting files in the Rate field (please note
that this will not do sample rate conversions). You can
also designate whether the resulting audio documents
contain Regions or Markers or not.

Output Directory area

Resulting audio documents can either be output to new
open audio document windows or saved to the hard
drive. Choose Output to new windows if you want to
have the resulting audio documents open in Peak or
choose Save To Disk if you just want to write the new
audio files to disk without opening them in Peak. If you
Save To Disk, you can simply choose to use the original
audio document’s folder or you can specify another fold-
er on you hard drive(s) to save the resulting audio doc-
uments by choosing Set Path. The Name Prefix field
allows you to include a specified prefix to all the result-
ing audio documents. The default prefix is the name of
the file. Each and every one of the resulting audio docu-
ments will be named with the prefix plus the name of the
individual region.

Be aware that the Name Prefix plus the name of
the region being exported cannot exceed the max-
imum number of characters for a file name

allowed by the Mac OS or Peak will return an
error and the Region will not be saved.

Another exciting feature of the Export Regions function
is that you can Export Regions through Peak’s Batch File
Processor. First configure the Batch File Processor and

turn it on, then, go to Export Regions and check the Use
Batch File Processor checkbox. When you begin export-
ing regions, each region exported will be processed by
the DSP processes you choose in the Batch File
Processor dialog (see Chapter 7: DSP & Plug-Ins).

Do not save the output of the Batch File Processor
lo input directory (i.e., a folder that is or is inside
a folder of files that are being Batch Processed).

@ Export Regions is not available in Peak LE.

@ Export Regions is not available in Peak DV.

Editing QuickTime Soundtracks in
Peak

Peak allows you to edit QuickTime movie soundtracks.
While you cannot edit QuickTime video in Peak, you can
use Peak as a full-featured audio post-production tool for
QuickTime movies. This makes Peak an ideal tool for
editing and cleaning up soundtracks, as well as adding
sound effects or music to QuickTime movies.

How to open and edit QuickTime sound tracks in Peak:

1. Select Open from the Edit menu (38-0) or
Toolbar.

2. In the dialog that appears, locate the QuickTime
movie that you wish to open.

3. Click the Open button, and Peak will open the
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The Peak Movie Window

QuickTime movie in a movie window, and open
the movie’s audio track in an audio document win-
dow. Use the QuickTime Sound Tracks from the
Preferences menu to Enable or Disable the movie’s
other audio tracks. You can also use this dialog to
toggle multiple soundtracks contained in a movie
on and off to check balances or “solo” certain
tracks. Click on the Set button to accept the
changes, or Cancel to leave the movie unaffected.
To toggle the Movie Window on or off, choose
Movie from the Window menu. A check next to
this item indicates it is enabled.

CuickTime Audio Tracks
Q Seliect Tracks ta Enable/Dizahle...

(canceld ¢ Enable % { Desable ) Hl—*

The Movie Sound Tracks dialog

4. You may now edit the movie’s audio track as you
would any other audio document. The movie will
“scrub” along with the audio, and the placement of
the insertion point in the audio document window
will also scroll the movie to that point.

5. When you are finished editing the QuickTime
sound track, use Peak’s “Save As” command to save
the movie with its new sound track.

Be careful not to change the duration of the audio
1 using cut, delete, or insert, as this will cause the
audio and video to fall out of sync.

Peak can add audio to, or record audio into a QuickTime
movie that contains no audio.

To add audio to a silent QuickTime movie:

1. Open the audio document
2. Open the movie

3. Choose save as... and select QuickTime as the file
format

Recording audio into a silent QuickTime movie is
! covered in Chapter 4: Recording and Playback

QuickTime Movie support is not available in Peak
LE. Peak LE can open and edit QuickTime audio,
but it will not open the QuickTime Movie window.

Conclusion

You have now learned how to manipulate audio with
Peak’s various editing tools, including how to work with
Markers, Loops, and Regions. In the next chapter you
will learn more about the use of Regions in Playlists.
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Chapter 6: Playlists
and CD Burning

Introduction

This chapter explains how to use Peak’s Playlist feature
to sequence audio events. A Playlist is a list of Regions
strung together in a specific order. The Peak Playlist is
merely a set of instructions that tell the hard disk which
regions to “read” in what order. Playlist editing does not
permanently alter the original audio data on your hard
disk. No matter how many changes you make, your orig-
inal recordings remain intact. This type of nondestruc-
tive editing is one of Peak’s most significant and power-
ful features.

When you edit an audio file within Peak’s Playlist window
you are not really deleting, moving, replacing, and
adding actual audio as you would if you were cutting and
splicing analog tape. Instead, Peak is merely creating a
“map” of your audio file. This map, or “playlist,” simply
describes the order in which you want portions of the
recording to be played. If you'd like to hear the middle
of a song first, the end next and the beginning last, then
so be it. Peak will read (e.g., play) from the hard disk
(where the audio data is stored) from any number of
possible points designated by Region markers, and these
Regions can be auditioned in the Playlist in any number
of possible arrangements.

Playlist editing allows you to adjust and re-sequence seg-
ments of audio (e.g., Regions) with fluidity and ease.
Edits can be heard as soon as you perform them. In addi-
tion, Peak allows you to apply VST plug-ins to playlist
events, using the included “Vbox SE” VST plug-in routing

matrix. Peak’s Playlist offers a fast, flexible, and powerful
approach to editing and processing digital audio.

Peak burns Disk At Once (DAO) audio CDs from its
Playlist, or directly from an audio document window.
You can also use Peak’s Playlist to create a Jam Image file

1

for burning with Roxio’s Jam™ software (Jam is sold
separately). Please consult Roxio for compatible CD-
Burners using Jam. You can also bounce (i.e., write to
disk) your Peak Playlist as a Sound Designer II file and
then import the Playlist Events as Regions into other

third party software.

Regions

The audio events that are played back in a Playlist are
Regions-portions of an audio document defined using
the New Region command from the Action menu (38-
Shift-R) or Toolbar. A Region is defined by Region
Markers in the audio document window. All Regions
defined in open audio documents will appear in that
document’s file drawer, and will also appear in the
Contents Palette - a global listing of all regions in all files.

@ The file drawer is not available in Peak LE
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The file drawer is not available in Peak DV

The main windows you will use to organize Regions are
the audio document’s file drawer, the Contents Palette,
and the Playlist.

(&) Contents
Name ¥ Time
b All In My Mind.aif . 00:0...4.448
» Audio_l.aif 00:0...4.830
¥ Atmosphere.aif 00:0...0.175
Verse 4 00:0...3.657
Verse 10 00:0...2.970
Verse 9 00:0...2.145 A
Verse 8 00:0...1.010 v
w ‘:le E [ ] )

The Contents Palette

The Contents Palette is available under the Window
menu, and will show all of the regions in any open audio
documents at a glance. You can drag and drop Region
names from the Contents Palette into the Playlist. To dis-
play the regions in open documents, click the disclosure
triangle to the left of each audio document’s name in the
Contents Palette. A list of regions will appear beneath
the document’s name. If you drag and drop an Audio
Document’s name from the Contents Palette into the
Playlist, it will add all the Regions in that Audio
Document to the Playlist.

In a similar manner, each audio document’s file drawer
contains a list of regions contained in that document,
and these may also be dragged into a Playlist for arrang-
ing prior to burning an audio CD.

Name Time
w01 Move... Life.mp300:06:37.03¢

Begin 00:00:01.05¢
Verse 1 00:00:11.19:
1 00:00:14,57!
2 00:00:18.08°
Fix 00:00:25.02¢
3 00:00:40.43:
4 00:00:51.75¢
Verse 2 00:01:19.68(
Chorus 00:02:23.69!
Verse 5 00:02:39.80.
5 00:02:39.80:

Breakdown End 00:03:19.87:
Breakdown Start 00:03:05.20:

illet]

X: 00:01:18.544 [L]
Y: -00994
Sel: 00:00:14.057

BPM: 17.07

The Contents Drawer

Regions can only be saved in AIFF, Sound Designer I,
and JAM Image file formats created by Peak. However,
Peak will also read Regions stored from other programs
in Sound Designer II files. The method Peak uses to
store Regions in AIFF files is specific to Peak and is not
supported by other software applications. If you are
planning to use Regions created with Peak in other pro-
grams, you will usually want to save your files in Sound
Designer 1I file format.

To define a new Region:

1. Make a selection in an opened audio document.

2. Choose New Region from the Action menu or
Toolbar (38-Shift-R). The Edit Regions dialog will
appear.

3. Type the name of the Region and click OK. The
new Region will appear in the audio document.

110

Peak User’s Guide



To define a new Region and have it automatically placed
into a Playlist:

1.

Select Playlist Document from the New submenu
under the File menu (38-Shift-P). An empty playlist
document will appear.

Make a selection in an opened audio document.

Choose Capture Region to Playlist from the Action
menu (38-K)

To modify the length of the Region by changing the start
or end:

Drag the start or end marker of the Region in the
audio document window.

Double-click the triangular base of one of the
Region markers and type in a new start time, end
time, or duration, and click OK.

To move the start and end points of the region together:

Option-drag on the start or end marker of the
Region.

Or; click on the Horizontal Lock button in the
audio document window, and drag the Region to
the desired position.

Be sure to turn off Horizontal Lock when you are
Sfinished, by clicking the button again - when this
feature is turned on, the Horizontal Lock bution
lights up in blue

To change the name of a Region:

1.

Double-click on either the start or end marker of

the Region in the audio document window, or
Option-double-click on the Region name in the
Contents Palette or file drawer.

Edit Region
Name: | Breakdown
Units: | Min:Sec:ms uﬁ
Start: | 00:00:29.593 End: |00:00:37.485
= M Adi
Length:  00:00:07.892 (#) Adiusts End

. Adjusts Start

P, e »
Cancel Delete

The Edit Region dialog

2.

The Edit Region dialog will appear.

Type the new name of the Region into the dialog
and click OK.

To move a Region without changing its length:

Hold down the Option key and drag either the
start or end marker of the Region.

Or; click on the Horizontal Lock button in the
audio document window, and drag the Region to
the desired position.

To edit a Region’s start, end, or length manually:

1.

Double-click on either the start or end marker of
the Region in the audio document window or
Option-double-click on the Region name in the
Contents Palette or file drawer. The Edit Region
dialog will appear.

Enter new values for Start, End, or Length times,
then click OK.

To locate a Region:

Double-click the Region you wish to locate in the
Contents Palette or file drawer. The audio docu-
ment will scroll automatically to display the region
and the Region will become the current selection
in the audio document.
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Creating a Playlist

To create a new Playlist:

*  Select Playlist Document from the New submenu
under the File menu (38-Shift-P). An empty playlist
document will appear. The top of the playlist has
category titles for each column of information. The
bottom of the playlist shows total duration of the
playlist.

Start Time VST

Playlist Event Time Display

Gap Time

Untitled!Playlist

Narpe in Sec .ap S1art Out

o Cain
Lo Intr B ooo0 ooooooo ooooooo B o000 +0.0dE
261 0.000 00:02.000 oo:10.140 [ 0000 +0.3d8
30 2 0.000 00:01.000 00:15.520 u 0.000 +0.0dE |
4. (e 3 0.000 00:00.000 00:20.032 [ o000 -2.0d8
5. {+ Charus 0.000 +0.0dB

3
0.000 00:00.000 01:21.626 -
0.000 00:00.000 02:25.640 .
0.000 00:00.000 02:41.746 T

2:41.747

8. [+ Chorus
4, {+ Alrernate 2

104 Outro
L Program Duysdtion

Crossfade In (Shape) /

]
]
]
B o000 0000000 oozesro [l
]
]

/
Crossfade Out (Shape) Gain

Crossfade In (Duration) Crossfade Out (Duration)

The Playlist Document window

To add an item to the playlist:

1. Make sure the Playlist is the front-most document
in Peak (38-P). Select the Contents Palette from
the Window menu if it is not already open.

2. Dragand drop the names of the Regions from the
Contents Palette or file drawer into the Playlist to
add Regions to the Playlist. Each Region you add to
the Playlist becomes a Playlist Event. The center of
the Playlist window shows Playlist Events as a
sequential list. You may use Regions from multiple
audio documents. Any audio documents contain-
ing Regions used in the current Playlist must be
open in Peak to be available to the Playlist.

To automatically add regions to a playlist:

1. Select the desired area in an audio document’s
waveform.

2. Choose Capture Region to Playlist from the Action
menu (38-K)

3. The selected range is automatically turned into a
Region, and is added to the current Playlist.

All audio documents referenced by the Playlist
! must have the same sample rate, number of chan-
nels (i.e., mono or stereo), and bit-depth.

The controls along the top of the Playlist window give
you access to most of the Playlist functions.

In the top left, you will find buttons to control Crossfade
Select, Delete, Burn CD, Nudge Regions (Crossfade
Editor), and Bounce Playlist. In the top middle of the
Playlist window is a Region/track number & time display.
Burn Audio CD

Default Crossfade Type Bounce Playlist

) s.ﬁr_J

Delete Playlist Event Nudge Regions (Crossfade Editor)

Playlist function buttons

At the top right of the Playlist are transport controls that
allow you to audition Regions. From left to right, these
controls are for previous track, stop, play, and next track.
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Previous Track Stop Play Next Track
\ !
“imjirim

Playlist transport controls

A playlist event has several properties that can be modi-
fied: crossfade in, gap time, crossfade out, gain, and VST
plug-ins. Since the transitions between one audio event
to another can be abrupt, a playlist crossfade can be used
to smooth the transition from one audio event to anoth-
er.

Crossfades between Playlist Events fade out the first
region while fading in the next region. Each Playlist
Event has separate controls for crossfade in, crossfade
out, crossfade-in time, and crossfade-out time. The curve
stored in crossfade in is used to fade in the current
region. The curve stored in crossfade out is used to fade
out into the next region.

Crossfades are stored on disk and are computed before
playback. When a crossfade is being calculated, the
watch cursor may appear.

Next Region’s Crossfade In

N

End of first region, beginning
of second region, and exact
mid-point of crossfade

First Region

First Region’s Crossfade Out

Crossfade Diagram

The illustration above shows how crossfades are used in
playlist events. The audio material from each region

overlaps beyond the region boundaries. Overlapping
areas are darker in the illustration above. The white diag-
onal lines correspond the crossfade in and out curves. As
the first region ends, the next region’s audio material
begins to fade in. When the next region begins playing,
the first region continues to fade out.

It is very important to understand that the Region
marker in the referenced Audio Document is the
exact midpoint of the fade. Consequently, there
must be sufficient audio data on either side of the
Region marker. That is, if you have a 60 second

crossfade between two Playlist Events, there must
be at least 30 seconds of audio data following the
end Region marker of the first Playlist Event and
at least 30 seconds of audio data proceeding the
begin Region marker of the second Playlist Event.

Using the separate crossfade in and crossfade out curves,
Peak provides you with the flexibility to create many
common crossfade types. These include “Linear
Crossfade,” “Equal Power Crossfade,” “Slow in but fast
out Crossfade,” “Fast in but slow out crossfade,” and
“Overlap transition.” Peak is also flexible in allowing you
to control crossfade in and crossfade out durations sep-
arately. All crossfades are based on overlapping audio
from the previous or subsequent regions and then mix-
ing the overlapping material after applying the crossfade
curves.

A linear crossfade actually sounds like an equal power
crossfade (i.e., no loss of energy in the audio signal),
since Peak playlist crossfades are calculated logarithmi-
cally.

A Playlist event’s gain setting can be used to control the
balance of the event in a Playlist. You may need to raise
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the volume or lower the volume of some Playlist events
to maintain a proper balance of volume levels. You can
make adjustments to the gain of individual Playlist
Events as you play back the Playlist.

Be careful not to set a Playlist event’s gain too high
as you may overload the signal and cause clip-
ping to occur. You may also introduce clicks

between Playlist events if the difference in gain
between the two playlist events is too large.
Crossfades can help smooth these transitions.

To select items in the Playlist:

*  (Click on the item in the Playlist that you wish to
select. You may use the Shift key to select several
items in the Playlist.

To hear the playlist:

* To hear your playlist, use the Play button in the
Playlist window. The Playlist will begin playback
from the current selected playlist event.

To preview transitions between Regions:

1. Select the playlist event in which you wish to hear
the transition.

2. Use the Playlist’s Play button or press the Spacebar
while holding down the Command key (38). The
pre-roll setting from the Auditioning dialog in the
Preferences dialog will be used to audition from
the end of the previous playlist event through the
transition into the selected playlist event.

To scrub in the Playlist window:

*  While playing audio in a Playlist, hold down the
control key and press the forward or reverse but-

tons in the playlist. The audio will advance “CD-
style” in larger increments. Release the mouse
when you find the spot you wish to hear. This is
useful for moving around quickly in the Playlist’s
audio to test gain levels and VST effects for poten-
tial clipping. You can also click and drag right or
left in the Playlist Window's Time Display.

To select next or previous Playlist event:

*  With the Playlist as the front-most window (38-P),
you can use the arrow keys (up and down arrows)
to select the next or previous playlist event. While
playing audio in a Playlist, you can use the arrow
keys to move playback to the next or previous
event in the Playlist during playback. Note that the
arrow keys don’t work with the control key to
scrub during playback. You can also use the Tab
key to select the next Playlist event, even during
playback.

Modifying Playlist Events

To move items in the playlist:

*  Click and drag the Playlist event to the new loca-
tion. A green line will indicate the new position for
the playlist event. Release the mouse button when
the green line is at the location you wish to place
the event.

To delete items in the Playlist:

1. Select the Playlist event you wish to delete by click-
ing on it.

2. Press the Delete key on your keyboard, or click on
the Trash Can icon in the Playlist window. The
event will be removed from the playlist, and the
audio events below the event will move up. This
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operation will, of course, decrease the length of
the Playlist.

To edit a crossfade in or out:

*  Double-click on the Playlist event’s Crossfade In or
Crossfade Out icon. The Fade Envelope Editor dia-
log will appear, where you may edit the Fade
Envelope for that particular Playlist Event’s Fade In
or Fade Out.

Region Crossfade Out

Current Envelope )

(1323000000 sec, =100.000000% )

“<—=> ) (Reset ) (Cancel) Changed

Fade Envelope Editor

To change Crossfade In or Out duration:

*  Double-click on the Playlist event Crossfade In
time or Crossfade Out time. A dialog will prompt
you to enter the duration in seconds for the
Playlist Event’s Crossfade In or Out.

The default setting for crossfade duration in Peak
s Playlists is 0.

Crossfades are not available in Peak LE Playlists.

@ Crossfades are not available in Peak DV Playlists.

To modify the gap time:

*  Double-click on the Playlist event Gap Time (i.c.,
the time between the beginning of one Playlist
Event and the end of the previous one). A dialog
will prompt you to enter the desired Gap Time for
the selected Playlist Event.

The Nudge Regions Dialog

The Nudge Regions function opens a crossfade editor
window, and is useful for fine-tuning the start and end
times of Regions in the Playlist as well as adjusting the
crossfade times. Access the Nudge Regions dialog by
clicking on the Nudge Regions icon in the Playlist win-
dow. In this dialog you can dynamically adjust start and
end times of selected regions by scrolling in the win-
dows, and listen to the changes as you make them by
clicking on the Play button.

Nudge Regions
Qut Nudge: .l »

1.00000 sec. Post-rall

& Pre-roll 100000 sec.

Min:Sec:...
Eocn

Nudge amount:  00:00:00.014

™ Preserve timing “Cancel Play

The Nudge Regions Dialog
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You can set the Pre-roll and Post-roll in seconds for audi-
tioning the crossfade. If the Preserve Timing checkbox is
checked, the duration between the Region markers will
remain fixed. If the Preserve Timing checkbox is not
checked, the Region markers can be moved independ-
ently of one another. The Zoom tools at the left of the
window allow you to zoom in to the sample level, or out
for a larger view. You can also allocate region Pre-roll and
post-roll times in this dialog. By clicking and dragging in
the window, you can adjust the fade times for the Fade
Out (on top) and the Fade In (on the bottom).

@ Nudge Regions is not available in Peak LE
@ Nudge Regions is not available in Peak DV

Applying VST Plug-Ins to the
Playlist

Peak will let you use VST plug-ins on any Playlist event in
real-time. For more information on using VST plug-ins
with Peak, see Chapter 8: Plug-Ins.

To apply VST effects to a Playlist Event:

1. Bring the playlist to the foreground by selecting
Playlist from the Windows menu (3€-P).

2. Choose Insert 1 from the Plug-Ins menu and
choose the Vbox SE plug-in routing interface, and
then choose a plug-in within Vbox SE.

3. Configure the desired VST plug-in (or multiple
plug-ins) within Vbox SE.

VST plug-in snapshots are only available when

using plug-ins within the Vbox SE interface

Gain  Vbox
)} +0.0dB m

v
el
—

) +0.0dB |3,

Playlist VST Plug-Ins pop-up menu

Use the Playlist VST Plug-Ins pop-up menu to take a
“snapshot” of the current VST plug-in configuration for a
particular Playlist Event. A snapshot is the current set-
tings of a plug-in (or the arrangement of multiple plug-
ins within the Vbox SE matrix).

When using plug-ins loaded into Vbox SE note that
clicking may occur between Playlist Events if VST
plug-ins are loaded or unloaded when changing
[from one snapshot to the next. This is because
Vbox SE bypasses the audio stream when making
plug-ins active or inactive. Therefore, it is recom-

1 mended that if you want to use different VST plug-
in configurations for each Playlist Event, config-
ure Vbox SE with all the plug-ins you want to use
Jfor all Playlist Events, and then create snapshots
Jfor each Playlist Event with the plug-ins that you
don't want to use on that Playlist Event muted or
bypassed. (For more information on using Vbox
SE, please refer to Chapter 8: Plug-Ins)
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To take a “snapshot” of the current VST plug-in settings:

*  Select Set from the Playlist VST Plug-Ins pop-up
menu for an individual Playlist event to take a snap-
shot and assign it to this playlist event.

[=]>[»]

Gain _ Vbm——=+=
3 +0.0d8 |
= Make Active
} +0.0dB 3
2 Clear
3 +0.0d8 [3

Playlist VST Plug-Ins submenu, showing the Set command

To make a Playlist Event’s “snapshot” active:

*  Select Make Active from the Playlist VST Plug-Ins
pop-up menu to activate the snapshot for the spe-
cific Playlist event in Vbox.

[=]>[»]

Gain_ wk— 4
) +0.0d8 %t

f  Make Active |,
3 +0.0dB L lear
T +00dR

Playlist VST Plug-Ins submenu, showing the Make Active command

To clear a “snapshot” for a specific Playlist Event:

*  Select Clear from the Playlist VST Plug-Ins pop-up
menu to remove the snapshot from this playlist
event.

Set
Make Active

SNPS  Clear [ |
) +0.0dB |

Playlist VST Plug-Ins submenu, showing the Set command

To set, make active, or clear a “snapshot” for all Playlist
Events:

*  With the Playlist in the foreground, select all
Playlist events (88-A), then Shift-click on any VST
Plug-Ins pop-up menu in the playlist to select Set,
Make Active, or Clear for all Playlist events.

The Playlist will playback with any active VST plug-in
snapshots. To write a new audio file to disk from the
Playlist with VST plug-ins applied, “bounce” the playlist.

@ VST plug-ins are not available in Peak LE Playlists.
@ VST plug-ins are not available in Peak DV Playlists.

Creating a New Audio Document
from a Playlist

After you have finished working on a Playlist, you may
wish to “bounce” the Playlist (i.e., write to disk) as a new
audio document, including all the Playlist’s VST effects
and crossfades. In other words, the new audio document
will be the equivalent of digitally recording the output of
the playlist. Additionally, Peak automatically places mark-
ers or regions into the new document that correspond
to each Playlist event boundary with names that match
the name of the source region.

To create a new Audio Document from the playlist:

1. Shift-click to select the playlist events you wish to
bounce to a new audio document, or use the
Select All command from the Edit menu (38-A).
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2.

Choose New Document from Playlist under the
File menu’s New submenu (Shift-38-B), or click
the Bounce Playlist button in the Playlist window.
The following dialog will appear:

Bounce Playlist...

File Format: | o AIFF

SDil
JAM Image File

Playlist events

® Region:
_ Markers
__ Nothing
“Cancel ( Bounce )

The Bounce dialog

3.

4.

In the resulting dialog, select whether you want to
bounce the playlist to a new AIFF file, a new Sound
Designer II file, or a JAM Image file. Use the radio
buttons to select whether you want Playlist Events
to appear in the new document defined by
Regions, Markers, or Nothing.

Anew audio document, with VST effects and cross-
fades will be generated from the selected playlist
events. Peak automatically places markers into the
audio document that correspond to each playlist
event boundary. The markers have names that
match the name of the source Region. For full
compatibility with Roxio’s JAM, choose “Regions.”

Exporting the Playlist as a Text
Document

If you wish to keep a text record of your playlist, you may

export the playlist into a new text document. The text

document will show the playlist events, times, crossfade

times, and gain levels.

To export a playlist as text:

1.

Open the playlist document you wish to save as a
text file.

Choose Export as Text from the File menu. The
Save dialog appears.

Enter a name to save the playlist under and a loca-
tion to store the file, and click Save.

Saving and Opening Playlists

To save a playlist:

Choose Save from the File menu. If the playlist has
not yet been saved, it will prompt you to save it
and name it when you close the Playlist.

Alternatively, you can save a copy of the playlist
with the Save As command.

To open a playlist:

Choose Open from the File menu. Select the
playlist you wish to open with the Open File dia-
log. Peak will automatically open any audio docu-
ments that the playlist refers to. If the audio docu-
ments that the playlist refers to are deleted, you
will be unable to use the playlist document. If Peak
is unable to locate the audio document containing
a referenced Region, you will be prompted to
locate it.
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Ifyou remove the regions used in a playlist, you
may not be able to use the playlist that refers to
those regions. If you delete a file that a playlist
refers to, you also will not be able to use the
Dplaylist.

Burning Audio CDs

Peak allows you to burn audio CDs either directly from
an audio document, or from a list of regions compiled in
a Playlist. When regions are present in an audio docu-
ment, they can be defined as individual tracks on the fin-
ished CD. Burning from a Playlist creates one CD track
for each item in a Playlist. You can also use Peak Playlists
to create a Jam Image file to create audio CDs using
Roxio Jam (Jam is sold separately). If you want to do PQ
subcodes, ISRC codes, and other more specific tasks in
producing a CD master, you should use Jam. Most CD
burners are supported, but check with Roxio for any spe-
cific questions regarding compatible CD Burners.

Peak is bundled with Roxio Toast lite, which can
also be used for audio CD burning. To burn
audio CDs with Toast lite, simply open Toast

lite, drag the desired audio documents into the
Tast lite window, and click the Record button.
Toast lite is also very useful for file backups,
archiving etc.

Burning from an Audio Document

To burn an audio CD from a Peak Audio Document:
1. Open the desired audio document.
2. Create regions if desired.

3. From the File menu, choose Burn Audio CD (or
click the Burn Audio CD button in the Toolbar).

If regions are present when burning from an
audio document window, Peak will prompt you
as to whether regions should create CD track

boundaries. If you want each region to become a
discrete CD track, select Yes. If you simply want to
burn the audio document as a single CD track,
select No.

4. The Burn Audio CD dialog appears - here you can
select which burner to use (if you have more than
one burner connected to your Macintosh), burn
speed, and whether POWr dithering and CD verifi-
cation should be used. When you have selected
the desired options, click Burn.

5. Peak will prompt you to insert blank media into
your burner (if none is present) - click OK to burn
your CD.

Burning from Peak’s Playlist

To burn an Audio CD directly from Peak’s Playlist, select
the Playlist Events you want to burn as Tracks to CD, or
simply select All from the Edit menu (38-A) if you want
all of the Playlist Events to appear as tracks on the audio
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CD. Then, click the Burn Audio CD button at the top of
the Playlist window and Peak will burn an audio CD. A
Peak Playlist is a “blueprint” of a finished audio CD.
Before burning, you can preview a Playlist as if it were an
audio CD. Be sure that gap times between tracks, gain
changes, effects, and crossfades are exactly as you like
them. To preview items in the Playlist, you can use the
Playlist’s transport controls at the top right of the Playlist
window. The Playlist’s transport controls function much
like those on a CD player.

To burn an audio CD from a Peak Playlist:

1. Create a Playlist with the tracks as you want them
to appear on the CD.

2. In Peak, click on the Burn Audio CD button in the
Playlist window.

3. The Burn Audio CD dialog appears - here you can
select which burner to use (if you have more than
one burner connected to your Macintosh), burn
speed, and whether POWr dithering and CD verifi-
cation should be used. When you have selected
the desired options, click Burn.

4. A dialog appears instructing you to insert a blank
CD into your CD Burner and click OK.

5. Peak will burn your Peak Playlist as an audio CD.

Regions and the JAM Image file for-
mat

A Jam Image file represents an entire CD to the CD-writ-
ing software Jam from Roxio. When you create a Jam
image with Peak, Jam will interpret the Regions created
in Peak as CD tracks. Any audio between one region’s
end and the next region’s start will be interpreted as gap

times. Finally, any markers you create in a Jam image file
will become indexes in Jam.

You can assign Peak as the external waveform editor for
Jam in Jam’s preferences. You can also open Jam Image
files created by Peak back into Peak for further editing as
needed. By using these features, assembling and editing
a CD in Peak prior to burning with Jam is both easy and
versatile.

To burn an audio CD from a Jam Image File:

1. Create a Peak Playlist with each track as you want
them to appear on the CD.

2. Use the Select All command from the Edit menu
(38-A) or Toolbar.

3. Choose New Document from Playlist under the
File menu’s New submenu, or click the Bounce
Playlist button in the Playlist window. The Bounce
Playlist dialog will appear.

4. In the pop-up at the top of the Bounce Playlist dia-
log, select Jam Image. Use the radio buttons to
select Playlist events to appear in the new docu-
ment as Regions.

5. A new audio document, with VST effects and cross-
fades will be generated from the selected playlist
events. Peak automatically places regions into the
audio document that correspond to each playlist
event boundary. The regions have names that
match the name of the source Region.

6. Close the new audio document (a Jam Image file
format) and open it with Jam to burn a red-book
format, Disk-at-Once, audio CD.

1 Rowio JAM is not included with Peak
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Conclusion

You have now learned about creating Regions and
Playlists, as well as how to create new mixes, splice
together multiple takes, bounce Playlists as new audio
documents, and how to create audio CDs. In the next
chapter, you will learn about the native DSP (digital sig-
nal processing) functions in Peak.
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Chapter 7: DSP

Introduction

Peak allows you to transform your audio with a variety of
powerful Digital Signal Processing (DSP) tools. You can
apply these tools at any time by first making a selection
in an audio document and then choosing the desired
menu command from the DSP menu.

Processing Audio with Peak’s
DSP Tools

The following general procedure describes how to
process a selection in an audio document, or the entire
document, with a particular DSP function. The specific
capabilities and parameters of the DSP function will vary.

To process audio with a DSP function:

1. Select the portion of the audio that you wish to
process with the DSP function. If no selection is
made, the entire document will be processed.

2. Select the type of process you wish to use from the
DSP menu.

3. A dialog appears allowing you to set the parame-
ters for the DSP function.

4. Set the parameters for the DSP function as desired
and click OK. Peak processes the selection with the
DSP function or plug-in.

Note that if no selection is made, Peak will apply
2 processing to the entire audio document.

Peak’s Audio Processing Tools

Peak’s DSP capabilities provide composers and profes-
sional sound designers with many interesting audio
effects and processing tools. Peak’s DSP functions
include Add, Bit Usage, Change Duration, Change Gain,
Change Pitch, Convert Sample Rate, Convolve, Crossfade
Loop, Invert, Fade In, Fade Out, Find Peak, Gain
Envelope, Harmonic Rotate, ImpulseVerb™ Loop Tuner,
Mono to Stereo, Stereo To Mono, Mix, Modulate,
Normalize, Panner, Phase Vocoder, Rappify™, Repair
Click, Repair Clicks, Remove DC Offset, Reverse

Boomerang ™, Reverse, Swap Channels, and Threshold.
The following sections explain how to use each of these
functions.

Add

The Add command adds any selection of audio copied to
the clipboard into the audio document at the selection
point. To use the Add command, you must first copy a
selection of audio. The copied material can then be
mixed into the target audio material. The Add command
can also be customized using an envelope. If you wish
to Add material with a variable level, click the envelope
button in the Add dialog.
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To use the Add command:

1. Select the audio that you wish to Add to another
audio document and choose Copy from the Edit
menu (38-C) or Toolbar.

2. Select the audio that you wish to mix the copied
material into.

3. Choose Add from the DSP menu or Toolbar.

4. In the dialog that appears, use the slider to adjust
the amount of the copied signal that you wish to
add into the target audio document. To add copied
material with a variable level, click the envelope

r Al

Add
Amount of clipboard to add in:

T 82 %

Description

The add operation adds the clipboard I
samples into the audio document at the |
selection point. Choose the level of the |
clipboard samples you wish to add into

the audio document. ‘

(cancel) ( Envelope... ) @W@l@”@

The Add dialog

button, create the desired envelope, and then click
the Change button, and then click the Add button.
Be careful not to adjust too high an amount which
can potentially clip the signal.

5. Click OK. Peak mixes the two signals together.

6. o hear the results, press the Spacebar.

Add is not available in Peak LE.

Add is not available in Peak DV.

Amplitude Fit

Amplitude Fit provides granular normalization of an
audio selection on a grain-by-grain basis. Grains are small
groups of samples, often around 30ms. As each grain is
read in, it is normalized according to the Amplitude Fit
Envelope-each normalized grain crossfaded with the
previous grain and written out as the result. Amplitude
Fit can be used to maximize the volume level of an audio
selection, or to make quiet passages as loud as louder
passages.

Amplitude Fit Envelope

(36,7400 seq, -100 000000% )

Load..) {save..) ( <——> ) ( Reset ) {Cancel ) {Change

The Amplitude Fit Envelope editor

To apply the Amplitude Envelope to an audio selection:

1. Select the audio material you wish to process.
2. Choose Amplitude Envelope from the DSP menu.

3. Draw the amplitude envelope you wish to apply to
the audio selection in the envelope editor. Points
above and below the 0% line will normalize the
selected audio using the grain-by-grain normaliza-
tion technique.

Amplitude Fit is not available in Peak LE.
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Amplitude Fit is not available in Peak DV.

Bit Usage is not available in Peak DV.

Bit Usage

The Bit Usage meter allows you to monitor bit satura-
tion, degradation, and the “true” bit depth of a file.

Bit Usage

The Bit Usage meter

To use the Bit Usage meter:

=

1. Se
examine.

ect the desired range of audio you wish to

2. Choose Bit Usage from the DSP menu - The bit
usage meter will appear, and plot a graph showing
the status of bit usage in the selected area of audio.

Bit Usage is not available in Peak LE.

Change Duration

The Change Duration command allows you to slow
down or speed up the selected material by a specified
amount without changing its pitch. You can specify the
change in duration by a value in seconds, a percentage of
the original, or, for rhythmically-oriented material, beats
per minute. A change in duration by a reasonable
amount, about 85% to 115%, can be very convincing.
Exaggerated time stretching, 200% or more, can resultin
some very interesting granular textures. Try experiment-
ing with the Change Duration function on drums,
rhythm loops, speech, sampled instruments or sound
effects to achieve a wide variety of useful effects.

Change Duration

100 percent of original length

@ BEF40SH seconds
~
St
&
O

New Tempo: 1200000 bpm
1 bars o beats
Old Tempo:  120.0000 | bpm
1 bars o beats
) Advanced...
(Cancef? € prefs...) m

The Change Duration dialog
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To change the duration of a selection:

1. Select the portion of the audio that you wish to
process.

2. Choose Change Duration from DSP menu. The
Change Duration dialog appears.

3. Click the radio button for one of the following
fields, and enter the value that you wish for the
change in duration:

* In the Seconds field, type the new
duration in seconds.

* In the Percentage field, type the per
centage you wish to slow down or
speed up the selected audio. For
example, typing “50%” will speed up
the selection to half its original dura-
tion, typing “200%” will slow down the
selection to twice its original duration.

* In the Beats per minute field, type the
old tempo for the selected audio and
then the desired new tempo, and Peak
will compute the correct new dura-
tion. Use this field to change the dura-
tion of rhythmically-oriented material.

*  Or, click the Advanced button bring up a stan-
dard Peak envelope editor window. In
Advanced Change Duration mode, you can

DSP Preferences

Sample Rate Conversion Quality:

10 ‘3!

(lower is faster, higher is better quality)

Time Shifting Window Size:

10 15 20 25 30 35 40 ms

SO s

(lower is better for simpler monophonic sounds, higher
is better for more complex pofyphonic sounds)

o

The DSP Preferences dialog

apply dynamic duration change, which speeds up
or slows down audio playback dynamically, accord-
ing to the envelope you create.

4. If you wish to adjust the quality of the pitch
change, click on the Prefs button. The DSP
Preferences dialog will appear, allowing you to
choose the size of the Time Shifting Window that
will be used in processing. A lower value is best for
simpler, monophonic sounds, while a higher value
yields the best results for more complex,
polyrhythmic sounds. One you have set these pref-
erences to your liking, click OK to exit the DSP
Preferences dialog.

5. Click OK when you have finished. Peak changes
the duration of the selection according to the set-
tings that you chose.

Change Duration is not available in Peak LE.

Change Gain

The Change Gain function changes the gain (i.e., ampli-

tude) of a selection. You can specify the amount of gain
change either in decibels (dB) or as a percentage.

Change Gain
Enter a scaling factor for the change gain:
—— gy | BEEE " dB m

S
TR et WO B ERS R A

Description

Change Gain changes the volume of the audio
document's selection. Choose the amount you wish to
change the gain by using the slider or text box above.
To avoid clipping the samples, click on the Clipguard
checkbox below.

"] Clipguard Cancel )

The Change Gain dialog
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If you wish to double the volume of a sound, you must
apply approximately 6 dB of gain change, or add 200%.
Enable the Clipguard checkbox in the Change Gain dia-
log to protect against the possibility of clipping.
Clipguard will search through the audio document or
selection for the maximum peak in amplitude, and then
limit the Change Gain slider’s range based on the maxi-
mum peak it finds in the audio document or selection.

To change the gain of a selection:

1. Select the portion of the audio that you wish to
process.

2. Choose the Change Gain command from the DSP
menu or from the Toolbar. The Change Gain dialog
appears.

3. Enter the number of decibels or percentage by
which you wish to change the amplitude of the
selection by.

4. Ifyou wish to protect against the possibility of clip-
ping, enable Clipguard by checking the Clipguard
checkbox.

5. Click OK when you have finished. Peak will change
the gain of the signal by the amount you specified.

Change Pitch

Peak’s Change Pitch function allows you to alter the
pitch of an audio selection by as much as an octave. The
Change Pitch dialog uses a pitch slider that allows you to
choose a new pitch by musical interval, and “fine tune”
the pitch change by smaller increments called “cents.”
(Cents are divisions of a musical octave-one octave is
equivalent to 1200 cents-thus, 100 cents is a semi-tone,
50 cents a quarter-tone, etc.) You can also choose to alter
the length, or duration, of the selection just as you

would by slowing down or speeding up analog tape, or
you can choose to preserve the duration of the selection
(something not possible with analog tape!). You can
even preview the pitch change by clicking on the Play
button at the bottom of the Change Pitch dialog.

To change the pitch of an audio selection:

1. Select the portion of the audio that you wish to
process.

2. Choose Change Pitch from the DSP menu or from
the Toolbar. The Change Pitch dialog appears.

3. Select the interval of transposition up or down by
entering a positive or negative value in cents in the
“Change Pitch” field or by using the pitch slider.
Fine tune the interval of transposition by entering
a positive or negative value in cents in the “Fine
Tune by” field or by using the Fine Tune slider. If
you wish to audition the transposition, click on the
Play button to preview the results of the pitch
change in real time. Check on the Preserve
Duration checkbox to retain the original duration
of the selected audio

Change Pitch
Interval:

8va M7 M6 PS5 P4 M3 M2 0O M2 M3P4 PS5 ME M7 +Bva
T 1

R

Change Pitch by 200

Fine Tune:
100 75 -50 25 0 25 S0 75 100 Cents

Fine Tune by BT Cents

@ Preserve Duration

( Prefs... _\ e-"‘ﬂﬂ ; 3

/ 3
{ Cancel

The Change Pitch dialog

4. If you wish to adjust the quality of the pitch
change, click on the Prefs button. The DSP
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Preferences dialog will appear, allowing you to
choose the size of the Time Shifting Window that
will be used in processing. A lower value is best for
simpler, monophonic sounds, while a higher value
yields the best results for more complex,
polyrhythmic sounds. One you have set these pref-
erences to your liking, click OK to exit the DSP
Preferences dialog.

5. Click OK when you have finished. Peak transposes
the pitch of the selected audio up or down by the
amount you specified.

Change Pitch is not available in Peak LE.

Change Pitch is not available in Peak LE.

©
&

Convert Sample Rate

The Convert Sample Rate command allows you to
change the sample rate of a sound without changing its
pitch. This feature is very useful for converting audio
material into lower or higher sample rates as required by
other applications. Please note that sample rate conver-
sion is applied to an entire document. It cannot be
applied to just a selection within a document. Refer to
Chapters 3 and 4 for an explanation of commonly used
sample rates.

To change the sample rate of a document:

1. Choose Convert Sample Rate from the DSP menu
or Toolbar. The Convert Sample Rate dialog

appears.

2. Type in the sample rate that you wish to convert
the audio document to, or click the down arrow to
select from a pop-up of commonly used sample
rates.

3. Click OK. Peak converts the entire audio docu-
ment to the selected sample rate.

Convert Sample Rate

Enter the new sample rate:
(=] #e

Convert sample rate changes the sample |
rate of the sound without changing the pitch |
or length. Enter the new sample rate for this |
audio document.

Description

o)

P oy
{_Cancel )

The Convert Sample Rate dialog

The Macintosh’s built-in audio bardware is typi-
cally limited to sample rates from 11 kHz to 64
kHz, and support will vary depending on the

! model of Macintosh. Higher sample rates are pos-
sible with CoreAudio depending on the particular
audio bardware device and its CoreAudio driv-
ers.

Convolve

The Convolve command is a unique and powerful sound
design tool that allows you to apply the sonic (i.e., spec-
tral) characteristics of one sound onto another.
Convolution works by multiplying the frequency spec-
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trum of the impulse contained in the clipboard and that
of the target audio document, reinforcing the frequen-
cies that are in common between the two. The results
are always interesting and often quite unlike anything
you've heard before. This is especially true when the
character of the two sounds are very different, and when
the clipboard impulse is harmonically rich (imagine, for
example, convolving a rainfall sample with piano tin-
kling!). To use the Convolve DSP command, you must
first copy a selection of audio. The copied material will
provide the spectral “character” that you will apply to
the target audio material. Convolution can be very useful
not only for creating new and unusual sound, but also
for giving an audio selection a sense of space-try copying
a small amount of room noise to the clipboard and then
Convolve it with a selection of audio and the convolved
audio will sound like is being played in that room.

Because the clipboard contents that provide the
spectrum for this process must be beld in RAM,
small clipboard impulses should be used, unless a

large amount of RAM is available. This process
can use a lot of RAM!

To use Convolve:

1. Select the audio with the characteristics you wish
to apply and choose Copy (38-C) from the Edit
menu or Toolbar.

2. Select the audio that you wish to modify with the
copied audio impulse.

3. Choose Convolve from the DSP menu. Peak
applies the spectral character of the copied mate-
rial to the selection.

4. To hear the results, press the Spacebar.

Convolve is not available in Peak LE.

Convolve is not available in Peak DV.

©
&

Crossfade Loop

The Crossfade Loop function applies a “smoothing”
effect to loops made in Peak audio documents.
Crossfade Loop fades the end of the loop into the begin-
ning of the loop to make the loop sound smoother. (It
uses the Blending envelope you've set in Peak’s
Preference dialog’s Blending dialog.) Use the Crossfade
Loop dialog to select the length of the crossfade in mil-
liseconds.

To create a crossfaded loop:

1. Create a loop using one of the techniques
explained earlier in this chapter.

2. Choose Crossfade Loop from the DSP menu.

3. In the Crossfade Loop dialog that appears, enter a
duration for the crossfade-in milliseconds and click
OK.

4. To hear the completed crossfade, choose Select
Loop from the Edit menu, select Use Loop in
Playback from the Preference menu (88-L) or click
the Loop button on the Toolbar, and press the
Spacebar. You will hear the loop, complete with
your crossfade.
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Crossfade Loop
Example:

= o

4,
Loop Start Loop End
Duration for crossfade(s) :
100 ms fEnveIope..‘ )
'Zi Logarithmic 5.

(Gnce) O

The Crossfade Loop dialog

want to fade. The Fade In will be applied to the
audio within this selection.

Choose Fade In Envelope from the Preferences
dialog.

In the Fade Envelope Editor dialog that appears,
you can use the default envelope, edit the enve-
lope, or load any envelopes included with Peak or
that you have created yourself.

Choose Fade In from the DSP menu. Peak applies
the Fade In to the selection you have made in the
audio document.

To hear the completed Fade In, press 38-Spacebar.
You will hear the selected audio complete with
your Fade In.

To create a Fade Out:

1.
@ Crossfade Loop is not available in Peak LE.
@ Crossfade Loop is not available in Peak DV. 2.
3.
Fade In & Fade Out
4.
The Fade In and Fade Out commands allow you to apply
an amplitude envelope to an audio selection. The Fade
In and Fade Out DSP functions, and the Fade Envelope
Editor dialog are described at length in Chapter 5. S,

To create a Fade In:

1. Click the cursor at the desired location in the
audio document and drag to select the audio you

Click the cursor at the desired location in the
audio document and drag to select the audio you
want to Fade. The Fade Out will be applied to the
selected audio.

Choose Fade Out Envelope from the Preferences
dialog.

In the dialog that appears, you can use the enve-
lope, create your own, or load any envelopes that
you have saved to your hard disk.

Choose Fade Out from the DSP menu. Peak
applies the Fade Out to the selection you have
made in the audio document.

To hear the Fade Out, press 38-Spacebar. You will
hear the selected audio complete with your Fade
Out.
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Find Peak

The Find Peak operation will place the insertion point at
the sample with the maximum amplitude value that it
locates in the audio selection.

To find the maximum amplitude point in an audio selec-
tion:
1. Select the audio in which you wish to locate the
maximum amplitude.

2. Choose Find Peak from the DSP menu.

3. Adialog will appear telling you what the peak value
is, and where it is located. The insertion point will
be placed at the sample where the greatest ampli-
tude was located.

4. Press the left arrow to bring the insertion point
into view or the Shift key to the view of the inser-
tion point at the sample level

Find Peak is not available in Peak IE.

@ Find Peak is not available in Peak DV.

Gain Envelope

The Gain Envelope operation allows you to enter an
amplitude envelope to be applied to an audio selection.
The selected audio’s amplitude will be boosted and/or
attenuated according to the envelope you draw in the
Gain Envelope editor. It is easy to cause samples to clip

when using this feature, so use it carefully.

To apply variable gain and attenuation to an audio selec-
tion:

1. Select the audio material you wish to process.

2. Choose Gain Envelope from the DSP menu.

Gain Envelope

{ Omsec, -100.000000% )

(toad...) {save..) ((<-—> ) (Reset ) (Cancel) {€hange:

The Gain Envelope dialog

3. Draw the gain envelope you wish to apply to the
audio selection in the envelope editor. Points
above the 0% line will amplify the selected audio.
Points below the 0% line will attenuate the select-
ed audio. Note that the waveform display in the
Gain Envelope editor will change according the
envelope you draw.

4. To process the audio selection using the gain enve-
lope, press Change.

Harmonic Rotate

The Harmonic Rotate tool is excellent for sound design
experimentation. This command allows the frequency
spectrum in a selected range of audio to be rotated
around a horizontal axis, which has the effect of taking
frequencies that were previously associated with one
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section of a file with a particular amplitude, and assign-
ing them to different areas of audio with different ampli-
tudes.

The Harmonic Rotate command can be previewed in
real time, so that desired setting can be found before

spending time processing. Options for processing

include checkboxes for using Real & Imaginary calcula-
tions, and a slider & text field to set amount of rotation.

To apply Harmonic Rotate to an audio selection:

1. Select the audio material you wish to process.

2. Choose Harmonic Rotate from the DSP menu.

Harmonic Rotate

T
356

@Reat

(" cancel )
e

™ imaginary (" Preview )

The Harmonic Rotate dialog

3. Click the Preview button, and select the desired
settings for Real or Imaginary frequency spectrum
calculation, and move the slider/enter in the
desired value.

4. When you've made the desired settings, click OK.

Harmonic Rotate is not available in Peak LE!

Harmonic Rotate is not available in Peak DV!

ImpulseVerb™

ImpulseVerb is an extremely high-quality reverb process-
ing tool, that utilizes actual reverb impulses recorded in
real spaces, such as performance halls, cathedrals, caves,
and other spaces that have various reverberation quali-
ties.

The same convolution technology that is used in Peak’s
Convolve DSP tool allows these natural reverb impulses
to be applied to dry audio signals, giving the impression
that a file was actually recorded in a particular environ-
ment. ImpulseVerb offers real time preview, so that the
ideal settings can be found before processing. In addi-
tion, ImpulseVerb offers an editable Space envelope,
which controls reverb length and decay characteristics,
and a Wet/Dry slider to control the amount of reverb
being applied.

To apply reverb using ImpulseVerb:
1. Select the audio material you wish to process.
2. Choose ImpulseVerb from the DSP menu.

ImpulseVerb™

Space:

" dramaten1.aiff ﬂ

| Space Envelope...

{ cancel ) “Apply

The ImpulseVerb dialog

3. Select a Space using the Space pop-up menu, or
choose clipboard to use the contents of the clip-
board.
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4. Click the Preview button, and adjust the Wet/Dry
slider to the desired position.

5. To apply the current reverb characteristics, click the
Apply button.

To modify reverb characteristics:

*  (lick the Space Envelope checkbox - a standard
Peak envelope editor appears.

*  The example below shows a recommended setting
for shortening the amount of reverb that will be
applied.

Response Envelope
Current Envelope %)

(1.5370 sec, -100.000000% )

“Cancel ) (€hanged

Load... ) {save..) [ <--> ) ( Reset )

The Space Envelope editor, showing settings for a shortened reverb

While the settings above describe how to simply
shorten the amount of reverb, other types of set-
tings may be useful for creative sound design.
When using the ImpulseVerb interface for real

time convolution, experiment with the type of
Space Envelope used - especially when the content
used is a non-impulse response file.

The ImpulseVerb dialog can also be used as a real
time convolution tool, and is not limited to using
impulse response files to create reverb effects. Any
selection that is copied 1o the clipboard can be
convolved with the selected range of audio. To
add audio files to the Space pop-up menu within
the ImpulseVerb dialog, simply save the desired file
as a 24-bit Sound Designer Il format file, and
Pplace into the Peak Impulses folder within:

[Macintosh HD/Library/Application Support/BIASPeak

ImpulseVerb is not available in Peak LE!

ImpulseVerb is not available in Peak DV!

Invert

The Invert function allows you to invert the phase of a
selection or an entire audio document.

To invert the phase of a selection:

1. Select the portion of the audio that you wish to
invert.

2. Choose Invert from the DSP menu. Peak inverts
the phase of the selected audio.
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Loop Tuner

Peak’s Loop Tuner provides a way to visually line up the
start and end points of your loop and listen to the effects
of these adjustments as you make them. If you wish to
“tune” a loop you've made, simply select Loop Tuner
from the DSP menu or Toolbar, and a dialog will appear.

Loop Tuner
Ed Buan

=] o =)
28

o

Cancel ¢ Play

The Loop Tuner dialog with a bad, abrupt transition

The waveform display in the Loop Tuner dialog shows
the Start and End points of the loop, which you can visu-
ally adjust with the scroll bars at the bottom of the win-
dow to achieve a natural transition at the loop point by
carefully adjusting the slope alignment.

Loop Tuner
Ed Buan

[=) “fr [=)

o8

Cancel ( Pay [Z

The Loop Tuner dialog with a good, smooth transition

The arrows of the slider will move the loop markers sam-
ple by sample and clicking in the body of the slider will
move the loop markers to the next zero crossing. The

two zoom buttons (magnifying glass icons) in the upper
left of the Loop Tuner dialog allow you to adjust the ver-
tical zoom up of the waveform. The two zoom buttons in
the lower left hand corner of the Loop Tuner dialog
allow you to adjust the zoom view in and out all the way
down to the sample level. You can listen to the effects of
the adjustments as you make them by clicking on the
Play button. To exit this dialog, click on OK to accept the
changes, or Cancel to leave the original loop unaffected.

©
&

Loop Tuner is not available in Peak LE.

Loop Tuner is not available in Peak DV.

Mono To Stereo/Stereo To Mono

These two DSP commands may be used to easily convert
an audio document between one and two channel for-
mats.

To change an audio document from mono to stereo:

1. Select the entire audio document with the Select
All command from the Edit menu (38-A).

2. Choose Mono To Stereo from the DSP menu or
Toolbar.

3. In the dialog that appears, adjust the slider to
adjust the left and right-channel balance in the
mix.
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Mono to Stereo Conversion

I |+

Description —————————————

You are converting a mono audio clipping
into a stereo audio clipping. Choose the

left vs. right level of the resulting stereo ‘
clipping.

( Cancel ) 60!(:*

Mono to Stereo Conversion dialog

4. Click OK. Peak converts the mono document to a
stereo document.
To change an audio document from stereo to mono:

1. Select the entire audio document with the Select
All command from the Edit menu (38-4).

2. Choose Stereo To Mono from the DSP menu or
Toolbar.

3. In the dialog that appears, adjust the slider to
adjust the left- and right-channel balance in the
mix.

Stereo to Mono Conversion

Pan

——— WS %
= Ty

Description —————————————

You are converting a stereo audio clipping
into 2 mono audio clipping. Choose the
left vs. right mix level of the stereo
clipping to use.

( Cancel )

Stereo to Mono Conversion dialog

4, Click OK. Peak converts the stereo document to a
mono document.

Mono 1o Stereo/Stereo To Mono is not available in
Peak LE.

Mono 1o Stereo/Stereo 1o Mono is not available in
Peak DV.

While automatic Mono 1o Stereo/Stereo To Mono

conversion is not available in Peak LE & DV, you

can achieve the same end result manually, by

selecting all in an open mono or stereo document,

and then opening a new, empty document. If you

2 copy an entire document, open a new empty doc-
ument, and attempt to paste in the contents of the
clipboard, Peak will detect if there is a different
number of channels, and will prompt you to enter
a Left/Right panning value, and will then allow
you to paste in the clipboard contents.

Mix

The Mix command allows you to mix material that you
have copied to the clipboard with a target selection. This
function can be used as a kind of “sound-on-sound”
capability for mixing audio tracks together, or for blend-
ing sound elements. The Mix command is similar to the
Add command, but it does not have the potential to clip
because the target and clipboard contents are attenuat-
ed before mixing. To use the Mix command, you must
first copy a selection of audio. The copied material can
then be mixed into the target audio material. The Mix
command also allows an envelope to be applied to the
copied material. This can be useful when the content
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being mixed needs to have variable levels in it.

To use the Mix command:

1. Select the audio you wish to mix into another
audio document and choose Copy from the Edit
menu or Toolbar (or press 38-C).

2. Select the audio that you wish to mix the copied
material into.

3. Choose Mix from the DSP menu.

4. In the dialog that appears, use the slider to adjust
the amount of the copied signal that you wish to
mix into the target audio document. To mix copied
material with a variable level, click the envelope
button, create the desired envelope, and then click
the Change button, and then click the Mix button.

r Al

Mixer

Amount of clipboard to mix in:

Description

The mix operation mixes the clipboard

samples into the audio document at the
selection point. Choose the level of the
clipboard samples you wish to mix into
the audio document.

£ b Y
Cancel |

Envelope...

The Mixer dialog

5. Click OK. Peak mixes the two signals together.

6. o hear the results, press 38-Spacebar.

Modulate

The Modulate command functions as a “ring modulator”

which multiplies two audio signals together (e.g., the
material copied to the clipboard and the currently select-
ed audio). The resulting audio includes the sum and dif-
ference tones of the frequency components of the mod-
ulated audio and the modulating audio. These are gen-
erally very complex timbres that often have a “metallic”
(i.e., inharmonic) character to them.

Try using generated tones, like sine, swept sine,
! square, or saw-tooth waves with the Modulate
command.

To use the Modulate command:

1. Select the desired source audio and choose Copy
from the Edit menu or Toolbar (or press 36-C).

2. Select the destination audio.
3. Choose Modulate from the DSP menu.

4. 1In the dialog that appears, use the slider to adjust
the amount of the copied signal that you wish to
use to modulate the destination audio document.

Modulator
Amount of clipboard to modulate in:

Description

The modulate operation performs a
synthesis multiplication using the
clipboard contents. Choose the level of
modulated samples you wish to mix in to
the audio document.

“cancel ) E"OK )

The Modulator dialog

5. Click OK. Peak processes the two signals.

6. To hear the results, press the Spacebar.
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Modulate is not available in Peak LE.

Modulate is not available in Peak DV.

Normalize

This command allows you to optimize the volume of a
selection or an entire audio document so that it is at its
maximum possible amplitude without clipping. The nor-
malize function is very useful for boosting the volume of
material that was recorded at too low a level, or if used
on multiple audio documents, for making sure that the
amplitude of each of the documents is uniform.

Note that because normalization uniformly
changes the amplitude of a selection (i.e., the pro-
portions between loud and soft stay the same), it

does not have the same effect as compression/lim-
iting (which makes the soft parts louder and does
not allow the loud part to exceed a specified
amplitude).

To normalize a selection:

1. Select the audio that you wish to normalize. If you
wish to normalize the entire audio document,
choose Select All from the Edit menu (38-A).

2. Choose Normalize from the DSP menu.

3. In the dialog that appears, use the slider to adjust
the percentage of normalization from the maxi-
mum level.

Normalize
Enter amount of normalization:

Description

The normalize function allows you to
control the gain of the audio document’s
selection to the maximum level without
clipping (digital distortion). You may

enter a percentage from the maximum
amplitude that you wish the selection to

be normalized to. ‘

(Cancel) ORI

The Normalize dialog

4. Click OK. Peak normalizes the selected audio.

Panner

The Panner allows you to adjust the panning, or left-to-
right movement, of a stereo document by drawing an
envelope in the Panner dialog. Left is at the top of the
graph, and right is at the bottom.

To adjust the panning of a selection:

1. Select the stereo document that you wish to
adjust. If you wish to select the entire document,
choose Select All from the Edit menu (38-A).

2. Choose Panner from the DSP menu.

3. In the Panner editor dialog that appears, use the
envelope to “draw in” the panning you desire.

4. Click OK. Peak will change the panning of the doc-
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ument to reflect the changes you've made.

Panner

# Keep Volume Constant

Current Envelope Tl

(3.4890 seq, -100.000000% )

Load... ) { Save..} ( <--> ) ( Reset ) (Cancel) {Change}

The Panner editor dialog

Panner is not available in Peak LE.

Panner is not available in Peak DV.

Phase Vocoder

The Phase Vocoder is a type of audio spectrum analy-
sis/resynthesis tool that allows you to modify the dura-
tion and/or pitch of an audio selection.

To use the Phase Vocoder:

1. Select the audio that you wish to process. If you
wish to select the entire document, press 8-A.

2. Choose Phase Vocoder from the DSP menu. The
Phase Vocoder dialog appears.

Phase Vocoder
Phase Vocoder
Change Duration:

348971 seconds

Change Pitch:
&) the pitch by

Raise
0 cents None T!

Analysis settings:

Num Bands: 8192 -—:—!
FFT Size: 1024 _:]
“Cancel ) o)

The Phase Vocoder dialog

3. In the Change Duration field, you can enter a new
duration for the selection by typing the time in sec-
onds.

4. In the Change Pitch field, you can change the pitch
of the selection by entering a new value in cents.
(Cents are divisions of a musical octave-one octave
is equivalent to 1200 cents.) Common musical
intervals are stored in the interval pop-up menu,
allowing you to enter a major third, octave, or
other intervals. Use the direction pop-up menu to
control whether the pitch is shifted upward or
downward.

5. In the Analysis Settings field, select the number of
bands and FFT (Fast Fourier Transform) size to
determine the quality of the output. The Phase
Vocoder works by analyzing the frequency content
of the audio selection and placing the found fre-
quencies into tracks. These tracks are then used to
control an oscillator-based resynthesis that uses
the pitch and duration modifications you enter. In
general, using a smaller FFT size brings less smear-
ing of the audio output than higher FFT sizes.
Using a larger number of bands setting used
increases the accuracy while tracking of harmonic
content of the source sound. In general, setting
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the FFT size larger than the number of bands will r p— \
give undesirable results. Due to the nature of the Enter amount of effect:

Phase Vocoder’s algorithm, optimum results are

achieved when it is used with solo instruments and

Description

steady state sounds (such as a voice or solo flute The rappify operation mixes in a filtered
. version of the audio document's selection
line) rather than complex tones (such as an into the audio document. Choose the

. amount of rappified samples you wish to
Or(:hestra playlng). mix into the audio document.

6. Click OK. Peak processes the audio. To hear the
results, initiate playback. (Cancel)  EORD)
The Rappify dialog
@ Phase Vocoder is not available in Peak LE.
3. In the dialog that appears, select the amount of

“rappification” you wish to mix back into the origi-

nal, with 100% being entirely rappified and 0%
Phase Vocoder is not available in Peak DV. being unchanged.

4. Click OK. Peak processes the audio. To hear the
results, initiate playback.

Rappify is not available in Peak LE.

Rappify

The Rappify command applies extreme dynamic filtering
to a selection. As one Peak user described it, “Rappify Rappify is not available in Peak DV.
can turn your hi-fi into lo-fi!” If the target material has a

pronounced beat, this has the effect of reducing the
material to its most essential rhythmic components. Try
using this function with a variety of different music mate-
rial for some surprising and exciting results. Repair Click

To Rappify a selection: The Repair Click command will eliminate a selected click

or “spike” in the waveform using the setting designated

1. Select the audio that you wish to process. If you the Repair Clicks dialog (explained next).

wish to select the entire document, press 8-A.

2. Choose Rappify from the DSP menu. To repair a single click:
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1. Place the Insertion Point located the click you wish
to repair.

2. Choose Zoom To Sample Level from the action
menu (Shift-Left arrow).

3. Select the click in the waveform. Please be sure
that your selection is no more than 100 samples.

4. Choose Repair Click from the DSP menu.

Repair Click is not available in Peak LE.

@ Repair Click is not available in Peak DV.

Repair Clicks

The Repair Clicks command allows you to find and
repair pops or clicks in an audio document. The Repair
Clicks dialog automates the process of finding and
removing clicks (usually indicated by a sharp “spike” in a
waveform), much like a search and replace dialog in a
word processor.

Repair Clicks
Smoothing Factor: Detection Setting: Repair Size:

T % 50 % 50 samples

¢ Next Click ) € Repair ) (Repair Al

"_ Done | ’_Auditinn )

The Repair Clicks dialog

The Repair Clicks operation works by looking for any sig-
nificant discontinuity from sample to sample. For exam-
ple, a sample value of -100 followed by a sample value of
10,000 is likely to be a click. Once the area of the click is
identified, a smoothing technique is used to maintain
the original shape of the area being repaired.

If you are working with mostly digitally induced clicks,
the Repair Clicks dialog will become an indispensable
tool. Extremely damaged signals such as those of a
scratching and popping vinyl record will require more
careful repair in addition to using the Repair Clicks dia-
log, such as Change Gain, Delete, and the Pencil Tool.
Clicks such as those of a scratching and popping vinyl
record loose their detectability once they are sampled
using Analog to Digital converters.

Smoothing Factor

Smoothing Factor determines how much smoothing is
applied to the click. Material with high frequency infor-
mation may require lower smoothing factors to preserve
the high frequencies. In general, a setting of 40-60 per-
cent will repair most clicks.

Detection Setting

The Detection Setting value determines how the clicks
are located. Higher values locate only the most severe
clicks, while lower values will detect less severe clicks.
Note that lower values such as 10% also have a greater
chance of misjudging audio for a click. In general, a set-
ting of 40-80% works well.

Repair Size

The Repair Size setting affects how many samples
around the click are used in determining the new shape
of the repair. Repair size can vary from 5 to 100 samples,
with a repair size of 50 samples working well in most cir-
cumstances. Peak will then interpolate what the correct
waveform should be, and repair the click.

Buttons along the bottom of the Repair Clicks dialog
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allow you to control repairing, auditioning, and undoing

click repairs:

Click the Repair button when you wish to repair a
click found by the Next Click button.

Use the Next Click button to search for the next
potential click in the audio selection.

Once a click is located, you may listen to the click
using the Audition button. The Audition button
plays the click using the Pre-roll and Post-roll set-
tings from the Auditioning dialog in the
Preferences dialog.

If you repair a click and are unsatisfied with the
results, simply click on the Undo button.

If you would like to repair all of the clicks in the
audio document’s selection without having to
repair each one individually, click the Repair All
button.

Be sure not to confuse repair size with the size of
the selection containing the audio you want to
scan and repair. The repair size refers to the size
of each individual repaired click.

To repair multiple clicks in an audio document:

1.

4.

Select the entire audio document or the area in the
audio document you wish to repair click.

Choose Repair Clicks from the DSP menu.

Click the Next Click button. Peak will search for
any clicks. If none are found, you can try again with
a lower detection setting.

Audition the click using the Audition button. The
click should sound in the middle of the auditioned
area.

Once the click is found, click the Repair button.
Click the Audition button to make sure the click
was adequately repaired. If it was not adequately
repaired, use the Undo button, modify the
smoothing factor or repair size and click the Repair
button again.

Proceed from step 3 until all clicks are removed, or
simply click the Repair All button. If you wish to
stop the Repair All process, press 38-period.

To repair a single click from an audio document:

1.

2.

Select the area around the click, centering the click
in the selection.

Choose Repair Clicks from the DSP menu or use
Repair Click and skip step 3.

Click the Repair button. Then click the Audition
button to make sure the click was adequately
repaired. If it was not adequately repaired, use the
Undo button, modify the smoothing factor or
repair size and click the Repair button again.

You may need to lower the detection setting in the

Repair Clicks dialog to find some clicks, depending upon

their severity. Be careful not to lower the detection set-

ting dramatically-lower it gradually for the best results.

©

Repair Click & Repair Clicks are not available in
Peak LE.

&

Repair Click & Repair Clicks are not available in
Peak DV.
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Remove DC Offset

This function allows you to remove any DC Offset in
your audio file. Peak scans the audio for DC offset and
then removes it. Peak will scan the left and right chan-
nels of a stereo file independently. DC Offset is usually
caused by problems in the analog to digital conversion
process. The result is that the waveform is not centered
on the base line — it is offset either higher or lower than
the center line.

To use Remove DC Offset:

1. Select the audio that you wish to process. If you
wish to select the entire document, choose Select
All from the Edit menu (38-4).

2. Choose Remove DC Offset from the DSP menu.
Peak will scan the audio, and automatically remove
any DC offset that might be present.

Remove DC Offset is not available in Peak LE.

Remove DC Offset is not available in Peak DV.

Reverse Boomerang

The Reverse Boomerang command mixes a reversed
copy of the selected audio with the original. This creates
a variety of interesting and useful results. Try using
Boomerang on drum loops, voice, and sound effects.

To use Reverse Boomerang:

1. Select the audio that you wish to process. If you
wish to select the entire document, choose Select
All from the Edit menu (38-4).

2. Choose Reverse Boomerang from the DSP menu.

3. In the dialog that appears, select the amount of
reversed sound you wish to mix back into the orig-
inal, with 100% being entirely reversed, and 0%
being unchanged.

Boomerang
Enter amount of effect:

Description

The boomerang effect mixes a reversed
copy of the audio document's selection in
with the original. Select the amount of
the reversed copy that you wish to mix in
with the audio document's selection.

£ Y

The Reverse Boomerang dialog

4. Click OK. Peak processes the audio. To hear the
results, press the Spacebar to initiate playback.

Reverse

The Reverse command reverses the current selection. In
a reversed selection, the last sample becomes the first
sample, the second-to-last sample becomes the second
sample, and so-forth. The effect is similar to playing a
record or cassette tape backwards.

To reverse a selection:

1. Select the audio that you wish to reverse. If you
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wish to select the entire document, choose Select
All from the Edit menu (38-4).

2. Choose Reverse from the DSP menu. Peak revers-
es the selected audio. To hear the results, start
playback.

Swap Channels

The Swap Channels command reverses the left and right
channels in a stereo selection.

To swap channels for a stereo selection:

1. Select the audio that you wish to reverse. If you
wish to select the entire document, choose Select
All from the Edit menu (38-A), or place the inser-
tion point at the beginning of the stereo audio
document.

2. Choose Swap Channels from the DSP menu. Peak
swaps the left channel for the right channel and
the right channel for the left channel. To hear the
results, start playback.

Swap Channels is not available in Peak LE.

Swap Channels is not available in Peak DV.

Threshold

The Threshold command allows you to split up an audio

document into its component parts by analyzing the
amplitude levels in the audio document and setting a
cutoff or threshold amplitude.

Region 01
egion 02
Region 03

Reg{on 04 Regign 05

Region P8
Region 0|

Region 05 |
REgHAbEC

egion 07
Region 08
Region 09

Region 05

Regidn 04
Region 03 1
Region 0. Region

Region 01

A drum loop, divided into individual beats, using the Threshold com-
mand, set to make regions

For instance, you might use the Threshold command on
an audio document that contains successive notes from
amusical instrument to split them up, or on a drum loop
to break it up into its component parts. You can save the
segments with Markers, or as Regions.

To use the Threshold command:

1. Select the audio you wish to process and choose
Threshold from the DSP menu. After Peak analyzes
the amplitudes in the selection, the Threshold dia-
log will appear, allowing you to select a threshold
amplitude for both attack and release values.

Threshold Regions

Attack Threshold
w8 7208 3668 1808 1208 608 JeB 048

Trreshold:

512 256 0 256 512
Offset: O
Duratio:  [0.040000 | Seconds ]

Release Threshold
~dB 7268 36d8 180B 1208 6B 3B 0dB

Theoshold:

512 256 0 256 s12
Offset:

Duration:  0.040000 | Seconds F}

@ Create Markers () Create Regions
Name Prefix:  Region (Cancel)  (@OKD

The Threshold Regions dialog
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Drag the threshold indicator left or right to set the
threshold amplitude. As you drag the indicator,
new markers will appear in the audio document
forming markers or regions, depending on your
settings. The Offset sliders allow you to “nudge”
the onsets of markers or regions by plus or minus
0 to 512 samples.

Select Create Regions to create regions instead of
markers. The separate Release Threshold, attack
and nudge settings affect the region end points,
allowing you to eliminate silence from the region
end points.

Adjust the Attack value. This setting sets the
amount of time that audio must stay above the
given threshold to qualify as a new marker or
region.

When you have finished, click OK.

After the audio document has been “thresholded”
to your satisfaction, you can use the Export
Regions command in the File menu to export the
separated regions into new windows or files.

To select and play regions in order from left to
right, press the Page Up key on your computer
keyboard. To select and play regions in order from
right to left, press the Page Down key.

Use the Threshold command to create several
looping points. To convert a marker to a Loop
Start or Loop End point, double-click on the mark-
er and change it to “Loop Start” or “Loop End” in
the Edit Marker dialog. Also, try rearranging the
regions generated by the Threshold function in the
Playlist or by using Cut and Paste to create new
interesting compositional and rhythmic ideas!

Threshold is not available in Peak DV.

@ Threshold is not available in Peak LE.

Conclusion

You have now learned how to manipulate and process
audio using Peak’s native DSP capabilities. In the next
chapter, you will learn how to use VST & Audio Unit
plug-ins with Peak.
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Chapter 8: Plug-Ins

Introduction

Peak supports “carbonized” and “Mach-O” VST 1.0, and
Audio Unit format plug-ins. VST (“Virtual Studio
Technology”) is a standard audio plug-in technology
developed by Steinberg Media Technologies, AG. Audio
Unit plug-ins are an emerging standard from Apple
Computer, Inc.

Both VST & Audio Unit plug-ins offer an exciting array of
real-time effects by companies like Arboretum, BIAS,
Cycling 74, Steinberg, Waves, Maxim Digital Audio, and
others. VST & Audio Unit plug-ins are real-time, host-
based audio plug-ins that run on your computer without
any additional hardware.

Installing VST Plug-Ins
VST plug-ins can be installed in two locations - either in:

/Macintosh HD/Library/Audio/Plug-Ins/VST

or:
/MacintoshHD/Users/<YourUserAccount>/Library/Audio/Plug-Ins VST

Be sure to consult the documentation that came with
your VST plug-ins for the manufacturer’s installation
instructions.

Using VST Plug-Ins

Inserts

Peak can access VST plug-ins in two different ways - using
“Inserts” or through Vbox SE. An insert can contain a
single plug-in, and up to 5 inserts are available. When
using inserts, signal flows through the effect in each
insert in the order of the insert number. For example, if
an equalizer plug-in is used on Insert 1, and a reverb
plug-in is used on Insert 2, the output of the equalizer
plug-in will flow into the input of the reverb plug-in.
Inserts are typically more convenient when using a small
number of plug-ins is required.

Vbox SE

Peak includes BIAS’ Vbox SE for managing and mixing
VST plug-ins. Think of Vbox SE as a virtual effects box, in
which you can combine, repatch, and mix your VST plug-
ins in real-time. Using its unique effects matrix, Vbox SE
lets you combine multiple individual plug-ins. Vbox SE
can patch plug-ins in series, in parallel, or in series and
parallel, and you can hot-swap plug-ins. Vbox SE has con-
trols for each plug-in to mute, solo, and edit parameters.
Vbox SE also provides input and output gain controls
both globally and for each individual plug-in, and a con-
trol for the global Wet/Dry mix. Use Vbox SE’s A/B com-
parison feature to get just the right settings, and use
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Vbox SE’s presets to store configurations and settings for
later use.

1 use multiple VST plug-ins within Vbox SE, you
must select Vbox SE from an available insert.
While Vbox SE can be used on one insert, and

other VST plug-ins can be used on other inserts, it
is recommended to use multiple plug-ins within
the Vbox SE matrix, as it offers much more control
and flexibility.

Using Peak with Inserts

To open a VST plug-in on an insert:
1. Select Insert 1 from the Plug-Ins menu.
2. Select VST from the submenu.

3. Select the plug-in you wish to use from the second
submenu.

Insert 1
Insert 2

»
P AudioUnits  »
Insert 3 >
>
»

BIAS Freqd
BIAS Sgweez 1.0
Carbon MDA VST Effects
freeverb-c

Freq-2

Inspector
RoomMachine844
RubyTube

BIAS FIX >
BIAS Freg4

BIAS Sqweez 1.0

Carbon MDA VST Effects  »
freeverb-c

Inspectar

Insert 4
Insert 5

>

Vbox... XV

Bounce...

Opening a VST plug-in

To close a plug-in:
1. Select Insert 1 from the Plug-Ins menu.

2. Select VST from the submenu.

3. Select None from the second submenu.

To preview a plug-in:

1. With an audio document open, open the desired
VST plug-in as described above.

2. Configure the plug-in’s settings as desired (plug-
ins from different manufacturers may have knobs,
buttons, sliders and other types of controls).

3. Audition the audio document, and make any
adjustments to the plug-in’s controls, if necessary.
VST plug-ins operate in real time, so any adjust-
ments to controls are heard instantly.

To apply a VST plug-in:

1. Follow the steps described above, for previewing
VST plug-ins.

2. Select Bounce from the Plug-Ins menu. Peak will
apply the current plug-in settings to the audio doc-
ument in the foreground.

3. When processing (“Bouncing”) is finished, Peak
will display a dialog asking if the plug-in should be
disabled. If you are finished using the plug-in for
the time being, click Yes. If you have additional
files to process with the same plug-in, click No.

Peak LE supports a single insert and can only host
one plug-in at a time.

5,

Peak DV supports a single insert and can only host
one plug-in at a time.
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Using Peak with Vbox SE The Vbox SE Matrix

To open Vbox SE in Peak: The large area inside the Vbox SE window with 4 rows

and 4 columns of smaller boxes inside it is the Vbox SE
1 Select Vbox SE from the Plug-Ins menu. matrix. You can assign, route, and modify VST plug-in

2. The Vbox SE matrix appears. inside the Vbox SE matrix.

The actual size of the Vbox SE matrix may be larger than

Peak LE € DV do ot include Vbox: SE. Peake LE & the 4x4 grid shown in the Vbox SE window. You can

DV users may purchase Vbox SE separately to add
support for multiple VST plug-ins in parallel or ~ trollers located at the lower-right hand corner of the

scroll through the Vbox SE matrix using the arrow con-

serial combinations. Vbox SE window.

The Vbox SE Matrix Graphical User Interface

Monitor State ‘A" Monitor State “B” Vbox SE Preferences

Vbox SE Preset Menu Assign State ‘A" Assign State “B” CPU Meter
a
Clip Indicators vbox pE 13051 i — Clip Indicators
(8 ) i T — bias
_, Effect Assignment Pop-Up Menu

Wet/Dry Mix Slider

Active Box L |

Input/Output Level Sliders
Inactive Box

Signal Flow Bypass Button
Dry Button ——————— 9 o
Routing Switch Edit Plug-In Parameters Button|

Input/Output Level VU Meters

Master Output Level Slider

Vertical Scroll Buttons

uT
Master Input Level Slider /
/ Horizontal Scroll Buttons

Master Input Level VU Meters Master Output Level VU Meters

The Vbox SE matrix with 5 plug-ins active
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An inactive box

An activated box

Box Controls

The Vbox SE matrix is made up of individual boxes. Each
box can be assigned a VST plug-in. When a box has a VST
plug-in assigned to it, it is activated. If there is no a plug-
in assigned to a box, it is inactive:

An activated box has several features including the name
of the assigned plug-in, input level control, output level
control, solo button, bypass button, mute button, edit
button, input meters, output meters, and input source.

Effect Assignment Pop-up

To assign a VST plug-in on a deactivated box, click on the
box. A pop-up menu displaying all the VST plug-ins
stored in the system’s VST plug-in folder will appear,
allowing you to assign a particular VST plug-in to the
box.

Assigning a VST plug-in in Vbox SE

To assign a VST plug-in:

1. Click in an inactive box for the Effect Assignment
pop-up menu.

2. Select the desired VST plug-in from the pop-up
menu. The pop-up menu will display all VST plug-
ins currently installed in the system’s VST plug-ins
folder.

Ifyou playback with more VST plug-ins than your

CPU can handle, audio may begin to playback

. erratically. The CPU meler at the top right of the
Vbox SE window allows you to monitor CPU
usage.

Organizing VST Plug-ins with Folders

Peak allows you to organize your VST plug-ins into fold-
ers inside the VST plug-ins folder.

008 [ vsT =)
17 items, 3.08 GB available

Name

v 7 BIASF/X
__ BIAS Freq
__ BIAS Sqweez 1.01
BIAS Superfreq4d
BIAS Superfreq6
BIAS Superfreq8
B 8IAS SuperFreq10
{4 Sound Soap.vst
[ vbox SE 1.3.wst

» | Carbon MDA VST Effects

¥ | Misc. Effects...
__ freeverb-c
@ Inspector (OSX)
__ RoomMachine844
__ RubyTube
74 SFX Machine RT.vst

__ WaveShell-VST 4.0_X

Organizing VST plug-ins with Folders
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Each folder you create inside the VST plug-ins folder can
store groups of plug-ins that will appear as submenus in
the Effect Assignment pop-up menu in Vbox SE.

To deactivate a VST plug-in on an active box:
1. Click on the name of the currently assigned plug-
in.
2. Choose None from the Effect Assignment pop-up
menu.
To “hot swap” a VST plug-in on an active box:
1. Click on the name of the currently assigned plug-
in.

2. Select a different VST plug-in.

When shopping for plug-ins, be sure that they are
Mac OS X compatible. Peak supports both “car-
bonized” and “Mach-O” format VST 1.0 effects
plug-ins.

Level controls

The small white triangular indicator located next to the
input and output meters allow you to cut or boost the
input or output of the box.

Output Level Slider

Input Level Slider

Click and drag the indicator up or down to cut or boost
the audio +/-6 dB (+/-100%). The center position of
the indicator is 0 dB cut/boost. Hold down the option
key on your keyboard and click the indicator to return it
to the center position.

Meters with Clip Indicators

On the left and right side of the box are input and out-
put meters. These meters show the audio levels input to
the plug-inand output from the plug-in. The lights at the
tops of the meters are clipping indicators. If the audio
clips (reaches maximum level for more than 2 consecu-
tive samples), the clip indicators will come on and stay lit
for a few moments.

Mute @]
The Mute button mutes all audio output from the box.

You can toggle the mute button on or off by pressing this
button.

Bypass (O]

The Bypass button prevents the VST plug-in from pro-
cessing the audio input to the box. The audio will flow
through the box directly to the outputs.

Solo (B!

The Solo button bypasses all the plug-ins on the same
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row. This allows you to audition just one box without
processing the audio through the other boxes in the

row.

Edit &

The Edit button brings up the VST plug-in editor for the
box. The VST plug-in editor will appear ina new window.
Moving Plug-Ins

Vbox SE lets you move plug-ins from any active box to
any other box, active or inactive, in the Vbox SE matrix.

To move a plug-in from one box to another:

*  Click on the meters of the active box, the cursor
will change to a grabbing hand, and drag and drop

it on any other box. There is no need to precisely

align the plug-in within the borders of the target
box, just drag and drop the plug-in to the middle
of the target box and it will snap into place.

Moving a plug-in from one box to another

Moving a plug-in to an inactive box will simply move the
plug-in from one box to the other. Moving a plug-in to an
active box will replace the plug-in in the target box.

Changing Input Routing

Vbox SE allows you to change the signal flow into paral-
lel box configurations. To move an input from the left-
box to the upper-left box, click on the green input indi-
cator on the left center of the box.

BIAS Fre..>

freevgrb..'

Left-box input

BIAS Fre..>

freeverb..™

Upper-left box input

Creating Serial Effects Chains

Vbox SE will automatically assume you want to create
serial chains of boxes. Simply activate boxes in rows,
making sure there are no inactive boxes between the
first and last active plug-ins in the row.
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Creating Parallel Effects Chains

Use the input indicator on the left center of a box to cre-
ate parallel effect chains.

Master Wet/Dry Controls

WET/DRY

-
L

Wet/Dry Mix Slider

The slider in the Vbox SE window labeled Wet/Dry allows
you to control the combination of dry signal with signal
passed through the Vbox SE matrix. Drag the slider indi-
cator upward to hear more of the effected signal from
the Vbox SE matrix (wet), or downward for more of the
original source signal (dry). Click on the Dry button to
here the original audio source only, without any pro-
cessing through the Vbox SE matrix.

Master Input/Output Levels

Master Input & Output Level VU Meters

The small white triangular indicators at the bottom of
the master input and output meters control input and
output levels. Click and drag the indicator up or down to
cut or boost the audio +/-6 dB (+/-100%). The center
position of the indicator is 0 dB cut/boost. Hold down
the option key on your keyboard and click the indicator
to return it to the center position.

Loading and Restoring Vbox SE Presets

PRESET v |

Vbox SE Presets Pop-Up Menu

You can save your Vbox SE matrix as a preset or restore
aVbox SE matrix by clicking on the Presets pop-up menu
at the top of the Vbox SE matrix. Any presets you save
into the Vbox SE Presets folder will appear in the Presets
pop-up menu. The Vbox SE Presets folder resides in the
following directory on OS X.

/Users/<YourUserAccount >/Library/Preferences/

A/B Comparisons

A/B Comparison Control Buttons

You can do A/B comparisons of different Vbox SE matri-
ces. Press the left arrow button to store the current Vbox
SE matrix into storage location A. Press the right arrow
button to store the current Vbox SE matrix into storage
location B. Press the A or B button to restore a saved
matrix.

Chapter 8: Plug-Ins

155




Vbox SE Preferences

Vbox SE Preferences Button

You can control the size of the Vbox SE matrix by press-
ing on the Preferences button at the top of the Vbox SE
matrix. Enter the height and width of the matrix you
wish to build. Note the new matrix size will not take
effect until the next time you launch Vbox SE. The Vbox
SE matrix can grow as large as 99x99!

vbox Preferences

Matrix Size:

10 5110

H v

@ Disable processing if overloaded

Ecicalh ‘ D
( Cancel )

The Vbox SE Preferences dialog
Editing VST Plug-In Parameters

Pressing the Edit button on an active box opens its edi-
tor. You will be able to adjust the parameters of the spe-
cific VST plug-in.

You can modify the parameters and save your presets
into the a preset file using the L and S buttons at the bot-

-1C)

Waveshell-VST 4.0.X

A plug-in editor window (Waves™ C4 Processor — not included with Peak)

tom of the plug-in editor’s window. The arrow buttons
allow you to move through any existing presets for the
plug-in, or click on the name of the preset for the Presets
pop-up menu.

—

FRESET 1 :C4 stereo [aj[7)

L= =

A plug-in editor window’s controls for scrolling through factory presets,
Loading/Saving custom presets, and bypassing signal through the
plug-in

BIAS Freq

‘86 BIAS Freqs

4

L=
PSPIDICC
2PTIV

® ©

195 200 || B8 ~6.87

Tk 164 2,04 681k
) £ P e
010] || glLa 10.0 0.36
o e o

B R EETE R

1ibefalt LY CE

BIAS Freq

BIAS Freq is a professional-caliber 4-band EQ included
with Peak 4.0. Freq supports -18 dB to +18 dB Gain
Values, 0.1 to 10 Q (bandwidth) values, and sweep-able
frequencies from 20 Hz to 20 kHz. Freq has Peak, Notch,
High-Shelf, and Low-Shelf filters available for each band.
Freq also includes individual band bypass buttons, and
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24 dB stereo input and output meters. For more infor-
mation on using BIAS Freq, please refer to the BIAS Freq
User’s Guide.

@ Peak LE includes a 2-band edition of Freq

BIAS Sqweez

BIAS Sqweez 1.0

'8 0

THRESH 10.04D8

ATTACK 39.79mS

= —

PRESET

1:Preset1 ¥ KifE §

BIAS Sqweez™ Compressor/Limiter

BIAS Sqweez ™ is a professional quality compressor/lim-
iter that is included with Peak4.0. Sqweez offers inde-
pendent input/output meters, threshold, gain, attack,
release, ratio, and knee controls, as well as auto-gain and
soft clip modes.

@ Peak LE does not include the Squeez plug-in

@ Peak DV does not include the Squeez plug-in

Bouncing VST Plug-Ins

Once you have the right settings for your VST plug-ins,
you will probably want to apply the effects to the audio
document. The process to do this is called “bouncing.”
Bounce the audio file to process the audio document
with any active VST plug-ins. Bouncing changes the
audio data stored on disk, allowing you to use the Save
command to permanently apply the plug-in effects to
your audio document.

To bounce VST plug-ins:

1. Make a selection in the audio document. If you
choose not to make a selection, the bounce will be
applied to the entire audio file.

2. Choose Bounce from the Plug-ins menu. The VST
plug-ins are applied to the selection. This process
may take a while, depending on the number of VST
Plug-Ins you are applying and also depending on
the size of selection in the audio file.

Insert 1
Insert 2
Insert 3
Insert 4
Insert 5

vvyVvyvwyy

Vbox...

Choosing Bounce from the Plug-Ins menu
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3. You will be prompted to disable all VST Plug-Ins
after the bounce. If there are no additional audio
documents you wish to bounce with the same VST
settings, click Yes. Otherwise, click No. Note that if
you leave the VST effects active after the bounce,
playback will sound like you are processing the
audio through the VST plug-ins twice.

4. You can now save the audio document using the
Save command under Peak’s File menu, or undo
the bounce using the Undo command under the
Edit menu.

VST Envelope

Peak allows you to apply VST effects gradually according
to a specified envelope.

To apply VST effects variably over time:

1. Make a selection of the audio document you want
to process.

2. Choose VST Envelope from the Preferences dialog.

VST Envelope

Current Envelope

{ Omsec, +0.000000% )

Load... ) {save..) [ <--> ) ( Reset )

VST Envelope dialog

3. Adialog appears allowing you to draw a breakpoint
envelope to control how much of the VST effect is
applied over time. Points at the top of the graph

represent 100% wet, while points at the bottom of
the graph represent 0% wet (dry).

4. When you are finished drawing an envelope, click
Change.

5. Configure the VST plug-ins you want to apply.

6. Choose Bounce from the VST Plug-ins menu.

VST Plug-In Delays

To compensate for VST plug-in delays when bouncing
VST effects on a selection, hold down the Option key
when choosing Bounce VST Effects and enter the delay
compensation you want in samples.

To determine VST delay compensation:

1. Bounce VST effects.

2. Measure the silence inserted by the bounce by
selecting the silence and viewing the duration of
the selection in samples.

3. Undo the bounce.

4. Hold down the Option key while choosing Bounce
VST Effects.

Bounce VST Effects...
Delay compensation:

A 1400

samps

Description

| Compensate for VST effect delay by
entering a value in samples above. For
instance, a VST effect chain may not
produce any audible effects for 102
samples due to internal delays. In this
case, you may enter a value above to

| compensate for the delay.

" Cancel |

The Bounce VST Effects dialog

158

Peak User’s Guide



5. Enter the VST delay compensation amount from
step 2.

6. Click OK or press Return.

Recording Through VST Plug-Ins

Peak will let you use record through your VST plug-ins.
This can be a very useful, timesaving step for processing
audio.

To record through VST plug-ins:

1. Open an Audio Document.

2. Select VST Plug-Ins from the VST Plug-Ins menu
and configure Vbox SE with the VST plug-ins you
want to record through.

3. Choose the Record Settings from under the Audio
menu.

4. Enable Record Through VST Plug-in in addition to
any other Record Settings you want. Click OK.

5. Choose Record from the Audio menu to open the
Record dialog and begin recording.

Using VST Plug-Ins with the Batch
File Processor

Peak will let you use your VST plug-ins with the Batch
File Processor (see Chapter 9: Batch File Processor &
Apple Events for a detailed description of the Batch File
Processor). This can be a very powerful and timesaving

processing option if you need to apply the same VST
plug-in(s) to many audio files.

To use VST plug-ins with the Batch File Processor:

1. Open an Audio Document.

2. Select VST Plug-Ins from the VST Plug-Ins menu
and configure Vbox SE with the VST plug-ins you
want to use in the batch process.

3. Choose the Batch File Processor from under the
File menu.

4. Choose any other processes you want to use for
the Batch File Processor and Set the Batch File
Processor’s Output directory folder.

5. Add Bounce VST Effects from the Available
Processes to the list of Selected Processes for
Batch.

6. 'Turn the Batch File Processor On and click OK.

7. Go to the Finder and drag and drop the Audio
Files/Folders that you want to batch process over
the Peak icon.

8. Peak will batch process these files and save them to
the designated directory folder.

@ Peak LE does not support Batch File Processing.

Using Audio Unit Plug-Ins

To open a Audio Unit plug-in on an insert:

1. Select Insert 1 from the Plug-Ins menu.
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2.

Select Audio Unit from the submenu.

Insert 2
Insert 3
Insert 4
Insert 5

None

Bypass

yrvyrw

Load Preset

Vbox... Save Preset

AUBandpass
AUDelay
AUGraphicEQ
AUHipass
AUHighShelfFilter
AUPeakLimiter
AULowpass
AULowShelfFilter

Bounce... Apple
The Sound Cuy

AUMatrixReverb [
AUParametricEQ

Opening an Audio Unit plug-in

3.Select the plug-in you wish to use from the second

submenu.

]

Taon
Audio Unit: AUDelay

Apple: AUDelay
Manufacturer: Apple |

Dry/Wet Mix:
Delay Time:
Feedback:
Lowpass Cutoff

S0} 100 50 % |
10.0 Femefn 22100 15400 | HE |

Audio Unit plug-in editor window (Apple AUDelay)

To close an Audio Unit plug-in:

1.

2.

Select Insert 1 from the Plug-Ins menu.

Select Audio Unit from the submenu.

3.Select None from the second submenu.

To preview an Audio Unit plug-in:

1.

With an audio document open, open the desired
Audio Unit plug-in as described above.

Configure the plug-in’s settings as desired (plug-
ins from different manufacturers may have knobs,
buttons, sliders and other types of controls).

Audition the audio document, and make any
adjustments to the plug-in’s controls, if necessary.

Audio Unit plug-ins operate in real time, so any
adjustments to controls are heard instantly.

To apply an Audio Unit plug-in:

1

Follow the steps described above, for previewing
Audio Unit plug-ins.

Select Bounce from the Plug-Ins menu. Peak will
apply the current plug-in settings to the audio doc-
ument in the foreground.

When processing (“Bouncing”) is finished, Peak
will display a dialog asking if the plug-in should be
disabled. If you are finished using the plug-in for
the time being, click Yes. If you have additional
files to process with the same plug-in, click No.

Using Audio Unit Plug-Ins with the
Batch File Processor

Peak will let you use your Audio Unit plug-ins with the

Batch File Processor (see Chapter 9: Batch File Processor

& Apple Events for a detailed description of the Batch

File Processor). This can be a very powerful and time-

saving processing option if you need to apply the same

Audio Unit plug-in(s) to many audio files.

To use Audio Unit plug-ins with the Batch File Processor:

1.

Open an Audio Document.

Select the desired Audio Unit Plug-Ins from the
Plug-Ins menu and configure them as desired for
use in the batch process.

Choose the Batch File Processor from under the
File menu.
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4. Choose any other processes you want to use for
the Batch File Processor and Set the Batch File
Processor’s Output directory folder.

5. Add “Bounce” from the Available Processes to the
list of Selected Processes for Batch.

6. Turn the Batch File Processor On and click OK.

7. Go to the Finder and drag and drop the Audio
Files/Folders that you want to batch process over
the Peak icon.

8. Peak will batch process these files and save them to
the designated directory folder.

@ Peak LE does not support Batch File Processing.

Conclusion

You have now learned how to manipulate and process
audio using VST & Audio Unit plug-ins with Peak. In the
next chapter, you will learn how to use Peak’s powerful
Batch File Processor as well as how to use Apple Events
with Peak for file management.
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Chapter 9:

Batch File Processor
and Apple Events

Introduction

Peak allows you to process any number of audio files at
once with any number of possible processes using the
Batch File Processor. Peak also supports Apple Events,
which allows you to manage whole libraries of audio files
quickly and easily with database applications such as
FileMaker Pro.

Batch File Processor

Peak’s Batch File Processor is one of the most powerful,
versatile, and useful features in Peak. Using the Batch
File Processor, you can integrate any series of Peak
processes (called a batch script), and apply these scripts
to any number of audio files.

The currently open audio document and selec-

tion you make will be used for previewing
processes sequenced into your batch script.

To use Batch File Processing, go to the File menu and
select Batch Processor. The Batch File Processor dialog
appears.

Peak’s Batch File Processor is split into three areas:
Input, Process, and Save Changes. Sequence a series of
steps for Peak to execute in the Process section, then set
your output file settings in the Save Changes area. Once
Peak’s Batch File Processor is configured, you may turn
on the Batch File Processor in the Input area.

Batch File Processor

Input
(O On  Batch processing is currently disabled. @ Process All Files
_ Only Mono Files
® off ") Only Stereo Files
Process
Available Processes: Selected Processes for Baich
Fade Out [- Fade In
Gain Envelope...  Add >> ) INSimElizE
Harmonic Rotate. Fade Out
ImpulseVerb... B fc Removed
Insert f
Invert
Mix... 7 " N
Modulate... Settings...
Mano To Stereo. ® Apply to entire file
Normalize... ~
Panner... (_ Apply just to first ‘sec
Dasta, O Apply just to last sec
(¥save Changes
Set... ) [Log File...
File Name Suffix: |
( Load Script... ) ( Save Script... ) (Cancel) EOKD

Peak’s Batch File Processor

Once the Batch File Processor is configured and turned
on, any files you drop onto the Peak application’s icon
(or an alias) will be batch processed according to your
settings. You can even drop folders or disks onto Peak’s
icon and all of the supported audio contents will be
batch processed. You can continue dropping files, folder,
or disks, onto the Peak icon for batch processing while
the Batch File Processor is turned on. All subfolders
within folders or disks you drag onto the Peak applica-
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tion for Batch File Processing will be recreated in the
Batch File Processor’s output directory, preserving all
organization of your files. Audio documents opened
using the Open command from the File menu will not be
batch processed.

You can also have the Batch File Processor run in the
background while you continue work in any other appli-
cation.

Supported contents include all file formats that Peak can
read, including AIFF, Sound Designer II, WAVE,
QuickTime, Raw, JAM image files, System 7 Sound, AU,
and MP3 & MP4 files.

New audio documents created with the Batch File
Processor will have the same file name as the original
input audio document or with a suffix.

Ingut

® Process All Files
Only Mono Files

{_ Only Stereo Files

) On  Batch processing is currently disabled.

@ off

Input Area

The Input Area allows you to enable or disable batch file
processing. Once the Batch File Processor is configured,
you may turn it on with the On button. If you have fin-
ished batch processing and no longer need to batch
process files, you can use the Off button to disable batch
file processing.

You can include/exclude mono or stereo files from the
batch process by using the Process All Files, Only Mono
Files, and Only Stereo Files buttons. Process All Files is
the default setting. To have Peak’s batch processor only
work with mono files, click the Only Mono Files button.
Similarly, to only process stereo files (excluding mono
files), engage Only Stereo Files.

If you are going to process both stereo and mono
audio documents, open a stereo audio document
and make a selection before configuring the batch
processor. This will allow most processes 1o make
the correct decisions on how 1o process both mono
and stereo input files using the Baich File

Processor.

The Process Area shows two lists. The list on the left,
labeled Available Processes allows you to select process-
es that will be used in your batch script. Almost every
process or plug-in available in Peak will appear in this list.
The list on the right is labeled Selected Processes For
Batch and contains the Peak processes in the current
batch script. Double-click on a process in the Available
Processes list to add it to the Selected Processes for
Batch list. Alternatively, click on a process in the
Available Processes list and then click the Add > > but-
ton. To remove items from the Selected Processes for
Batch list, click on the items and then click on the < <
Remove button.

Process

Awvailable Processes: Selecied Processes for Balch

Far

Gain Envelope...
Harmonic Rotate.

ImpulseVerb... B ? ompen e §
i

{ Add>> )

Insert
bvert
M.,

Modulate... Settings...
Mana To Stesea.. @ Apply to entire file
Normalize... - i :

Panner... : O Apply just to first sec
siy O Apply just to last sec

Process Area

When you add a process to the Available Processes list, you
may be required to supply settings for the process. The
front-most audio document and selection will be used for
any previewing the process may support. Peak’s batch
processor allows you to use multiple instances, or occur-
rences, of a single process-each with its own settings.
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You may also specify which part of the file to apply the
process to. Once a process has been added to the
Selected Processes for Batch list, you may use one of the
buttons Entire File, Apply Just To First x Seconds, or
Apply Just To Last x Seconds. Use these buttons to con-
figure how to apply the selected process to an audio
document. For instance, if you are using a Fade In
process and only wish to apply it to just the first three
seconds of the audio document, click the Fade In
process from the Selected Processes for Batch list and
then type a “3” into the Apply Just to First x Seconds edit
text field. All processes are applied by default to Entire
File unless you configure the process otherwise.

5ave Changes.
{Set.. ) LogFile...

File Name Suffix.

(Load Script... ) Save Script... ) Cancel ) (HOKTD

Save Changes Area

Use the Save Changes Area to configure how your audio
documents will be stored after they have been saved
using your batch script. Click the Set button to specify
the output document format and settings.

After clicking Set you will be asked to provide the output
file format, bit depth, and compression options using
the Save As dialog described in Chapter 3. Choose which
folder to save the processed audio files into with the
Save As dialog.

You can create a text Log File during batch processing to
keep track of which files have been processed. This is
useful for lengthy batch processing sessions where the
possibility of a power failure or other circumstance could
prevent the batch process from completing. Click on the
Log File checkbox to specify that a log file should be cre-
ated for the batch process. After turning the Log File fea-
ture on, Peak will ask you to provide a destination for the

log file. The log file can be viewed using TextEdit or any
application that can view text files. The Batch File
Processor will divert any error messages to the log file if
it is enabled. This is useful because any errors Peak
encounters during batch file processing will not require
user attention during processing. However, Peak will
issue a System Beep sound if an error occurs during
Batch File Processing. If this happens, check the log file
for errors.

If you want the output audio files of your Batch Process
to be appended with a suffix, such as .\WAV, simply enter
the suffix you want appended in the File Name Suffix
field. All resulting audio file names will be appended with
the suffix you specify.

Make sure that the output directory (folder) is not
set 1o the input directory or Peak’s Batch File

Processor may get caught in a loop. Peak’s Batch
File Processor does not support overwriting input
files.
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Save Script

Peak allows you to save your batch script into a settings
file that can be recalled later. This feature is useful if you
frequently process files using a specific sequence of
processes. After configuring the Batch File Processor,
click Save Script to save your batch sequence into a
Batch Script file. You will be prompted for a saving loca-
tion and name for the batch script. The settings file hold-
ing your batch script will store the processes, each
process’ settings, the and output file format.

Load Script

To recall a batch script settings file that was stored using
the Save Script feature (as described above), click this
button. For example:

To convert a folder of files into AIFF IMA 4:1 files
Normalized to 95% with a Log:
1. Choose the Batch Processor command from the
File menu.

2. Double-click the Normalize item in the Available
Processes list. Enter “95” in the following normal-
ization settings dialog.

3. Click Set in the Save Changes Area of the Batch File
Processor. Choose AIFF from the File Format pop-
up menu. Choose IMA 4:1 from the Compression
pop-up menu.

4. Choose the folder to save the output files into.
Click Save.

5. You will be back in the Batch File Processing dia-
log. Click Log and choose the output folder to save
the log file into.

6. Click the On button in the Input Area of the Batch
File Processor. The Batch File Processor is now
turned on.

7. Click OK to close the Batch File Processor dialog.

8. Switch to the Finder, and drag and drop a folder
full of audio documents onto the Peak applica-
tion’s icon.

9. Peak will process all audio files in the folder that
was dropped onto the Peak application icon.

10.  Once the files have been processed, open an audio
document, choose the Batch Processor command
from the File menu. You may then turn off the
Batch File Processor by clicking Off in the Batch
Processing dialog.

Errors and Cancelling Batch
Processes

Any errors during Batch File Processing will produce a
System Beep to notify you of the trouble. If an error
occurs during Batch File Processing, Peak will not place
an error dialog on the screen. This happens so that pro-
cessing can continue. If you have specified that you wish
to create a log file, errors messages that would appear in
an error dialog will appear in the log file indicating
where in the batch file process the error occurred.

Once the batch file processor has started, it will contin-
ue to process files as quickly as possible. If you find it
necessary to halt the batch process, press #6-Period. A
dialog will appear allowing you to cancel the batch
process. If you choose to cancel the batch process, Peak
will finish processing the current file and then ignore any
other files to be processed. Once batch processing has
been cancelled, Peak will turn the batch file processor
Off.
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@ Baich File Processing is not available in Peak LE.

Peak’s Audio Librarian Tools

Peak’s Audio Librarian Tools are ideal for anyone who
maintains a large number of sound effects and other
audio files. Through Apple Events, the Peak allows users
to catalog and audition sounds from ordinary database
applications, such as FileMaker Pro (several ready-made
templates are included). Peak also includes Batch Region
Processing (via the Export Regions command in the File
menu).

Apple Events Support

Peak understands a vocabulary of Apple Events. Apple
Events can automate procedures for you, such as trig-
gering the playback of an audio document.

The standard suite of Apple Events that “savvy” applica-
tions must understand includes the “odoc” (open docu-
ment) event. For example, when you double-click on a
Microsoft Word document, the Macintosh Finder sends
an “odoc” Apple Event to the application Microsoft
Word. Unfortunately, “odoc” requires the complete doc-
ument path of the document you wish to open. You can
use “odoc” with Peak, but Peak has another feature that
makes opening and playing your documents much easi-
er: simplified document descriptions instead of entire
document paths. To illustrate this difference, compare
the following;

Full Document Path:

John’s HD:Sounds:Brass:Trombones:With Mutes:C5A6.aiff

Simplified Document Path:

Volume Name: John’s HD:

Document Name: C5-A6.aiff

Using the simplified document path, Peak searches the
indicated volume for the first occurrence of a document
matching the name described (called a Find File opera-
tion). Once it is found, it is opened up and ready for
playback.

“Savvy” Core Suite of Apple Events
( event class = ‘aevt’ )

odoc

Open Document

The “odoc” event instructs Peak to open an audio docu-
ment with the document path provided in the data fol-
lowing the event.

quit

Quit Peak

The “quit” event Quits Peak.

Peak has its own class of events that it understands, all of
which have the ID “furp.” This class descriptor must be
present for Peak to understand the events you send to it.
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Peak events ( event class = ‘FURP’ )

sff

Set FindFile Volume

The “sffv” event tells Peak to use the data following the
event (a string of text) as the Volume name to search
when providing a simplified document path. When spec-
ifying volumes, don’t use colons in the name of the vol-
ume.

sfff

Set FindFile File

The “sfff” event tells Peak to use the data following the
event as the name of the document to find when speci-
fying a simplified document path.

offf

Open the FindFile File

The “offf” event tells Peak to find the document on a vol-
ume specified by the most recent “sfff” and “sffv” events.
If the document is found, it is opened in a window. If the
document is not found, Peak will beep once.

stop

Stop any currently playing audio

The “stop” event takes no additional data and instructs
Peak to stop playing any audio that is currently playing.

clos

Close the front-most window

The “clos” event takes no additional data and instructs
Peak to close the front-most window, if one exists.

play

Play the front most window

The “play” event initiates playback of the front most
opened audio document. Use the “stop” event to stop
playback, or wait until the document completes it’s play-
back.

Example Scripts

The FileMaker Pro documents included in the Peak
Extras folder are intended to illustrate Peak’s functional-
ity in an audio document database environment. To try
out the scripts, open one of the FileMaker Pro docu-
ments, type in the Volume Name (the exact name of the
hard disk the audio document resides on) and
Document Name for an audio document on one of your
hard drives, hit Enter and press the graphic play button.
If the document is found, Peak will play the audio docu-
ment. You can type in new records with the 38-N key-
stroke from FileMaker Pro to get a new empty record.

Below is an example Script Definition from FileMaker
Pro that might be used to create a Play Button. There are
six steps to this Script Definition:

1. Stop any currently playing audio documents
(STOP).
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2. Close any open digital audio windows (CLOS).

3. Pass the FindFile Volume name to Peak from some
FileMaker Pro field (SFFV).

4, Pass the FindFile File name to Peak from some
FileMaker Pro field (SFFF).

5. Tell Peak to find and open the document described
by steps 3 and 4, above (OFFF).

6. 'Tell Peak to Play the front-most audio document
(PLAY) (most likely opened in step 5).

FileMaker Pro is not included with Peak.

Script Definition for Play audiod”

View (i by caregory 1) iy audior”

Sample Script Definition from FileMaker Pro

Apple Events are not supported in Peak LE.

Apple Events are not supported in Peak DV.

©
Z

Conclusion

You have now learned how to batch process audio using
Peak’s Batch File Processor as well as using Apple Events
to manage whole libraries of audio files with database
software such as FileMaker Pro. In the next chapter, you
will learn how to use Peak to edit and transfer samples
with Samplers.
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Chapter 10:
Samplers

Introduction

Peak allows you to import samples directly from com-
patible samplers, edit or process the audio using all of
Peak’s powerful editing and processing functions, and
then send the modified sample back to the sampler, all
in the digital domain. This capability allows you to use
Peak as a powerful sample editing and sound design
tool, giving you access to audio processing capabilities
far more advanced than those typically found on sample
playback instruments.

Peak supports SMDI samplers, including the Kurzweil
K2000 and K2500 series, the Peavey SP/SX, and several E-
mu samplers, including the ESI-32, the E-64, and the E-
IV (requires a SCSI cable between the sampler and the
Macintosh).

The following sections explain how to transfer audio
documents between your sampler and your Macintosh.

Some samplers have a different interpretation of
loop points than Peak does. 1o compensate, you
may need to use the Sampler preference dialog to
adjust loop points forward or backward by plus

or minus one sample. You may enter independent
settings for sending and receiving loop points, as
well as loop start and loop end offsets for each. To
adjust loop point offsets, select Sampler from the
Preferences dialog.

Working with SMDI Samplers

Peak’s SMDI Sampler Support makes it possible to trans-
fer several audio documents at once to or from your
SMDI sampler.

SMDI Samplers supported in Peak (at time of printing):

e E-mu - E-IV, ESI-32, ESI-4000, E-64, E5000
*  KURZWEIL - K2000, K2500, K2600
¢ PEAVEY - SP/SX

*  YAMAHA - A3000, A4000, A5000

SMDI Samplers

SMDI Samplers, such as the Kurzweil K2500 or the E-mu
E-IV, use SCSI to transfer samples between devices. In
order to transfer samples between the Macintosh and
your sampler using SMDI, you must connect a SCSI
cable between your Macintosh and the sampler. Consult
your sampler’s owner’s manual for instructions on how
to connect the cable to your Macintosh with proper ter-
mination. Always use high-quality SCSI cables to avoid
data transmission errors.

Peak allows the user to turn fast Asynchronous SCSI
transfers On or Off in the Sampler dialog. Turn
Asynchronous transfers OFF if you are having trouble
transmitting samples to a SMDI device, or if your
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Macintosh does not support Asynchronous SCSI trans-
fers

To use the SMDI Sampler dialog:
*  Choose SMDI Sampler or the name of your sam-

pler from the Sampler menu. The SMDI Sampler
Transfer dialog appears.

(&) SMDI Sampler Transfer
SMDI Device: 6: Kurzweil K2000 T!
Start: |1

#ltems: | 100

( Updatej
3 =C*1 (384 k)
4-F1(425k)
S5-C2(383K)
& - 52 (306 K)
7-C3 (256 k) A
8 - F*3 (246 k) v
info .
|
|
P 3 ey I
Done | __ Selection [ Receive Send

The SMDI Sampler Transfer dialog

List of Samples

This dialog features a list of samples stored in the SMDI
device. Since there are hundreds of sample locations in
a SMDI device, an exact range of samples to display is
used. You may click on items in the list to view detailed
information about the sample in the Info portion of the
SMDI Sampler Transfer dialog. You may also Shift-click or
3 -shift-click to select multiple items in the list of sam-
ples.

Update

The Update button rebuilds the list of samples shown in
the SMDI Sampler Transfer dialog. Peak will scan the
SMDI device starting at the sample number indicated in
the Start edit text field until the number of samples
entered in # Items edit text field have been scanned.

SMDI Device

Any SMDI devices Peak detects attached to your
Macintosh will show up in this pop-up menu. Choose
the device using the pop-up menu. Peak will scan the
device for sample information starting at the sample
number indicated in the Start edit text field.

Start

Enter the first sample number stored in your sampler
that you wish to view in the list of samples. If you change
this value, you must click on the Update button for the
list of samples to be updated. Some SMDI samplers start
their samples at sample number zero, others start at 200.
Refer to your SMDI Sampler’s manual for information on
how samples are stored in your particular device.

# Items

The # Ttems edit text field controls how many samples
are displayed in the list of samples. If you change this
value, you must click on the Update button for the list of
samples to be updated.
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Send 2. Choose the SMDI Sampler command from the
Sampler menu. If Peak finds a SMDI sampler con-
To send the front-most Peak audio document to the nected to your Macintosh, the SMDI Sampler

SMDI Sampler; click on the sample in the list of samples Transfer dialog appears.

h ish h 1 the Send
that you wish to send the sam.p ¢ o and press the e.n 3. Make sure the correct SMDI device is selected in
button. If a sample already exists at the chosen location i

o the SMDI Device pop-up menu.
in the SMDI Sampler, it will be replaced.
4. Click on the sample in the List of Samples that you

wish to replace.

5. Click Send. Peak will send the sample to your
1 send multiple opened Peak audio documents to SMDI sampler.

the SMDI Sampler, shift-click or d-click to select

multiple destinations in the list of samples and 6. When you are finished using the SMDI Transfer

| click the Send button. Peak audio documents will dialog, click the close box of the dialog or click the
be sent to the selected destinations in the order Cancel button.
that they appear under Peak’s Windows menu.
To send a SMDI sample to Peak:
Receive 1. Choose the SMDI Sampler command from the

Sampler menu. If your SMDI sampler is properly
To receive a sample from the SMDI sampler click on the connected to the Macintosh SCSI chain, you will

sample in the list of samples that you wish to receive and see the SMDI Sampler Transfer dialog appear

press the Receive button. 2. Make sure the correct SMDI device is selected in

the SMDI Sampler pop-up menu.

To receive multiple samples from your SMDI 3.
Sampler; shift-click or F-click multiple destina-
tions in the list of samples and click the Receive
button. 4. Click the Receive button. Peak will transfer the

Click on a sample in the List of Samples that you
wish to receive.

sample you identified to the Macintosh and place
it into a new audio document window. Audio doc-
To send an audio document to your SMDI sampler: uments created by bringing sam pl es over from a
SMDI device are not saved until you use the Save
1. Choose Open from the File menu to locate and command from the File menu.

open the audio document you wish to send to 5. When you are finished, click the SMDI Sampler

your SMDI sampler. Alternatively, open the audio Transfer dialog’s close box or click the Cancel but-

document by double-clicking it in the Finder. won
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To browse through samples stored in your SMDI device:

*  (lick on a sample in the List of Samples. If your
SMDI device has a sample stored at this sample
number location, Peak will retrieve the informa-
tion about the sample including its sample rate,
size, bit depth, stereo/mono format, and loop
points and display the information in the Info area
of the SMDI Transfer dialog. If there is not a sam-
ple stored in the SMDI device with the sample
number, “(Empty)” will appear in the sample Info
area of the SMDI Transfer dialog.

SMDI Sampler Error Messages &
Troubleshooting

If a SMDI device cannot be found connected to your
Macintosh, Peak will display the message “No SMDI
devices could be found connected to this Macintosh.” If
this happens, and your SMDI device is connected to
your Macintosh with a SCSI cable, try the following:

*  Make sure your SCSI cables are properly connect-
ed. SCSI cables can come loose if they are not
tightened down using the cable’s connector
screws. Make sure you connect the SCSI cables to
your Macintosh only when it is turned off.

*  Make sure there is not another SCSI device con-
nected to your Macintosh using the same SCSI ID
as your SMDI device. Consult your SMDI device’s
owner manual for information on how to change
the SCSIID of your SMDI device.

*  You may need to turn on your SCSI devices in the
correct order. Turn all of the SCSI devices con-
nected to your Macintosh on first, then turn on the
Macintosh and launch the Peak application.

A note about the Yamaha A3000

Peak supports the Yamaha A3000 digital sampler. You can
access the A3000 sampler using either the Yamaha A3000
or SMDI menu selection under Peak’s Sampler menu.
Please note the A3000 cannot replace existing samples,
and any transfers to the A3000 will be placed in at the
next available empty sample in RAM, regardless of where
you instruct Peak to place the sample. When
“BulkProtect” is turned on, the A3000 does not respond
to SMDI messages. “BulkProtect” is at UTILITY mode,
MIDI function, Bulk page. BulkProtect is always ON after
you turn on the A3000, so you will need to turn it off
before you can do SMDI transfers.

You can access the Sampler Preferences from Peak’s
Preferences dialog to set Loop Offsets and Asynchronous
SCSI transfer.

Sampler Preferences

On sending loop positions to sampler,
offset by:
Loop Start: @

Loop End: o

On receiving loop positions from the
sampler, offset by:

Loop Start: O

Loop End: 0

'zl Asynchronous SCSI Transfers

o

The Sampler Preferences dialog

Conclusion

You have now learned how to import samples directly
from compatible samplers (to edit or process the audio
using all of Peak’s functions) and send the modified sam-
ples back to the sampler. In the next and final chapter,
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you will find detailed descriptions of every Peak menu
item.
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Chapter 11:
Peak Menus

This chapter explains each of the commands found in  pAuthorize Peak
Peak’s menus. For step-by-step instructions on imple-
menting these commands, refer to the index, and go to

This menu option will automatically take your contact

the appropriate chapter where use of the command is information from the OS X Address Book application,

covered. and fill out Peak’s Authorization screen. You will need to

enter your Peak serial number. Once submitted, your

information will be sent to BIAS, your copy of Peak will
be registered in your name, and your Product
Peak Menu Authorization Code will be returned to the email address
you specified in the Authorization screen.

Peak 4 (G4+)

About Peak...

Help 8/
Preferences...
Authorize Peak™...

Preferences...

Services > The Preferences command opens Peak’s Preferences dia-
Hide Peak 4 (C4+) %H log, which contains many of the customizable elements
;:giv c:\t:ers HH of the application. Preferences details are listed below,

for each category of Preferences found in Peak’s
Quit Peak 4 (G4+) 88Q

About Peak...

Preferences dialog.

Peak™ Preferences

( Colors... )
This menu shows information about the particular ver- G SEraER DRI m
sion of Peak you are using, including the exact version C__ Sending..

( Auditioning... )

number and your serial number.

Fade In Envelope...
Fade Out Envelope...
VST Plug-Ins Envelope...

Sampler Preferences... )

Hel p ( DSP Preferences... )

(" Playback Preferences... )

{ Shortcuts/Toolbar Preferences... )
This command will launch your web browser, and take € Windowreferences. )
you to the Documentation section of the BIAS website, (C pow-™Dither Preferences... )
where you can download manuals, tutorials, and access ( svereferences Now ) (@)
online technical support information. Peak’s Preferences dialog
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Colors

Peak allows you to customize the colors used to display
the elements in audio documents. You can use this dia-
log to set the background color, waveform color, and col-
ors for markers and loops. You can select either a preset
color combination, or individual colors for each element
in the audio document window, as well as picking your
own custom colors from a color palette. You can also
choose to have the waveform display shading for a 3-D
look, as well as select the amount of shading. Changes
made using the Colors dialog affect both the current
audio document’s colors, and any subsequent new audio
document’s colors. See Chapter 3 for more information
on this feature.

Document Colors

Theme  Custom _:]
Background M
Waveform M
Markers Yellow = }
Loops Red ,"_ﬂ
Regions | White 49

# Shadowed Waveforms
Selection Shading Intensity:

T
Vi s %

Cancel ) { Change Aily\ (Change)

Document Colors dialog

Scratch Disks

Because audio data can be very large, Peak utilizes a por-
tion of your hard disk’s free space to hold audio docu-
ments that have been cut or copied, as well as for tem-
porary or “scratch” files for undo purposes. If your hard
disk is short on space, you may not be able to cut, copy,

or modify large selections. If you have more than one
hard drive attached to your Macintosh, the Scratch Disks
command in the Preference dialog allows you to choose
the hard drives (or “scratch disks”) that you wish to use
for these temporary files. Peak allows you to select which
disk you want to have as your default, or “Primary” disk
for this purpose-usually you would select the disk that
has the most free space. If you are connected to a file
server, you can utilize available storage on the server by
clicking the Allow Servers checkbox. Any available
servers will then appear in the Scratch Disks pop-up
menu. This feature is recommended only if you have
access to a high speed Ethernet, Media Net, or other fast
server.

[6] Scratch Disks:

5325.5 MB free
2082.7 MB free

Big Momma

It #
® ™ & iMacDv

[ Reset ‘ @Allow Servers “Cancel \ K

Scratch Disks dialog

Blending

Blending is an automatic crossfade function with a user-
editable envelope. Peak can apply blending to areas of an
audio document when they are modified by cutting,
pasting or other editing processes in order to smooth
abrupt transitions between waveform amplitudes. It can
be very useful for creating a smooth transition between
edits that would otherwise sound too abrupt. If are
going to cut, paste, or insert audio into a document, you
may wish to enable blending to smooth things out a bit.
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It can be toggled on or off by choosing this command or
by clicking the Blend enable/disable button at the top
right of the audio document window. For detailed
instructions on how to use blending or how to edit the
blending crossfade envelope, see Chapter 5: Editing.

Blending

Duration: 100 ms

" Edit Blending Envelope... |

@ Linear Blend Calculations

“Cancel’ €0
The Blending dialog
Auditioning

Peak’s Auditioning command allows you to audition a
selection along with a specific amount of audio preced-
ing or following it. The Auditioning dialog allows you to
select a desired amount of Pre-roll or Post-roll when you
play the selection.

Auditioning
Preroll:
1.000000 seconds
Postroll:
1000000 seconds
(Cancel) HOKH)
The Auditioning dialog

Fade In Envelope

The Fade In Envelope command allows you to edit
Peak’s fade-in envelope. Fade-ins can be very useful for
smoothly fading into an audio document, or for fading
into one type of audio material from another. Very short
fade ins can also be useful for smoothing or removing
clicks and pops in a recording. The Fade In Envelope
dialog allows you to control the exact shape of a fade in
by providing you with user definable envelope controls.
For detailed instructions on how to create fade ins and
edit their envelopes, see Chapter 5: Editing.

Fade In Envelope
Current Envelope

{ Omsec, -100.000000% )

_Cancel ) ((Change)

Load... ) {save..) [ <--> ) { Reset )

Fade In Envelope

Fade Out Envelope

The Fade Out Envelope command allows you to edit
Peak’s fade-out envelope. Fade-outs can be very useful
for smoothly fading out of an audio document, or for
fading out of one type of audio material into another.
The Fade Out Envelope dialog allows you to control the
exact shape of a fade out by providing you with user-
definable envelope controls. For detailed instructions on
how to create fade out and edit their envelopes, see
Chapter 5: Editing.
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VST Plug-Ins Envelope

This command allows you to apply VST plug-in effects
gradually according to the envelope you create in the
Envelope Editor dialog. This is very useful for applying
effects over time.

VST Envelope

Current Envelope

{ Omsec, +64.17%108% )

Load... ) { save... (_Reset )

{Cancel ) ((Change)

VST Plug-Ins Envelope

Sampler Preferences

The Sampler command allows you to set an offset of one
sample, for those samplers that require it, as well as
choose SCSI preferences. See Chapter 10: Samplers, for
more on the Sampler Preferences dialog.

Sampler Preferences

On sending loop positions to sampler,
offset by:

Loop Start: | @
Loop End: 0

On receiving loop positions from the
sampler, offset by:

Loop Start: 0

Loop End: 0

@ Asynchronous SCSI Transfers

‘Cancel )

The Sampler Preferences dialog

DSP Preferences

Peak DSP Preferences allow you to set the size of the
“window” used in time shifting, and the quality of sam-
ple rate conversion.

DSP Preferences

Sample Rate Conversion Quality: 10 &l

v
J
(lower is faster, higher is better guality)
Time Shifting Window Size:
40 ms

10 15 20 25 30 35

30 ms

(lower is better for simpler monophonic sounds, higher
s better for more complex polyphonic sounds)

" Cancel |

The DSP Preferences dialog

Playback Preferences

Peak’s Playback Preferences dialog contains the follow-
ing controls:

Playback Preferences
Playback Master Volume:
)
0712 B4 5.8 7
32k %)

Use the lowest possible setting. Higher
settings will require much more RAM for the
Peak™ application. 32k or 64k should work for
most purposes.

Playback Buffer:

Window Buffer: 128k
This controls how much of the audio kept
cached in RAM. Increase if working with only a
few files at once for better performance, or
decrease if you work with lots of files.

( Cancel

Playback Preferences Dialog

Playback Master Volume

Peak provides a master volume control for audio play-
back. In the Playback Preferences dialog, set Peak’s out-
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put volume to the level that you desire by adjusting the
slider or entering a number value from 0 (silent) to 7
(loudest). If you are controlling your playback volume
with the volume control of your playback system, you
will most likely want to leave the output level set to 7.

Playback Buffer

Peak allows you to control the amount of RAM the pro-
gram uses when playing back audio documents. In gen-
eral, lower is better. A playback buffer of 32k is a good
place to start. If you are experiencing clicks in your play-
back, working with fragmented files, using processor-
intensive real-time DSP, or are using a slow hard drive,
you may need a larger playback buffer setting.

Window Buffer

Peak also allows you to control the amount of RAM the
program uses to keep audio documents buffered in
RAM. Use larger values if you are working with a few
large files, and smaller values if you are working with
many smaller files. Experiment to find the best settings
for your system and working style.

Shortcuts/Toolbar Preferences

Peak allows you to customize any Peak menu item with a
keyboard shortcut. To change your keyboard shortcuts,
go to the Preference menu and select the Shortcuts and
Toolbar item. Keyboard shortcuts are stored in a pref-
erence file in the directory

/Users/<YourUserAccount> /Library/Preferences/.

Peak’s default Keyboard Shortcuts are listed in Appendix 1.

You may also customize the Peak Toolbar using the
Shortcuts & Toolbar dialog. Just scroll to a function in
the dialog list, and use the checkbox to toggle the icon
on and off. This allows you to group only the items you
use most frequently on the Toolbar for easy access.

Shortcuts & Toolbar

Add...
Amplitude Fit... B
Audio Info...

Auto Snap To Zero
Auto-Balloon Help

Shortcut
| Shorteut Key:

& __ Option
[_Ishift [ Control

Auto-Impart Dual Maona
Bars[Beats

Batch Processor...

Bit Usage...

Bounce...

Burn Audio CD...

Capture Region To Playlist
Change Duration...

Change Gain...

Change Pitch...

Clear Clipboard

Close

Close All

Colors.. %
Compute File Max dB b

| crear )

Toolbar

_ Contextual Popup
| [_! Place in Toolbar

leon...

Toolbar Icon Size:
—————————————

The Shortcuts & Toolbar dialog

Customized Shortcuts & Toolbar are not available
in Peak LE

Customized Shortcuts & Toolbar are not available
in Peak DV

Window Preferences

Peak’s Window Preferences allow you to designate which
windows “float” above open documents. Use the
Floaters dialog to specify which windows (Transport,
Contents, Movie, or VST plug-ins) float or not.
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Also contained in the Window Preferences dialog is a
checkbox for Live Document Resizing. Live Document
Resizing scales an audio document’s contents when the
window is resized, allowing you to see the audio wave-
form’s size change as you change the size of the window.
A check in the Live Document Resizing box indicates that
the preference is turned on - an absence of a check indi-
cates that it is turned off.

Floaters

Check which windows you would
like to be floating windows (visible
above document windows):

# Movie Window
™ VST Plug-Ins

| Audio Document Window Live Resize

o

{ Cancel )

The Floaters dialog

POW-r™ Dither Preferences

Choose the POW-r Dither Settings from the Preference
dialog to adjust the settings for POW-r Dither.

If you use Save As command to save an audio document
to a lower bit depth (e.g., saving a 24-bit file to a 16-bit
file), be sure to enable the POW-r Dither checkbox. The
file will then be saved to the specified bit depth using
POW-r Dither according to the type of dithering selected
in the POW-r Dither Settings dialog.

pow-r™ Dither Settings

Choose dithering algorithm:

"Powr-3 3}
€

£ ~ 1\
[ Cancel

POW-r Dither settings dialog

Hide Peak

Temporarily puts Peak into the background, and hides all
windows. Peak can be brought back into the foreground
by choosing its icon from the Dock.

Hide Others

Temporarily puts any other open applications into the
background. This is a useful command if you have sev-
eral applications open, and want to focus on working in
Peak. Other applications can be brought back into the
foreground by clicking on their icon in the Dock.

Quit Peak

Choosing Quit Peak closes the Peak application. If you
haven’t saved changes to a currently open audio docu-
ment, Peak will prompt you to do so before quitting.

File Menu

This menu contains all of the standard Macintosh com-
mands for opening, closing, and saving files, as well as sev-
eral additional commands specific to the Peak application.

New

This command allows you to create a new Peak audio
document. When you choose this command, a submenu
menu appears which allows you to choose either a mono
or stereo format for the new audio document, or to cre-
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ate a Playlist document or a new audio document from
an open Playlist document.

New | 4
Open... %0
Close 8/W
Close All THW
Save As... 085

Save A Copy As... CH#S

Import CD Track...
Import Dual Mono...

Export Dual Mono...

Batch Processor...
Burn Audio CD...

class under tree - ms

beach - full moon

Will Johnson_Instrumental.aif
TraktorLoops_Kanzleramt_01.mp3
noiseharp50Hzhum.aif

06 Blue Monday (Manue#8B282.aif
90_funky groove

120_rock groove

Mono Document

Choosing Mono Document (38-N) creates a mono (one
channel) audio document.

Stereo Document

Choosing Stereo Document (Shift-38-N) creates a stereo
(two channel) audio document.

Document From Selection

Choosing Document From Selection (Option-N) creates

a new audio document from any selected audio in an
open audio document.

Playlist Document

Choosing Playlist Document (Shift-38-P) creates a new
Playlist document.

Document From Playlist

Choosing Document From Playlist (38-B) creates a new
audio document from an open Playlist document.

Open

The Open command (38-0) allows you to locate and
open an audio document. Peak can open audio docu-
ments in a variety of formats including AIFF, Sound
Designer I, WAVE, QuickTime, .dv, Raw, System 7
Sound, Sonic AIFF, Paris, JAM Image, AU, MP3, and MP4.
Peak allows you to have as many documents open at the
same time as RAM permits. The more free memory that
is available, the more documents you will be able to
open and work with simultaneously.

Open

From: |/ Audio ﬁ?

AIFF

A 01 Regress No Way.mp3

Traktor Lo...anzleramt
2 Untitled-1.mp3

Kind: Document
Size: 76.1 MB

% 44100.00Hz 16 bit Stereo AIFF
Duration = 00:07:31.027
Compression = raw

i

Go to:

open )

{ Add to Favorites ) { cancel )

The Open dialog
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Close

The Close command (38-W) closes the currently active
Peak audio document. If you haven’'t saved changes,
Peak will prompt you to do so before it closes the docu-
ment. If you have many documents open and don’t wish
to save any of the changes you've made, option-click on
the prompt dialog’s Don’t Save button.

Close All

The Close All command (Option-38-W) closes all open
Peak audio documents. If you haven't saved changes,
Peak will prompt you to do so before it closes the docu-
ments. If you don’t wish to save any of the changes
you’ve made, option-click on the prompt dialog’s Don’t
Save button.

Save

The Save command (38-S) saves the current audio doc-
ument. Peak can save audio documents in a variety of
audio file formats including:

* AFF: This is Apple’s Audio Interchange File
Format. It is also Peak’s default file format and is
supported by many Macintosh software applica-
tions.

*  Sound Designer II: This is Digidesign’s audio file
format for its digital audio products. Use this for-
mat if you wish to use an audio document in a
Digidesign audio application.

* wave: This is Microsoft’s Windows Audio File
Format. It is supported by many Window’s soft-
ware applications and some Macintosh applica-

tions. The WAVE format is best if you plan to use an
audio document in an application that supports or
requires WAVE format files.

*  Quicktime: This is Apple’s audio file format for
QuickTime-based multimedia. It is supported by
all Macintosh software applications that support
QuickTime. The QuickTime format is best if you
plan to use an audio document in multimedia
applications that support QuickTime, such as
Adobe Premiere™ or Macromedia Director ™.

*  Raw: This is the headerless raw file format that may
be useful for some game platforms.

*  System 7 Sounds: This the Apple audio file format
used for legacy Macintosh Operating System
Sounds.

*  Sonic AIFF: The file format used by Sonic Solutions
audio workstations.

* _paf: This is the file format used by E-mu’s Paris
audio system.

*  JAM image files: This is the JAM audio image file
format. JAM audio image files may be created in
Peak and used in Roxio JAM for burning audio CDs.
(See Chapter 6: Playlists & CD Burning for more
information.)

* _.au: This file format is commonly used on the
World Wide Web and in Java audio applets. It is
supported by many platforms and programs.

e mpP3: Saves audio as MP3 encoded audio.

Different formats allow different information to be
stored with the file. If you open a file created in a format
other than Peak’s default AIFF format, Peak will preserve
any format-specific information unless you save the file
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into a different file format. Saving a file in a different for-
mat than its original format, however, may cause some
information stored in the file to be discarded. For
instance, Sound Designer regions cannot be stored in
QuickTime, AU, System 7, or MP3 files; nor can copy-
right, author, or other file format-specific information be
saved in a format which doesn’t support it.

Save Audio Document

Save As: | BURIGH aif

Where: | | m @

Traktor Loops Kanzleramt

File Type: | AIEF
Eit Depth:

[%] @ auto Fite Type Extensions
16-bits %)

Compressor: [ None 8 ( options... )

(Cancel ) @isaves

The Save As dialog

Save As

The Save As (Shift-38-S) command allows you to save a
copy of the current audio document under a different
name, in a different location on your hard drive, or in a
different audio file format. The saved copy will become
the active open audio document.

You can save the document with a variety of audio com-
pression schemes. For detailed instructions on using this
feature, see Chapter 3: Peak Basics.

Save A Copy As

The Save A Copy As command (Option-38-S) allows you
to save a copy of the currently active open audio docu-
ment under a different name without replacing the
active open audio document.

Import CD Track

The Import CD Track command allows you to import
tracks from an audio CD. CD tracks imported to Peak will
be saved as AIFF files. For more detail on importing CD
audio with Peak, see Chapter 4: Playback & Recording.

Import CD Audio
0
(\g) Select Tracks To Import from this Audio CD...

2 60 Miles an Hour.aiff
3 Turn My Way.aiff

4 Vicious Streak.aiff

5 Primitive Notion.aiff

6 Slow Jam.aiff

7 Rock the Shack.aiff

8 Someone Like You.aiff
9 Close Range.aiff

10 Run Wild.aiff

 Track Name... ) (" Set Import Times... 3

/ Mark Al  Unmark All \ CUnmark (W'th@

Eg] Open tracks after import

i
. Cancel )

Import CD Audio dialog

Import Dual Mono

The Import Dual Mono command lets you import two
mono files and create an interleaved stereo file. Certain
audio applications, such as BIAS Deck, do not directly
support stereo interleaved files, and instead use “dual
mono” files, which comprise the right and left channels
of stereo material. Peak allows you to open such dual
mono files, and in the process creates a new stereo
audio document. Because Peak actually writes a new
stereo audio file to disk, this conversion process requires
hard disk space equivalent to the two original mono
files. For more information on opening dual mono files,
see Chapter 3: Peak Basics.
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Import Dual Mono is not available in Peak LE.

Import Dual Mono is not available in Peak DV.

Export Dual Mono

The Export Dual Mono command allows you to save a
stereo audio document as separate mono digital audio
documents. This feature is convenient if you intend to
use the audio document in a multitrack audio applica-
tion, such as BIAS Deck or Pro Tools, which does not
directly support stereo audio files. When you choose this
command Peak will prompt you to name both the left
and right sides with a Save dialog.

Export Regions

If you have placed markers or Regions in an audio docu-
ment, Peak’s Export Regions command allows you to
save each of these regions as a separate audio document.
This feature is very convenient if you wish to divide a
larger file into regions and transfer them as samples into
a sample playback instrument, or divide a live concert
record into regions and export those regions as separate
files. Furthermore, you can use Peak’s Batch File
Processor to process a file’s regions with any of Peak’s
DSP functions and third party plug-ins during the auto-
matic exporting of regions into new files. For more infor-
mation on exporting regions, see Chapter 5: Editing.

Export Regions

: Export Audio between Markers
_ Only Audio between Markers

® Ex port Regions

ontaining v in name.

Output Format

Stereo il

|44100.0000 | kHz

Format + Channels

16-bit T‘ Rate

Resulting doecuments contain:

Resolution
® Regions
) Markers
.. None
Output Directory

) Output to new windows

) Save To Disk
Source file directory ( Sel Path ) |

Name Prefix: 1 Crystalaiff __! Use Batch File Processor |

(cancel} (Begin )

The Export Regions dialog

Export Regions is not available in Peak LE.

Export Regions is not available in Peak DV.

Export as Text

If you wish to keep a text record of your Playlist, you may
export the Playlist into a new text document. The text
document will show names, times, crossfade times, and
gain levels of each Playlist Event.

Batch Processor

Peak’s Batch File Processor is one of the most powerful,
versatile, and useful features in Peak. Using the Batch
File Processor, you can integrate any series of Peak
processes (called a batch script), and apply these scripts
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to any number of audio files.

organization of your files. Audio documents opened
using the Open command from the File menu will not be

To use Batch File Processing, go to the File menu and  batch processed.

select Batch Processing. The Batch File Processor dialog

appears.
Batch File Processor
Input
) On  Batch processing is currently disabled. @ Process All Files
P _ Only Mono Files
®) off ) Only Stereo Files
Process
Available Processes: Selected Processes for Baich
Fade Out [- Fade In
Gain Envelope...  Add >> ) INoimalizes
Harmanic Rotate. Fade Out
ImpulseVerb... Feonemond
Insert i
Invert
MiX... e =
Modulate... Settings...
Moro To Stereo. @ Apply to entire file
Normalize... ~
Panner... (_ Apply just to first ‘sec
Dasta, O Apply just to last sec
(¥save Changes
(Set..) [ LogHFile...
File Name Suffix: |
( Load Script... ) ( Save Script... ) (Cancel) EOKD

Batch File Processor

Peak’s Batch File Processor is split into three areas:
Input, Process, and Save Changes. Sequence a series of
steps for Peak to execute in the Process section, then set
your output file settings in the Save Changes area. Once
Peak’s Batch File Processor is configured, you may turn
on the Batch File Processor in the Input area.

Once the Batch File Processor is configured and turned
on, any files you drop onto the Peak application’s icon
(or an alias) will be batch processed according to your
settings. You can even drop folders or disks onto Peak’s
icon and all of the supported audio contents will be
batch processed. You can continue to dropping files,
folder, or disks, onto the Peak icon for batch processing
while the Batch File Processor is turned on. All subfold-
ers within folders or disks you drag onto the Peak appli-
cation for Batch File Processing will be recreated in the
Batch File Processor’s output directory, preserving all

Batch File Processor is not available in Peak IE.

Burn Audio CD

Choosing the Burn Audio CD command will burn the
foreground audio document as an audio CD. If regions
are contained in the document, Peak will prompt you as
to whether these should be used to designate different
tracks on the finished audio CD.

Recently Opened Documents

Peak automatically remembers the last several audio
documents or playlists that you have opened and keeps
a list of these at the bottom of the File dialog. This allows
you to easily select a document’s name and reopen it
without having to search for it on your hard drive. Peak
can find and open a document even if you have changed
its location on your hard drive, too. And if you change
the name of the file, the next time you open Peak, Peak
will automatically update the name in its internal list.
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Edit Menu

This menu contains all of the standard Macintosh com-
mands for cutting, copying, and pasting, as well as sever-
al other commands specific to Peak.

Edits...

Cut #8X
Copy 8C
Paste ®/Y
Replace

Duplicate...

Insert €D
Insert Silence...

Silence 8E
Delete &
Delete except Audio &l
Crop %F5

Clear Clipboard

Select All #BA
Insertion Point at Selection Start 81

Insertion Point at Selection End 1

Set Selection...

Select Loop 8-

Previous Selection Rex:
Next Selection £r36-+

Undo

The Undo command (38-Z) undoes the last action that
you performed. Since Peak features unlimited undo and
redo capability, repeatedly choosing this command will
undo each action that you have performed on your
audio document. If you wish, you can continue undoing
actions until you return to the original state of the audio
document. When there are no actions left to undo, the
Undo command will be unavailable and appear grayed
Out.

Redo

The Redo command (38-Y) “undoes” the undo com-
mand. If you wish, you can continue redoing actions

until there are no items left to redo. In this case, the
Redo command will be unavailable and appear grayed
out. The only limitation in using the Redo command is
that if you insert a new action when a redo action is avail-
able, you will no longer be able to redo. In other words,
as soon as you perform an editing action other than
Undo, Redo is no longer available

Edits

The Edits command provides you with a second unique
and powerful “unlimited undo” feature. You can think of
the Edits command as a kind of “random access” undo
with a list of all your editing actions since you last saved.
Using this list, you can navigate back in time to the point
at which you performed a particular edit, and if you
wish, undo it. Once you have returned to an earlier state
in the project, you are free to start editing from that
point on, if you wish.

1 Crystal.alff Edits

= Mon Jul 2B 1
= Won Jul 28 18:37:50 2003
< Mon Jul 78 13:33:81 2003
= Mon Jul Z8 15:38:89 2003
< Mon Jul 28 1%:38:14 2003
< Mon Jul 78 18:38:26 2003
= Mon Jul 28 1

< Mon 21
« Won Jul
- Won Jul 28 1
= Mon Jui 78 1

: Goln Envelope from 90:00:00,962 to 09:00:41.969
* Mom Morkor ot @0:01:83 361

+ Pormer from 82:81:11.812 to #0:01:28.549
t Dalete audlo from BRIE1:27.074 to 02:01:41,376
: Bounce Plug-Ins from BO:B:27.979 to 0O:08:36 847

: Delete audia from BB:
© Masta Audio free
* Momolize from 80:

: Swop Chaneels from

The Edits dialog

Be aware that if you do go back to a past action and per-
form a different action at that state in the project, any
edits that originally followed will be gone and you won't
be able to redo them.
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Cut

The Cut command (36-X) cuts selected data from an
audio document and places a copy of it on Peak’s
Clipboard. Once you have cut a portion of an audio doc-
ument, you can paste it or insert it at another location in
the same document or a different document.

Copy

The Copy command (38-C) copies selected audio into
Peak’s Clipboard. Once you have copied a portion of an
audio document, you can paste it or insert it at another
location in the same document or a different document.

Paste

The Paste command (38-V) allows you to paste the con-
tents of the Clipboard into a location that you choose by
placing an insertion point. Pasting audio deletes any
selected audio and inserts the clipboard audio at the
insertion point.

Replace

The Replace command allows you to paste audio over
existing audio-to paste audio into an audio document
without pushing all data to the right of the insertion
point farther to the right (later in time) to accommodate
the newly pasted audio.

Insert

The Insert command (38-D) allows you to paste audio

into an audio document without overwriting any existing
data at the insertion point. When you paste data with the
Insert command, all audio to the right of the insertion
point or selection start is pushed farther to the right
(later in time) to accommodate the newly pasted audio.

Insert Silence

The Insert Silence command allows you to insert a spe-
cific amount of silence into an audio document at the
current insertion point. When you choose this com-
mand, Peak will prompt you to enter the amount of
silence you wish to insert. You can enter this value in
samples, milliseconds, or seconds. All audio occurring
after the insertion point is moved later in time by the
amount of the silence that you insert.

Insertion

Enter the duration of silence to insert:

5.575 seconds

Description

| Insert Silence will insert silent digital audio at the audio
document's insertion point. Enter the amount of silence |
you wish to insert at the insertion point.

|
€ ok )

F S
Cancel

The Insert Silence dialog

Silence

The Silence command (38-E) replaces the selected
audio in the audio document’s selection with silence.

Delete

The Delete command (the Delete key) allows you to cut
an audio selection without transferring it to the
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Clipboard.

Delete Except Audio

The Delete Except Audio command (Option-Delete)
allows you to easily remove all markers, region markers
and loops in the current audio document selection with-
out removing the audio.

Crop

The Crop command (38-") allows you to remove all
other audio from the audio document except the selec-
tion.

Clear Clipboard

Peak utilizes a portion of your hard disk’s free space to
hold audio that has been cut or copied. The Clear
Clipboard command allows you to free up disk space
occupied by the contents of the clipboard if you no
longer need the audio contained there.

Select All
The Select All command (88-A) selects all audio in the

audio document.

Insertion Point at Selection
Start/End

The Insertion Point at Selection Start command (Up
Arrow) places the insertion point at the beginning of a

selection. The Insertion Point at Selection End command
(Down Arrow) places the insertion point at the end of a
selection.

Set Selection

The Set Selection command allows you to precisely edit
the length, start and end times of an audio selection by
entering numerical values ion the Set Selection dialog.
Use the Units pop-up menu at the top of the dialog to
select the time units you want, and use the radio buttons
to select whether you want to affect the Start or End of
the selection.

Set Selection

Units: Min:Sec:ms ?}
Selection Start: 00:00:14 638
Selection End:  00:00:19.071
'D0:00:04.434 |

Selection Length:

@ Affects Start
O Affects End

“cancel

The Set Selection dialog

Select Loop

R

The Select Loop command (38-"-") will automatically
select the audio within the loop start and loop end mark-

ers, if you have defined a loop in a document.

Previous Selection/Next Selection

If you have made a selection in an audio document, then
made another selection, you can use Previous Selection
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(38-Left Arrow) to jump back to the previous selection.
You can then use Next Selection (38-Right Arrow) to
jump ahead again. This works for multiple selections.

Action Menu

This menu provides several commands for zooming in
and out of the audio document window, creating loops,
markers and regions, and navigating to specific locations
in an audio document.

Z2oom Out x|
Zoom In ®]
Increase Vertical Zoom ool |
Decrease Vertical Zoom ~l
Fit Selection OR]
Zoom Out all the way OR|
Zoom at Sample Level Q-
Zoom to Sample (End) O =
Snap Selection to Zeros

Loop this Selection oR-
Nudge Loop Backward e
Nudge Loop Forward =
New Marker M
Markers from Tempo...

New Region O R

Capture Region To Playlist 8K
Markers To Regions
Nudge...

Go To »

Loop Surfer™ ®x)
Guess Tempo...

Zoom Out

The Zoom Out command (38-[) zooms the waveform
view out allowing you to see more of the entire wave-
form, but in less detail. The Zoom Out command is use-
ful for obtaining a better “big picture” view of audio

material. To zoom progressively out from a waveform,
select this command repeatedly or press 36-[ repeatedly
on your computer keyboard.

Zoom In

The Zoom In command (38-]) zooms the waveform view
in so that you can view audio data in greater detail. The
Zoom In command is essential when you wish to select
and edit audio with great precision. To view a waveform
in progressively greater detail, select this command
repeatedly or press #8-] repeatedly on your computer
keyboard. Holding down the Option key while you make
a selection will zoom the waveform view in so that your
selection fills the audio document window after you
release the mouse button.

Increase Vertical Zoom

The Increase Vertical Zoom command (Control-Up
Arrow) makes the waveform “taller,” or increases the ver-
tical zoom. The Increase Vertical Zoom command is use-
ful for obtaining a better “big picture” view of quieter
audio material.

Decrease Vertical Zoom

The Decrease Vertical Zoom command (Control-Down
Arrow) makes the waveform “shorter,” or decreases the
vertical zoom.

Fit Selection

The Fit Selection command (Shift-38-]) will zoom the
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view so that your selection fills the audio document win-
dow.

Zoom Out All the Way

The Zoom Out all the way command (Shift-38-[) zooms
the audio document window to show an overview of the
entire audio document.

Zoom at Sample Level

The Zoom at Sample Level command (Shift-Left Arrow)
zooms the audio document window to the single-cycle
level, allowing you to view the waveform a single sample
ata time. This is useful for drawing on the sample with a
pencil tool, or fine-tuning loops and markers.

Zoom at Sample Level (End)
The Zoom at Sample Level (End) command (Shift-Right
Arrow) zooms the audio document window to the sin-

gle-cycle level and places the insertion point at the end
of the audio selection.

Snap Selection to Zeros

The Snap Selection to Zeros command will cause the
beginning and end of the current selection to move to
the nearest zero-crossings.

Loop This Selection

The Loop This Selection command (Shift-38-"-") auto-

matically creates a loop from the current selection by
placing loop markers on either side of the selection.
Since Peak supports a single loop per audio document,
choosing this command in a document with a loop
already defined will cause the loop markers to move to
the current selection.

Nudge Loop Backward

The Nudge Loop Backward command (Option-Left
Arrow) pushes, or “nudges,” the loop point backward.
This allows you to fine-tune the loop.

Nudge Loop Forward

The Nudge Loop Backward command (Option-Right
Arrow) pushes, or “nudges,” the loop point forward.
This allows you to fine-tune the loop.

New Marker

The New Marker command (38-M) creates a new mark-
er at the current insertion point in an audio document.
Markers are locations in an audio document that you
define as important. By marking specific locations in a
recording, you can navigate easily to a location for selec-
tion, editing or playback purposes.

Once you have defined a marker, you can assign or edit
a number of its attributes with the Edit Marker dialog
that appears when you double-click the marker. This dia-
log and the attributes contained within are explained in
Chapter 5: Editing.
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Edit Marker 1

Text:  URtitIEdMarREr2

Marker Position: 00:00:14.638 Min:Sec:... I'§ ]

@ Regular Marker
) Loop Start

@ Anchor To Sample

) Reference Marker
£ Loop End

Delete Marker ¢ cancel )

¢rord

The Edit Marker dialog

Markers from Tempo

The Markers from Tempo command will automatically
create reference markers at regular intervals based on
the tempo that is entered. To use Markers from Tempo,
you will either need to know the tempo of the audio
material you are working with, or you can use Peak’s
Guess Tempo feature to figure it out. Place Peak’s inser-
tion point in the waveform at the point you wish to have
the first marker placed. Designate whether you prefer to
have markers placed every Beat or Bar, and then indicate
the duration for which you wish to have markers placed.
Peak will place markers either for the duration of a
selected range of audio, or you can enter a specific value.
Click OK to create markers. Markers from Tempo is
described in more detail in Chapter 5: Editing.

When working with audio material with a pro-
nounced beat, it’s best to place the insertion point
Just before a downbeat. This ensures that all fol-
lowing reference markers will also be placed just
before beats for the duration you choose.

New Region

The New Region command (Shift-38-R) defines a selec-
tion as a new region and adds it to the Regions menu.
Locate a region by double-clicking the name of a Region
in the Contents Palette or Contents Drawer. The audio
document will automatically scroll to display the select-
ed region, and the region will become the current selec-
tion in the audio document. For more detail on using
Regions in Peak, see Chapter 6: Playlists & CD Burning.

Capture Region to Playlist

The Capture Region to Playlist command (38-K) will cre-
ate a region based on a selection made in an audio doc-
ument and automatically enter it into a Playlist. This fea-
ture is very useful when you need to quickly create
regions that will also be used immediately in a Playlist.

Markers to Regions

The Markers to Regions command will convert any mark-
ers ina selection to Regions. If you make a selection con-
taining two markers, they will be converted to one
Region with the name of the first marker. If you make a
selection containing three or more markers, the markers
will be converted to contiguous, butt-spliced Regions.
For example, if you have three markers named “Foo 17
“Foo 27, and “Foo 3” and select them and apply Markers
to Regions, the resulting two regions will be named “Foo
17 and “Foo 2"-wherein the first marker has become the
begin Region marker of Region “Foo 17, the second
marker has become the end Region marker of Region
“Foo 1" and the begin Region marker of “Foo 2”, and the
third marker has become the end Region marker of
Region “Foo 2.

Chapter 11: Peak Menus

199




Alternatively, hold down the option key down when
selecting the Markers To Regions command to make
each marker a region that ends at the next marker.

Two Regions named “Foo”

Nudge

The Nudge command allows you to nudge all markers,
loops and regions in the current audio document selec-
tion by the number of seconds entered in the Nudge
Markers dialog. Type either positive or negative num-
bers, and Peak nudges the marker by the value you
entered in the dialog.

Nudge Markers
Nudge markers by...
245 seconds

Description

Nudge markers slides all markers, loops, and regions in
the current audio selection by the specified amount of
time. Use this feature to move several markers forward
or backward in time.

The Nudge dialog

Go To

The Go To command (38-G) allows you to quickly and
precisely navigate to a the start or end of a selection, the
start or end of a loop, a specific marker, or a specific time
location in an audio document. This command is essen-
tial for speedily locating any of these important locations
in an audio document. Choosing the Go To Time com-
mand allows you to enter the exact time location that
you wish to navigate to. In addition, the Location sub-
menu lists all markers, regions and loops.

Go To Time
Enter the time to go to:
6.794 seconds

Description

Go To Time moves the audio document's viewing area
to the time entered above. It also places the insertion
point at this time. Enter the time in the audio
document that you wish to go to.

The Go To Time dialog

In addition, the Location submenu lists all markers,
regions and loops.
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Selection Start
Selection End
Loop Start
Loop End

Loop Surfer™ £

The Go To Location submenu

Loop Surfer

Peak’s Loop Surfer feature (38-]) automates some of the
steps for setting up loop points. Loop Surfer allows you
to “Loop Surf” (adjust your loops during playback)
quickly, easily and in a musically intuitive manner.

Loop Surfer™
Number of beats:

8 beats

] Use Selection

Tempo Calculator
The selection is...

1 barsand 0 beats
with a time signature of... ]
The tempo is : 66.071 4

(Cancel\, { Make Loop ) GStar'r-Sui'ﬁn'g‘)

The Loop Surfer dialog

If you're working with music, and know the music’s
tempo in beats per minute, you can use Loop Surfer to
create a loop which lasts for a rhythmically “correct”
length of time. For more detail regarding Loop Surfer,
see Chapter 5: Editing.

Loop Surfer is not available in Peak LE.

Loop Surfer is not available in Peak DV.

Guess Tempo

If you are working with music and don’t know the
tempo-and your music has a relatively pronounced or
obvious beat-you can use the Guess Tempo command to
have Peak automatically guess the tempo of a selection.
Make a selection and choose Guess Tempo from the
Action menu. There will be a pause while Peak scans
your selection and calculates the tempo for you. A dialog
will then appear showing you the estimated tempo in
BPM, or beats per minute. You can then enter the esti-
mated tempo in BPM in the Loop Surfer dialog’s Tempo
field or in the Audio Information dialog’s Tempo field or
press the Loop It button to create a loop at the current
insertion point with the detected BPM.

Audio Menu

Stop+Rewind &2
Play+Pause

Play Selection

Play with Auditioning

Stop & Extend Selection 2
Fast Forward

Record SR
Record Settings... R
Sound Out 3
Hardware Settings...
Meters...
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The Audio menu contains commands for playing back
and recording audio, as well as configuring Peak’s
Recording Settings, your audio hardware, and Peak’s
Meters.

Stop/Rewind

The Stop/Rewind command (Return) stops playback and
places the insertion point at the beginning of the audio
document.

Play/Pause

The Play/Pause command (Spacebar) starts playback of
the audio file from the insertion point or pauses play-
back.

Play Selection

The Play Selection command plays only the selected por-
tion of an audio document.

Play w/Auditioning

The Play w/Auditioning command (38-Spacebar)
plays the selected portion of an audio document with
pre-roll and post-roll. The pre-roll and post-roll times
are designated in the Auditioning dialog in the
Preference dialog.

Stop & Extend Selection

The Stop & Extend Selection command stops playback

and extends any selection from the point at which play-
back was initiated. The Stop & Extend Selection com-
mand can also be used to start playback from the inser-
tion point or selection start.

Fast-Forward

The Fast-Forward command places the insertion point at
the end of the audio document.

Record

The Record command (38-R) opens the Record window.
This window allows you to start and monitor recording.

When you select Record from the Audio menu (38-R),
Transport, or Toolbar, the Record dialog appears. There
are transport buttons-Record Settings, Pause, Stop, and
Record-along the bottom, an Audio Source display that
shows you the waveform as it is being recorded, and a
Notepad window. The sample rate, bit depth, and num-
ber of channels you selected in the Record Settings dia-
log are also displayed, along with the amount of time
you have available to record on the selected Record Disk
with the recording settings you have chosen.

Record
Audio Source Display H:ﬂ

__ Notepad __ Notepad regions, not markers

Recerd 16-bit 44100Hz Stereo SD 1 file.

Rec Time Left: 09:46:59.703 - 'T‘

The Record dialog
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The Notepad feature in the Record Dialog allows you to
type in text descriptions, transcribe a recording, or type
in comments called Notepad Cues at specific points dur-
ing the recording of an audio document. The Notepad
feature is available from the Record dialog and may be
used once a recording starts. For more information on
Notepad Cues, please see Chapter 4.

Notepad Cues are not available in Peak LE.

@ Notepad Cues are not available in Peak DV.

Record Settings

When you select Record Settings (Option-R) from the
Audio menu or Toolbar, the Record Settings dialog
appears. This dialog is used to configure your settings
for recording with Peak.

Record Settings

Record Disk
Recording Type

%] File Format

Largest drive  ©'§
Uptions

Sound Des... T‘_!

|
| (Device and sample Format... ) | |

| P n N | ] Monitor

i __ Hardware Settings... (I Split Stereo Files

| | _IAppend to document
I | []Record timer...

|

L

} @.Open after saving

The Record Settings dialog

You will notice several pop-up menus, buttons, and
checkboxes in the Record Settings dialog. These allow
you to select which hard drive to record to, what file for-
mat you'd like to record in, sampling rate, source input,
and so on. You may also wish to record through VST
plug-ins. The next few paragraphs describe how to set all

of these parameters using the Record Settings dialog.

Record Disk

The Record Disk pop-up menu allows you to choose
which hard drive you would like to record to. If you have
more than one hard drive connected to your Macintosh,
use this pop-up to select your record drive. (This option
will default to the largest drive currently available to your
Macintosh unless you select otherwise.)

File Format

The File Format pop-up menu allows you to select the
file format for the incoming audio. You can choose from
AIFF or Sound Designer II. (If you need the newly
recorded audio file to be in a different format, use the
Save As function to save it as a another format once
recording is complete.) If you do not select a file format
for recording, Peak will default to AIFF.

Auto Gain Control checkbox

The Auto Gain Control checkbox allows you to disable
the Automatic Gain Control feature used by the Apple
0S X Audio HAL system with some Macintosh micro-
phone inputs. Auto Gain Control adjusts input gain auto-
matically to get maximum recording levels. If the record-
ing device you are using supports this feature, check the
Auto Gain Control checkbox.

Monitor checkbox

The Monitor checkbox allows you to monitor the audio
source while you are recording.
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Split Stereo Files checkbox

The Split Stereo Files checkbox allows you to record the
incoming stereo audio as dual mono files rather than a
single stereo file. Dual mono files are used in programs
like Digital Performer, Pro Tools, or BIAS Deck, so this
option is useful if you need to record dual mono files
(i.e., split stereo).

Append to document checkbox

The Append to document checkbox allows you to record
into an existing audio document. To record into an exist-
ing audio document, place the insertion point in the
existing audio document at the point where you want to
insert the new audio. If the insertion point is at the
beginning of the file, the newly recorded audio will be
inserted at the beginning of the file. If the insertion point
is at the end of the file, the newly recorded audio will be
appended to the end of the existing file. If the insertion
point is somewhere in the middle of the file, the newly
recorded audio will be inserted at that point. If you make
a selection, the Append to document feature will allow
you to replace the selection with newly recorded audio
from the beginning of the selection through the end of
the selection or wherever you stop the recording.

Record timer checkbox

The Record timer checkbox allows you to designate a
specific duration for recording. Peak will stop recording
after this set time and bring up the Save dialog for your
audio recording. Checking the Record timer checkbox
will bring up the Recording Time dialog. In the
Recording Time dialog, designate the duration for
recording in seconds and click OK.

Recording Time

Record for:

s

Description |

You can instruct Peak™ to record for a
specified number of seconds by typing |
into this dialog. For example, type 600

for 10 minutes of recording. Peak will

stop the recording after this duration of
audio has been recorded.

The Recording Time dialog

Open after saving checkbox

The Open after saving checkbox determines whether
the audio document is opened in Peak after it is record-
ed.

Device and Sample Format

Clicking on the Device and Sample Format button will
open a different dialog depending on which audio
engine Peak is using (i.e, Mac OS X Audio HAL,
CoreAudio, or FireWire DV).

Hardware Options

Clicking on the Hardware Options button in the Record
Settings dialog brings up a dialog for the audio hardware
you selected in the Source dialog. Note that in many
instances there may be no settings for a given device
(including the Apple BuiltIn Sound!). Some sound
card’s drivers have control panels or utility applications
that will launch when you click on the Hardware Options
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button. The actual third-party dialog will differ depend-
ing on the type of audio hardware you have.

Record Through VST Plug-In

If you have VST plug-ins installed in your system’s VST
Plug-Ins folder, you can record through them in real-time
when using CoreAudio. This is useful if you want to use
anoise reduction, equalizing, or dynamics plug-in during
recording.

For complete instructions on recording audio in Peak,
please see Chapter 4.

Hardware Settings

The Hardware Settings command brings up a dialog for
the audio hardware you selected in the Source dialog.
Note that in many instances there may be no settings for
a given device (including the Apple Built-In Sound!).
Some sound card’s drivers have control panels or utility
applications that will launch when you choose Hardware
Settings. The actual third-party dialog will differ depend-
ing on the type of audio hardware you have.

Meters

The Meters command opens the Meters dialog, which
allows you to configure the Meters display. Using the
Meters dialog, you can select the Peak Hold time and the
Clip Indicator Hold Time. The Peak Hold indicators
appear as yellow bars at the far right of each of the bar
graphs, and selecting a hold time causes the indicator to
pause for easy reading of the peak value during playback.
The Clip Indicators appear as red bars at the far right of

each of the bar graphs, and are triggered when audio dis-
torts, or “clips”, and selecting a hold time causes the
indicator to pause for easy reading of any clipping or dis-
tortion that occurs during playback. Setting the Peak

Meters

Peak Hold Time: Clip Indicator Hold Time:

_) None () None
'ES 3 Seconds f;} 3 Seconds
_ Infinite ) Infinite
( cancel ) f OK %

The Meters dialog

Hold and Clip Indicator Hold Times to None turns these
features off.

DSP Menu

Add...

Amplitude Fit...
Bit Usage...
Change Duration...
Change Gain...
Change Pitch...
Convert Sample Rate...
Convolve...
Crossfade Loop...
Fade In

Fade Out

Find Peak

Gain Envelope...
Harmonic Rotate...
ImpulseVerb...
Invert

Loop Tuner...
Mono To Stereo...
Stereo To Mono...
Mix...

Modulate...
Normalize...
Panner...

Phase Vocoder...
Rappify...

Remove DC Offset
Repair Click
Repair Clicks...
Reverse Boomerang...
Reverse

Swap Channels
Threshold...
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This menu contains Peak’s DSP-based audio processing
and advanced editing tools. A complete description of
Peak’s DSP functions and instructions on how to use
them are given in Chapter 7: DSP.

Add

The Add command adds any selection of audio copied to
the clipboard into the audio document at the selection
point. To use the Add command, you must first copy a
selection of audio. The copied material can then be
mixed into the target audio material. To add copied
material with a variable level, click the envelope button,
create the desired envelope, and then click the Change
button, and then click the Add button. Be careful not to
adjust too high an amount which can potentially clip the

signal.
Add
Amount of clipboard to add in:
P e b e | i
Description
The add operation adds the clipboard I
samples into the audio document at the |
selection point. Choose the level of the |
clipboard samples you wish to add into
the audio document. ‘
(cancel) ( Envelope... ) @W@l@”@
The Add dialog

Add is not available in Peak IF.

Add is not available in Peak DV.

Amplitude Fit

Amplitude Fit provides granular normalization of an
audio selection on a grain-by-grain basis. Grains are small
groups of samples, often around 30ms. As each grain is
read in, it is normalized according to the Amplitude Fit
Envelope-each normalized grain crossfaded with the
previous grain and written out as the result. Amplitude
Fit can be used to maximize the volume level of an audio
selection, or to make quiet passages as loud as louder
passages.

Ampdiluce Fil Erreslops
Cuimenl Erreeiope )

I M e | ~10W DT |

Losd... S e

The Amplitude Fit Envelope editor

Amplitude Fit is not available in Peak LE.

Amplitude Fit is not available in Peak DV.

Bit Usage

The Bit Usage meter allows you to monitor bit satura-
tion, degradation, and the “true” bit depth of a file.

To use the Bit Usage meter:

1. Select the desired range of audio you wish to
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examine.

2. Choose Bit Usage from the DSP menu - The bit
usage meter will appear, and plot a graph showing
the status of bit usage in the selected area of audio.

Change Duration

The Change Duration command allows you to slow
down or speed up the selected material by a specified
amount without changing its pitch. You can specify the
change in duration by a value in seconds, a percentage of
the original, or, for rhythmically-oriented material, beats
per minute. A change in duration by a reasonable
amount, about 85% to 115%, can be very convincing.
Exaggerated time stretching, 200% or more, can result in
some very interesting granular textures. Try experiment-
ing with the Change Duration function on drums,
rhythm loops, speech, sampled instruments or sound
effects to achieve a wide variety of useful effects.

r "

Change Duration

@ | SENEBSN seconds

oo percent of original length

0 New Tempo: 1700000 bpm

1 bars a beats

Oid Tempo: 1200000 bpm

1 bars a bears

) Advanced...

€ o)

il LY i
Cancel Prefs

The Change Duration dialog

Change Duration is not available in Peak LE.

Change Gain

The Change Gain function changes the gain (i.e., ampli-

Change Gain
Ertar a scaling facwar far the change gain
—— [ B

e scriptiaan
Change Cain chistges the valume of th Fehd
o et ction. Choos e amount you wish o
thange ¥ wsang A ezl bow above
T i €lip@ing the sam e Chpquard
checkbo below.

_ Clipguard

Cancel

o)

The Change Gain dialog

tude) of a selection. You can specify the amount of gain
change either in decibels (dB) or as a percentage. If you
wish to double the volume of a sound, you must apply
approximately 6 dB of gain change, or add 200%. Enable
the Clipguard checkbox in the Change Gain dialog to
protect against the possibility of clipping. Clipguard will
search through the audio document or selection for the
maximum peak in amplitude, and then limit the Change
Gain slider’s range based on the maximum peak it finds
in the audio document or selection.

Change Pitch

Peak’s Change Pitch function allows you to alter the
pitch of an audio selection by as much as an octave. The
Change Pitch dialog uses a pitch slider that allows you to
choose a new pitch by musical interval, and “fine tune”
the pitch change by smaller increments called “cents.”
(Cents are divisions of a musical octave-one octave is
equivalent to 1200 cents-thus, 100 cents is a semi-tone,
50 cents a quarter-tone, etc.) You can also choose to alter
the length, or duration, of the selection just as you
would by slowing down or speeding up analog tape, or
you can choose to preserve the duration of the selection
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(something not possible with analog tape!). You can
even preview the pitch change by clicking on the Play
button at the bottom of the Change Pitch dialog.

Change Fiich
Irfterval
Eva M7 ME PSP UYoM2 0N MERE I OME MT B
i
Lhange Pich by 200 Lenix
Firre: Tang.
5 -5 E 180 Gerta
FneTuse by -1 Cinls
i eperruns D atian

Carcd )

The Change Pitch dialog

@ Change Pitch is not available in Peak LE
@ Change Pitch is not available in Peak DV

Convert Sample Rate

The Convert Sample Rate command allows you to
change the sample rate of a sound without changing its
pitch. This feature is very useful for converting audio
material into lower or higher sample rates as required by
other applications. Please note that sample rate conver-
sion is applied to an entire document. It cannot be
applied to just a selection within a document. Refer to
Chapters 3 and 4 for an explanation of commonly used
sample rates.

©

Peak IE is limited 1o a maximum sample rate of
96kHz

Peak IE is limited to a maximum sample rate of
96kHz

&

Convolve

The Convolve command is a unique and powerful sound
design tool that allows you to apply the sonic (e.g., spec-
tral) characteristics of one sound onto another.
Convolution works by multiplying the frequency spec-
trum of the impulse contained in the clipboard and that
of the target audio document, reinforcing the frequen-
cies that are in common between the two. To use the
Convolve DSP command, you must first copy a selection
of audio. The copied material will provide the spectral
“character” that you will apply to the target audio mate-
rial.

@ Convolve is not available in Peak LE.
@ Convolve is not available in Peak DV.

Crossfade Loop

The Crossfade Loop function applies a “smoothing”
effect to loops made in Peak audio documents.
Crossfade Loop fades the end of the loop into the begin-
ning of the loop to make the loop sound smoother. (It
uses the Blending envelope you've set in Peak’s
Preference dialog 's Blending dialog.) Use the Crossfade
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Loop dialog to select the length of the crossfade in mil-
liseconds.

Crossfade Loop

Loop Start

Loop End

Duration for crossfade(s) :
100 ms [ Envelope...

IET Logarithmic

€ o)

" Cancel

The Crossfade Loop dialog

©
&

Crossfade Loop is not available in Peak LE.

Crossfade Loop is not available in Peak DV.

Fade In & Fade Out

The Fade In and Fade Out commands allow you to apply
an amplitude envelope to an audio selection. The Fade In
and Fade Out DSP commands, and the Fade Envelope
Editor dialog are described in detail in Chapter 5: Editing.

Find Peak

The Find Peak operation will place the insertion point at
the sample with the maximum amplitude value that it
locates in the audio selection.

Find Peak is not available in Peak LE.

@ Find Peak is not available in Peak DV.

Gain Envelope

The Gain Envelope operation allows you to enter an
amplitude envelope to be applied to an audio selection.

The selected audio’s amplitude will be boosted and/or
attenuated according to the envelope you draw in the
Gain Envelope editor.

Luairi Ervesd oz

The Gain Envelope dialog
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Harmonic Rotate

The Harmonic Rotate tool is excellent for sound design
experimentation. This command allows the frequency
spectrum in a selected range of audio to be rotated
around a horizontal axis, which has the effect of taking
frequencies that were previously associated with one
section of a file with a particular amplitude, and assign-
ing them to different areas of audio with different ampli-
tudes. The Harmonic Rotate command can be pre-
viewed in real time, so that desired setting can be found
before spending time processing. Options for process-
ing include checkboxes for using Real & Imaginary cal-
culations, and a slider & text field to set amount of rota-
tion.

Harmunic Rolale

LI

EET
™ Real o Imagirary " Preview
" Canrel ) F or

The Harmonic Rotate dialog

Harmonic Rotate is not available in Peak LE.

@ Harmonic Rotate is not available in Peak DV.

ImpulseVerb

ImpulseVerb is an extremely high-quality reverb process-
ing tool, that utilizes actual reverb impulses recorded in
real spaces, such as performance halls, catherdrals,

caves, and other spaces that have various reverberation
qualities. The same convolution technology that is used
in Peak’s Convolve DSP tool allows these natural reverb
impulses to be applied to dry audio signals, giving the
impression that a file was actually recorded in a particu-
lar environment. ImpulseVerb offers real time preview,
so that the ideal settings can be found before processing.
In addition, ImpulseVerb offers an editable Space enve-
lope, which controls reverb length and decay character-
istics, and a Wet/Dry slider to control the amount of
reverb being applied.

impulsevers™

Spaca. dranialsnl. il

Wt

oy

T Spee e Ermvelup...

" Frosize

{ Cancel 1}

The ImpulseVerb dialog

The ImpulseVerb dialog can also be used as a real
time convolution tool, and is not limited to using
impulse response files to create reverb effects. Any
selection that is copied 1o the clipboard can be
convolved with the selected range of audio. To
add audio files to the Space pop-up menu within
the ImpulseVerb dialog, simply save the desired file
as a 24-bit Sound Designer Il format file, and
place into the Peak Impulses folder within
/Macintosh HD/Users/Library.

ImpulseVerb is not available in Peak LE!

©
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two zoom buttons-magnifying glass icons-in the upper
left of the Loop Tuner dialog allow you to adjust the ver-
ImpulseVerb is not available in Peak DV! tical zoom up of the waveform. The two zoom buttons in

the lower left hand corner of the Loop Tuner dialog

allow you to adjust the zoom view in and out all the way

down to the sample level. You can listen to the effects of
Invert the adjustments as you make them by clicking on the
The Invert function allows you to invert the phase of a Play button. To exit this dialog, click on OK to accept the

selection or an entire audio document. changes, or Cancel to leave the original loop unaffected.

Loop Tuner is not available in Peak LE.

Loop Tuner is not available in Peak DV.

Loop Tuner

Peak’s Loop Tuner provides a way to visually line up the

start and end points of your loop and listen to the effects
of these adjustments as you make them. The waveform

display in the Loop Tuner dialog shows the Start and End M To S M
points of the loop, which you can visually adjust with the ono To Stereo/Stereo To Mono
scroll bars at the bottom of the window to achieve a nat-

ural transition at the loop point by carefully adjusting the These two DSP commands may be used to easily convert

slope alignment. an audio document between one and two channel for-

mats.

Mono to Sterec Conversion

Pan

= ., m

Description

You are converting a mong audio dipping

into a stereo audio clipping. Choose the
left vs. right level of the resulting stereo

A clipping

Carics Ay L ]

The Loop Tuner dialog

Cancel f 0K *
The arrows of the slider will move the loop markers sam- ~ Mono to Stereo Conversion dialog
ple by sample and clicking in the body of the slider will
move the loop markers to the next zero crossing. The
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Stereo to Mono Comversion

-«

Description

You are converting a stered audio dipping
into a mono audio clipping. Choose the
left vs. right mix level of the stereo
clipping to use

Stereo to Mono Conversion dialog

Mono 1o Stereo/Stereo To Mono is not available in
Peak LE.

Mono 1o Stereo/Stereo To Mono is not available in
Peak LE.

While automatic Mono 1o Stereo/Stereo To Mono
conversion is not available in Peak LE & DV, you
can achieve the same end result manually, by
selecting all in an open mono or stereo document,
and then opening a new, empty document. If you

copy an entire document, open a new empty doc-
ument, and attempt to paste in the contents of the
clipboard, Peak will detect if there is a different
number of channels, and will prompt you to enter
a Left/Right panning value, and will then allow
you lo paste in the clipboard contents.

Mix

The Mix command allows you to mix material that you
have copied to the clipboard with a target selection. This
function can be used as a kind of “sound-on-sound”
capability for mixing audio tracks together, or for blend-
ing sound elements. The Mix command is similar to the
Add command, but it does not have the potential to clip
because the target and clipboard contents are attenuat-
ed before mixing. To use the Mix command, you must
first copy a selection of audio. The copied material can
then be mixed into the target audio material.

Mixer

Amount of clipboard 1o mix in;

e |
%

Description

The mix operation mixes the clipboard

samples inte the audio decument at the
selection point. Choose the level of the
clipboard samples you wish to mix into
the audio document.

FCancel ™ Envelope... } f’ 0K "}

The Mixer dialog

Modulate

This Modulate command functions as a “ring modulator”
which multiplies two audio signals together (e.g., the
material copied to the clipboard and the currently select-
ed audio). The resulting audio includes the sum and dif-
ference tones of the frequency components of the mod-
ulated audio and the modulating audio. These are gen-
erally very complex timbres that often have a “metallic”
(i.e., inharmonic) character to them.
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Modulator
Amount of clipboard to modulate in

—— — 3B ¥

Description

The modulate operation performs a
synthesis multiplication using the
dlipboard contents. Choose the level of
modulated samples you wish to mix in to
the audio document.

ok )

Cancel 3

The Modulator dialog

Modulate is not available in Peak LE.

Modulate is not available in Peak DV.

Normalize

This command allows you to optimize the volume of a
selection or an entire audio document so that it is at its
maximum possible amplitude without clipping.

r "

Normalize

Enter amount of normalization

———{ ¥ = ¥

Description

The normalize function allows you o
control the gain of the audio document's
selection to the maximum level without
clipping (digital distortion). You may
enter a percentage from the maximum
amglitude that you wish the telaction o
be normalized 1o.

Cancel 3

The Normalize dialog

The normalize function is very useful for boosting the
volume of material that was recorded at too low a level,
or if used on multiple audio documents, for making sure
that the amplitude of each of the documents is uniform.

Panner

The Panner allows you to adjust the panning, or left-to-
right movement, of a stereo document by drawing an
envelope in the Panner dialog. Left is at the top of the
graph, and right is at the bottom.

E‘-\..'l.p Wi Consiant

Ciifrent E2vcloge ¥l

I AN e, =1 AT

Lonc Y [ Suwm.. c--= 1 Reser Y [ Cancel ) (FCRangEl

The Panner editor dialog

Panner is not available in Peak LE.

Panner is not available in Peak DV.

Phase Vocoder

The Phase Vocoder is a type of audio spectrum analy-
sis/resynthesis that allows you to modify the duration
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and/or pitch of an audio selection.

Phase Vocoder

Phase Vocoder
Change Duration:

EENSE| ceconds

Change Pitch:

P8 the pitch by

J Cents

Raise
Mone

Analysis settings:

Num Bands: 8192 |8
FFT Size: 024 19
Cancel o )

The Phase Vocoder dialog

Phase Vocoder is not available in Peak LE.

Phase Vocoder is not available in Peak DV.

Rappify

The Rappify command applies extreme dynamic filtering
to a selection. As one Peak user described it, “Rappify
can turn your hi-fi into lo-fi!”

Rappify

Enter amount of effect

—_—
o

SE— <

Description

The rappify operation mixes in a filvered
version of the audio document's selection
into the audio document. Choose the
amount of rappified samples you wish to
mix into the audio document.

o)

F e Y
Cancel

The Rappify dialog

If the target material has a pronounced beat, this has the
effect of reducing the material to its most essential rhyth-
mic components. Try using this function with a variety of
different music material for some surprising and exciting

results.
Rappify is not available in Peak LE.
Rappify is not available in Peak DV.
Repair Click

The Repair Click command will eliminate a selected click
or “spike” in the waveform using the setting designated
in the Repair Clicks dialog (explained next).

Repair Click is not available in Peak LE.

Repair Click is not available in Peak DV.

Repair Clicks

The Repair Clicks command allows you to find and
repair pops or clicks in an audio document. The Repair
Clicks dialog automates the process of finding and
removing clicks (usually indicated by a sharp “spike” in a
waveform), much like a search and replace dialog in a
word processor.
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The Repair Clicks operation works by looking for dis-
continuity from sample to sample. For example, a sam-
ple value of -100 followed by a sample value of 10,000 is
likely to be a click. Once the area of the click is identified,
a smoothing technique is used to maintain the original
shape of the area being repaired.

If you are working with mostly digitally induced clicks,
the Repair Clicks dialog will become an indispensable
tool. Extremely damaged signals such as those of a
scratching and popping vinyl record will require more
careful repair in addition to using the Repair Clicks dia-
log, such as Change Gain, Delete, and the Pencil Tool.
Clicks such as those of a scratching and popping vinyl
record loose their detectability once they are sampled
using Analog to Digital converters.

ErpoarCloke
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The Repair Clicks dialog

Smoothing Factor

Smoothing Factor determines how much smoothing is
applied to the click. Material with high frequency infor-
mation may require lower smoothing factors to preserve
the high frequencies. In general, a setting of 40-60 per-
cent will repair most clicks.

Detection Setting

The Detection Setting value determines how the clicks
are located. Higher values locate only the most severe
clicks, while lower values will detect less severe clicks.
Note that lower values such as 10% also have a greater

chance of misjudging audio for a click. In general, a set-
ting of 40-80% works well.

Repair Size

The Repair Size setting affects how many samples
around the click are used in determining the new shape
of the repair. Repair size can vary from 5 to 100 samples,
with a repair size of 50 samples working well in most cir-
cumstances. Peak will then interpolate what the correct
waveform should be, and repair the click.

Buttons along the bottom of the Repair Clicks dialog
allow you to control repairing, auditioning, and undoing
click repairs:

*  Click the Repair button when you wish to repair a
click found by the Next Click button.

*  Use the Next Click button to search for the next
potential click in the audio selection.

*  Once a click is located, you may listen to the click
using the Audition button. The Audition button
plays the click using the Pre-roll and Post-roll set-
tings from the Auditioning dialog under the
Preference menu.

¢ If you repair a click and are unsatisfied with the
results, simply click on the Undo button.

¢ If you would like to repair all of the clicks in the
audio document’s selection without having to
repair each one individually, click the Repair All
button.

You may need to lower the detection setting in the
Repair Clicks dialog to find some clicks, depending upon
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their severity. Be careful not to lower the detection set-
ting dramatically - lower it gradually for the best results.

Repair Clicks is not available in Peak LE.

@ Repair Clicks is not available in Peak DV.

Remove DC Offset

This function allows you to remove any DC Offset in
your audio file. Peak scans the audio for DC offset and
then removes it. Peak will scan the left and right chan-
nels of a stereo file independently. DC Offset is usually
caused by problems in the analog to digital conversion
process. The result is that the waveform is not centered
on the base line-it is offset either higher or lower than
the center line.

©
&

Remove DC Offset is not available in Peak LE.

Remove DC Offset is not available in Peak DV.

Reverse Boomerang

The Reverse Boomerang command mixes a reversed
copy of the selected audio with the original. This creates
a variety of interesting and useful results. Try using
Boomerang on drum loops, voice, and sound effects.

Boomerang
Enter amount of effect

— 34

Nt

—

Description

The boomerang effect mixes a reversed
copy of the audio document's selection in
with the original. Select the amount of
the reversed copy that you wish to mix in
with the audio document's selection.

’Canrplx F 0K 3

The Reverse Boomerang dialog

Reverse

The Reverse command reverses the current selection. In
a reversed selection, the last sample becomes the first
sample, the second-to-last sample becomes the second
sample, and so-forth. The effect is similar to playing a
record or cassette tape backwards.

Swap Channels

The Swap Channels command reverses the left and right
channels in a stereo selection.

Swap Channels is not available in Peak LE.

Swap Channels is not available in Peak DV.

@
Z
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Threshold

The Threshold command allows you to split up an audio
document into its component parts by analyzing the
amplitude levels in the audio document and setting a
cutoff or threshold amplitude. For instance, you might
use the Threshold command on an audio document that
contains successive notes from a musical instrument to
split them up, or on a drum loop to break it up into its
component parts. You can save the segments with
Markers, or as Regions. See Chapter 7: DSP for more info
on using the Threshold command.
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The Threshold Regions dialog

Threshold is not available in Peak LE.

Threshold is not available in Peak DV.

©
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Sampler Menu

Send To Sampler
Revert From Sampler
Send All To Sampler
Revert All From Sampler

E-mu Sampler

Ensanig ASR-X
Kurzweil K2000, K2500
Peavey 5P, 5X

SMDI Sampler

Yamaha A3000

This menu allows you to import samples directly from
compatible samplers, edit or process the audio using all
of Peak’s functions, and send the modified sample back
to the sampler. Peak supports SMDI samplers. For
detailed information on using Peak with SMDI samplers,
see Chapter 11: Samplers.

Send to Sampler

The Send to Sampler command will send the previously
received sample from Peak to your sampler using the
Sampler dialog.

Revert from Sampler

The Revert from Sampler command will revert to the
previously received sample from Peak to your sampler
using the Sampler dialog.

Send All to Sampler

The Send All to Sampler command will send all previ-
ously received samples from Peak to your sampler using
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the Sampler dialog.

Revert All from Sampler

The Revert All from Sampler command will revert all pre-
viously received samples from Peak to your sampler
E-mu, Ensoniq ASR-X|
Kurzweil, Peavey, Yamaha Sampler

using the Sampler dialog.

A large number of samplers support SMDI sample trans-
fer. Choosing the name of your sampler from the
Sampler menu will open the Sampler dialog. SMDI
Samplers, such as the Kurzweil K2500 or the E-mu E-IV,
use SCSI to transfer samples between devices. In order
to transfer samples between the Macintosh and your
sampler using SMDI, you must connect a SCSI cable
between your Macintosh and the sampler. Consult your
sampler’s owner’s manual for instructions on how to
connect the cable to your Macintosh with proper termi-
nation. For detailed information on using Peak with
Samplers, see Chapter 10: Samplers.

a8 SMD4 Sampler Transfer
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The SMDI Sampler Transfer dialog

@ Sampler Support is not available in Peak LE.

Sampler Support is not available in Peak DV.

Plug-Ins Menu

The Plug-Ins menu provides access to any VST or Audio
Unit plug-ins that are installed in your system.

Peak can access VST plug-ins in two different ways - using
“Inserts” or through Vbox SE. An insert can contain a
single plug-in, and up to 5 inserts are available. When
using inserts, signal flows through the effect in each
insert in the order of the insert number. For example, if
an equalizer plug-in is used on Insert 1, and a reverb
plug-in is used on Insert 2, the output of the equalizer
plug-in will flow into the input of the reverb plug-in.
Inserts are typically more convenient when using a small
number of plug-ins is required.

Vbox SE

Peak includes BIAS’ Vbox SE for managing and mixing
VST plug-ins. Think of Vbox SE as a virtual effects box, in
which you can combine, repatch, and mix your VST plug-
ins in real-time. Using its unique effects matrix, Vbox SE
lets you combine multiple individual plug-ins. Vbox SE
can patch plug-ins in series, in parallel, or in series and
parallel, and you can hot-swap plug-ins. Vbox SE has con-
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trols for each plug-in to mute, solo, and edit parameters.
Vbox SE also provides input and output gain controls
both globally and for each individual plug-in, and a con-
trol for the global Wet/Dry mix. Use Vbox SE’s A/B com-
parison feature to get just the right settings, and use
Vbox SE’s presets to store configurations and settings for
later use.

1 use multiple VST plug-ins within Vbox SE, you
must select Vbox SE from an available insert, or
simply select the Vbox command from the Plug-Ins
menu — this automatically instantiates the Vbox
SE interface on Plug-In Insert 1. While Vbox SE
can be used on one insert, and other VST plug-ins

can be used on other inserts, it is recommended to
use multiple plug-ins within the Vbox SE matrix,
as it offers much more control and flexibility.

1 ke W O

The Vbox SE effects routing matrix for VST Plug-Ins

Inserts (1-5)

Any installed VST or Audio Unit plug-in may be assigned
to any insert. Each insert can contain a single plug-in.
VST & Audio Unit plug-ins may be mixed and matched.
When more than one plug-in/insert is active, the output
of Insert 1 flows into the input of Insert 2, the output of

Insert 2 flows into the input of Insert 3, and so on.

Using the Vbox SE matrix requires using 1 insert — by
instantiating the Vbox SE matrix on a single insert, you
can then open as many plug-ins as desired within the
Vbox SE matrix. The Vbox SE matrix can hold a virtually
unlimited number of plug-ins — in reality, the amount of
simultaneous plug-ins that can be used depends on the
speed of your Macintosh’s CPU.

Peak LE & Peak DV support only a single Insert,
and can host only one plug-in at a time. Peak LE

1
= & Peak DV users may purchase BIAS Vbox sepa-
rately to add multiple plug-in capability.
Bounce

Once you have the right settings for your plug-ins, you
will probably want to apply the effects to the audio doc-
ument. This process is called “bouncing.” Bounce the
audio file to process the audio document with any active
plug-ins. Bouncing changes the audio data stored on
disk, allowing you to use the Save command to perma-
nently apply the plug-in effects to your audio document
(this action is undo-able before saving).

VST

Choosing VST from the Insert “X” submenu brings up
another submenu, displaying all currently available VST
format plug-ins. Select the desired plug-in from this
menu, and its editor window (interface) will appear.
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Audio Unit

Choosing Audio Unit from the Insert “X” submenu
brings up another submenu, displaying all currently
available Audio Unit format plug-ins. Select the desired
plug-in from this menu, and its editor window (inter-
face) will appear.

For more information on individual third-party plug-ins,
please refer to the manufacturer’s documentation. For
detailed information on using plug-in and Vbox SE in
Peak, see Chapter 8: Plug-Ins.

Options Menu

Time Limits |
Sample Units *
Use Loop in Playback %L

+ Scroll During Play
Mowve Waveform During Play
Compute File Max dB
Show Edits
Show Marker Times

¥ Show Overview =,
Show Cursor Info ®T
¥ Auto-Import Dual Mono
Audio Info... =l
Dynamic Scrub Time »

¥ Auto Snap To Zero

¥ Auto-Balloon Help
“Open” Dialog after Launch

This menu contains a number of commands that allow
you to customize aspects of your Peak software such as
time units, dynamic scrub time, and other user prefer-
ences.

Time Units

The Time Units command allows you to choose a time
format for the audio timeline in Peak’s audio document
window. You can choose samples, Min:Sec:ms, SMPTE
frames, and Bars|Beats. The format you choose will
depend on the nature of the project that you are work-
ing on.

Sample Units

The Sample Units command allows you to select
whether sample units will be displayed in decimal, per-
centage, or dB.

Use Loop in Playback

If an audio document contains a loop (defined by loop
markers), the Use Loop in Playback command (38-L)
allows you to listen. Once playback reaches the looped
region of the audio document the loop will begin repeat-
ing. A check mark next to this menu item indicates that
it is enabled. To turn off loop playback, disable this com-
mand by selecting it a second time.

Scroll During Play

When the Scroll During Play command is enabled, Peak
will “scroll” through the audio document as playback
progresses. This conveniently allows you to visually fol-
low the progress of audio playback. A check next to this
menu item indicates that it is enabled. To disable this
command, deselect it.
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Move Waveform During Playback

The Move Waveform During Play command will move
the waveform under the cursor as playback progresses,
so that the insertion point is always in the middle of the
waveform display. A check next to this menu item indi-
cates that it is enabled.

Compute File Max dB

The Compute File Max dB command scans the audio
document for it's maximum amplitude, and gives you a
readout of the maximum value and its precise location.
This feature requires extra time, and is best used with
smaller audio documents when needing to monitor
overall volume during editing. Otherwise, keep this
option off and option-click the “Max” text in the lower
left corner of the audio document window, which brings
up a dialog with information about the maximum level.

Show Edits

The Show Edits command indicates areas of an audio
document that you have edited by enclosing these areas
with hatched lines. This provides you with a convenient
visual reference to portions of the document that have
been affected by your editing actions. Once you save a
document, the edits are saved, and these indicators will
no longer appear.

Show Marker Times

The Show Marker Times command will show a time
value as well as a marker name for all Peak markers,
loops, and regions.

Show Overview

The Show Overview command (38-) provides an
Overview display of the entire audio waveform along the
top of the Audio Document window under the title bar.
This provides you with a convenient visual reference of
the overall document when you are editing only a por-
tion in the audio document window.

Show Cursor Info

The Show Cursor Info command (38-T) brings up a
floating, translucent cursor information window, which
follows along with the mouse cursor as it is moved.
Choosing this command again turns the window off.

Auto-Import Dual Mono

Certain audio applications such as Digidesign’s Pro Tools
do not directly support stereo interleaved documents,
and instead use “dual mono” documents which com-
prise the right and left channels of stereo material.
Enabling the Auto-Import Dual Mono command tells
Peak to automatically convert such documents into new
stereo audio documents when you attempt to open
these documents with the Open command. Because
Peak actually writes a new stereo audio file to disk, this
conversion process requires hard disk space equivalent
to the two original mono documents. (Please note that
the Import Dual Mono command requires that both files
be mono documents, have the same sample rate, and
the files must have exactly the same name with the sep-
arate suffixes of “.L” and “.R")
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Audio Info

The Audio Info command (38-I) allows you to change an
audio document’s length, sample rate, root key, low key,
or high key parameters. When you choose this com-
mand, a dialog indicating the total time of the sample, its
sample rate, and its key mapping information will
appear. The Audio Info dialog allows you to change the
sample rate, duration, root key (for use in a sample play-
back instrument), and high and low key range. Note that
by changing the sample rate, the pitch and duration of
the sample will be affected. (To change the sample rate
of an audio document without changing the pitch, use
the Convert Sample Rate command from the DSP
menu.)
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The Audio Info dialog

You can also adjust the key range (for use in a sample
playback instrument) of a document by clicking on the
miniature keyboard in this dialog. To set the lower limit
of the key range, click on the keyboard at the desired
key. To set the upper limit of the key range, hold down
the Shift key and click on the keyboard. To set the root
key of the audio document’s key range, hold down the
Option key and click on the keyboard. You can also enter
the desired numerical value in any of the appropriate
fields to accomplish this.

Dynamic Scrub Time

Peak provides a unique audio auditioning technique
called dynamic scrubbing. This feature is very useful for
precisely pinpointing a desired location in an audio doc-
ument. Dynamic scrubbing allows you to drag the
mouse forward or backward over a waveform while Peak
plays a short loop (between 10 and 600 milliseconds) at
the scrub location. You can control the tempo and direc-
tion (forward or backward) of playback by dragging the
mouse slower or faster, forwards or backwards. When
you have found the location you are looking for, you can
commence editing or playback. The Dynamic Scrub
Time command allows you to choose the length of this
playback loop. Depending on the audio document’s
content, a value of between 40 to 80 milliseconds typi-
cally works well. See Chapter 5: Editing, for step-by-step
instructions on how to use the Dynamic Scrubbing fea-
ture.

Auto Snap To Zero

The Auto Snap to Zero command will automatically
“snap” any Peak selection to a zero crossing after you
make a selection.

Movie

Movie Sound Tracks

The Movie Sound Tracks command brings up a dialog
that allows you to Enable or Disable the movie’s existing
soundtracks. You can use this dialog to toggle multiple
soundtracks contained in a movie on and off to check
balances or “solo” certain tracks. Click on the Set button
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to accept the changes, or Cancel to leave the movie unaf-
fected.

Tit: Liniins L2

Samaple Urins LS

Use Loop m Maghack 3
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Compu File Max JE
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Double Size
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Selecting a movie viewing size...

Half Size

Selecting this menu command displays the open
QuickTime movie at half of its original size.

Original Size

Selecting this menu command displays the open
QuickTime movie at its original size.

Double Size

Selecting this menu command displays the open
QuickTime movie at double its original size.
Auto-Balloon Help

Auto-Balloon Help, when enabled, will automatically

activate Balloon Help for items in the Toolbar if the cur-
sor rests over an item fro more than 3 seconds.

“Open” Dialog after Launch

The “Open” Dialog after Launch option allows you to
choose whether an open dialog is automatically dis-
played when Peak is launched. A check next to this
menu items indicates that it is active. The absence of a
check indicates that it is inactive.

Window Menu

The commands in this menu allow you to display and
manage Peak’s windows - including the Transport,
Toolbar, Contents Palette, Movie Window, Playlist, and
any open audio documents or active plug-ins.

Transport

The Transport window is a floating, re-sizable window. It
contains three areas: a time display showing elapsed
time, the Transport controls (Return to Zero, Stop, Play,
Go to End, Record, and Loop during playback), audio
level meters with clip/peak indicators, and a master vol-
ume fader.

Toolbar

You may assign almost any Peak command as an icon in
the Toolbar. The Toolbar menu allows you to group
together the functions you use most often, so that you
can simply click a button instead of going to the menus.
For example, if you frequently use Normalize and Pitch
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Change, you can choose to have the icons for these func-
tions in the Toolbar, so that all you have to do to use one
of them is to make an audio selection and click a button.
The Toolbar is an easy way to make your work in Peak
faster and more efficient, allowing you to customize the
program to suit the way you work.

To add or subtract items from the Toolbar, use the
Shortcuts & Toolbar command in the Preferences dialog.

Contents Palette

Peak has a floating Contents Palette that will display all
Regions, Markers, and Loops contained in any open
audio documents. There are three buttons at the bottom
of the palette that allow you to select which items to
view-from left to right: the Markers button, the Region
button and the Loop button. Option-double-clicking on
any item in the Contents window will bring up the Edit
Region or Edit Marker dialog.

Movie

The Movie command toggles the Movie window on and
off for any QuickTime movie you currently have open in
Peak.

The QuickTime Movie Window is not available in
Peak LE.

@

Playlist

The Playlist command (38-P) allows you to open up the

current Playlist window. For more information on using
playlists, see Chapter 6: Playlists & CD Burning,

Crossfades, VST, and Nudge Regions are not avail-
able for the Playlist in Peak LE.

©

Crossfades, VST, and Nudge Regions are not avail-
able for the Playlist in Peak DV.

&

Tile Windows

The Tile Windows command (38-shift-T) arranges all
open audio documents in a tile formation on your com-
puter screen. This type of arrangement allows you to
view multiple open audio documents and once, and is
particularly convenient if you are cutting and pasting
between several documents or jumping back and forth
between them for editing purposes. You can press a 36-
number key corresponding to an open audio document
and the document will become the active window. (Click
the Windows menu to see the numbers that correspond
to each open audio document.)

Stack Windows

The Stack Windows command arranges all open audio
documents into a stack, with each document overlap-
ping the previous document, in the order that they were
opened. This type of arrangement allows you to have the
maximum number of documents open and use the min-
imum amount of screen real estate. You can then conve-
niently use the Windows menu to select any open docu-
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ment and make it the active window. Alternatively, you
can press the #8-number key corresponding to the open
document and the document will become the active win-
dow. (Click the Windows menu to see the 8-numbers
that correspond to each open audio document.)

Toggle Contents Drawer

The Toggle Contents Drawer command opens and clos-
es the Contents drawer that is located on each audio
document.  Choosing this command will open the
Contents drawer on the right side of an audio document.
Choosing this command when the Contents drawer is
open will close the drawer. Toggling the Contents draw-
er can also be done with a button in the top right corner

of each audio document window.

The Contents Drawer is not available in Peak LE!

The Contents Drawer is not available in Peak DV!

©
&

Plug-In Effect 1 - 5

The Plug-In effect commands allow you to bring any
active VST or Audio Unit plug-in editor windows to the
foreground. When using the keyboard equivalent, (36-
Option-<# >) the number should correspond to the
insert number that the plug-in was instantiated on. For
instance, to bring up the plug-in editor window for an
EQ plug-in that was instantiated on Insert 3, the key-

board equivalent would be: 38-Option-3.

Links Menu

The Links menu in Peak provides useful links to BIAS's
Web site. Included are the Peak online registration page,
the BIAS home page, the Peak updates page, technical
support pages, online documentation, and current BIAS
product information pages.
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Appendix 1:
Keyboard Shortcuts

Keyboard Shortcuts

This section lists the default keyboard shortcuts for Peak. As you learned in Chapter 3: Peak Basics, these keyboard
shortcuts may be reassigned to any desired key or combination of keys, as well as to icons in the Toolbar.

Menu Keyboard Shortcut Command Comments

File
FB-N New Mono Document Creates a blank mono document
F6-Shift-N New Stereo Document Creates a blank stereo document
Option-N New Document from selection Creates new document from selection
F6-Shift-P New Playlist Document Creates a blank playlist
F6-Shift-B New Document From Playlist Creates a document from a playlist
#-0 Open... Opens a file from disk
W Close Closes the front-most document
38-Option-W Close All Closes all documents
F8-S Save Saves the front-most document
F6-Shift-S Save As... Saves the front-most document with a

new name and/or new location

F8-Option-S Save a Copy As Saves a copy of the front-most document
with 2 new name and/or new location

*-Q Quit Quit Peak

Edit

F8-7Z Undo  Undo edits one by one
(as long as you haven’t Saved)

Y Redo Redo edits one by one
(as long as you haven’t Saved)

X Cut Cut selected audio

F8-C Copy Copy selected audio to clipboard (useful for
Clipboard based DSP effects like Mix and Convolve)
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Menu

Edit (Cont.)

Action

8-V

3#-D

#-E
Delete Key

Option-Delete
56.°

F8-A
Up Arrow

Down Arrow
gg_ 44_77

38-Left Arrow
F8-Right Arrow

&8 or +

&8-[or-
Control-Up Arrow
Control-Down Arrow
38-Shift-)

&8-Shift-[
Shift-Left Arrow

Shift-Right Arrow

Keyboard Shortcut

Paste

Insert

Silence
Delete

Delete Except Audio
Crop

Select All
Insertion Point at Selection Start

Insertion Point at Selection End
Select Loop

Previous Selection

Next Selection

Zoom In

Zoom Out

Increase Vertical Zoom
Decrease Vertical Zoom
Fit Selection

Zoom Out all the way
Zoom To Sample Level

Zoom To Sample Level (End)

Command Comments

Pastes Copied or Cut audio at insertion
point

Pastes, pushing audio at insertion point
further to the right.

Replaces audio selection with silence
Deletes selection, does not put in
Clipboard

Deletes Markers, Loops & Regions
Crops selected audio

Selects all audio and events
Places Insertion Point at beginning of
selection

Places Insertion Point at end of selection
Selects loop

Selects previous view or selection
Selects next view or selection

Zoom in to start of selection at sample
level

Zoom in to end of selection at sample
level
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Menu

Action (Cont.)
F8-Shift- =
Option-Left Arrow
Option-Right Arrow
38 «_»
#-M
F8-Shift-R
#-G
3
#-K

Audio
Spacebar
F8-Spacebar

Return
Shift-Return
F#-R
Option-R

Option
F8-L
-,
381
38T

Window
8-p
&8- Shift-T

$8-1,-2, 3...

3-Option-1, -2, -3....

Keyboard Shortcut

Loop this Selection
Nudge Loop Backward
Nudge Loop Forward
Select Loop

New Marker

New Region

Go to Time...

Loop Surfer

Capture Region to Playlist

Play/Pause
Play with Auditioning

Stop/Rewind

Stop & Extend Selection
Record

Record Settings

Use Loop in Playback
Show Overview
Audio Info...

Show Cursor Info

Playlist
Tile Windows

Document Windows

Plug-In Windows

Command Comments

Plays audio with pre-roll amount desig-

nated in Auditioning Preferences

Toggles waveform overview on and off

Opens document’s Playlist.

Arranges open documents in a tile forma-

tion.

Brings document windows to front by

number, in the order they were opened.

Brings Plug-In windows to front by num-

ber, in the order they were opened.
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Appendix 2: Peak
Actions

This section lists common Peak Actions not found in  To stop playback:

Peak’s menus. It is organized by Peak windows and func- Press the Spacebar again, or dlick Stop on the

tions.
Transport.

To play from a desired location in the audio document:

Useful Peak Actions, General
*  Click cursor at desired location in track and press
the Space bar, click the Play button on the Toolbar,

To stop lengthy processes, Saves and recalculations:
or double-click mouse at desired location in the

e Press 38-Period track.

Audio Document Window, General Scrubbing

To find the Max Level in an audio document: To begin dynamic “shuttle” scrubbing:

*  Option-click on Max Level Indicator (at bottom left o old down the Control key and drag the mouse

of audio document window). across the desired area.

To bring up the Audio Info Dialog: To begin dynamic “jog” scrubbing:

e (lick on the Audio Info Area at the bottom left of
the audio document window.

Hold down the Control and Option keys, and drag

the mouse.
To navigate the Overview without playing audio:
Selections
*  Option-drag in the Overview
Playback To make a selection:

* Click and drag the mouse.

To play from beginning of a document, or from the loca-
tion of the insertion point: To select all:

*  Press the Space bar, or click the Play button on the T

Toolbar
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To extend or shorten a selection:

*  Shift-click on the end of the selection that you
wish to modify, then drag the mouse to extend or
shorten the selection.

To toggle selection start/end:

*  Use the shift key.

To snap selection to the nearest zero crossing:

*  Hold 3-Option while making a selection.

Views

To zoom out by increments:

*  Press 38

To zoom in by increments:

*  Press 3]

To scroll audio display left or right:

*  Press control-arrow key left or right

Markers, Loops, and Regions

To find a Marker by name:

* Type in the first few letters of the marker name

To edit a Marker:
*  Double-click on the triangular base of the Marker
to open the Edit dialog
To name a Marker:

*  Double-click the triangular base of the marker, and
enter a name.

To select the audio between two markers:
e 3-click anywhere between the markers, or press
the Tab key.
To select additional audio between markers:
e 3B-Shift-click between another two markers, or
press Shift-Tab.
To move a marker:
*  (Click on the triangular base of the marker and drag
it.
* O, double-click on the triangular base and enter a
time.
To change regular markers into loop markers:
* Double-click the triangular base, and click the
Loop Start or Loop End radio button.
To move a pair of loop markers together:

* Hold down the Option key and drag one of the
loop markers, or select area containing loop mark-
ers and turn on Horizontal Lock - markers move
together until Horizontal Lock is turned off.

To move a marker to a zero-crossing:

*  (Click on the triangular base of the marker, and
hold down the Shift key while you drag the mark-
er.

To move both ends of a loop or region marker simultane-
ously:

* Hold down the Option key while moving the mark-
er, or select area containing loop markers and turn
on Horizontal Lock - markers move together until
Horizontal Lock is turned off.
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To delete a marker:

*  Double-click the triangular base. Click the Delete
button. A range of markers can be selected and
deleted by clicking Option-Delete.

To delete all markers, loops and regions, leaving audio
intact:

*  Select all, then press Option-Delete.

To paste just markers, loops and/or regions, leaving
audio intact:

*  hold down option while selecting paste from the
edit menu (38-Option-V).

Playlist

To scrub Playlist audio during playback:

*  (lick and hold the mouse on the time display. The
cursor changes to a scrub cursor ( <—> ). Drag
to the left to scrub backwards, drag to the right to
scrub forwards. The farther to the left or right you
drag, the faster the scrub will progress.

Loops

To create a loop from a selection:
* Select desired range, and choose Loop This
Selection from the Action menu (88-Shift- “-”).
To listen to a loop:

*  Choose Use Loop in Playback from the Preference
menu or Toolbar, and start playback before the
loop end marker.

VST Plug-Ins

To set the VST delay compensation offset:

*  Hold down the Option key while choosing Bounce
VST Effects.

Tools - Audio Document Window

To toggle between tools:

* Press the esc (Escape) key.

To toggle Blending on and off:

*  Press the Caps Lock key.

To find the zoom factor amount:
* Option-click on the Zoom tool in the Cursor
Palette.
To bring up the Smoothing dialog for the Pencil tool:
* Option-click on the Pencil tool in the Cursor
Palette.
To bring up the Contextual Menu:

e Control-shift-click in the audio waveform.

The Contents Palette

To edit a region, marker or loop in the Contents Palette:

*  Option-double-click on its name in the Contents
Palette or Contents Drawer.
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The Movie Window

To change the size of the Movie Window:

*  (lick on the QuickTime movie’s “grow button” (at
the upper left corner of the Movie window) to
double the size of the movie window.

*  Control-Option-click on the QuickTime movie’s
“grow button” (at the upper left corner of the
Movie window) to halve the size of the movie win-
dow.

*  Select the desired size (original, half, or double)
under the Options menu>Movie...
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Appendix 3:
Troubleshooting -
Before Calling For Help

Before you call BIAS Technical Support for help, please
take a2 moment to examine the Read Me file installed
with Peak. This document contains late-breaking infor-
mation not included in your User’s Guide.

Use the Apple System Profiler utility to gather informa-
tion about the configuration of your computer. The
information the Apple System Profiler reports is very
helpful when reporting a problem to BIAS Tech Support.

Visit the BIAS web site for the latest technical support
information, downloads, updates, and more at:

http://www.bias-inc.com

Please verify the following:

*  Double check the authorization code you've typed
in with the authorization code we've provided.
Sometimes people mistake I's for I's and 8's for B's
etc. Please note authorization codes always use
the number zero, never the letter O.

*  Make sure the version of the product you have
installed on your computer matches the version
listed on the registration card, as well as the prod-

If you continue to have trouble, please contact the BIAS
Technical Support Department at:

Email: support@bias-inc.com

Phone: +1-707-782-1865

Common problems and solutions

How do I set up my USB or FireWire audio hardware
device?

1. Please download the latest USB or Firewire driver
from you hardware manufacturers website.

2. Boot your computer system with your USB or
Firewire device already installed to an available
USB or Firewire port directly on your computer
and NOT into a USB or Firewire hub.

3. Once your system is up locate the Peak application
and run it.

4. Then, from the Peak’s audio menu, choose
“Hardware Options”. You should see the hardware
options available for Peak ( Fig. A).

* Toaccept an input source, change the Input
Device to your USB or Firewire audio

uct name in the authorization email you received device.
from BIAS. * You can either listen to playback via your USB
or Firewire audio device or use the  built in
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audio controller (which is the built-in audio
card inside your Mac).  Depending on your
preference, change the output device setting

to your preferred listing environment.

CoreAudio Settings
Input Device: Select Your Audio Device Here| § |
Output Device: Select Your Audio Device HereT]

Buffer Size: = 512 Tl

)

Input Level:

P
Cancel

Fig. A

5. After ensuring that you have connected your audio
recording sources to your USB or Firewire device,
and that the recording source is playing, press the
“record” button located on the transport ( Fig. B
cirlcled in red )

Fatala

00r00T 00000 K

Fig. B

At this point you should be able to see a recording

! signal in the transport windouw.
Record

Audio Source Display lﬁl

[l Notepad _! Notepad regions, not markers

Record 16-bit 44100Hz Stereo SD Il file.

Rec Time Left: oss6:59.703 [ [l ‘_
Fig. C

6. The record dialog will pop up (Fig. C) - Press the
“record” button (circled in red) in this window and
you will see a preview waveform of your recording
as well as metering at the transport bar.

Ifyour USB or Firewire device is not available for
selection within the bardware options window
you can verify if the operating system is able to
recognize it by launching the Audio MIDI Setup
Application located in:

Macintosh HD/Applications/Utilities.

7. Ensure that all circled fields (Fig. D) are set to your
preferred USB or Firewire hardware. If it is not an
option please contact your hardware manufacturer
for support.

" Audic MIDI Setup

668

[ Adio Bevices | miD: Devices

System Setting

ut | Your Audio Device Hare (31 + | Your Audio Devics Hare (51

1 Your Audio Devico Hers 151

e Your Audio Devica Hor 131

[CTR— A3 0B Output Volume a8

Device Mute
Input Section Output $ection
Inpat Source

Currem Format | 2Ch-44100.0 He-16bit TR} Current Format | 2Ch-44100,0 Hz-1660 18]

G o

Naive._ s Py frveve

Fig. D

Why am I getting clicks and pops with my USB device?

1. Update to the most recent Mac OS. There were
major improvements in CoreAudio in OS 10.2.3
and we recommend using the latest OS update.

2. If your USB audio device manufacturer provides
drivers make sure you are using the most recent
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version.

3. Delete the “ACA Preference” preference file. This
file is located in:

MacintoshHD/Users/<YourUserAccount >/username/Library/Preferences

After you delete this file, you will need to reset
your hardware and recording settings in Audio
MIDI Setup and in your audio applications.

4. Go to your Audio MIDI Setup utility (this is avail-
able in OS 10.2 or later, and is shown in Fig. E).
Audio MIDI Setup is found at this location:

MacintoshHD/Applications/Utilities .

eoe Audio MIDI Setug
_Phidopenees moioewess |

it

System Settings

Delault input | USB Audio Deviee

Se(EEted Audio Device | USE AuioDevice 181

Input veluma WA dE  Output Volume nia o8

Sl Quiput | USB Audio Bevice
System Outpat | USB Audio Devico

Input Section Output Section

Input Seurce

Current Format | 2Ch-44100.0 Hz- 16 Currant Formar 2Ch-44100.0 He-16bi 18]

[ Frre

Channe B uiem Mate

Fig. E

Make sure your input AND output are set to your USB
device and the sample rate you have selected is support-
ed by your device

5. Go into the Hardware Settings dialogue. Make sure
you have the USB device selected as your input
AND output device. Also try experimenting with
recording at different CoreAudio buffer sizes
(increasing this buffer size normally helps). The
hardware settings dialog is located in
Audio>Hardware Settings. (See Fig. F)

Fig. F

Fig. G

I CoreAudio Settings

Input Device: USB Audio Device ?]
Output Device:  USB Audio Device ‘:!

Buffer Size: 512 ﬂ
Input Level:
(Cancel § OK -’\'

If you are experiencing pops and clicks during
recording, go to Audio>Record Settings >Device
and Sample Format, and specify a bit depth and
sample rate that is supported by your device. (See
Fig. G)

CoreAudio Record Settings

Record Through:

‘(no1&2 89
Sample Rate:
44100 2
Clock Source:
Internal Ti
Channels:
“IMono @ Stereo
Bit Depth:

® 16-bit () 24-bit ) 32-bit

(cancel) ( oK

Go to System Preferences>Energy Saver. Make
sure you turn off any energy saving preferences,
especially the option to spin down the hard drive.

If these suggestions don't work, launch Peak, and
in the Audio Menu, choose Sound Out, and select
Mac OS X Audio HAL as the preferred audio engine
to use. (See Fig. H)
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Some users report that when using a USB device
that doesn't require/include drivers, recording is
more stable under OSX HAL

Hardware Settings...
Meters...

Record
Record Settings...

FireWire DV
¥ Mac 05 X Audio HAL N
Mac 0S5 X Audio HAL (System)

IR CorcAudio-.

Fig. H

Peak will not launch:

Does your Macintosh have enough RAM to run
Peak? You must have at least 256MB of RAM—
512MB of RAM is recommended. To find out how
much memory your Macintosh has, choose About
This Macintosh in the Finder’s Apple Menu. A win-
dow will appear telling you how much memory is
currently installed in your computer. If you have
less than the amount required to run Peak, you will
have to install additional RAM in your computer.

Peak used to work but now acts strangely or won't
launch:

If Peak used to work but now won't launch or sud-
denly started acting strangely, the Peak Preferences
file may be corrupted. Try quitting Peak, dragging
the Peak Preferences file from the Preferences fold-
er (in your home directory’s Library folder) to the
Trash icon on the Desktop, choosing Empty Trash
from the Finder menu and then relaunching Peak.

When I place the cursor on the waveform, it jumps to the
right or the left. Why?

This is the result of Peak’s “Auto Snap To Zero”pref-
erence, that automatically places the cursor at a
zero crossing in the waveform. You can turn it off
by going to the Options menu and un-checking
the option.

I notice files on my hard drive with Peak file icons, called
“AFM.temp”

These are temporary files that Peak created as you
edited audio. If you change Scratch Disk prefer-
ences at the end of a session, or force-quit or crash
in Peak, sometimes these temporary files won't be
deleted. You can either manually drag them into
the Trash, or launch and then quit Peak.

I know that I can process separate channels in Peak, but
not edit them separately. Is there a workaround?

The workaround is to export dual mono files, open
the Left and Right channels in Peak as two separate
mono files, edit them, save them, and then Import
as Dual Mono. You will then have a stereo file with
your changes in it.

Peak stops or stutters during recording or playback:

Is your hard disk too slow? For direct-from-disk
recording and playback, your hard drive must have
an average seek time of 18ms or faster. If you are
not sure of the speed of your drive, check with the
manufacturer or the dealer where you purchased
the drive.

Is the data on your hard disk fragmented? If the
files on your hard drive have become fragmented
(see Chapter 3 for an explanation of fragmenta-
tion) you may have to use a hard disk maintenance
program such as Norton Speed Disk™ or the opti-

™

mizer module of TechTool Pro™ to defragment
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your drive.

* Is Peak’s playback buffer in the Playback
Preferences (found in Peak’s Preference menu) set
too low? Try increasing the playback buffer to 128K
or higher.

* Try turning off Interrupt-based metering in Peak’s
Meters dialog.

*  Is AppleTalk turned on? If so, use the Apple menu’s
Chooser to turn it off if you don’t need it.

* Try increasing the playback buffer size in Peak’s
Playback Preferences dialog. (Always use the small-
est working setting, because this setting also
affects how much memory is used per audio doc-
ument window.)

I can’t access Tape Style Scrubbing:

*  Make sure Peak is set to use the Mac OS X Audio
HAL audio engine - to check this, go to Peak’s
Audio Menu>Sound Out and select Mac OS X
Audio HAL.

I can’t use the real-time pitch change preview in the
Change Pitch window:

*  Make sure Peak is set to use the Mac OS X Audio
HAL audio engine - to check this, go to Peak’s
Audio Menu>Sound Out and select Mac OS X
Audio HAL.

There are items in the DSP menu that are grayed out:

*  You need to open an audio document before the
DSP effects will be available.

*  Not all DSP processes are available in Peak LE and
Peak DV.

Problems using Peak with a SMDI sampler (via SCSI):

* Use high-quality, tested SCSI cables that are as
short as possible.

*  Check for SCSI ID conflicts. Make sure every SCSI
device in the SCSI chain has a unique ID.

*  Check for problems with SCSI termination. For
more information, consult the manuals of your
SCSI devices. SCSI termination should exist on
each end of the SCSI chain: one termination inside
the Macintosh (usually this is the case), and one
termination on the last SCSI device in the chain.

* Try turning off Asynchronous transfers in Peak’s
Samplers Preferences dialog.

*  Reduce the number of components in your SCSI
chain. If you have more than one device connect-
ed between the sampler and your Macintosh, try
removing devices to determine if this affects the
errors.

*  Change the power-up order of your devices. Try
turning all SCSI devices on first, including the sam-
pler. Once the devices have powered up, turn on
the Macintosh. If this does not help, try turning on
your other SCSI devices, then the Macintosh, and
finally the sampler.

When I try to move a region marker that’s in the same
position as a reference marker, the reference marker
moves instead:

*  When editing markers that exist in the same
space/sample, reference markers take priority. To
get to a region marker, move or delete the refer-
ence marker first.

I try to save files in MP3 format, but the MP3 option is
grayed out:

e Peak needs to have the LamelLib encoder installed.
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To install this encoder:

Make sure Peak is not running,
Download the LameLib.bundle from:
http://homepage.mac.com/awk/lame/

Select the Peak 4 application and choose Get Info
from the Finder’s File Menu.

Open the Plug-Ins tab.
Click the Add button.

Locate the LameLib.bundle file, highlight it, and
click the Choose button.

The next time Peak is launched, MP3 will be an
available option.

I try to instantiate a VST plug-in on an insert, but there is
already a plug-in called Vbox SE running on that insert:

Choosing the Vbox menu item automatically
opens Vbox SE on the first available insert — per-
haps this menu item was chosen and automatical-
ly assigned Vbox SE to the insert you are trying to
use. To turn off Vbox SE, simply select the insert it
is running on, and then choose None from the
submenu.

How to I create a Scratch Disk?

1.

2.

3.

Create a folder called "Peak Scratch Disk" on a
drive/volume you prefer. We recommend parti-
tioning your hard drive or using an external drive
for the scratch disk, however creating a scratch
disk on the same drive as your operating system
will work as well.

Open Peak’s Preferences dialog.

Click on "Scratch Disk".

Be sure that only the "Primary” radio button and
"Use" checkbox are selected for the drive you cre-
ated your scratch disk folder on as mentioned in
step 1. No other drive should should have
"Primary" or "Use" selected if you are using multi-
ple hard drives or partitions.

Click the "Folder" checkbox, then navigate to the
scratch disk folder you created in step 1. "Choose"
that folder.

Click "OK" to exit the scratch disks dialog,

Locate the "Audio" menu (located next to the DSP
menu) within Peak.

Click on "Record Settings".

From the “Record Disk” pop-up menu, choose the
hard drive on which you created the scratch disk,
and click “OK”.

After setting up the scratch disk and record disk
settings be advised that you will have to save all
your recorded files on the scratch disk drive.
Saving on any other drive or volume will result in
the following error "You must save the new audio
recording to the volume that you recorded onto".

Burning to CD-RW media:

Peak supports burning to CD-RW media, however the
CD-RW media must be blank. Peak will not erase a CD-
RW that already contains data.

To erase CD-RW media:

Use the included Roxio Toast lite application — be sure
to choose “Full Erase” (not “Quick Erase”). If you
chose Quick Erase, you only will be able to write to
the CD-RW media using Toast lite. No other burning
application will be able to write to it.
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Glossary

AAC

Advanced Audio Coding - (Also known as AAC, MP4, or
mpeg 1, layer 4) - A compressed audio file format that
uses psychoacoustic modeling to reduce file size signifi-
cantly, while audio quality rivals that of uncompressed
CD audio. MP4 is a fairly new standard and rising in pop-
ularity for use on the Internet and in personal music
players. Peak supports reading/writing AAC files.

AIFF

Apple’s Audio Interchange File Format used for record-
ing and storing digital audio. It is also Peak’s default file
format and is supported by many Macintosh software
applications.

AU

AU, or .au, is the audio file format common to most Sun
Unix workstations. It is one of the most commonly used
audio file formats on the World Wide Web.

Audio Unit

Audio Unit is a real-time, native plug-in standard from
Apple Computer, Inc. Audio Unit plug-ins are accessed
by compatible host applications from a central directory.
Mac OS X includes several Audio Unit plug-ins, which

can be accessed in Peak, or by any other Audio Unit com-
patible hosts. (Audio Units are sometimes referred to as
“AU” plug-ins, not to be confused with the AU, or .au file
format used on Sun Unix workstations)

audio hardware (audio interface,
audio card)

Audio hardware can be any audio expansion card that
plus into a PCI or PCMCIA slot in your Macintosh, with
or without an additional break-out box, or an audio
interface that connects to your computer by USB or
FireWire. Third-party audio hardware enhances a com-
puter’s audio recording and playback capabilities. Using
Apple CoreAudio, Peak works with a variety of Macintosh
audio interfaces from Digidesign, Digigram, Echo, Korg,
Mark of the Unicorn, M-Audio, and others. CoreAudio
Driver software from the manufacturer of the audio
hardware may be required to work properly with Peak.

audio document

An audio document is a Macintosh audio data file creat-
ed by Peak. Peak can create and open audio documents
in a variety of common audio file formats. The AIFF file
format is Peak’s default file format. For more informa-
tion, refer to AIFF, AU, WAVE, Sound Designer 1I, and
QuickTime.

Glossary
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bit resolution (bit rate or bit depth)

Describes how many bits-as in “0s” and “1s”-are available
to describe a digital recording. In practice, the bit reso-
lution defines the dynamic range of a sound, whereas
the sample rate defines the frequency range. 24-bit is a
high-resolution bit depth used for professional audio
recording, editing, and processing; 16-bit audio is the
professional Compact Disc standard; 8-bit audio is suit-
able for less demanding applications, such as multimedia
presentations. More bits result in better quality, but also
require more hard drive storage space. Also refer to
dynamic range, frequency, and sample rate.

blending

Blending is an automatic crossfade function that Peak
applies to areas during cutting, pasting and other editing
processes in order to smooth abrupt transitions between
waveform amplitudes. Blending can be toggled on or off
by choosing the Blending command from the Preference
dialog, or by clicking the Bending enable/disable button
in the Cursor Palette.

clipping

A type of audio distortion that occurs when a source sig-
nal (such as from an audio CD player) is recorded at
such a high level that the recording device (such as a
Macintosh running Peak) runs out of “headroom.” It can
also occur when a signal is played back from a audio
source into an audio destination at an excessive level,
such as when a mixing console feeds a signal to a power
amplifier at an extremely high level. In either case, clip-
ping represents a mismatch in level between an audio
source and an audio destination. When digital clipping

occurs, such as during digital recording, the results can
be a harsh “crackling” or “raspy” sound. When you use
Peak, you can avoid digital clipping by ensuring that the
record levels are set so that the loudest incoming audio
passages stay below the maximum input level, as indi-
cated on the record or playback meters. Peak’s Clip indi-
cator will easily show any clipping that occurs. Also refer
to headroom.

dB (decibel)

This is the most common unit used for measuring the
level of audio. The greater the number of decibels, the
higher the audio signal. Within Peak, the record and
playback meters show a signal’s relative level in terms of
dB. There are many different kinds of decibel scales, but
for the purposes of using Peak, “dB” can be used to
describe the relative gain of different passages of audio,
or to describe the available headroom during recording.
Also refer to gain and headroom.

DSP

DSP stands for digital signal processing. In the world of
audio, DSP refers to manipulating a digital audio signal
by processes such as level changes, reverberation, delay,
or other such effects. Peak uses DSP to perform many of
its audio processing tasks-including those found in the
DSP menu or Toolbar.

dynamic range

In audio recording terminology, dynamic range refers to
the range in level between the quietest and loudest pas-
sages of a selection of audio. It is usually expressed in
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decibels. Bit resolution determines a recording’s dynam-
ic range. An 8-bit recording has 256 available levels,
which translates into a dynamic range of 48 dB. This may
be suitable for some applications, but it may also sound
noisy, since the difference in gain between the loudest
passages and the quietest passages (which may contain
hiss and other potential noise) is not that great. A 16-bit
recording has 65,536 available levels, which translates
into a high-quality dynamic range of 96 dB. As a rule of
thumb, you can calculate dynamic range in decibels by
multiplying the bit rate by “6.” Also refer to bit resolu-
tion, decibel, and gain.

fade-in/fade-out

A fade-in is a process where the gain of an audio signal is
increased from zero (silence) to its full volume. A fade-
out is a process where the gain of an audio signal is
decreased from its full volume to zero (silence). Peak
allows you to create fade-ins/fade-outs by making a selec-
tion and choosing the Fade In or Fade Out command
from the DSP menu, or from the Toolbar. Envelope
shapes can be editing with the Fade In Envelope or Fade
Out Envelope commands in the Preference dialog.

frequency

Sound consists of waves, which occur in cycles.
Frequency refers to how frequently these wave cycles
occur in a given period of time (generally, one second).
The higher the frequency of a sound, the higher its
“pitch” as perceived by human ears. Frequency is meas-
ured in Hertz (Hz), or cycles per second. Roughly speak-
ing, humans are able to hear sounds in the frequency
range between 20 Hz and 20,000 Hz (20 kHz).

gain

1) The process of amplifying a signal. 2) A way to express
relative signal levels for audio. For instance, by adding 6
decibels of level to a signal, we double the perceived
loudness of the signal. Also refer to decibel and head-
room.

headroom

Describes how much gain is left before a signal induces
clipping or distortion. When recording with Peak, the
record meters indicate how much headroom is left
before clipping. When playing back audio in Peak, the
meter strip at the bottom of the screen will indicate this
as well. Most professional audio engineers leave between
3 dB and 12 dB of headroom while recording, to mini-
mize the possibility of clipping. If you leave too much
headroom, however, your signal may be recorded at too
low a level, and you may end up with excessive noise or
hiss. Also refer to clipping, decibel, and gain.

Hz (Hertz)

This is the unit of measurement for frequency, and refers
to the number how many “cycles per second” a sound
wave generates. In the world of sound, the higher the
number of Hertz, the higher the frequency of a sound
and hence the higher its “pitch” as perceived by human
ears. A thousand Hertz can be expressed as 1 kHz (one
kilohertz), so that 20,000 Hertz may also be referred to
as 20 kHz.
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loop

Loops are used to sustain or repeat a section of audio.
They can be used for material that you intend to transfer
to a sampler, or simply for playback within Peak itself.
Peak allows you to create one loop per audio file. You
can do this either by making a selection and choosing
the Loop this Selection command (38-L) from the
Actions menu or Toolbar, or by placing markers at the
desired start and end point of a region, and defining the
markers as loop markers.

Loop Tuner

A feature of Peak that allows you to “fine tune” the start
and end points of a loop.

Loop Surfing

Peak’s term for adjusting loops during playback.

Loop Surfer™

A proprietary feature of Peak, which automates many of
the steps required to “loop surf.”

marker

A marker is a location in an audio document that you
define as important; you can also think of a marker as a
“memory location.” By marking a specific location in a
recording, you can easily navigate to it for selection, edit-
ing or playback purposes. Peak allows you to define a
marker by pressing 3-M or clicking a Toolbar button,

either when playback is stopped or while it is engaged.

MP3

(Also known as mpeg 1, layer 3) - A compressed audio
file format that uses psychoacoustic modeling to reduce
file size significantly, while retaining good audio quality.
Popular for use on the Internet and in personal music
players.

MP4

(Also known as AAC, or mpeg 1, layer 4) - A compressed
audio file format that uses psychoacoustic modeling to
reduce file size significantly, while audio quality rivals
that of uncompressed CD audio. MP4 s a fairly new stan-
dard and rising in popularity for use on the Internet and
in personal music players. Peak supports reading/writing
MP4 files.

playlist

A playlist is a list of audio events, or “regions,” strung
together in a specific order. See also region.

Plug-Ins

Plug-Ins are optional software enhancements for Peak
that are available from BIAS and other third-party manu-
facturers. By installing plug-ins in Peak’s VstPlugIns fold-
er, you can enhance Peak’s audio editing and processing
capabilities with tools such as filtering, reverberation,
chorusing and flanging, noise reduction, spatialization,
and more.
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QuickTime

This is an audio format developed by Apple Computer
for QuickTime-based multimedia. It is supported by all
that
QuickTime. The QuickTime format is best if you plan to

Macintosh ~software applications support
use an audio document in multimedia applications that
support QuickTime, such as Adobe Premiere or

Macromedia Director.

region

A region is a portion of an audio document bounded by
region markers. Regions are portions of an audio docu-
ment defined using the New Region command (38-Shift-
R) from the Actions menu or Toolbar. Regions can be
saved into only AIFF and Sound Designer II files created
by Peak. See also playlist .

sample

(verb) Sampling refers to the act of recording audio
material digitally by a sampling instrument or other digi-
tal recording device. See sampler and sample rate.

sample

(noun) A sample refers to audio material which has
recorded digitally or “sampled” by a sampling instru-
ment or other digital recording device. Sample also
refers to a single wave-cycle” snapshot” of sound. See
also sampler and sample rate.

sampler

A sampler is an electronic instrument capable of digital-
ly recording or “sampling” a sound and playing it back
from a keyboard or other controller. Samplers are used
extensively in all areas of audio production, ranging from
recording and performance, to film production and
sound design. See sample rate.

sample rate

Sample rate describes how frequently an analog audio
signal is been “sampled” or analyzed as it is recorded and
converted to a digital medium. Sample rate directly
affects audio fidelity in terms of upper frequency
response: the higher the sample rate, the higher the
available frequency response. A fundamental principle of
sampling states that to accurately capture a sound, the
sample rate must be at least twice the highest frequency
in the sound. The standard sample rate for Compact
Discs is 44.1 kHz. The following are common sample
rates which are supported by many Macintosh comput-
ers and Peak software.

192.000 kHz

This is the standard for HD (High-Definition) audio
hardware/production. This rate results in an upper fre-
quency response of 96 kHz-well above the range of
human hearing.

96.000 kHz

This is the standard sample rate for Digital Video Disc
(DVD) audio, and is often used by sound editors work-

Glossary
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ing in audio post-production for DVD. This rate results in
an upper frequency response of 48 kHz-well above the
range of human hearing,

48.000 kHz

This is one of two standard sample rates for digital audio
tape (DAT) recorders, and is often used by sound editors
working in audio post-production for video or film. This
rate results in an upper frequency response of 24 kHz-
above most people’s hearing range.

44.100 kHz

This is the standard sample rate for Compact Discs, dig-
ital audio tape (DAT) recorders, and high-fidelity audio
applications on Macintosh and PC-compatible comput-
ers with 16-bit playback capability. It is colloquially called
“forty-four one” (as in 44.1 kHz). Most sound engineers
working in music production - or anything that may be
distributed on a CD-work at this rate. This rate results in
an upper frequency response of 22,000 Hz-above most
people’s hearing range.

22.050 kHz & 11.025 kHz

These sample rates are sometimes used for lower-fideli-
ty audio playback on Macintosh and PC-compatible com-
puters. Many games, web-sites and other multimedia
productions utilize 22.050 kHz (or lower) 8-bit audio,
since it uses half the disc space of CD-quality audio. The
22.050 kHz sample rate results in an upper frequency
response of 12.025 kHz; this may sound “muffled,” since
most people can hear considerably higher frequencies
than 12.025 kHz.

Also refer to bit resolution, frequency, and Hertz.

SCsl

Stands for Small Computer System Interface. It is a stan-
dard developed to allow a variety of computers and
peripheral devices such as hard disks, CD recorders,
scanners, and other storage media, to connect and trans-
fer data. Most external hard drives designed for use with
the Macintosh are SCSI hard drives and must be con-
nected to the SCSI port on the rear of the Macintosh.
The SCSI specification allows up to seven SCSI-equipped
devices to be connected or “daisy-chained” together.

SMDI

SMDI stands for SCSI Musical Data Interchange Protocol.
SMDI Samplers use SCSI to send samples between
devices several times more quickly than over MIDL In
order to transfer samples between the Macintosh and
your sampler using SMDI, you must connect a SCSI
cable between your Macintosh and the sampler.

Sound Designer 1™

This is an audio file format developed by Digidesign for
use with its digital audio products. The format can also
be read by a wide variety of Macintosh-based audio edit-
ing and multimedia development programs, including
Peak.

vst™

“Virtual Studio Technology” - VST is a real-time, native
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plug-in standard created by Steinberg Media
Technologies, AG. Plug-ins conforming to the VST stan-
dard can be used in any compatible host application.
VST plug-ins are accessed from a central directory in the
Mac OS, making it very easy to maintain large collections
of plug-ins. Peak supports “Mach-O” and “carbonized”
VST 1.0 format effects plug-ins.

WAVE

This is Microsoft’s Windows Audio File Format. It is sup-
ported by many Windows software applications and
some Macintosh applications. The WAVE format is best if
you plan to use an audio document in an application that
supports or requires WAVE format files.

zero-crossing

The zero-crossing is the point where the waveform
meets the zero crossing line or the center line through
the waveform. It is the point of zero amplitude in the
waveform.

Glossary
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Symbols

-10 dBV 31

+4 dBu 31

au 42, 190, 249
.paf 42, 190
WAV 42

A

AAC 249

Action Menu 197

Actions 235

Add 125, 206

AIFF 21,3944, 65, 71, 97, 110, 118, 166, 189, 191, 203, 249
Allow Servers 55, 56, 86, 184
Amplifier 30-33

Amplitude Fit 25, 126
Analog-to-Digital Converter 37
Anchor 80, 95

Append to document 66, 71, 204
Apple Events 25, 26, 169

Apple System Profiler 241
AppleTalk 23, 245

Asynchronous SCSI transfer 175
Audio

playing 64

Audio between adjacent markers
selecting 80

Audio CD Import Options 70, 191
Audio Compression 40, 44, 72
Audio Connections 30

Audio Document 39, 45, 53, 78, 117
Audio Extraction 70

Audio Info 80, 102, 201

duration 127, 207

key range 80, 222

root key 80, 222

sample rate 80, 105, 130
Audio Info Area 80

Audio Interchange File Format — See “AIFF”
audio interface 32, 249
connecting 31

FireWire 32, 33, 71, 72, 204
USB 33, 241, 249

Audio Levels 69, 153

setting for recording 69
Audio Librarian Tools 169
Audio menu 64, 201

Audio Source 68, 69, 155
connecting 68

Audio Waveform Overview 64, 78
Audio Waveforms 64, 78
Audio Window 45

Audio Unit 159, 220, 249
Auditioning 52, 82, 185, 202
Authorization 29, 183

Auto Snap To Zero 222
Auto-Balloon Help 223
Auto-Import Dual Mono 221

Batch File Processor 25, 159, 160, 165
Available Processes 166

File Name Suffix 167

Input Area 166

Process Area 166

Save Changes Area 167

Index

259



BIAS Deck 21, 40, 191, 192, 204 CoreAudio 22, 32, 33, 63, 243

BIAS Freq 156 configuring for playback 64
BIAS Vbox SE 151 configuring for recording 65
Bit Depth 43, 67, 202, 206, 243, 250 Record Settings 65
Bit Resolution 80, 250 Recording 65
Blend Enable/Disable 250 Bit Depth 65
Blending 46, 52, 90, 184 Channels 65
Envelope Editor 91, 93, 100 Record Through 66, 67
Blending Envelope 53, 87, 100, 131, 208 Sample Rate 67
Bounce 109, 112, 150 CoreAudio Playback dialog 64
BPM 201 CoreAudio Settings 64
Burn Audio CD 193 Creating an Audio Document 39
Creating Loops 80
Creating Markers 80
C Crop 88
Crossfade Loop 99
CD-ROM drives 63, 70 Crossfades 90
CDDB online CD database 71 Hand Tool 46
Change Duration 127, 207 Magnifying Glass 46
Change Gain 128, 207 Arrow Cursor Tool 46
Change Pitch 129 Cut 86

Choosing a Time Format 220
Choosing Colors 53, 187

Clear Clipboard 86, 196 D

Clicks 22, 45, 47, 142, 144

Clip Indicator 48, 69, 151, 153 dB (decibel) 48, 69, 80, 128, 153, 156
Clipboard 195, 196, 206, 210 Decibel 48, 69

Clipping 48, 69, 114, 213, 250, 251 Decrease Vertical Zoom 197, 230
Close 42 Delete 86, 90

Close All 42 Delete Except Audio 196

Colors 53, 187 Device and Sample Format 72, 204
Compressed Audio support 40, 44, 72 Digidesign 190, 221, 249

Compute File Max dB 80, 221 Digigram 249

Contents Palette 49, 223, 224, 237 Digital Audio

resizing 188 explained 37

Convert Sample Rate 129, 208 Digital Sampling 37

Convolve 130, 208 Digital Signal Processing 125

Copy 86 Disk-based Recording 38
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dithering 43, 119, 188 through Batch File Processor 104
Document From Playlist 118, 120, 189
Document From Selection 89, 189, 229

Exporting Playlist as a Text Document 118

Drag and Drop

folders, disks, CD audio tracks 41
Draw Tool 46

DSP 125

DSP Preferences 128

DTR 47

Dual Mono 40, 58, 66
auto-import 53, 221

Dynamic Range 38, 250
Dynamic Scrub Time 51, 82, 222
Dynamic Scrubbing 51, 82, 222

E

E-mu 42, 175

Paris System 40, 42

Echo 249

Edit Marker dialog 49, 94
Edit Menu 194

Editing 75

Cut 85, 86
Nondestructive 21, 38
Editing Audio 75
Auto-Zero 46, 79, 94

editing VST plug-in parameters 156

Edits command 84

Effect Assignment pop-up menu 152

Ensoniq ASR-X 218

Export Dual Mono 192
Export Marker Regions 192
Export Regions 192
Output Directory 166
Output Format 104
Region Detection 104

Fade Envelope Editor 126, 132
Fade In 71, 92

custom, saving 92

Fade In Envelope 92

Fade In/Out Envelope
loading 92

Fade Ins and Fade Outs 92
Fade Out 71, 92

Fade Out Envelope 92
Fast-Forward 202
feedback 32

File Format 42

selecting for recording 65
File Menu 188

File Sharing 21, 169
FileMaker Pro 21, 169
FileMaker Pro template 57, 170
Find Peak 133, 209

Fit Selection 197

Floaters 187, 188
Fragmentation 39
Frequency 37

G

Gain 66, 128

Gain Envelope 133, 209

Go To command 200
Graphical User Interface 151
Guess Tempo 102
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H

Hard Disk Maintenance 23, 39
Hard Drive, recording to 37-39
requirements 22

Hardware Options 73, 204
Hardware Settings 64
Headroom 69

Help 183, 241

Help Menu 183

Hertz 37, 251

Hz (Hertz) 37, 251

IMA 40

Import CD Track 70, 191
Import Dual Mono 40, 53
Increase Vertical Zoom 78
Insert 66, 77

Insert Silence 88

Insertion Point, at Selection Start /End 66, 77

Installing Peak 29
Interactive Editing 77
Invert 135, 211

ISRC codes 119
iTunes 71

JAM Image 40, 109
Audio CD burning 119
regions 49, 97

Jog Scrubbing 51, 82, 83

K

Key Range 80, 222
Keyboard Shortcuts 56, 229
“cue card” 57

customizing 56

removing 56

Korg 249

Kurzweil 175

Levels for Recording 69
Linear Recording 38

Links Menu 225

Location submenu 200
Loop 80

crossfade 52, 90

Loop Tuner 136, 211

using Threshold command 145
Loop End 95

Loop End button 98

Loop Start 95

Loop Start button 98

Loop Surfer 98, 100

Loop This Selection 98, 198
Loop Tuner 88, 103, 211
Loops 80, 98, 99, 100
creating 98

Use Loop in Playback 64

M

M-Audio 21
MACE 40
Macintosh, using the built-in inputs and outputs 30, 63
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Make Loop button 101 Normalize 139, 213

Mark of the Unicorn 21 Notepad 68

Marker 80 Nudge 79, 96, 198

Show Marker Time 221 Nudge Loop Backward 198
Markers 80 Nudge Loop Forward 198
Audio between adjacent markers 80 Nudge Regions 115
Delete 86

dynamic scrubbing 51

Nudge 79, 96, 198 (0)

Markers to Regions 199

Master Output Volume 50 Online Help 26

Meters 48 Only Regions 104

Meters dialog 48 Open 39

Mix 137, 212 Open an Existing Documents 39
Mixer 30, 31

mixer configuration 30

Modulate 138 P

Monitor 31, 32, 66

Mono to Stereo 136, 211 Palettes 44

MOTU-828 33 Panner 139, 213

Move Waveform During Playback 52 Paste 77, 87

Movie Sound Tracks 105, 222 Peak, finding 133, 209

Movie Window 106, 223
MP3 21, 22, 40, 252 what’s new 22
Peak Envelopes Folder 91, 92, 100
Peak Features 21

installing 29

N Peak Hold 48, 205

Peak LE 24
New 39, 188 Peavey 175
New Audio Document, from a Playlist 117 Pencil 45, 47
from Selection 89 Performance, maximizing 23
New Marker 147 Phase Vocoder 140, 213
New Region 97 Pitch Change 129, 207
Next Selection 196 Play Selection 202
Non-Destructive Editing 21 Play w/Auditioning 202
Non-Destructive Recording/editing 21, 38 Play/Pause 202
Non-Linear Recording/Editing 38 Playback 64
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Playback Buffer 51
Playback Buffer Size 51
Playback Master Volume 51
Playback Preferences 50
playback systems 30
Playing Audio 64

Playlist 112

applying VST plug-ins 150
auditioning 52

post-roll 52

pre-roll 52

Bounce 118, 150

Burn CD 119

crossfade 115

gain 113

gap time 115

modifying events 114
Nudge Regions 115
opening 118

saving 118

scrubbing 114

VST plug-ins 116

Playlist Document 112
Playlist Event 114

Playlist VST Plug-Ins pop-up menu 116
Plug-Ins 149

VST 149, 254

bounce 150

Position field 94

Post-roll 52

POW-r dithering 43
POW-r Dither Settings 43
Preferences 50
Preferences dialog 50
Previous Selection 196
Pro Tools 190, 221, 249
Processing. See Plug-in
Channel Independent 79

Product Authorization Code 29
Progress Bar 49
Proper Levels 69

Q

QDesign 40
QuickTime 21, 71, 105
file format 42

QuickTime Movies, editing soundtracks 105

Quit 188
Quitting 58

RAM 22, 131
crossfades 90, 115

requirements 22

Random-access Recording/Editing 38
Rappify 141, 214

Recently Opened Documents 193
Record 48, 63, 202

Record Dialog 68

Record Settings 65, 203

CoreAudio 63

Record Through VST Plug-In 66, 159
Record Timer 66

Recording 68

Recording levels 69

Recording Options 65

Red-Book 119

Redo 84, 194

Reference Point 95

Regions 97, 109

creating 97

editing 97
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exporting 97

while recording 68

Remove DC Offset 144, 216
Repair Clicks 142, 214
Replace 87, 195

Reverse 144, 216

Reverse Boomerang 144, 216
Root Key 80, 222

Roxio 21

JAM 42, 109, 118

Toast 21, 119

S

Sample 37, 253

Sample Rate 37, 45, 253
conversion 130, 208

Sample Units 220

Sampler 175

send 177

Sampler Menu 217

Sampler Preferences 50, 186
Sampler Support 175
Samplers 175
Asynchronous SCSI sample transfers 175, 245
E-mu 175, 218

Kurzweil 175, 218

List of Samplers 175

Peavey 175, 218

receive 177

SMDI Device 175

SMDI Sampler Error Messages & Troubleshooting 178
Samples List 176

Sample Units 220

Sampling 21

Save 43, 190

Save A Copy As 43, 191

Save As 43, 191

with dithering 43

Saving 42

Scratch Disks 55, 85, 184
Script (Batch File Processor) 168
Script Definition 170

Scroll During Playback 51
Scrubbing 82

SCSI 70, 175, 245

Sel 47

Select All 196

Select Loop 196

Selecting a region 79

Selecting Audio 81

Selections 79

Set Selection 196

Shortcuts & Toolbar 187

Show Edits 90, 221

Show Marker Times 52, 221
Show Overview 221

Shuttle Scrubbing 82, 235
Silence 195

insert 195

SMDI 175

SMDI Sampler 175, 178

Snap Selection to Zeros 198
Sonic Solutions 42, 190

Sound Designer 1I 21, 42, 97, 109
Sound Designer II format 135, 210
Sound Dialog 72

Sound frequency 37

Source 30, 68

Spacebar Operation 52, 64, 235
Speakers 30

Split Stereo 66, 204

Stack Windows 224

Start Surfing 101

Steinberg 21, 149
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Stereo Document 39, 137, 189
stereo mini-plug 31

Stereo To Mono 136, 211

Stop & Extend Selection 202
Stop/Rewind 202

Storage Requirements 38
Swap Channels 145, 216
System Requirements 22
0§X22

T

Tape-Style Scrubbing 83
Tascam US-428 33
technical support 7
Tempo 101, 102, 199, 201
Tempo Calculator 101
Theme 54

Threshold 102

Tile Windows 224

Time Display 48

Time Format 54

Time Units 220
Timestamp 220

Toolbar 57, 223
customizing 187
Transport 68

Transport Controls 64
Transport Window 48

U

Undo 194
Unlimited Undo and Redo 77
Use Loop in Playback 220

'}

Vbox SE:

A/B comparisons 155

box controls 152

Bypass button 153

changing input routing 154
creating parallel effects chains 155
creating serial effects chains 154
Edit button 154

input and output meters 153
level controls 153

master input and output meters 155
Master Wet/Dry controls 155
matrix 151

moving boxes 154

Mute button 153

Preferences 156

presets 155

Solo button 153

Vbox SE 149, 151, 156, 218
Vertical Scaling 78

Views 236

VST 219, 254

VST Envelope 158, 186

VST plug-ins 116, 149, 152, 218, 219, 237

assigning 152

batch file processing 159
bouncing 157, 219

delay compensation 158
in Peak LE and DV 24
insert 149

installing 149

managing and mixing 149
organizing 152

Playlist snapshot 117
record through 159
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WAVE 42, 166, 189, 190, 249, 255

Waveform Display 45, 52, 54, 78, 184, 211, 221
Waves 149, 156

Window Buffer:

settings 50

size 50

Windows 44

Windows Audio File Format 42, 255

Windows Menu 44, 177

Y

Yamaha 178

y A

Zero-Crossing 79, 94, 198, 255
Zoom All the Way Out 198
Zoom at Sample Level 198
Zoom In 197

Zoom Out 197

Zoom Tool 46
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